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Citrix App Layering 4

Mar 24 , 2017

Welcome to application management simplicity

Citrix App Layering makes it easier to manage your Windows applications. Regardless of which hypervisor or provisioning

service you use, Citrix App Layering can help you manage your applications and operating systems.

Citrix App Layering separates the management of your OS and apps from your infrastructure. With Citrix App Layering you

can install each of your apps and operating system patches once, and use them as part of any image you deploy. You can

publish Layered Images as open standard virtual disks usable in any environment. This allows you to maintain a single

Windows installation, and a single copy of each application, that you use for all of your images across all of your virtual

environments.

Citrix App Layering wraps each of your applications in a Layer, and stores the Layers as virtual disks.

You can pull together any combination of these App Layers and an OS Layer as part of a Layered Image, and publish it

to your target platform.

That means that you can install an application or OS once, and deploy it as part of any number of images.

Provision servers in any environment

Citrix App Layering lets you to package any Windows app as a virtual disk Layer and deliver it, installation-free, to session

hosts. With Citrix App Layering, you can:

Install and manage a single copy of your Windows OS and a single copy of each of your apps in Layers.

Select any combination of Layers to create Layered Images that are deployable as Session Hosts.

Deploy those Layered Images to virtual machine session hosts, making the applications available to users.

New applications, application updates, and Windows patches can be delivered to an entire RDSH farm with a single image

update.

Deliver applications with ease

Using the Citrix App Layering Management Console, you can:

Layer Applications and deliver them as read-only virtual disks to session hosts. Layering is faster and easier than app

virtualization and is compatible with more apps.

Layers have the look and feel of a local installation and enable full application interoperability.

Layer a Windows OS and deliver it as a read-only virtual disk to all session hosts. Patch an OS layer once to update an

entire RDSH server farm.

Layer platform tools and software to hold infrastructure-related software and settings. This allows you to maintain

platform-independent OS and App Layers.

Provision RDSH VMs. You can create custom RDSH virtual machines by assigning any combination of compatible OS and

App layers in any order.

A simple addition to your environment

The heart of the Citrix App Layering deployment is the App Layering apliance (aka Enterprise Layer Manager), a virtual

appliance that you deploy in your environment. The App Layering appliance hosts the App Layering Management Console, a

friendly interface where you create Layers, and then assign them to either Layered Images, or directly to users via Elastic
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Assignment.

Citrix Layers

With Citrix App Layering you can create OS, App, and Platform Layers once, and use them to create any number of Layered

Images. You can then update the OS, app, or Platform software by adding a new Version to the Layer for each patch or

update that you apply.

In App Layers you can deploy virtually any applications compatible with the OS. Each App Layer can include one or more

applications. When it's time to upgrade an application, you can add a new version to the Layer for the latest update.

Platform Layers are designed to support your environment. A Platform Layer containing your hypervisor tools and settings

makes it easy to create layers using VMs in your hypervisor environment. A Platform Layer containing your hypervisor,

provisioning service, and connection broker software isolates App and OS Layers from the infrastructure where they will be

published.

Layered Images for provisioning Session Hosts and servers

Image Templates are where you choose the Operating System and Layer assignments for an Image. You can include OS

and App layers in any number of Image Templates. Using an Image Template and a Platform Layer, you can publish a Layered

Image to your provisioning service, hypervisor, or network file share .

You can publish Layered Images as virtual disks to any location to which the appliance has access, and use the disks to

provision as many servers as you need.

Connectors

A Connector configured with the credentials for a specific location in your virtual environment, allows Citrix App Layering to

publish the Layered Images and provision servers in a specific location.  

Compatability

For compatibility details, see System Requirements.  

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
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What's new

Jun 29, 2017

Welcome to Citrix App Layering 4

Citrix App Layering provides open application management across all end user computing solutions, hypervisors, and clouds.

Citrix App Layering is the open solution for Windows application packaging and image management. With Citrix App

Layering, IT  administrators can package any Windows app as a virtual disk container (“layer”) in minutes for install-free

delivery to session hosts and virtual desktops on any hypervisor or cloud. With Citrix App Layering Elastic Layering

applications are attached dynamically at logon to pooled non-persistent desktops remote desktop session host (RDSH)

sessions based on user policy. This enables Users’ sessions to be personalized with the applications they need.

Citrix App Layering supports leading virtualization and cloud platforms including Citrix XenServer, Microsoft Azure, Microsoft

Hyper-V, Nutanix AHV, and VMware vSphere. App Layering integrates with leading end user computing platforms including

Citrix XenApp/XenDesktop, Citrix XenServer, Microsoft Azure RDSH, Microsoft Hyper-V RDS, VMware Horizon View, and

Nutanix AHV.

Supported platforms

For information about Citrix App Layering -supported platforms, see System Requirements.

Upgrade path

You can upgrade from Unidesk 4.0.8 to Citrix App Layering 4.2.0. To access the Management Console via the Citrix Cloud,

please install a Cloud Connector, as described in the Upgrade instructions.

Contact Citrix

We welcome your feedback about this release.

Use our online Forum to speak directly with Citrix employees and other organizations deploying Citrix App Layering.

For product issues and questions, open a Support Case.

We look forward to hearing what you think about App Layering!

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
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What's New in App Layering 4.2

Jun 29, 2017

User Layers now support Windows 10, 64-bit (Labs) This support is still only for publishing to View Composer / View

JIT  / XenDesktop use cases for VDI. (App Layering Labs)

When a User Layer is unavailable to end users, they will be notif ied via an on-screen message. You can

customize these notif ication messages. (App Layering Labs)

Labs features in this release

Labs features are early versions of features planned for future releases. Typically, new Labs features are disabled when you

install the product. In this release, Labs features include:

User Layers. You can persist user profile settings, data, and user-installed applications in non-persistent VDI

environments with the User Layer. The User Layer now supports Windows 7 64-bit and Windows 10, 64-bit environments

for Citrix XenDesktop, VMware Horizon View and View JIT . Additional operating systems and session environments will be

supported going forward.

Access the Management Console via Citrix Cloud (Labs). You can access the App Layering Management Console via

the Citrix Cloud App Layering Manage tab.  

Known issues and considerations

Access via Citrix Cloud (Labs). For known issues accessing the Management Console via the Cloud, which is currently in

Labs, see the Access the Management Console section for full details.

File downloads f rom Citrix ShareFile. If  using Citrix ShareFile, you can download files, but changes to the files cannot be

saved. (UNI-55850)

NFS protocol no longer supported for new File Shares. Current NFS shares cannot be configured, but will continue to

work. Because NFS cannot be used for Elastic Layers and User Layers, the option to configure an NFS fileshare has been

removed from the product. File Shares already configured using the NFS protocol, will continue to work, though you will not

be able edit/change/or add new File Shares using NFS. SMB only is recommended. (UNI-55648)

User Layer (Labs)

There are issues with Windows Search when using a User Layer. (UNI-53320), (UNI-54524), (UNI-54520)

Red 'X' network adapter icon indicates there's an issue even when the network is functional. When using a User Layer,

the network icon will appear as a red x, even when everything is functional. You can ignore the red 'X'. (UNI-53443)

Microsoft Office should be in the Layered Image. If  using add-ins or Office 365, you must include Office in the Layered

Image, not in the User Layer. If  not, you will have activation issues. (UNI-53474)

User Layers on Windows 10

If  User Layers were enabled on a Windows 10 Layered Image using a previous version of the product, those User Layers

(.vhd f iles) must be deleted, as User Layers were not supported on Windows 10. The current release (4.2.0) contains

signif icant updates to the User Layers feature, which allows User Layers to work with Windows 10 images. If  prior to this
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release any Windows 10 images have been published with User Layers enabled, these must be re-published. Further, if

Windows 10 App Layers have already been created, a new Version of those Layers must be added for use with this and

future releases.

Windows 10 Store Apps can be turned off  on Windows 10 Enterprise (but not Professional edition). If  you want to

completely disable Windows 10 Store Apps, please create a new OS revision, run

C:\Windows\Setup\Scripts\RemoveStoreApps.cmd from an administrator prompt, f inalize and deploy image based on

this OS revision. Users will have access to Edge and Cortana only. (UNI-56935)

When advancing the OS layer to a new major version of Windows 10, for example, advancing from 1511 (Threshold 2) to

1607 (Redstone), existing users may experience Store Tile reconstruction on their initial login following the upgrade. The

reconstruction period is generally less than one hour but could be longer depending on system load factors and the

behavior of Windows itself . During this period, users may notice Start-menu tiles that lack their proper icons, or that do

not respond. In most cases, a tile's response will be slow and may appear to be broken. However, these conditions will

resolve themselves during the reconstruction period. Other (non-tile) applications will continue to work f ine, but may run

slower due to the reconstruction activities in the background.Each user's initial log-in following a major OS upgrade will,

itself , take longer. This too is caused by reconstruction activities and should be considered normal post-upgrade behavior.

If  you roll back a Windows 10 OS Layer across major versions (ex.1607 to 1511), User Layers will not be compatible. Rolling

back from one sub-release to another is f ine. If  the User Layers are not compatible, they will need to be deleted and

recreated. (UNI-57006)

Temporary Element not found. Some newer versions of Windows 10 use Store apps as default applications. When

starting a system, those applications may not be ready or may take some time to update. In those cases attempting to

open a f ile with an association to one of those applications may produce an "Element not found" message until the

application is ready to use thorough the Windows Store. (UNI-57749)

Changes to Windows Indexing options do not persist when User Layers are enabled on Windows 10 and Windows 7

desktops. If  you have set Indexing Options for an App that is elastically layered, the settings will not be present when

the user logs in. If  there is an indexing option change that is critical for all users, you can include it in a new version of the

OS Layer, or better yet in a new App Layer. This will become the default for all users. (UNI-56064, UNI-56213)

User Layers on Windows 10 and Windows 7

Changes to Windows Indexing options do not persist when User Layers are enabled on Windows 10 and Windows 7

desktops. If  you have set Indexing Options for an App that is elastically layered, the settings will not be present when

the user logs in. If  there is an indexing option change that is critical for all users, you can include it in a new version of the

OS Layer, or better yet in a new App Layer. This will become the default for all users. (UNI-56064, UNI-56213)

Common across platforms

Tasks created prior to this release do not have fully qualif ied owners and can only be canceled by an Administrator. (UNI-

52741)

Appliance with reconfigured IP address loses network service failure."If  the App Layering appliance has a Dynamic IP

address and it is reconfigured to use a Static IP address, and the address is already in use with another VM, the appliance

may lose network service with the error, "job for network service failed." If  the appliance loses network connectivity,

change to an unused IP address and reboot the appliance.
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App may appear to load slowly on a user's session. For applications that automatically update, like Chrome and Firefox,

updates should be turned off . Windows will prompt the user to make changes with Admin rights even though the user

does not have those rights. Instruct the user to click No when prompted, and the application will load successfully.

Citrix App Layering Agent requires .NET Framework 4.5, but the installer lists 4.0 as a prerequisite.The Citrix App Layering

Agent needs .NET Framework 4.5 but lists 4.0 as a prerequisite. This causes the installer to fail when it reaches "Starting

services", and the Citrix App Layering Agent logs show the service trying to start up repeatedly. Install .NET Framework

4.5 as a prerequisite for the Citrix App Layering Agent. (UNI-50769)

User receives alert on f irst launch of an elastically assigned Skype Layer.When a Skype Layer is elastically assigned, the

user receives this alert the f irst time the app is launched, "The Installer has insufficient privileges to modify this f ile: url." If

the user clicks the Ignore button, Skype opens as expected. (UNI-52164)

Use the same hypervisor when adding a Version to your OS Layer. When adding a Version to an OS Layer, you must

package the Layer on the same hypervisor from which you imported the OS during Layer creation. (UNI-44372)

After adding new disks to the appliance, be sure to reboot. When adding disks to expand storage, a reboot of the

appliance is recommended after the disk expansion wizard has completed the operation. (UNI-53580)

Elastic Layers require .NET Framework 4.5. If  you are using Citrix App Layering Elastic Layers, .NET Framework 4.5 must be

installed on any Layered Image where Elastic Layers are enabled.

Empty directories visible to Windows Explorer users when Citrix App Layering drivers are running. When an image has been

enabled with Elastic Layering, a user using Windows Explorer to view files and directories may be able to see empty

directories associated with other sessions using Elastic Layering if  they also use Windows Explorer to browse f iles.

Directories explored in the other session may create folders visible to all sessions that have the rights to browse that

directory. The directories and the contents of them will not be visible to users who do not have access to the volume.

If  using Elastic Layer Assignments with Windows Server 2008 or Windows 7, your f ileshare must be created with a sector

size of 512.

For details about this issue and related OS updates, see the Microsoft articles about Microsoft support policy for 4K

sector hard drives in Windows, and Update that improves the compatibility of Win 7 and Win Server 2008 R2 with

Advanced Format Disks. (UNI-48984)

When using Elastic Layer Assignments, Persona Management in Horizon View is not supported. Although Citrix App

Layering supports Horizon View 6.1 and later, Elastic Layer Assignments do not work with these versions of View Persona

Management. (UNI-53639)

When using Connector Caching, the OS Machine Tools are not updated. When creating a new App Layer version, if  the

previous boot disk is still in the connector cache, it will be used to build the packaging machine and the tools on it may be

out-of-date. (UNI-58113)

When logging in to a Packaging Machine, you must use the built-in Administrator account. Otherwise, RunOnce scripts

will not be executed, and the Layer will not be f inalized. (UNI-58154)
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Automatic Windows Updates are now disabled during OS Layer updates. This helps to avoid situations where Windows

could initiate an update in the background just prior to, or during, an OS Layer f inalization. When adding a new Version to

an OS Layer, you must manually initiate the download and installation of the Windows updates, and repeat until all

available updates have been applied before f inalizing the new OS Layer Version. (UNI-58115)

Elastic Layering MS Office

Shortcuts to elastically assigned Office apps may be visible on the Start menu for users who are not assigned the apps.

Although these shortcuts are visible, they only work for users who are assigned the apps. (UNI-49687)

When MS Office is assigned elastically, use built-in license activation scripting. For best results when using off ice

elastically, consider using built-in license activation scripting and adding c:\windows\setup\scripts\off iceactivate.cmd to

the script path when f inalizing the Office App Layer or editing its properties. (UNI-50467)

When elastically layering MS Office, do not install One Note. Instead, include OneNote in the Layered Image. The One

Note printer driver allows other Office apps to print to One Note. For further details, refer to the Microsoft Office

Recipe. (UNI-50449)

Windows 10

Windows 10 upgrades require a 60 GB disk for the OS Layer Version. When adding a Version for upgrading your Windows

10 OS Layer, be sure to change the Max Layer Size from the default of 30 GB to the required 60 GB. (UNI-52422)

Additional step required when upgrading a major Win 10. During a major upgrade, for example when upgrading from 1511

to 1607, Windows 10 sometimes creates a Recovery Volume as a new partition on the same disk as the OS Layer

Version. This volume should always be removed before you f inalize the OS Layer Version. Otherwise, the recovery volume

can cause desktops to fail to boot correctly. For the steps to safely remove a recovery volume, click here.

Citrix PVS

When creating an Image Template, the template's target device hardware settings must match the Windows OS and

Platform Layer settings. Make sure the target device hardware settings match the OS and Platform layer hardware

settings, especially the number of CPUs. If  they don't match, you can get a reboot required message when the published

image is booted. (UNI-50799, UNI-46333, UNI-51599)

When using PVS, you must disable IPv6 in the OS Layer. If  this is configured in the Platform Layer instead of in the OS

Layer, when the resulting PVS machines boot, they will lose their network connection and hang. (UNI-53600)

If  permissions are wrong when publishing an image, you may get an error message that states that the operation has

timed out. (UNI-54516)

Although the UMC allows image names that contain a period ("."), those names fail in the PVS environment. Do not

include a period in the name. UNI-54263)

XenServer

When preparing your OS image for use in XenServer, you must open port 5900. (UNI-50846)
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Creating a Citrix App Layering Connector Configuration that points to a slave node in a XenServer pool produces an

unexpected error message.To avoid this issue, only use the master node when creating Connector Configurations. (UNI-

52454)

When importing an OS layer from a XenServer VM, use the XenServer connector to perform the import directly.There

may be issues exporting the VM image to a network f ile share f irst and then reimporting it. (UNI-52669)

VMware Horizon View

Elastic layers are only supported with f loating desktop pools. (UNI-53442)

Microsoft Azure

The Azure File Share feature is not supported. However, you must create an NFS or SMB file share in Azure to use with

Citrix App Layering . (UNI-42272)

Publishing Layered Images simultaneously to the same Azure resource group fails. Either deploy one at a time, or deploy

the Layered Images to different resource groups.(UNI-43376)

Using a Fully Qualif ied Domain Name (FQDN) in Azure can fail if  not entered in the format Azure expects. When

deploying in Azure, the Azure template requires the FQDN in a specif ic format, or it will fail. Click here for details. (UNI-

51587)

Azure Connector Configuration name must be unique. When creating an Azure Connector Configuration, you cannot use

the same name as an existing configuration, or your changes will not be saved. (UNI-56230)

Microsoft Hyper-V

When using Elastic Layering in Hyper-V, you must use unmanaged RDS pools.(UNI-53545)

Imprivata

Imprivata App Layers must be created with the appropriate broker Platform Layer as a prerequisite. This is critical for

Citrix PVS/MCS and Horizon View environments
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What's New in App Layering 4.1

Jun 29, 2017

Improved performance when Creating App Layers using XenServer and Nutanix. You can configure the XenServer

and Nutanix Connectors to cache boot and packaging disks and reuse them. Once these disks have been cached as part

of creating your f irst App Layer, the time it takes to create subsequent App Layers is cut in half .

OS images can be imported directly f rom your vSphere or XenServer VM. When using a vSphere or XenServer

connector to create an OS Layer, the OS image can now be imported directly from a VM.

User Layers can now be stored in multiple f ile shares of  your choice.
Automatic shutdown for MCS or View. When you publish a Layered Image to MCS or View, the image is shutdown

automatically so that a snapshot can be taken. For details, click Publish to MCS, and Publish to View.

The PVS connector allows canceling of  long running operations. The PVS connector now provides the ability to

cancel long running operations, for example, copying the VHD to a PVS datastore. The Cancel operation automatically

cleans up unnecessary f iles, such as vDisks, from failed publish operations.

Improved search for Platform Layers. You can now search for Platform Layers that were created using a particular OS

Layer.

Upgrades are automatically downloaded, and you choose when to install them. When App Layering software

upgrades become available, it is automatically downloaded to the appliance. When the download completes, you will be

notif ied that an upgrade is available the next time you log into the Management Console.

When upgrading to this release, the default passwords for the Admin accounts must be changed (a one-time
event). When you install this release or upgrade to it, you will be required to change default passwords for the

administrator accounts, including the Management Console Administrator, the Appliance Configuration Tool

administrator, and the Linux root user.

Labs features in this release

Labs features are early versions of features planned for future releases. Typically, new Labs features are disabled when you

install the product.  In this release, Labs features include:

User Layers. You can persist user profile settings, data, and user-installed applications in non-persistent VDI

environments with the new User Layer. The User Layer currently supports Windows 7 64-bit environments for Citrix

XenDesktop, VMware Horizon View and View JIT . Additional operating systems and session environments will be

supported going forward.

Access the Management Console via Citrix Cloud (Labs). You can access the App Layering Management Console via

the Citrix Cloud App Layering Manage tab. For steps and known issues, click here, if  this is a new installation, or here if

you are upgrading from a Unidesk 4.0.x release.

Issues fixed

OfficeActivate.cmd script modified. The OfficeActivate.cmd script now executes as expected. (UNI-52166)

Network information. Issues with Network cards during boot image creation have been fixed. (UNI-53643, UNI-51569)

Windows 10 and Windows Server 2012 R2 Start Menu. After upgrading Windows, the Start Menu works as expected.

(UNI-53736)
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Known issues and considerations

Access via Citrix Cloud (Labs). For known issues accessing the Management Console via the Cloud, which is currently in

Labs, see the Access the Management Console section for full details.

File downloads f rom Citrix ShareFile. If  using Citrix ShareFile, you can download files, but changes to the files cannot be

saved. (UNI-55850)

NFS protocol no longer supported for new File Shares. Current NFS shares cannot be configured, but will continue to

work. Because NFS cannot be used for Elastic Layers and User Layers, the option to configure an NFS fileshare has been

removed from the product. File Shares already configured using the NFS protocol, will continue to work, though you will not

be able edit/change/or add new File Shares using NFS. SMB only is recommended. (UNI-55648)

User Layer (Labs)

There are issues with Windows Search when using a User Layer. (UNI-53320), (UNI-54524), (UNI-54520)

Red 'X' network adapter icon indicates there's an issue even when the network is functional. When using a User Layer,

the network icon will appear as a red x, even when everything is functional. You can ignore the red 'X'. (UNI-53443)

Microsoft Office should be in the Layered Image. If  using add-ins or Office 365, you must include Office in the Layered

Image, not in the User Layer. If  not, you will have activation issues. (UNI-53474)

Common across platforms

Tasks created prior to this release do not have fully qualif ied owners and can only be canceled by an Administrator. (UNI-

52741)

Appliance with reconfigured IP address loses network service failure."If  the App Layering appliance has a Dynamic IP

address and it is reconfigured to use a Static IP address, and the address is already in use with another VM, the appliance

may lose network service with the error, "job for network service failed." If  the appliance loses network connectivity,

change to an unused IP address and reboot the appliance.

App may appear to load slowly on a user's session. For applications that automatically update, like Chrome and Firefox,

updates should be turned off . Windows will prompt the user to make changes with Admin rights even though the user

does not have those rights. Instruct the user to click No when prompted, and the application will load successfully.

Citrix App Layering Agent requires .NET Framework 4.5, but the installer lists 4.0 as a prerequisite.The Citrix App Layering

Agent needs .NET Framework 4.5 but lists 4.0 as a prerequisite. This causes the installer to fail when it reaches "Starting

services", and the Citrix App Layering Agent logs show the service trying to start up repeatedly. Install .NET Framework

4.5 as a prerequisite for the Citrix App Layering Agent. (UNI-50769)

User receives alert on f irst launch of an elastically assigned Skype Layer.When a Skype Layer is elastically assigned, the

user receives this alert the f irst time the app is launched, "The Installer has insufficient privileges to modify this f ile: url." If

the user clicks the Ignore button, Skype opens as expected. (UNI-52164)

Use the same hypervisor when adding a Version to your OS Layer. When adding a Version to an OS Layer, you must
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package the Layer on the same hypervisor from which you imported the OS during Layer creation. (UNI-44372)

After adding new disks to the appliance, be sure to reboot. When adding disks to expand storage, a reboot of the

appliance is recommended after the disk expansion wizard has completed the operation. (UNI-53580)

Elastic Layers require .NET Framework 4.5. If  you are using Citrix App Layering Elastic Layers, .NET Framework 4.5 must be

installed on any Layered Image where Elastic Layers are enabled.

Empty directories visible to Windows Explorer users when Citrix App Layering drivers are running. When an image has been

enabled with Elastic Layering, a user using Windows Explorer to view files and directories may be able to see empty

directories associated with other sessions using Elastic Layering if  they also use Windows Explorer to browse f iles.

Directories explored in the other session may create folders visible to all sessions that have the rights to browse that

directory. The directories and the contents of them will not be visible to users who do not have access to the volume.

If  using Elastic Layer Assignments with Windows Server 2008 or Windows 7, your f ileshare must be created with a sector

size of 512.

For details about this issue and related OS updates, see the Microsoft articles about Microsoft support policy for 4K

sector hard drives in Windows, and Update that improves the compatibility of Win 7 and Win Server 2008 R2 with

Advanced Format Disks. (UNI-48984)

When using Elastic Layer Assignments, Persona Management in Horizon View is not supported. Although Citrix App

Layering supports Horizon View 6.1 and later, Elastic Layer Assignments do not work with these versions of View Persona

Management. (UNI-53639)

Elastic Layering MS Office

Shortcuts to elastically assigned Office apps may be visible on the Start menu for users who are not assigned the apps.

Although these shortcuts are visible, they only work for users who are assigned the apps. (UNI-49687)

When MS Office is assigned elastically, use built-in license activation scripting. For best results when using off ice

elastically, consider using built-in license activation scripting and adding c:\windows\setup\scripts\off iceactivate.cmd to

the script path when f inalizing the Office App Layer or editing its properties. (UNI-50467)

When elastically layering MS Office, do not install One Note. Instead, include OneNote in the Layered Image. The One

Note printer driver allows other Office apps to print to One Note. For further details, refer to the Microsoft Office

Recipe. (UNI-50449)

Windows 10

Windows 10 upgrades require a 60 GB disk for the OS Layer Version. When adding a Version for upgrading your Windows

10 OS Layer, be sure to change the Max Layer Size from the default of 30 GB to the required 60 GB. (UNI-52422)

Additional step required when upgrading a major Win 10. During a major upgrade, for example when upgrading from 1511

to 1607, Windows 10 sometimes creates a Recovery Volume as a new partition on the same disk as the OS Layer

Version. This volume should always be removed before you f inalize the OS Layer Version. Otherwise, the recovery volume

can cause desktops to fail to boot correctly. For the steps to safely remove a recovery volume, click here.
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Citrix PVS

When creating an Image Template, the template's target device hardware settings must match the Windows OS and

Platform Layer settings. Make sure the target device hardware settings match the OS and Platform layer hardware

settings, especially the number of CPUs. If  they don't match, you can get a reboot required message when the published

image is booted. (UNI-50799, UNI-46333, UNI-51599)

When using PVS, you must disable IPv6 in the OS Layer. If  this is configured in the Platform Layer instead of in the OS

Layer, when the resulting PVS machines boot, they will lose their network connection and hang. (UNI-53600)

If  permissions are wrong when publishing an image, you may get an error message that states that the operation has

timed out. (UNI-54516)

Although the UMC allows image names that contain a period ("."), those names fail in the PVS environment. Do not

include a period in the name. UNI-54263)

XenServer

When preparing your OS image for use in XenServer, you must open port 5900. (UNI-50846)

Creating a Citrix App Layering Connector Configuration that points to a slave node in a XenServer pool produces an

unexpected error message.To avoid this issue, only use the master node when creating Connector Configurations. (UNI-

52454)

When importing an OS layer from a XenServer VM, use the XenServer connector to perform the import directly.There

may be issues exporting the VM image to a network f ile share f irst and then reimporting it. (UNI-52669)

VMware Horizon View

Elastic layers are only supported with f loating desktop pools. (UNI-53442)

Microsoft Azure

The Azure File Share feature is not supported. However, you must create an NFS or SMB file share in Azure to use with

Citrix App Layering . (UNI-42272)

Publishing Layered Images simultaneously to the same Azure resource group fails. Either deploy one at a time, or deploy

the Layered Images to different resource groups.(UNI-43376)

Using a Fully Qualif ied Domain Name (FQDN) in Azure can fail if  not entered in the format Azure expects. When

deploying in Azure, the Azure template requires the FQDN in a specif ic format, or it will fail. Click here for details. (UNI-

51587)

Azure Connector Configuration name must be unique. When creating an Azure Connector Configuration, you cannot use

the same name as an existing configuration, or your changes will not be saved. (UNI-56230)

Microsoft Hyper-V

When using Elastic Layering in Hyper-V, you must use unmanaged RDS pools.(UNI-53545)
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Imprivata

Imprivata App Layers must be created with the appropriate broker Platform Layer as a prerequisite. This is critical for

Citrix PVS/MCS and Horizon View environments
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System requirements

Jun 29, 2017

Hypervisor

Citrix Layering appliance (Enterprise Layer Manager [ELM])

The Citrix Layering appliance and connectors execute in the following environments:

Azure Resource Manager

Citrix XenServer 6.5, 7.0, 7.1

Microsoft Hyper-V, Windows Server 2012 R2

Nutanix Acropolis

vSphere vCenter 5.5.x, 6.0.x, 6.5.x

Network file share protocol

Server Message Block (SMB)

Network connection

A 10 GB connection is recommended between the Citrix Layering appliance and the f ile share.

Image publishing

You can publish Layered Images to these platforms:

Citrix MCS for Nutanix AHV

Citrix MCS for vSphere

Citrix MCS for XenServer

Citrix PVS 7.1, 7.6 - 7.9, 7.11 - 7.12 with recommended network speeds to the PVS Store of 10 GB.

Citrix XenApp and XenDesktop 6.5, 7.0 - 7.13

Microsoft Azure, with recommended network speeds to the Azure publishing location of 10 GB.

VMware Horizon View 6.x, 7.0.x

Note: View Persona Management is not supported with Elastic Layering.

You can use Layers and Layered Images with other provisioning systems and hypervisors, although those solutions have not

been tested.

Operating system for layered images

Windows Server 2016, 64-bit (Standard and Datacenter Editions)

Windows Server 2012 R2, 64-bit (Standard and Datacenter Editions)

Windows Server 2008 R2, 64-bit (Standard and Datacenter Editions)

Windows 10, 64-bit (Education, Enterprise, and Professional Editions)

Windows 7, 64-bit (Enterprise and Professional Editions)

Windows 7, 32-bit (Enterprise and Professional Editions)

App Layering supports single-byte language packs for the base US English Windows operating system. Language packs

must be installed on the OS Machine before importing the OS into a Layer. Language packs installed on a Version added to
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the OS Layer will not work correctly.

Directory service

Microsoft Active Directory

Internet browser

The Management Console supports the following browsers with Silverlight 4.0 support:

Internet Explorer v11

Firefox v45 and later versions that support Microsoft Silverlight 4.0.
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App Layering in XenServer

Jun 29, 2017

Citrix XenServer prerequisites

XenServer account and privileges
A XenServer account (new or existing) to use for App Layering service.

The account must have XenServer privileges to:

Create and remove virtual disks.

Copy and delete layers on virtual disks using XenServer f ile APIs.

 

Citrix XenServer software and settings
Access to the XenServer Tools to install on the layer.

XenServer resource information
The XenServer info listed in XenServer Connector Configuration.

Storage requirements

350-500 GB Storage Space
The App Layering appliance uses local storage for temporary f iles and f inalized layers. The more layers you create, the

more space you need. However, if  you run low on space, you can expand the size of the current disk, or add other disks

to the appliance when needed.

40-100 GB network f ile share (SMB)
The f ile share connected to the appliance is used for upgrades, Elastic Layers, and cross-platform publishing. This space is

easy to expand, if  needed.

Operating system requirement

OS for Layered Images
You need a supported operating system to import into an OS Layer. This OS will be used to build your Layered Images.

http://docs.citrix.com/en-us/citrix-app-layering/4/xenserver/publish-layered-images/connectors-for-publishing/xenserver-connector-configuration.html
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Install

Jun 29, 2017

Before you start

To get started, you need:

An App Layering account.

A supported version of Citrix XenServer.

A Virtual Network in XenServer.

Storage requirements and XenServer requirements listed here.

A XenCenter Client.

Installation package

The installation package, citrix_app_layering_xenserver_4.x.x, includes:

File Description

xenserver_x.x.x.ova OVA file for the appliance VM

citrix_app_layering_agent_installer.exe App Layering Agent installer

citrix_app_layering_win_gold_image_tools.exe OS Machine Tools

Deploy the App Layering appliance

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to layering.cloud.com.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
http://docs.citrix.com/en-us/citrix-app-layering/4/xenserver.html
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8. At the top of the page select the hypervisor where you are deploying the App Layering service. This selection determines

which platform-specif ic installation package is downloaded in Step 2.

9. Under Step 2, click the Download for Hypervisor button to download the appliance installation package for the

hypervisor you have selected.

10. Under Step 3, right-click Instructions, open the page in a new browser tab, and select your hypervisor. The installation

instructions for your hypervisor are displayed.

11. Extract the download package, citrix_app_layering_xenserver_4.1.0.zip. The f iles included are listed above.

12. Extract the xenserver_elm_4.x.x.x.ova f ile to a folder on your local drive.

13. In your XenCenter Client, select File > Import .

14. In the wizard that opens, select the following values:

Import Source - Browse to your unique location.

Location - Choose the XenServer where you want to deploy the appliance.

Storage - Use the default value to put storage disks on the Local XenServer Storage.

Networking - Select the correct network for your XenServer configuration.

Security - This tab should be grayed out. Click Next to continue.

OS Fixup Settings - Select Don't use Operating System Fixup.

Transfer VM Settings - Choose the correct network , and choose DHCP.

Finish - Review your settings and select Finish.

 

15. Switch to Notif ication view and wait for deployment to complete. This takes about 20-35 minutes.

16. Switch to Infrastructure view.

17. Rename your new appliance:

1. Select your new appliance, which will be named CentOS-7_x86_64_build_template_xenserver.
2. Click Properties, and enter a good name and description for your new appliance.

The new VM has 8 GB of memory and 4 CPUs.

 

18. Under Step 4, the Documentation link opens the instructions for logging in.

19. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions to log into the appliance.

 

Install the App Layering Agent (required for PVS and
Connector Scripts)

The App Layering Agent enables the App Layering appliance (Enterprise Layer Manager) or a Unidesk Packaging Machine VM

to run PowerShell commands locally. If  you supply the proper credentials, the agent can run PowerShell commands as a
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specific user.

The App Layering Agent is required in cases where one of your Connector Configurations launches a PowerShell script. This

includes Connector Configurations you use to:

Publish Layered Images to a provisioning system.

Package Layers in your hypervisor environment.

The App Layering Agent installer prompts you to register the agent with a App Layering appliance. If  you do not register the

agent during installation, you can manually register it later. However, keep in mind that the PowerShell scripts will not run

until the agent is registered with the ELM.

Prerequisites

Before you install the App Layering Agent, you must have the following requirements on the system where you are

installing the App Layering Agent:

An account with administrator privileges

.NET 4.5

PowerShell 3.0 or greater

PowerShell Snap-in

Before using the App Layering Agent on a PVS server you must ensure the PowerShell Snap-in is installed. This is a

manual step.

For PVS 7.7 and later, you must install the Powershell Snap-in Citrix.PVS.Snapin.dll.

For PVS 7.6 and PVS 7.1, you must install McliPSSnapIn.dll. Use the installutil.exe to install the Snap-in.

Example (7.6):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" McliPSSnapIn.dll

Example (7.7):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" Citrix.PVS.snapin.dll

On Windows 2008 R2, you must also enable PowerShell remote commands. For background information, see this Microsoft

article: https://technet.microsoft.com/en-us/library/hh849694.aspx

If  your 2008 R2 OS does not have PowerShell remoting enabled, run the following PowerShell command on the PVS server:

Enable-PSRemoting  

Install the App Layering Agent

1. Log in as an administrator on the system where you are installing the agent.

2. Download the App Layering Agent from the Unidesk Download page.

3. Copy the Unidesk_agent_installer.exe f ile from the App Layering Agent folder to a convenient location on the PVS

server.

4. Run the Unidesk_agent_installer.exe as Administrator, and when prompted, enter the path to the directory where you

want to install the App Layering Agent. The default location is C:\\Program Files (x86)\Unidesk\Agent.

https://technet.microsoft.com/en-us/library/hh849694.aspx
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5. The App Layering Agent installer checks to see if  all Prerequisites are present. If  any prerequisites are missing, the installer

reports this and exits without installing.

6. The installer prompts you for an Agent Port number. You can accept the default port number (8016) or specify a

different one if  the default port is already in use.

7. The installer prompts you for the credentials (address, username, and password) for your App Layering appliance. Register

the App Layering Agent with the ELM by entering the IP address and login credentials for a Unidesk Management

Console (UMC) user on the ELM with Administrator privileges, (for example, the credentials you use to log into the UMC).

Note: If  the App Layering appliance is not available yet or you choose not to register with it now, you can manually

register at a later time using the procedure described in Register with the App Layering appliance manually.

8. Click Finish to exit the wizard.

Register the App Layering Agent manually

If  the App Layering Agent was not registered with a App Layering appliance during installation, you can register it later by

using the following procedure.

To manually register the App Layering Agent with the ELM:

1. As an administrator, log in to the server where you installed the App Layering Agent.

2. Open a command window (cmd.exe) as administrator and navigate to the directory where the App Layering Agent is

installed. (The default location is C:\\Program Files (x86)\Unidesk\Agent.)

3. Run the following command, using the IP address of the ELM where indicated:

Unidesk.Agent.Service.exe register /i /e:IP_address_of_ELM /u:Administrator

4. When prompted, enter the password for a user who has Administrator privileges in the Unidesk Management Console

(UMC) on the ELM.

5. When the registration process completes, a message appears informing you of the successful outcome. The App

Layering Agent registration appears in the Audit log for the Management Service in the UMC.

If  the process does not succeed, examine the \Unidesk\Agent\Logs\unidesk.agent.log file in the App Layering Agent

installation directory. You can also view Help for the App Layering Agent command line options by running the following

command: Unidesk.Agent .Service.exe /?.
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Configure

Jun 29, 2017

You can access the App Layering Management Console using the appliance's IP address entered in a web browser, or via the

Citrix Cloud. Currently, access via Citrix Cloud is in Labs, and there are a few things you should be aware of when accessing

the Management Console via the Cloud.

Default credentials for the Management Console

The first time you log into the Management Console, you must use the default user name and password, Administrator,
password Unidesk1. At that point, you will be asked to change all administrator passwords for the appliance.

Access the Management Console directly via your private network

To log directly into the Management Console hosted on the App Layering appliance:

In your hypervisor, locate the VM you created for the appliance and determine its IP address.

Using the IP address for the appliance, enter the following URL in a compatible web browser:

http://<ip_address_of new_vm>/

This displays the Login page for the Management Console.

Log into the Citrix Cloud, and select the App Layering tile. This displays the Log in page for the Management Console.

Log in to the Management Console as Administrator.

If  this is the first login on this appliance, the Set up Login Credentials wizard is displayed. Here you must change the

password for each of the appliance's administrative accounts.

Access the Management Console via Citrix Cloud (Labs)

When you log into Citrix Cloud, you can use the App Layering Manage tab to access the Management Console. Below,

please see the minor issues you may encounter when using the Manage tab to access the appliance.

In your hypervisor, locate the VM you created for the appliance and determine its IP address

In your internet browser, navigate to citrix.cloud.com and select the Manage button on the App Layering tile. This

displays the Citrix App Layering page.

Click the Manage tab, and in the window that appears, select the Resource Location, enter the Appliance Address, and

click Connect. This displays the Login page for the Management Console.

Log in to the Management Console as Administrator.

If  this is the first login on this appliance, the Set up Login Credentials wizard is displayed. Here you must change the

password for each of the appliance's administrative accounts.

Known issues and considerations with Management Console access via Citrix Cloud (Labs)

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

1.

2.

3.

4.

1.

2.

3.

4.
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Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.
Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.

Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.

Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Change administrative passwords

Jun 29, 2017

The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

adminstrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the passwords for the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, skip to Step 3.

2. Select User > Set up Login Credentials. On the About Your Credentials tab, the three administrative accounts are

described.

3. Take a moment to familiarize yourself  with the administrative accounts for the appliance.

4. For each account, enter the new password and then re-enter it in type it in the Conf irm Password f ield.

5. On the Confirm and Complete tab, click Change Credentials.
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Set up a file share for the App Layering appliance

Jun 29, 2017

The App Layering appliance must be connected to a network file share. When setting up the appliance's file share:

The file share must be configured using SMB technology.

Note: If  you used a previous (Unidesk 4.0.x) version of the product to configure an NFS file share, you can continue using

the file share, but it will not support Elastic Layer assignments.

The user credentials for the file share must have full permissions for that share.

The share must be set up by the admin to be readonly for all users except for the one configured in the appliance. This

secures the Layers and other files stored on the share.

Ensure that you have the minimum storage space requirement of 40-100GB for your file share.

Note: Storage space is expandable, as you can add space to a disk, or other disks to the appliance.

For convenience, set up a File Share hosted in your hypervisor.

For Azure: Currently, the App Layering Appliance does not support the Azure File Share feature. For best performance, it

is best to create a file share server in Azure using a fast system with a Premium Disk, for example, a DS class machine. 

Create the network file share

Configure a file share that uses Server Message Block (SMB) protocol.

Follow the vendor's instructions for setting up a file share using the SMB protocol. 

Configure the App Layering appliance to access the file share

Once you have created a file share, configure the App Layering Appliance to attach to it. You can configure the

appliance via the App Layering Management Console.

1. In the Management Console, select System > Settings and Configuration, then scroll down to the network file shares

setting and click Edit .

2. Specify a Type, Path, User name, and Password for the file share.

3. Click Test Network File Share to see if  you can connect to the file share. The test returns a message stating either

Success or Failed to mount network file share path.

4. Once the test returns a Success message, click Save.
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Open firewall ports for App Layering, as needed

Jun 29, 2017

The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin User

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.

Destination Activity Protocol Ports

App Layering appliance (Enterprise Layer Manager (ELM)) Management Console TCP 80, 443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

Connector for PVS Communication TCP

3009 (HTTP)

3509 (HTTPS)

Connector for vSphere Communication TCP

3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP

3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.26https://docs.citrix.com

App Layering Appliance (Enterprise Layer Manager (ELM))

Internal Connections

By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent  - refers to the App Layering agent, which you install on

Admin User - A Management Console user who is assigned the App Layering Admin Role.
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Source Destination Activity Protocol Ports

Appliance Agent Communication TCP 8016

Agent Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via

ESXI Host
TCP 443

Agent Appliance
Communication with datastore via

ESXI Host
TCP 8888

Appliance Active Directory
Communication with datastore via

ESXI Host
TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP)

3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP)

3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the
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destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.

Destination Activity Protocol Ports

XenCenter Communications 5900
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Connect to a directory service

Jun 29, 2017

You can configure the appliance to connect to a directory service, for example, Active Directory. When you connect to your

directory service, you will create one or more Directory Junctions to access specific domains or OUs. The appliance does not
modify the directory service you connect to. The software caches the attributes for each directory service entry, so that if

the connection to the directory service is lost temporarily, the software can use the cached information for management

tasks.

About connecting the appliance to a directory service

The Management Console Directory Tree displays a hierarchical view of Users and Groups. Each Directory Junction that you

create specifies a starting node in the directory tree.

Overlapping directory junctions

Overlapping (or nested) directory junctions occur when you create multiple directory junctions that contain the same users

and then import the users into the directory tree. When overlapping occurs, each directory junction contains its own copy

of the duplicate users.

Example: Overlapping directory junctions

Assume you create Directory Junction A that starts at the Marketing folder in a directory service tree. Next, you create

Directory Junction B which starts at a folder above the Marketing folder. If  you browse both directory junctions, you can

see the Marketing users in both folders.

User attributes are imported f rom the directory service

The App Layering software imports and caches user and group attributes from your directory service when:

You assign administrator privileges to a user.

The values of the attributes change in the directory service.

The attributes that the software caches are read only. All changes to the attributes for directory service users come from

the directory server.

Imported attributes are synchronized regularly

The software synchronizes the information it caches for directory service users with the directory service every 12 hours. If

the software discovers that a user is no longer an object in the directory service, it classifies the user as abandoned (you can

view this information in the Information view for the user).

Create a directory junction

Create the folders where you want to place the Directory Junctions or decide which existing folder you want to use. You

can add a Directory Junction folder to any existing folder in the Management Console directory tree.

Best Practice: Avoid creating overlapping Directory Junctions, if  possible. In some circumstances, deleting an overlapping

Directory Junction can affect your ability to delete another Directory Junction that contains the same users.

1. Select Users > Directory Service.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.30https://docs.citrix.com

2. Select Create Directory Junction in the Action bar. This opens the Create Directory Junction wizard.

3. In the Connection Details tab, specify the details for the directory server.

Directory Junction Name- This name becomes the name of the folder that you see in the tree view. You can use any

name, including the name of a domain in your directory service tree.

Server address - This is the name for the server you will use for the directory service. (IP Address or DNS Name)

Port - Specify the port number for communicating with the directory server.

SSL check box - Select this if  you want to use Secure Sockets Layer (SSL) communication.

If  certificate errors occur, the wizard displays a list of these errors. If  you know it is safe to ignore them, select Ignore

Certificate Errors.

Test Connection - Click to verify that the appliance can connect to the directory service.

4. In the Authentication Details tab, enter the authentication details for a user who has permissions to search the

directory service.

Bind Distinguished Name - To determine the correct syntax for the Bind DN or user name, see the documentation for

your directory.

Examples: The following examples shows some of the ways you can specify a user for the directory service:

domain\username or username@domain.com.

Bind Password.

Test Authentication - Click to verify that the connection to the directory server is valid.

5. In the Distinguished Name Details tab, specify where the software should start searching for users and groups in the

remote directory service.

Base Distinguished Name (DN) - The software starts searching for users and groups in the remote directory service.

Once you establish a connection to the server for the directory service, the wizard displays a list of available DNs. You

can select a DN from the list or enter the DN directly in the box.

Example: Assume that you want to start the search at the Marketing Organizational Unit at the root of a domain.

You would enter the following Base DN:

OU=marketing, DC=root,DC=mydomain DC=com

Test Base DN - Click to verify that the Base DN is valid.

6. In the Folder Location tab, select the folder in the Unidesk tree where you want to add the directory junction for the

remote directory service.

7. In the Attribute Mapping tab, enter the names of directory service attributes that you want to map to the local

attributes or use the default settings.

Note: To change the mapping from local attributes back to default mappings, click Use Defaults.

8. In the Confirm and Complete tab, verify the Directory Junction settings, enter a comment if  required, and click Create

Directory Junction.

If  you enter comments, they appear in the Information view Audit History.
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About App Layering users, roles, and rights

Built-in administrator account

When you first install the App Layering appliance and log onto the Management Console, there is a "built-in" Administrator

account that you can use to get started. This Administrator has the rights to perform all App Layering operations. You can

edit this user's properties, including the name, password, and contact info. Be sure to change the password for this built-in

Administrator account as part of installing and configuring the appliance. 

AD user accounts

Other than the built-in Administrator account, all users are actually AD users imported via one or more directory junctions.

Once your directory junction(s) have been created, you can assign Roles to each user, as described later in this topic. You

can see which roles are assigned to a user in the User Details.

App Layering Roles defined

Roles determine which App Layering modules a user can manage. Users assigned one or more Roles can log into the

Management Console, and these users are listed on the Administrators tab (select Users > Administrators).

Note
When upgrading from version 4.0.6 or earlier, users assigned the Machine Administrator Role in earlier releases will now be

assigned the Read Only role. If the user needs more than read only access, reconfigure the user roles, as needed.

Rights by role
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Rights Role

Administrator

Can do every operation available in the Management Console.

Only users assigned the Administrator Role can edit user properties on the Users tab (Select Users
> Users).

Only administrators can configure system settings and manage licenses.

Manage App Layers Can create, edit, and delete application layers and versions.

Manage Elastic Layer

Assignments
Can add, update, and remove Elastic layer assignments.

Manage Image Templates

Can create, edit and delete Image templates.

Can add, update, and remove app layer assignments for image templates.

Can update platform layer assignments for image templates.

Can update OS layer assignments for image templates.

Manage OS Layers Can create, edit, and delete OS layers and versions.

Manage Platform Layers Can create, edit, and delete Platform layers and versions.

Publish Layered Images
Can publish layered images.

Cannot create or modify existing image templates.

Read Only

Can view information about any items in the Management Console.

Cannot launch any wizards or make any changes.

The Read Only user cannot cancel any tasks.

User credentials for logging into the Management Console

When you assign Roles to Directory Service users, they can use their Directory Service credentials to log into the

Management Console.

Who can assign App Layering Roles?

You can change a user's role if  you are logged into the Management Console as a user assigned the Administrator Role.

Assign App Layering roles to users

Log into the Management Console.

Select Users > Users.

Select a user and click Edit Properties. This opens the Edit User wizard. 

1.

2.

3.
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Skip to the Roles tab, and select one or more roles for this user. For details, see Rights by Role above.

In the Confirm and Complete tab, click Update User. Any comments you enter will appear in the Information view Audit

History.

4.

5.
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Want to experiment with cool new features that are under development? Through the Management Console, you can

now see which features are available in Unidesk Labs in any given release. You can enable features you're interested in, try

them out, and let us know what you think. The only caveat? Best not use Labs features in your production environment, as

they are likely to evolve with the feedback we receive from users like you!

Throughout this documentation, features that are available through App Layering Labs are marked (Labs) in the title. Most

Labs features require enabling.

To find out which Labs features are available in this release, see What's New.

Enable a Labs feature

When a release includes a Labs feature that you want to enable:

1. Log into the Management Console and select System > Settings and Conf iguration.

2. Select the check box for the feature you want to enable, and click Save. The feature's status changes to Enabled.

You can turn off  the feature at any time by deselecting the check box and clicking Save.

Labs features in this release

To find out which Labs features are available in this release, see What's new.

http://docs.citrix.com/en-us/citrix-app-layering/4/whats-new.html
http://docs.citrix.com/en-us/citrix-app-layering/4/whats-new.html
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What are Connectors?
Connectors are the interfaces to environments where you create Layers and publish Layered Images. You create one or

more Connector Configurations for each platform where you intend to package Layers or publish Layered Images.

What are Connector Configurations?
A Connector Configuration is a stored set of values for connecting to a storage location in your environment. A

configuration typically includes credentials for authentication, a storage location, and any other information required to

interface with the environment where you will be creating layers or publishing images. You can create multiple Connector

Configurations, each configured to access a unique location in your environment.

What Connector Configurations do I need?
Connector Configurations for importing an OS to create an OS Layer

When you create an OS Layer, you need a Connector Configuration to give the appliance access to the location of the OS

image that you want to use for your OS Layer.

Connector Configurations for creating and updating App Layers, and adding Versions to OS Layers
When creating or updating an App Layer, or adding Versions to an OS Layer, you need a Connector Configuration for the

location in your environment where you will package the Layer. You can create as many configurations as you need, for

example, if  you have more than one storage location in the environment.

Connector Configurations for publishing Layered Images
Publishing Layered Images will require different Connector Configurations than the ones you use for creating Layers, if, for

example, you publish Layered Images to a variety of storage locations near the users being served. For example, you can

prepare your Layers for a server farm in vSphere, and publish Layered Images to Citrix PVS for streaming to servers in

vSphere. Or, you can publish Layered Images to more than one storage location in the same environment, each requiring a

different Connector Configuration. Each location is likely to require different credentials.

How and when to add a new Connector Configuration
If  this is your first time using the App Layering Service, you will need to add one or more Connector Configurations in the

process of adding Layers and publishing Layered Images. In the Management Console, the wizards for Creating Layers,

Adding Versions, and Publishing Layered Images each include a page for selecting and creating Connector Configurations.
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Automatic updates of  available package downloads

The App Layering appliance (aka Enterprise Layer Manager) automatically downloads upgrades, but the upgrades are not

automatically installed. Instead, you are notified that an upgrade is available.

The appliance periodically checks for upgrades, and when one is found, downloads the package, verifies it, and extracts the

files. Once the package is extracted, you are alerted that there is an upgrade ready.

If  you log into the Management Console as Administrator, you can apply an upgrade either by clicking the Start Upgrade

button on the notification, or by selecting System tab > Manage Appliance > Upgrade.

Notifications

Periodically, the appliance asks api.unidesk.com if  an upgrade is available. The following sections walk you through common

scenarios.

Note: If  the appliance cannot access api.unidesk.com, auto-downloading will not work. The user will not see any error.

However, there will be a note in the log that the check failed.

If  an update is not available...
Nothing happens. Another check will be made at the next scheduled interval.

If  an update is available, but there is no network file share configured...
The user will receive a pop-up (see below) to let them know there is an upgrade available, and that the administrator needs

to finish configuring a network file share before it can be downloaded and applied.

If  an update is available...
The Download Upgrade Media job is started, and it is visible in the task list. This job is responsible for:

Downloading the upgrade to local storage.

Ensuring the checksum of the successfully downloaded upgrade package is correct.

Extracting the downloaded upgrade package to the configured Network File Share. The download is extracted to the

appliance's File Share:

Location: NetworkFileShare\AppLayeringVersion

Example: \\MyServer\AppLayeringFileShare\4.0.8

If  extraction is successful, the next time any user logs in they will be notif ied that an upgrade is available.

If  at any time during this process an error is encountered that requires Administrator intervention (out of space on local

storage, out of space on the network file share, invalid file found, etc.) the job will fail with an appropriate error.

Note: If  a job fails it will be retried at the next check interval regardless of whether the Administrator has resolved the fixed.

If  another update is found before a previously downloaded one is installed...
The new upgrade will be downloaded (see above) and once successfully completed it will become the Upgrade Available.

If  one upgrade is downloading when another is made available...
The running download will be aborted and a new download (as above) will be started. In this case, all files related to the in-
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progress download will be deleted.

User notification when an upgrade is available

When logging in every user will receive a notification that an upgrade is available. However, only an Administrator will be able

to run the upgrade.

Prerequisites

Verify that a Network File Share has been configured. You can confirm that this has been done by logging into the

Management Appliance, selecting System > Settings and Configuration, and finding the Network File Share setting. If

the file share has been configured, you can upgrade the appliance. 

Download packages

Platform Package Files Included

Citrix

XenServer
app_layering_upgrade_xenserver_pkg_4.x.x.zip upgrade_xenserver_elm_4.x.x.xx.vhd

Microsoft

Azure
app_layering_upgrade_azure_pkg_4.x.x.zip upgrade_azure_elm_4.x.x.xx.vhd

Microsoft

Hyper-V
app_layering_upgrade_hyperv_pkg_4.x.x.zip upgrade_hyperv_elm_4.x.x.xx.vhd

VMware

vSphere
app_layering_upgrade_pkg_4.x.x.zip

upgrade_vmware_elm_4.x.x.xx.vhd

app_layering_agent_installer.exe

Note: An Agent upgrade is only required if you've installed the agent

for your implementation, for example, if you are using PVS, or

Connector Scripts.

Back up the appliance

Take a snapshot or checkpoint of the appliance.

Download the upgrade media to the network file share

The App layering 4 upgrade files include both the Appliance and Agent upgrades. The Agent upgrade can be used to bring

either or both of these installations up to date:

The agent on PVS servers.

Servers where Layered Images are enabled for Elastic Layers.

To download the upgrade package:

1. In a network browser, navigate to the App Layering Download page, and sign in.

2. Download the App Layering Upgrade package for your platform to the \Upgrade folder on the Network File Share.

3. Unzip the package in \Upgrade.

4. Copy the Agent upgrade to the server(s) where the agent is installed, and refer to Upgrade the App Layering Agent

http://docs.citrix.com/en-us/citrix-app-layering/4/xenserver/configure/set-up-a-file-share-for-the-app-layering-appliance.html
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below.

Load the App Layering upgrade

1. Log into the Management Console, select System and click the Upgrade action to launch the Upgrade Wizard.

2. On the Upgrade Disk Details tab, click Browse.

3. Navigate to the upgrade f ile, and click Choose.

4. Verify the Upgrade path, and click Upgrade. This starts the upgrade process, and opens a status page in the browser.

5. Once the upgrade has completed, the status changes to "Upgrade Status: Complete."

6. Refresh the Web page to return to the UMC.

7. Verify that the upgrade was successful by clicking the About  link in the Management Console to confirm the version

number. 

Upgrade the App Layering agent

When using PVS or Elastic Layers the Agent is required. To upgrade the App Layering Agent:

1. Uninstall the previous version of the App Layering Agent from the server(s) where they are installed.

2. Make sure that you have copied the App Layering Agent Upgrade f ile to the PVS server(s) where the agent is installed.

3. Double-click the Agent upgrade f ile, and follow the instructions for upgrading the Agent.

Create a Cloud Connector for accessing the Management Console via Citrix Cloud (Labs)

If  you want to access the Management Console via the Citrix Cloud, install a Cloud Connector as described here. For known

issues when accessing the Management Console via the Cloud, see the list of issues below.

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to the Cloud.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. Under Step 4, the Documentation link opens the instructions for logging in. 

9. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions to access the appliance. 

Known issues

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.
Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.
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Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.

Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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OS Layers

An OS Layer includes the software and settings for the operating system that you deploy as part of your other layers and

ultimately, your Layered Images. Once you have prepared the OS disk for deployment, you can create a Unidesk Operating

System Layer by importing the OS disk into a new Layer.

With an OS Layer, you can install your operating system once, and update it by adding a new Version to the Layer whenever

there's a new patch or update. You can deploy this layer, or a version of it, in every image you publish. This allows you to

maintain one OS image and use it to provision all of your servers.

If  you need to support more than one operating system, for example, if  you need both Windows Server 2012 R2 and

Windows Server 2008 R2, you can create more than one OS Layer. However, each App Layer is only compatible with the

OS Layer you use to create it, and if  you deploy two OS Layers, you will also need to deploy a compatible App Layer for

each one. Further, in future releases when deploying Elastic Layers to users, those layers will only be compatible with users'

desktops that use the same OS Layer.

If  you can support your users with a single OS Layer, the work associated with creating and updating App Layers will be

much reduced.

Each time you need to deploy operating system patches and updates, you will do so by adding a new Version to the

OS Layer. You can continue to publish Layered Images using any version of the OS Layer.

The prerequisites for creating an OS Layer include:

An App Layering-supported operating system

App Layering appliance and network f ile share installed and configured

Platform Layers

A Platform Layer is a layer that includes platform-specific configuration settings, tools, and other software required for

your OS and Apps to be installed in or to run in a particular environment.

Types of  Platform Layers

A Platform Layer for Packaging (required in some cases, see below)

Platform Layer for Publishing (always required)

Platform Layer for packaging layers and versions

The only time you need a Platform Layer for Packaging layers is when your OS image was created on a different hypervisor

than the one where you are building your other layers. When creating an App Layer or Layer Version, or OS Versions, the

purpose of the Platform Layer is to ensure that any hypervisor-related software and settings are available during the

installation of the application(s) on that layer, if  needed. If  you choose to use a Platform Layer for Packaging a layer, the

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
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hypervisor-related software will only be used during layer packaging, and has no effect on where you can publish the layer

as part of a Layered Image.

Platform Layer for publishing Layered Images

A Platform Layer for Publishing is required when you publish Layered Images. The purpose of the Platform Layer for

Publishing is to include the settings and software that the Layered Image needs to be deployed in your environment. When

creating a Platform Layer for Publishing, Unidesk removes unselected (and unnecessary) tools and software related to the

platforms you are not publishing to. This is to prevent any unnecessary platform software from slowing down the Layered

Image when it runs in the target environment.

App Layers

An App Layer is a virtual disk containing one or more applications that you can use in Layered Images. You can combine an

App Layer with any other App Layers and a Platform Layer, as long as the OS Layer used to create the App Layer is

selected.

With most applications, creating an App Layer is simple. In a few cases, it 's best to start with tips from experienced users, so

the Unidesk Forum includes Application Layer Recipes that you can search for tips about a particular application before you

start. 

To create an App Layer, you use the Create App Layer wizard to deploy a Packaging Machine in your environment and install

the application on the Packaging Machine, leaving the application in the state you want it to be in for users. Then you

finalize the Layer. 

User Layers (Unidesk Labs)

A User Layer is a virtual disk where a user's app data and configuration settings are saved. User Layers are created when you:

Publish a Layered Image with Elastic Layering set to Application and User Layers.

Users log into their desktops on the above Layered Image.

With User Layers enabled on the Layered Image, users can install applications locally on their desktops, and the apps and

their data will be saved in the User Layer.

Verifying Layers

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized. The new Layer or

Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.
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Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX
3. Enter the NGen command to execute the queued items:

ngen update /force
This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It ’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status
3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Connectors for layering (XenServer)

When creating Layers in a XenServer environment, you need a Connector Configuration to define the hypervisor location

from which you will:

Import the OS image when creating your OS Layer.

Deploy a VM for the Layer and Install the application software or the Layer.

It is strongly recommended that you use the hypervisor where the App Layering appliance is installed. If  you decide to

create Layers on a hypervisor other than the one where the appliance is installed, you can use NFS instead of a XenServer

Connector Configuration, and manually copy the file to your hypervisor and back to file share once the software for the

Layer is installed.

See Connectors for publishing for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/xenserver/publish-layered-images/connectors-for-publishing.html
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This topic explains how to prepare an OS Image for layering, using the OS Machine Tools available for download. 

Notes:

The OS Image should not be in a domain.

The OS Image should get its IP address from DHCP.

Using Third-party optimization scripts can have adverse effects for layering, as they can change services and features

that the App Layering service uses, for example, Universal Plug and Play and the 8.3 f ile names setting. Use the

optimization tools in the Installer download to optimize your image.

Ensure that the VM for your OS Layer is MBR partitioned, rather than GPT partitioned. Otherwise, you will not be able to

install the Unidesk OS Machine Tools.

XenCenter uses Port 5900 to access the console on each VM. Make sure that this port is open on your OS image.

Otherwise, the packaging machines or publish images the console will not work until you reboot the VM.

Choose the operating system you are using for the OS Image:

Windows Server 2012 R2 (Session Host)

Windows Server 2008 R2

Windows 10

Windows 7

Prepare a Windows Server 2012 R2 image (Session Host)

STEP 1: Set up a Windows Server 2012 R2 OS Image on a virtual machine

In the XenServer client:

1. Create a VM for the OS image.

2. Configure the virtual machine hardware settings, for example, the NIC and video memory.

3. Configure a virtual hard disk that is large enough for a Windows operating system installation, and make sure it is

accessible by the Management Appliance.

4. Install the OS.

5. Disable Windows System Restore and Windows Automatic Updates. The system handles restore points for you, and

layer versions allow you to control when updates occur.

6. Install XenServer Tools on your OS image.

STEP 2: Copy the OS Machine Tools onto the OS Image

1. Download the Citrix_App_Layering_OS_Machine_Tools ZIP f ile onto the OS Image.

2. Extract the Citrix_App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct

KMS activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine

https://www.unidesk.com/support/downloads
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Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script f ile in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on Layered
Images

1. In the c:\windows\setup\scripts folder, right-click the unattend.exe tool and choose Run as administrator. The

unattend builder form opens.

2. Complete the unattend form.

Product key activation

 For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml f ile to join Layered Images to a specif ic domain. If  you

plan to use AD join scripts, ensure Enable is not selected.

You can add Layered Images to the Computer's container in Active Directory by deleting the OU entry. However,

we recommend that you use an alternate OU for Layered Images, both to segregate the Layered Image from

other machines and to avoid applying virtual desktop-specif ic GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs

by creating different unattend.xml f iles in different application layers.

Local Administrator account

If  you want to use the unattend.xml f ile to enable the Administrator account on each Layered Image,

select Enable. Remember to also enable this account in your OS Image or Operating System Layer revision. It is

possible to enable the Administrator account for your OS Image and then have it disabled in the deployed Layered

Images by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This

account cannot be pre-configured in the OS Image.

You can create a Layered Image where the Administrator is disabled and the alternate administrator is created and

enabled. However for this to work, the Administrator account must be enabled in the OS Image and it cannot be

renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone,

not the display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

3. Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

1. In the c:\windows\setup\scripts folder, run the optimize.exe executable to create a .cmd file (optimization.cmd) that will

be run to optimize the image during Layered Image creation.

2. Follow the instructions to run the optimize.cmd file on the OS Image. This removes installation-specific drivers and

https://technet.microsoft.com/en-us/library/cc749073(v=ws.10).aspx
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settings.

If  you are using the optimization script and you are enabling the View Persona feature, you must go to the section of

the optimize script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable
Offline File Service, and click Save File. This is because View Persona folder redirection requires Offline files to be

enabled, and by default, the Optimizer turns off  Offline files, which are not a requirement for Citrix App Layering .

STEP 6: Create a snapshot of the OS Image

Once the OS Image is ready, create a snapshot of it, so that you can return to this state at any time.

Important: It is critical to create a snapshot before installing the App Layering software onto the OS Image. Without this

snapshot, returning to this state requires rebuilding the image.

Important
It is critical to create a snapshot before installing the App Layering software onto the OS Image. Without this snapshot, returning to

this state requires rebuilding the image.

STEP 7: Install the OS Machine Tools onto the OS Image

1. In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

2. The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS Layer.

Prepare a Windows 2008 R2 image

STEP 1: Set up a Windows Server 2008 R2 OS Image on a virtual machine

In the XenServer client:

1. Create a VM for your OS image, making sure to choose the default cluster allocation size of 4K.

2. Configure the virtual machine hardware settings, for example, the NIC and video memory.

3. If  you are using Citrix PVS or VMware Horizon View, install Windows Server 2008 R2 Service Pack 1 (SP1).

Notes:

When creating the image, be sure to choose the default cluster allocation size of 4K.

4. If  using PVS:

1. Install KB255098 hitfix.

2. Reboot the VM.

3. Enter the commands:

set devmgr_show_nonpresent_devices=1
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devmgmt.msc

4. Uninstall any dead (ghost) NICs.

5. Reboot the system.

5. Disable Windows System Restore and Windows Automatic Updates. The system handles restore points for you, and

layer versions allow you to control when updates occur.

6. Install XenTools on the OS image.

STEP 2: Copy the OS Machine Tools onto the OS Image

1. Download the App_Layering_Citrix_App_Layering_OS_Machine_Tools ZIP f ile onto the OS Image.

2. Extract the App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct

KMS activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine

Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script f ile in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on Layered
Images

1. In the c:\windows\setup\scripts folder, right-click the unattend.exe tool and choose Run as administrator. The

unattend builder form opens.

2. Complete the unattend form.

Product key activation

 For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml f ile to join Layered Images to a specif ic domain. If  you

plan to use AD join scripts, ensure Enable is not selected.

You can add Layered Images to the Computer's container in Active Directory by deleting the OU entry. However,

we recommend that you use an alternate OU for Optimize the OS Image for Layered Images, both to segregate

the Layered Image from other machines and to avoid applying virtual desktop-specif ic GPOs to other types of

machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs

by creating different unattend.xml f iles in different application layers.

Local Administrator account

If  you want to use the unattend.xml f ile to enable the Administrator account on each Layered Image,

select Enable. Remember to also enable this account in your OS Image or Operating System Layer revision. It is

possible to enable the Administrator account for your OS Image and then have it disabled in the deployed Layered

Images by clearing the check box.

https://www.unidesk.com/support/downloads
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If  you want to add an alternate Administrator account, select Enable and enter the account information. This

account cannot be pre-configured in the OS Image.

You can create a Layered Image where the Administrator is disabled and the alternate administrator is created and

enabled. However for this to work, the Administrator account must be enabled in the OS Image and it cannot be

renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone,

not the display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

3. Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

1. In the c:\windows\setup\scripts folder, run the optimize.exe executable to create a .cmd file that will be run to optimize

the image during Layered Image creation.

2. Follow the instructions to run the optimize file on the image. This removes installation-specific drivers and settings.

If  you are using the Optimizer script and you are enabling the View Persona feature, you must go to the section of the

Optimizer script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable
Offline File Service, and click Save File. This is because View Persona folder redirection requires Offline files to be

enabled, and by default, the Optimizer turns off  Offline files, which are not a requirement for layering.

Prepare a Windows 10 image

When preparing the OS Image for import into an OS Layer, you can speed up start times by removing Windows 10 built-in

applications. If  you do, we recommend removing these applications either on the OS Image itself, or on the OS Layer.

STEP 1: Set up a Windows 10 image on a virtual machine

In the XenServer client:

1. Create a VM for your OS image.

Important: When creating the image, be sure to choose the default cluster allocation size of 4K.

2. Configure the virtual machine hardware settings, for example, the NIC and video memory.

3. Disable Windows System Restore and Windows Automatic Updates:

1. Log into the VM.

2. Select Computer Conf ig > Administrative Templates > Windows Components > Windows Updates > Conf ig
Auto Updates.

3. Set this to Disabled.

The App Layering system handles restore points for you, and layer versions allow you to control when updates occur.

4. If  using KMS licensing, run a command window as Administrator, and enter these commands:

https://technet.microsoft.com/en-us/library/cc749073(v=ws.10).aspx
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slmgr /skms <kmsserverhost>

slmgr /rearm

reboot

slmgr /ipk XXXX-YOUR-KMS-KEY-XXXX

slmgr /ato

5. Install the VMware Tools on the OS image.

6. If  you are including the Windows Store in your Windows 10 image, get the latest updates for all Store Apps.

1. Launch the Windows Store application, click the Sign in icon (top right), then select Downloads and Updates.

2. Check for Updates, and click Update All. This should be repeated at least twice to ensure that the latest updates

have been pulled.

Important
Avoid finalizing the OS Layer while download or update processes are running, as this may cause deployed images (and every user)

to experience a continuation of those operations each time they log in.

STEP 2: Copy the OS Machine Tools onto the OS Image

1. Download the Citrix_App_Layering_OS_Machine_Tools ZIP f ile onto the OS Image.

2. Extract the Citrix_App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct

KMS activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine

Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script f ile in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on Layered
Images

1. In the c:\windows\setup\scripts folder, right-click the unattend.exe tool and choose Run as administrator. The

unattend builder form opens.

2. Complete the unattend form.

Product key activation

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/layers_os_prep_win10_store.png
https://www.unidesk.com/support/downloads
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 For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml f ile to join Layered Images to a specif ic domain. If  you

plan to use AD join scripts, ensure Enable is not selected.

You can add Layered Images to the Computer's container in Active Directory by deleting the OU entry. However,

we recommend that you use an alternate OU for Layered Images, both to segregate the Layered Image from

other machines and to avoid applying virtual desktop-specif ic GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs

by creating different unattend.xml f iles in different application layers.

Local Administrator account

If  you want to use the unattend.xml f ile to enable the Administrator account on each Layered Image,

select Enable. Remember to also enable this account in your OS Image or Operating System Layer revision. It is

possible to enable the Administrator account for your OS Image and then have it disabled in the deployed Layered

Images by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This

account cannot be pre-configured in the OS Image.

You can create a Layered Image where the Administrator is disabled and the alternate administrator is created and

enabled. However for this to work, the Administrator account must be enabled in the OS Image and it cannot be

renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone,

not the display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

3. Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

1. In the c:\windows\setup\scripts folder, run the optimize.exe executable to create a .cmd file (optimization.cmd) that will

be run to optimize the image during Layered Image creation.

2. Follow the instructions to run the optimize.cmd file on the OS Image. This removes installation-specific drivers and

settings.

If  you are using the optimization script and you are enabling the View Persona feature, you must go to the section of

the optimize script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable
Offline File Service, and click Save File. This is because View Persona folder redirection requires Offline files to be

enabled, and by default, the Optimizer turns off  Offline files, which are not a requirement for Citrix App Layering .

STEP 6: Install .Net Framework 3.5.1

The .Net Framework is a software framework provided by Microsoft that is required for many 3rd party applications to run.

To install this feature, follow the steps below.

https://technet.microsoft.com/en-us/library/cc749073(v=ws.10).aspx
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1. On the Start menu, select Control Panel > Programs and Features.

2. In the left panel select Turn Windows features on or of f. A window opens.

3. Select .NET Framework 3.5, click OK, and wait for the installation to complete.

Important: Even if  .NET is already installed, continue with the rest of these steps.

4. Exit the Control Panel.

5. In Notifications in the right-side of your taskbar, click All Settings, and open the Windows 10 Settings app.

6. Select Settings > Update & Security.

7. Check for updates, and install all updates available.

8. Exit Settings.

9. Open an administrator-level command prompt, and enter the following commands:

cd \windows\Microsoft.Net\Framework\v4.nnnnn

ngen update /force

10. Wait for the command to complete, and enter the following commands:

cd \windows\Microsoft.Net\Framework64\v4.nnnnn

ngen update /force

11. Exit the command prompt.

STEP 7: If using PVS, follow these steps to avoid ghost NICs.

1. Enter the commands:

set devmgr_show_nonpresent_devices=

devmgmt.msc

2. Remove any ghost NICs.

3. Reboot the system.

STEP 8: Install the OS Machine Tools onto the OS Image

1. Run setup_x64.exe from c:\Windows\setup\scripts.

Once this is done, you are ready to create an OS Layer.

Prepare a Windows 7 image

STEP 1: Set up a Windows 7 OS Image on a virtual machine

In the XenServer client:

1. Create a VM for your OS Image.
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Important: When creating the image, be sure to choose the default cluster allocation size of 4K.

2. Configure the virtual machine hardware settings, for example, the NIC and video memory.

3. Disable Windows System Restore and Windows Automatic Updates. The App Layering system handles restore points for

you, and layer versions allow you to control when updates occur.

4. Make sure you have installed VMware Tools on the OS image.

STEP 2: Mount or copy the Citrix App Layering OS Machine Tools onto the OS
Image

1. Download the Citrix_App_Layering_OS_Machine_Tools ZIP f ile onto the OS Image.

2. Extract the citrix_app_layering_os_machine_tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct

KMS activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine

Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script f ile in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on Layered
Images

1. In the c:\windows\setup\scripts folder, right-click the unattend.exe tool and choose Run as administrator. The

unattend builder form opens.

2. Complete the unattend form.

Product key activation

 For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml f ile to join Layered Images to a specif ic domain. If  you

plan to use AD join scripts, ensure Enable is not selected.

You can add Layered Images to the Computer's container in Active Directory by deleting the OU entry. However,

we recommend that you use an alternate OU for Layered Images, both to segregate the Layered Image from

other machines and to avoid applying virtual desktop-specif ic GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs

by creating different unattend.xml f iles in different application layers.

Local Administrator account

If  you want to use the unattend.xml f ile to enable the Administrator account on each Layered Image,

select Enable. Remember to also enable this account in your OS Image or Operating System Layer revision. It is

possible to enable the Administrator account for your OS Image and then have it disabled in the deployed Layered

Images by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This

https://www.unidesk.com/support/downloads
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account cannot be pre-configured in the OS Image.

You can create a Layered Image where the Administrator is disabled and the alternate administrator is created and

enabled. However for this to work, the Administrator account must be enabled in the OS Image and it cannot be

renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone,

not the display setting. 

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

3. Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

1. In the c:\windows\setup\scripts folder, run the optimize.exe executable to create a .cmd file that will be run to optimize

the image during Layered Image creation.

2. Follow the instructions to run the optimize.exe file on the OS Image. This removes installation-specific drivers and

settings.

If  you are using the Optimization script and you are enabling the View Persona feature, you must go to the section of

the Optimization script called Disable Unnecessary Services to Save Memory and CPU, deselect the option

to Disable Offline File Service, and click Save File. This is because View Persona folder redirection requires Offline files

to be enabled, and by default, the optimization script turns off  Offline files, which are not a requirement for App

Layering.

STEP 6: If using PVS, follow these steps to avoid ghost NICs

1. Install KB2550978 hotfix.

2. Reboot the VM,

3. Enter the commands:

set devmgr_show_nonpresent_devices=1

devmgmt.msc

4. Remove any ghost NICs.

5. Reboot the system.

STEP 7: Install the Citrix App Layering OS Machine Tools onto the OS Image

1. In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

2. The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS layer.

Create an OS Layer
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The OS Layer contains the Windows OS to use in your other Layers and Layered Images. Once created, you can use the OS

Layer to build as many Layered Images as you need.

The OS Layer includes a virtual machine in your infrastructure running the supported Windows Operating System that you

want to use for your Layered Images.

To create an OS Layer, you create a virtual machine in XenServer to serve as the OS Machine, then export the OS to the

appliance's network file share, and import the OS to create the OS Layer.

Import the OS Image into a new OS Layer

1. In the Management Console, select Layers > OS Layers and click Create OS Layer in the Action bar. This opens the

Create OS Layer Wizard.

2. In the Layer Details tab, specify a Layer Name and Version, both required values. Optionally, you can enter Descriptions

of the Layer and Version, and change the Max Layer Size to accommodate the OS you are going to import.

3. In the Connector tab, select a XenServer Connector Configuration that specif ies the location of your clean OS image. If

the configuration you need is not listed, add a New one, and then select it from this list. For details about adding this

Connector Configuration, see Create a Connector Configuration..

4. In the OS Disk Details tab, click the Select Virtual Machine button. This opens a new browser tab.

5. Click in the Virtual Machine f ield to reveal a list of all VMs. Select a VM from the list, or start by typing the name to f ilter

the list to VMs that contain the search text, and then select the VM.

6. Click OK. The selected VM is validated to ensure that the VM has a single OS disk attached as a SCSI disk. (Attaching the

OS disk as IDE is not supported.)

If  there are problems with the VM or OS Disk, an error is displayed. Otherwise, you are returned to the wizard where the

VM's name, and the size of the OS disk are listed.

7. In the Icon Assignment tab, select an icon image to assign to this Layer.

8. In the Confirm and Complete tab, review the details of the OS Layer, enter a comment if  required, and click Create Layer.

If  you enter comments, they appear in the Information view Audit History.

When the task completes, the new OS Layer in the Management Console displays a "Deployable" status.
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Platform layer

Jun 29, 2017

Citrix MCS for vSphere

PVS connector

XenServer connector

Network File Share connector
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Citrix MCS for vSphere

Jun 29, 2017

A Platform Layer includes the platform software and settings required to deploy images in your environment. For example, a

Platform Layer for publishing to Citrix MCS in vSphere with XenApp as the broker would include the vmTools, the XenApp

Virtual Delivery Agent Installer, and any other platform-related software.

This article explains the next steps to create a Platform Layer, based on your connector and platform choices. If  you need

more information than is included here, check these other sources: Layer essentials and the App Layering Forum.

A Platform Layer should include the platform software and settings required to deploy images in your environment, given

your choice of hypervisor, provisioning service, and connection broker.

You can create two kinds of Platform Layers:

Platform Layers for publishing Layered Images (Required) - A Platform Layer for publishing is used in Image Templates to

ensure that your published Layered Images include the software and settings required to run flawlessly in your environment.

Platform Layers for packaging Layers (Required in some cases) - A Platform Layer for packaging is used for creating App

Layers and OS Layer Versions in your hypervisor environment. This Layer includes the hypervisor software and settings

required to easily install the app or OS update on a VM in the selected hypervisor.

Prerequisites

When creating a Platform Layer, the software installers for your platform must be available in a location that's accessible

to the Packaging Machine VM where you are going to create the Layer. As summarized in the following table, the

prerequisites vary based on the type of Platform Layer you choose to create.

Type of
Platform Layer

Prerequisites

Publishing

Layered Images

Software installers, and settings you use for your:

Hypervisor

Provisioning service

Connection broker

Packaging

Layers

The software and settings for your:

Hypervisor

For example, your hypervisor installer and settings.

Note : You only need a Platform Layer for packaging Layers if you are creating your Layers on a different hypervisor

than the one from which you imported your OS image.

Citrix MCS prerequisites

When creating a Platform Layer for publishing images to an MCS environment, you need:

An OS Layer
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Network access to App Layering Tools

Access from the Platform Layer Packaging Machine VM to the OS Machine Tools (in the installation download package).

Citrix Virtual Delivery Agent (VDA) installed on the Platform Layer

The Citrix VDA installer for the Windows OS you are using must be installed on the Platform Layer.

Citrix Desktop Delivery Controller (DDC)

The Citrix DDC software must be installed on the server where the Layered Image will be published.

As part of the Connector Configuration, if  you include a script to run on the newly published Layered Image, you will need

the following:

Agent - Installed and running on the DDC. This allows the appliance to run the script on the DDC.

PowerShell Snap-in - Appropriate PowerShell Snap-in must be installed on the DDC.

Citrix resource information

The Citrix info listed in this MCS Connector Configuration topic.

Prepare a new platform layer

To create a Platform Layer you prepare the layer using the Create Platform Layer wizard, deploy a Packaging Machine in

your environment, install the tools and configure the settings for MCS, and finalize the Layer.

Select Layers > Platform Layers and select Create Platform Layer in the Action bar. This opens the Create Platform Layer

wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

In the OS Layer tab, select the OS Layer you want to associate with this Platform Layer.

In the Connector tab, choose a Connector Configuration for the platform where you are creating this layer. If  the

configuration you need isn't listed, add a New Connector Configuration and select it from this list.

Example: If  you are creating the layer in your vSphere environment, select the vSphere connector with the information

needed to access the temporary storage location where you will package this layer.

In the Platform Types tab, select This platform will be used for publishing Layered Images, and the Hypervisor, Provisioning

Service, and Connection Broker to which you will be publishing the Layered Image.

Note: If  you are not using one of these, for example, if  you are not using a connection broker, select None.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the tools, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the App Layer, enter a comment if  required, and click Create Layer.

Any comments you enter will appear in the Information view Audit History.
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Expand the Tasks bar at the bottom of the UI, and double-click the Packaging Disk task to show the full task description.

Once the Packaging Disk has been created, the Task bar displays the location of the Packaging Disk in your environment.

Deploy a Packaging Machine

The Packaging Machine is a virtual machine where you install the tools for your selected environment.

Note: The Packaging Machine is a temporary VM that will be deleted once the new Platform Layer has been finalized.

Log into the Packaging Machine

The Task Description (example shown in the last step above) contains the location of the Packaging Machine in your

environment.

Log into your vSphere web client.

Back in the Management Console, use the instructions in the expanded Packaging Disk Task shown below to navigate to

the Packaging Machine.

Power on the Packaging Machine.

 

Install the required platform tools

This section explains how to install the platform software to be used by the Platform Layer. The platform software to

install includes the provisioning server software and/or connection broker software that your Layered Images will need to

run in the target environment.

Platform software to install

You need the installers for your hypervisor, provisioning service, and connection broker.

If  you are using a supported App Layering Connector to connect to your environment, you will install the provisioning

service and/or connection broker software on the Packaging Machine that the App Layering software created in that

environment. Otherwise, you will be installing the software on a VM in your hypervisor of choice, moving the VM to the

appliance's network file share, from which you can import the VM.

Keep in mind that the state of the software before you finalize the layer is what the image will use.

Remote log in to the Packaging Machine you created. Be sure to log in using the User account you used to create the OS.

Install the tools that your Layered Image will need to run in your environment. This includes any hypervisor, provisioning

service, and connection broker software that you're using, along with any drivers, boot-level applications, and files needed.

If  some of the installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

Make sure the Packaging Machine is in the state you want it to be in when the image is booted:

If  the tools you install require any post-installation setup or registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

Next, you'll need to shut down the Packaging Machine and verify that the Platform Layer is ready to finalize.
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Verify the Layer and shut down the Packaging Machine

Once the tools are installed on the Packaging Machine, the next step is to verify that the Layer is ready to finalize. At this

point, any required post-installation processing needs to be completed. For example, a reboot may be required, or a

Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

 

To use the Shutdown For Finalize tool:

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages you may see during the finalization process

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the
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foreground can help the task to complete as quickly as possible. To do this:

Open a command prompt as Administrator.

Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

Open a command prompt as Administrator.

Check status by running this command:

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the Layer

Once the Packaging Machine is created, the software is installed and ready to finalize, and you have shut down the

machine, you'll need to finalize the Layer.

Note: When you finalize a Layer, the App Layering software may delete the Packaging Machine so as not to incur extra

cost for storage.

When the Layer has been verified and is ready to finalize:

Return to the Unidesk Management Console.

Select Layers >App Layers, and then the layer you just prepared.

Select Finalize in the Action bar.

Monitor the Task bar to verify that the action completes successfully and that the Layer is ready to deploy.
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PVS connector

Jun 29, 2017

A Platform Layer includes the platform software and settings required to deploy images in your environment. For example, a

Platform Layer for publishing to Citrix PVS in XenServer with XenApp as the broker would include the XenServer, PVS, and

XenApp tools, and any other platform-related software.

This article explains the next steps to create a Platform Layer, based on your connector and platform choices. If  you need

more information than is included here, check these other sources: Layer essentials and the App Layering Forum.

A Platform Layer should include the platform software and settings required to deploy images in your environment, given

your choice of hypervisor, provisioning service, and connection broker.

You can create two kinds of Platform Layers:

Platform Layers for publishing Layered Images (Required) - A Platform Layer for publishing is used in Image Templates to

ensure that your published Layered Images include the software and settings required to run flawlessly in your environment.

Platform Layers for packaging Layers (Required in some cases) - A Platform Layer for packaging is used for creating App

Layers and OS Layer Versions in your hypervisor environment. This Layer includes the hypervisor software and settings

required to easily install the app or OS update on a VM in the selected hypervisor.

Prerequisites

When creating a Platform Layer, the software installers for your platform must be available in a location that's accessible

to the Packaging Machine VM where you are going to create the Layer. As summarized in the following table, the

prerequisites vary based on the type of Platform Layer you choose to create.

Type of
Platform Layer

Prerequisites

Publishing

Layered Images

Software installers, and settings you use for your:

Hypervisor

Provisioning service

Connection broker

Packaging

Layers

The software and settings for your:

Hypervisor

For example, your hypervisor installer and settings.

Note : You only need a Platform Layer for packaging Layers if you are creating your Layers on a different hypervisor

than the one from which you imported your OS image.

Citrix XenServer prerequisites
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XenServer account and privileges

A XenServer account (new or existing) to use for App layering service.

The account must have XenServer privileges to:

Create and remove virtual disks.

Copy and delete layers on virtual disks using XenServer f ile APIs.

Citrix XenServer software and settings

Access to the XenServer Tools to install on the layer.

XenServer resource information

The XenServer info listed in Citrix XenServer Connector Configuration.

Prepare a new platform layer

To create a Platform Layer you prepare the layer using the Create Platform Layer wizard, deploy a Packaging Machine in

your environment, install the tools and configure the settings for MCS, and finalize the Layer.

1. Select Layers > Platform Layers and select Create Platform Layer in the Action bar. This opens the Create Platform

Layer wizard.

2. In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other

values.

3. In the OS Layer tab, select the OS Layer you want to associate with this Platform Layer.

4. In the Connector tab, choose a Connector Configuration for the platform where you are creating this layer. If  the

configuration you need isn't listed, add a New Connector Configuration and select it from this list.

Example: If  you are creating the layer in your vSphere environment, select the vSphere connector with the information

needed to access the temporary storage location where you will package this layer.

5. In the Platform Types tab, select This platform will be used for publishing Layered Images, and the Hypervisor,

Provisioning Service, and Connection Broker to which you will be publishing the Layered Image.

Note: If  you are not using one of these, for example, if  you are not using a connection broker, select None.

6. In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for

the Packaging Machine (the VM) where you will install the tools, as described in the next two sections.

7. In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

8. In the Confirm and Complete tab, review the details of the App Layer, enter a comment if  required, and click Create
Layer. Any comments you enter will appear in the Information view Audit History.

9. Expand the Tasks bar at the bottom of the UI, and double-click the Packaging Disk task to show the full task

https://www.unidesk.com/support/learn/4.2.0/citrix_xenserver/itoc_2_publish_xs4/itoc_3_connectors_publishing_xs4/connectors_about_xs4
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description.

Once the Packaging Disk has been created, the Task bar displays the location of the Packaging Disk in your environment.

Next, you can deploy the Packaging Machine for your Layer.

Deploy a Packaging Machine

The Packaging Machine is a virtual machine where you install the tools for your selected environment.

Note
The Packaging Machine is a temporary VM that will be deleted once the new Platform Layer has been finalized.

Log into the Packaging Machine

The Task Description (example shown in the last step above) contains the location of the Packaging Machine in your

environment.

1. Log into your vSphere web client.

2. Back in the Management Console, use the instructions in the expanded Packaging Disk Task shown below to navigate

to the Packaging Machine.

3. Power on the Packaging Machine.

Install the required platform tools

This section explains how to install the platform software to be used by the Platform Layer. The platform software to

install includes the provisioning server software and/or connection broker software that your Layered Images will need to

run in the target environment.

Platform software to install

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/layers_app_action_required_vs.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/layers_app_action_required_vs.png
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You need the installers for your hypervisor, provisioning service, and connection broker.

If  you are using a supported App Layering Connector to connect to your environment, you will install the provisioning

service and/or connection broker software on the Packaging Machine that the App Layering software created in that

environment. Otherwise, you will be installing the software on a VM in your hypervisor of choice, moving the VM to the

appliance's network file share, from which you can import the VM.

Keep in mind that the state of the software before you finalize the layer is what the image will use.

1. Remote log in to the Packaging Machine you created. Be sure to log in using the User account you used to create the

OS.

2. Install the tools that your Layered Image will need to run in your environment. This includes any hypervisor, provisioning

service, and connection broker software that you're using, along with any drivers, boot-level applications, and files

needed.

If  some of the installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

3. Make sure the Packaging Machine is in the state you want it to be in when the image is booted:

If  the tools you install require any post-installation setup or registration, complete those steps now.

Remove any settings, configurations, f iles, mapped drives, or applications that you do not want to include on the

Packaging Machine.

Next, you'll need to shut down the Packaging Machine and verify that the Platform Layer is ready to finalize.

Verify the Layer and shut down the Packaging Machine

Once the tools are installed on the Packaging Machine, the next step is to verify that the Layer is ready to finalize. At this

point, any required post-installation processing needs to be completed. For example, a reboot may be required, or a

Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

1. If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

2. Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verif ication

process.

3. If  there is an outstanding operation that must be completed before the Layer can be f inalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

4. Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

https://www.unidesk.com/support/learn/4.2.0/citrix_xenserver/itoc_2_layer_xs4/itoc_3_layer_platform_create_xs4/layer_platform_create_pv_xs4#Layer_Integrity_Check
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The Layer is now ready to finalize.

Layer integrity messages you may see during the finalization process

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

3. Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It ’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:
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ngen queue status

3. When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the Layer

Once the Packaging Machine is created, the software is installed and ready to finalize, and you have shut down the

machine, you'll need to finalize the Layer.

Note: When you finalize a Layer, the App Layering software may delete the Packaging Machine so as not to incur extra

cost for storage.

When the Layer has been verified and is ready to finalize:

1. Return to the Unidesk Management Console.

2. Select Layers >App Layers, and then the layer you just prepared.

3. Select Finalize in the Action bar.

4. Monitor the Task bar to verify that the action completes successfully and that the Layer is ready to deploy.
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XenServer connector

Jun 29, 2017

A Platform Layer should include the platform software and settings required to deploy images in your environment, given

your choice of hypervisor, provisioning service, and connection broker.

You can create two kinds of Platform Layers:

Platform Layers for publishing Layered Images (Required) - A Platform Layer for publishing is used in Image Templates to

ensure that your published Layered Images include the software and settings required to run flawlessly in your

environment.

Platform Layers for packaging Layers (Required in some cases) - A Platform Layer for packaging is used for creating App

Layers and OS Layer Versions in your hypervisor environment. This Layer includes the hypervisor software and settings

required to easily install the app or OS update on a VM in the selected hypervisor. 

Prerequisites

When creating a Platform Layer, the software installers for your platform must be available in a location that's accessible

to the Packaging Machine VM where you are going to create the Layer. As summarized in the following table, the

prerequisites vary based on the type of Platform Layer you choose to create.

Type of
Platform Layer

Prerequisites

Publishing

Layered Images

Software installers, and settings you use for your:

Hypervisor

Provisioning service

Connection broker  

Packaging

Layers

The software and settings for your:

Hypervisor

For example, your hypervisor installer and settings.

Note: You only need a Platform Layer for packaging Layers if you are creating your Layers on a different hypervisor

than the one from which you imported your OS image.

Citrix XenServer prerequisites

XenServer account and privileges

A XenServer account (new or existing) to use for App layering service.

The account must have XenServer privileges to:

Create and remove virtual disks.

Copy and delete layers on virtual disks using XenServer file APIs.

Citrix XenServer software and settings
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Access to the XenServer Tools to install on the layer.

XenServer resource information

The XenServer info listed in Citrix XenServer Connector Configuration.

 

Prepare a new platform layer

Select Layers > Platform Layers and select Create Platform Layer in the Action bar. This opens the Create Platform Layer

wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

In the OS Layer tab, select the OS Layer you want to associate with this Platform Layer.

In the Connector tab, choose a Connector Configuration for the platform where you are creating this layer. If  the

configuration you need isn't listed, Click New, select your platform from this list, and Add a Configuration for it.

Example: If  you are creating the layer in a XenServer environment, select the XenServer connector with the information

needed to access the location where you will package this layer.

In the Platform Types tab, select the radio button that describes the purpose of this Platform Layer: to create and update

layers, or to publish Layered Images. For more about these choices, see Platform Layers.

From the dropdown menus, select the platform(s) you are using.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the tools, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the Layer, enter a comment if  required, and click Create Layer. Any

comments you enter will appear in the Information view Audit History.

At the bottom of the UI, expand the Tasks bar and double-click the task to show the full task description.

Once the task is complete, the location of the Packaging Disk is shown (example task message shown below).

Next, you can deploy the Packaging Machine for your Layer. The Packaging Machine is a temporary virtual machine where

you install the software to include in the Layer being created.

Power on the Packaging Machine in XenServer

Log into your XenServer client.

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create Platform

Layer task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenCenter client.

While in the Infrastructure View, select your Packaging Machine's VM from the list of machines.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.68https://docs.citrix.com

In the XenCenter UI in the panel on the right, choose the Console option for the VM.

Power on the VM.

Select the Click here to create a DVD drive link.

Power cycle the VM (yes, you have to in order to get the DVD Drive).

At the top of the console window, click the DVD Drive 1 drop down menu and select the xs-tools.iso.

Install the XenTools. This will require multiple reboots as part of the tools installation. Once complete, you should see that

you have access to all XenTools, as well as all of the data available under the Performance tab for your VM.

Note: The XenCenter console uses RFB for it's console connection, which uses Port 5900. On Windows 2008 and Windows

7, this port is closed in the Firewall by default and should be opened so you can use the console to access any VMs

Install the platform tools on the Packaging Machine

Whether you are creating a Platform Layer or adding a version to it:

Remote log in to the Packaging Machine. Be sure to log in using the User account you used to create the OS.

Install the platform software and tools, along with any drivers, boot-level applications, or files needed. Keep in mind that

the state of the software before you finalize the layer is what the image will use.

If  this Platform Layer is going to be used for packaging new layers, install and configure your hypervisor tools and settings.

If  this Platform Layer is going to be used for publishing Layered Images, install and configure your hypervisor, provisioning

service, and connection broker tools and settings.

If  a software installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

Make sure the Packaging Machine is in the state you want it to be in for users:

If  the tools you install require any post-installation setup or registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

When using PVS, if  your OS image was activated using KMS, rearm KMS just before you shut down

Verify the Rearm count on the OS by running slmgr /dlv from a command prompt. The Rearm count must not be zero.

slmgr /dlv

Rearm KMS:

slmgr /rearm

Verify the Layer and shut down the Packaging Machine

Once the software is installed on the Packaging Machine, it is important to verify that the Layer is ready to be finalized. To

be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.
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Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation. For details, see Verifying Layers.

If  you are using KMS licensing, once any pending operations are complete, be sure to rearm KMS yet again just before you

shutdown. First, enter this command to verify that the Rearm count is > 0:

slmgr /dlv

Then, rearm KMS:

slmgr /rearm

Double-click the Shutdown For Finalize icon again to shut down the Packaging Machine.

The Layer should be ready to finalize.

During the shutdown for finalization

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

Open a command prompt as Administrator.
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Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

Open a command prompt as Administrator.

Check status by running this command:

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

 

Finalize the Layer

To finalize the Layer, you import the installed software into the Platform Layer you prepared in the Management Console.

Return to the Management Console.

Select Layers > Platform Layers.

Select Finalize in the Action bar.

Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.
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Network File Share Connector

Jun 29, 2017

When the App Layering appliance (Enterprise Layer Manager) is installed, you set up a network file share that you can then

use as a Connector Configuration when creating layers and publishing Layered Images. This Connector Configuration

contains the appliance's Network File Share credentials and location so you can deploy a Packaging Machine to the File

Share when creating layers, or publishing Layered Images.

Each Connector Configuration is set up to access a storage location via a specific account.

Network File Share location

The name of the Network File Share Connector Configuration includes its location. Look for the App Layering folder at the

top level of the Network File Share. For details, see Configure a file share for the App Layering Appliance.

When to select the Network File Share as your Connector Configuration

When you publish Layered Images to a provisioning service for which we do not yet have a Connector, you can select the

Network File Share Connector Configuration. You can then copy the Layered Image from the network file share to the

correct location for provisioning servers.
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App layer

Jun 29, 2017

An App Layer is a bootable software image (virtual disk) containing one or more applications that you can use in any number

of Layered Images. When publishing a Layered Image, you can combine an App Layer with the OS Layer used to create it,

other App Layers, and a Platform Layer.

To create an App Layer, you open the Create Layer wizard, deploy a Packaging Machine in your environment, then install the

application(s). Once the application(s) are installed, you finalize the Layer.

A Packaging Machine is a VM where you install the application(s) that will be included in the Layer. The App Layering

software creates the Packaging Machine in the location and using the credentials you supply by choosing the Platform

Target (hypervisor) and selecting a Connector Configuration containing this information. If  you don't yet have the

Connector Configuration you need, you can add a new one, as described in the steps below.

Before you start

Requirements

To create an App Layer, you need:

Create an OS Layer

Optional

Before you create an App Layer, you may also want to create resources that facilitate the application installation process.

These resources are for temporary use during installation only, and will not be used to deliver the application.

Prerequisite Layer

Platform Layer (for cross-platform deployments) (Only required if  creating App Layers on a hypervisor other than the one

from which you imported your OS Layer)

Run Once Script

If  the application you install affects boot-level components, you'll need to restart the Packaging Machine as part of

finalizing the layer or version.

Prerequisite Layer

Prerequisite Layers let you include existing App Layers on the Packaging Disk when creating or adding a version to an App

Layer. Prerequisite Layers should only be used if  they are required, since it is possible that the prerequisite applications will

pull something into the Layer that is not required for the current application deployment, and which may cause conflict in

the future.

Reasons to consider using Prerequisite Layers:

The application you are installing requires another application during installation. For example, if  you are installing an

application that requires Java and you have Java in a separate layer.

The add-in or plugin you are installing adds settings to an application. For example, when installing an Office add-in, you

would use your Microsoft Office App Layer as a prerequisite layer.

Two applications modify the same registry key, and the second application must add to an existing key rather than replace

it. For example, Citrix Agent and Imprivata software both modify login keys in Windows.

Note: Some of these issues can also be handled by putting the two applications in the same layer.
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Platform Layer (for cross-platform deployments)

A Platform Layer is only required when creating App Layers on a hypervisor other than the one from which you imported

your OS Layer.

If  you are creating App Layers and Versions on a different hypervisor than the one you used to create your OS Layer, it is

strongly recommended that you create a Platform Layer containing the hypervisor tools and hardware settings you need

to seamlessly install and package applications in your environment.

Run Once Script

You can include a Run Once script in an App Layer. This allows you to run a script the first time any Layered Image that

includes the App Layer boots. If  the App Layer is elastically layered, the Run Once script runs when the App Layer Disk is

mounted. Run Once scripts are typically used for apps, such as MS Office, that require license activation on the first boot.

Prepare a new App Layer

Select Layers > App Layers and select Create Layer in the Action bar. This opens the Create Layer wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

For details, see more about these values below.

In the OS Layer tab, select the OS Layer you want to associate with this App Layer.

(Optional) In the Prerequisite Layers tab, if  the application you are layering requires other App Layers to be present during

installation, select the Include Prerequisite Layers check box, and pick the necessary App Layer(s).

Notes:

Prerequisite layers are used while installing applications, and are not included in the App Layer.

Prerequisite layers are not included by default when adding a new Version to this App Layer. So, when you add a new

Version to this App Layer, you must choose the Prerequisite Layers again, if  needed.

The App Layer you are creating and each of its Prerequisite Layers must be associated with the selected OS Layer.

In the Connector tab, choose a Platform Connector Configuration that contains the credentials for the platform where

you plan to build the Layer, along with the storage location. If  the configuration you need isn't listed, add a New Connector

Configuration and select it from this list.

Example: If  you're using the XenServer environment to create the Layer, select the XenServer connector with the

credentials and location required to access the location where you want to build the Layer.

In the Platform Layer tab you can select a Platform Layer containing the tools and hardware settings that you need to

install and package an application during Layer creation. This selection is only used during layer creation. Once created, the

Layer can be used in Layered Images published to any platform.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the application, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the App Layer, enter a comment if  required, and click Create Layer.

Any comments you enter will appear in the Information view Audit History. Once the Packaging Disk has been created, the



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.74https://docs.citrix.com

Task bar displays instructions to navigate to the Packaging Machine in XenServer.

Next, you can log into the Packaging Machine for your Layer, and install the software for the layer on it.

Deploy a Packaging Machine in XenServer

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App Layer

task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenServer client.

Power on the Packaging Machine.

You can now install the applications for this layer on the Packaging Machine.

Deploy a Packaging Machine in XenServer

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App Layer

task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenServer client.

Power on the Packaging Machine.

You can now install the applications for this layer on the Packaging Machine.

Install the software on the Packaging Machine

When you've completed the Layer wizard, Unidesk creates a Packaging Machine in your environment, in the location defined

in the Connector Configuration. The Packaging Machine is a virtual machine where you install the software to be included in

the layer.

Note: The Packaging Machine is a temporary VM that will be deleted once the new Platform Layer has been finalized.

Log into the Packaging Machine

Log into your vSphere web client.

Back in the Unidesk Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App

Layer task to see the full Task Description.

Use the instructions in the Task Description to navigate to the Packaging Machine in your vSphere web client.

The Packaging Machine will be powered on.

Install the Application(s)

When installing your application(s) on the Packaging Machine, leave each application as you want users to see it when they

log in. The state of the applications when you finalize the layer is what users experience when they access the application.

More guidance about this is included in the steps below.

Remote log in to the Packaging Machine in vSphere. Be sure to log in with the User account you used to create the OS in

vSphere.

Install the applications, along with any drivers, boot-level applications, or files that the user will need with it.

If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart
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automatically.

Make sure the Packaging Machine is in the state you want it to be for the user:

If  the applications you install require any post-installation setup or application registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, it is important to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages you may see during the finalization process

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.
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Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

Open a command prompt as Administrator.

Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

Open a command prompt as Administrator.

Check status by running this command:

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the Layer

Once the software has been installed and the Packaging Machine has been verified and shut down, you are ready to

finalize the layer.

Note: When you finalize a Layer, Unidesk may delete the Packaging Machine to minimize storage space used.

When the Layer has been verified and is ready to finalize:

Return to the Management Console.

Select Layers >App Layers, and then the layer you just prepared.

Select Finalize in the Action bar. The Finalize wizard appears.

(Optional) On the Script Path wizard tab, you can enter the path to a Run Once Script located on a server on your network.

If  the App Layer is elastically assigned, the Run Once script will be executed the first time the app is used.

If  the App Layer is included in a Layered Image, the Run Once script will be executed the first time the Layered Image is

booted. 

Click Finalize to finish creating the Layer.

Monitor the Task bar to verify that the action completes successfully and that the Layer is ready to be deployed.
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Reference: create App Layer Wizard values

Layer Name - (Required) A name that will let you know what app(s) the layer will be used for.

Layer Description - (Optional) Description of the Layer

Version - (Required) This can be the version of the application or a version you assign to the Layer. This value is displayed in

the Details view of the Layer. Keep in mind that you'll add a new version to this layer whenever you update the app(s)

included in it, and this is where the version will be described.

Version Description - (Optional) Enter a description of the version.

Specify the Max Layer Size - Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 10 gigabytes. If  the application you are installing could eventually require more

space, change this to an appropriate value.
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User layer

Jun 29, 2017

User Layers let you persist user profile settings, data, and user-installed applications in non-persistent VDI environments.

User Layers are created when:

You set Elastic Layering on an Image Template to Application and User Layers, so that the Layered Image supports User

Layers.

A user logs in to their desktop for the first time, and a User Layer is created for them. From then on, the user's data and

settings are saved in the User Layer, along with any applications that the user installs locally on their desktops.

 

Before you start

Prerequisites

Create the OS Layer

Create a Platform Layer

Create App Layers

Adequate network bandwidth. Bandwidth and latency have a significant effect on the User Layer. Every write goes across

the network.

Allocate storage space for users' locally installed apps and the data and configuration settings for them. (This leaves the

main storage location solely for packaging layers, publishing Layered Images, and serving up Elastic Layers.)

Compatibility

Currently, User Layers are supported for the following platforms:

Operating systems:

Windows 7, 64-bit

Windows 10, 64-bit

Publishing platforms: VMware Horizon View and Citrix XenDesktop.

User Layer creation process

Enable User Layers in your Image Template:

Set Elastic Layering in the Image Template wizard on the Image Disk tab) to Application and User Layers.

Publish Layered Images using the above Image Template.

When a user logs on to their desktop for the first time, a User Layer is created for them.

User Layer size and location

The default size of a User Layer is 10 GB.

User Layers are created in the Users folder on the appliance's network file share, for example:

\\MyServer\MyShare\Users

Each user will have his/her own directory within the Users directory, and it will be named as follows:
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Users\domainIname\username\OS-Layer-ID-in-hex_OS-Layer-name\username.vhd

For example:

User's login name: jdoe

User's Domain: testdomain1

OS layer: MyOSLayer (ID is in hexidecimal format: 123456)

User Layer would be created in:

\\MyServer\MyShare\Users\testdomain1\jdoe\123456_MyOSLayer\jdoe.vhd

Upgrading existing User Layers to this Release

Once you upgrade the appliance to Release 4.2.0, if  you want to continue using existing User Layers, you'll need to move

them to new locations as described below in Upgrade User Layers created using a previous release.

Other Considerations

Before deploying User Layers, please consider the following guidelines and limitations.

The User Layer is delivered via the appliance's file share, therefore:

If  the host is disconnected from the User Layer storage, the user will have to log out and log in again to re-establish the

disk mount. The user will have to wait approximately 5 minutes because the user layer will be inaccessible.

Certain enterprise applications, such as MS Office and Visual Studio should be installed in Layers, not as user-installed

applications in the User Layer. In addition, the Elastic Layering limitations are applicable for User Layer. For more information

on Layering limitations, please see the Elastic Layering Limitations section.

Windows updates must be disabled on the User Layer.

VMware Horizon View:

View must be configured for non-persistent desktops, and the desktop must be set to Refresh at log off. Delete or refresh

the machine on log off. Example:

After logging off  with View set to Refresh Immediately, the desktop goes into maintenance mode. If  there is only one

machine in the pool, the pool will not be available until that machine has completed the refresh.

The first time a user logs into his/her desktop, a User Layer is created for the him/her.

If  there is problem loading the elastically assigned Layers for the user, they will still receive their User Layer.

If  you rename the user in AD, a new directory and User Layer will be created for the new name. To avoid this, rename the

directory on the file share and the VHD file in the directory structure to the new AD user name.

 

Add storage locations for user layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.
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Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The first storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's User

Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest priority

location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until that

point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the their User

Layer to the new highest priority location.

Create Storage Locations

To add a storage location:

Log into the management console.

Select System > Storage Locations.

Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

Select Add Storage Location, and enter a Name and Network Path for the new location.

On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to add

to the new storage location.

On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure security on user layer folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:
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Setting name Value Apply to

Creator Owner Modify Subfolders and Files only

Owner Rights Modify Subfolders and Files only

Users or group:

Create Folder/Append Data

Traverse Folder/Execute File

List Folder/Read Data

Read Attributes

Selected Folder Only

System Full Control Selected Folder, Subfolders and Files

Domain Admins, and selected Admin group Full Control Selected Folder, Subfolders and Files

Set security on the User Layer folders

1. Log into the management console.

2. Select System > Storage Locations. The file shares displayed are the storage locations defined for User Layers. For

example, say you've defined three Storage Locations so that you can more easily manage storage for Group1 and Group2

separate from everyone else in the organization:

Default location - \\MyDefaultShare\UserLayerFolder\

Group1 - \\MyGroup1\Share\UserLayerFolder\

Group2 - \\MyGroup2\Share\UserLayerFolder\

Note: The appliance's main file share, which is used for storing OS, App, and Platform Layers, is not listed as a User Layer

Storage Location.

3. Create a \Users subdirectory under each file share:

\\MyDefaultShare\UserLayerFolder\Users\

\\MyGroup1Share\UserLayerFolder\Users\

\\MyGroup2Share\UserLayerFolder\Users\

4. Apply the security settings listed above to each /Users subdirectory.

Customize User Layer messages for users

You can customize notification messages sent to users when their User Layer is not available. The message is displayed to

the user upon login.

 

The App Layering software displays messages for end users when the software is unable to:
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Read configuration (json) files from the configuration file share.

Attach a User Layer because it is in use.

Attach a User Layer for any other reason.

The messages are displayed as needed in the App Layering Management Console when you add a new storage location or

modify an existing one.

 

User Layer In Use (customizable message)

 

We were unable to attach your User Layer because it is in use. Any changes you make to application settings or data will

not be saved. Be sure to save any work to a shared network location.

 

User Layer Unavailable (customizable message)

 

We were unable to attach your User Layer. Any changes you make to application settings or data will not be saved. Be sure

to save any work to a shared network location.

 

Review Permissions on Users folder, all subfolders and files

 

Unable to read json files from the config share

 

We were unable to load the required configuration files. You may not be able to access some of your applications. And, any

changes you make to application settings or data will not be saved. Be sure to save any work to a shared network location.

 

When logged into the appliance as Administrator, you can customize the first two of the above messages. To do so:

 

Log into the Management Console as Administrator.

Select Add Storage Location if  creating a new location, or Edit Storage Location if  customizing messages for an existing

location.

In the Add/Edit Storage Location wizard, select the User Layer Messages tab and the Override check box.
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Enter the messages exactly as you want them to be displayed. The message can be in any language.

Use the Confirm and Complete tab to save your changes.

Disable Store Apps (Optional)

On Windows 10 Enterprise editions (not Windows Professional), you can disable the Windows Store by creating an OS

Version specifically for that purpose. A script is provided that uninstalls all Store Apps for all users. Once complete, users will

have access to Edge and Cortana only.

 

To disable Store Apps, add a new OS Version, and:

 

From an administrator prompt, run this command:

 

C:\Windows\Setup\Scripts\RemoveStoreApps.cmd

Finalize and deploy the image based on this new version of the OS Layer. For new users, the Start menu will look like this:

 

 

 

Enable User Layers in the Layered Image

Log into the Management Console as an Admin user.

Select Images.

Select the Image Template from which you will publish the Layered Image(s), and click Edit Template. This opens the Edit

Image Template wizard.

On the Layered Image Disk tab, set Elastic Layering to Application and User Layers.

On the Confirm and Complete tab, click Save Template Changes.

Publish your Layered Images.

 

Upgrade User Layers created using a previous release

Once you upgrade the appliance to Release 4.2.0, if  you want to continue using existing User Layers, you'll need to move

them to new locations as described below.

 

In this release, the User Layer directory structure has been collapsed by one level, as shown below:
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Previous: ...\Users\DomainUser\LayerId_OsName\User.vhd

 

New: ..\Users\Domain_User\LayerId_OsName\User.vhd

 

For example, move the following User Layer VHD file.

 

From:

 

\\Root\Engineering\Users\Domain1\User1\32_Win7\User1.vhd

To:

 

\\Root\Engineering\Users\Domain1_User1\32_Win7\User1.vhd

If  you want to continue using the current User Layers, you must move each Storage Location and the main file share to the

new location.

 

Important: All of these steps must be completed while all users are logged out. Although no data will be lost if  a user logs in

during this procedure, failure to finish all steps will result in existing users not being able to access their previously created

user layers. No data will be lost, but users will be confused.

 

To upgrade the User Layers:

 

Using your Image Templates, republish each of your Layered Images that uses Elastic Layering and/or User Layers.

Move existing User Layers to the new location, as explained below.

Verify the security settings on each renamed folder and on the /User folder, as described above.

Move existing User Layers to the new location

Copy each User Layer Storage Location to its new location:

 

Make sure the User Layer is not in use.
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If  a user logs in before you move his/her User Layer, a new User Layer will be created. No data will be lost, but you will need

to delete the newly created User Layer, and copy it to the new directory, ensuring that the user's ACLs are preserved.

 

Browse to the directory containing the User Layer VHD file.

 

Using the following command, copy each of the User Layer VHD files from the previous location to the new one

 

xcopy Domain1\User1 Domain1_User1\ /O /X /E /H /K

Verify that all permissions are correct on the following directories, and files within them:

 

\\Root\Engineering\Users

\\Root\Engineering\Users\Domain1_User1\...

\\Root\Engineering\Users\Domain2_User2\...

Let users create new User Layers and remove the previous ones

If  you choose to let users create new User Layers, you must manually clean up the original directories and files from your

share.
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Publish layered images

Jun 29, 2017

The Citrix App Layering service lets you publish Layered Images as disks compatible with your platform. You can use a

Layered Image to provision servers, as you would with any other image.

About Layered Images

Layered Images are bootable images composited from Layers. Each Layered Image contains an OS Layer, a Platform Layer,

and any number of App Layers.

Creating and updating Layered Images

The way you specify which layers to include in a Layered Image is by saving the combination of layers you want for a

particular group of users in an Image Template. You then use this template to publish a Layered Image to your chosen

platform.

When you need to update the Layered Image, you simply edit the Image Template to add or remove layer assignments, and

publish a new version of the image.
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Connectors for publishing

Jun 29, 2017

When publishing Layered Images, you need a Connector Configuration that defines the location where you will publish the

images, preferably near the servers you intend to provision with the images. You can create as many Connection

Configurations as you need.

It is strongly recommended that Layered Images are published to the environment where the App Layering appliance is

installed, in this case, XenServer. To do this, you need an XenServer Connector Configuration to define the publishing

location. If  you don't yet have an XenServer Connector Configuration, you can create one while in the process of publishing

Layered Images.

Note: If  you decide to publish Layered Images on a hypervisor other than the one where the appliance is installed, you can

publish to the appliance's file share using the NFS Connector. Once the image is published, you can manually copy the file to

the desired location.

See Connector essentials for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/xenserver/configure/connector-essentials.html
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MCS for XenServer connector configuration

Jun 29, 2017

An MCS for XenServer Connector Configuration contains the credentials and storage location App Layering needs to

publish Layered Images to MCS in your XenServer environment.

You can publish Layered Images to MCS running in a XenServer environment using an MCS for XenServer Connector

Configuration. In the Connector Configuration wizard, be sure to configure a Virtual Machine Template, so that the Layered

Image you publish will be in a ready-to-use VM, the image shut down and a snapshot taken. You can use the VM in your

Horizon environment without further modifications.

Each Connector Configuration is set to publish Layered Images to a specific storage location in your environment, so you

may need more than one MCS Connector Configuration if  publishing to multiple locations. Further, you may want to publish

each Layered Image to a location convenient to the system you will be provisioning with the published image. For more

about Connectors, and Connector Configurations, see Connector essentials.

Notes:

This Connector Configuration is for publishing Layered Images. You cannot package Layers in the MCS environment. For

packaging Layers, use a XenServer Connector Configuration.

Personal vDisks are not supported for MCS. The published desktop images will be non-persistent. Currently, vDisks can only

be used when publishing to Citrix PVS.

Before you start

You can use your XenServer environment for creating Layers, and for publishing Layered Images. Each Connector

Configuration accesses a specific storage location in your XenServer environment. You may need more than one XenServer

Connector Configuration to access the correct location for each purpose. Further, you may want to publish each Layered

Image to a location convenient to the system you will be provisioning with the published image. For more about

Connectors, and Connector Configurations, see About Connectors.

Since XenServer uses a pod-like architecture where you, the administrator, interact with individual servers or clusters of

servers, rather than with a central management server, you manage these pods via command line access or GUI

management software like XenCenter, which you install directly on your desktop and connect individually to each

standalone host or to clusters of hosts.

If  this is your first time using the App Layering service

If  this is your first time using the App Layering service and you want to create Layers using a XenServer VM, you will need a

XenServer Connector within App Layering. When publishing Layered Images to XenServer, you will need a Connector

Configuration for each of your publishing locations as well.

The Create Layer and Publish Layered Image wizards each ask you to select a Connector Configuration. If  you don't yet

have the right Connector Configuration for the task, you can create one by clicking New on the Connector wizard tab

(details below).

Required information for XenServer Connector Configuration settings

The XenServer Connector Configuration wizard let's you browse for the XenCenter Server, Data Store, and Host to use for

a new configuration.
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Important: The fields are case sensitive, so any values that you enter manually must match the case of the object in

XenServer, or the validation will fail.

Configuration Name - A useful name to help identify and keep track of this connector configuration.

XenServer Address - The name of the XenServer host with which the appliance will integrate.

User Name/Password - The credentials for the account that the appliance will use to connect to XenServer.

Use Secured Protocol - Lets you use SSL encryption for the API connection traffic between the Connector and Citrix

XenServer. This field is checked by default.

Allow Certificate Errors - Enables certificate errors to be ignored. By default, this setting is disabled.

Template - VM Template that can be used for cloning. The list of choices will only contain custom VM templates, rather

than actual VMs or any of the built-in templates. The selected template must not have any disks attached, and must have

at least one network card attached. If  it does not, you will see an error when trying to validate or save the configuration.

Storage Repository - The storage repository for the disk that will get uploaded. The list will be filtered to only show

repositories that can contain VHDs (ISO repositories are filtered out).

Use HTTPS for File Transfers - Encrypts the image file transfers. HTTPS is checked by default for more secure uploads and

downloads, but can be unchecked for increased performance.

Virtual Machine organization

XenServer allows for VMs to be organized either by folder or by tag. These organizational tools are optional when creating

and managing VMs through XenCenter or other tools. Although XenServer Connector Configurations do not allow the

administrator to specify folders or tags, the VMs created by the XenServer Connector, both Packaging Machines and

published Layered Images, can utilize both organizational tools.

Tags

If  the template specified in the XenServer connector configuration has any tags, then those tags will be carried over to any

VM cloned from that template. Therefore all packaging VMs or published layered images will be tagged with the same tags

that the template has. Additionally, the XenServer connector will add three tags.

Unidesk - All VMs created by the XenServer connector can be found by this tag regardless of their purpose or image.

Purpose Tag - All packaging machines will be tagged with "Unidesk Packaging Machine" while all published layered image

VMs will be tagged with "Unidesk Published Images".

Image/Layer Name - All packaging machines will be tagged with the layer name for the layer which they are generated,

while all published layered images will be tagged with the template image name.

If  you are using XenCenter, you can view your VMs by tag by selecting the "Organization Views" and then select "By Tag".

Folder

By default VMs created by the XenServer Connector will not be placed in a folder. However, if  the template specified in the

XenServer Connector Configuration resides in a folder, then any VM that the Connector creates from that template will

also reside in the same folder. All packaging VMs and published Layered Images will be placed in that same folder. There will

not be separate subfolders for packaging VMs or published Layered Iimages.

Machine network connectivity

The virtual network settings of the source template specified in the XenServer Connector Configuration will be carried over

when creating any VMs through the XenServer Connector. There is no option in the Connector Configuration UI to override

the network settings.

XenServer Clusters

The XenServer Connector does not yet work correctly with XenServer clusters. If  the host specified in the configuration is

part of a cluster, then it must be the master host in the cluster for the connector to work. However, this means that any
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time the master XenServer host goes down and a new master is elected, the XenServer configuration must be updated.

Create a Connector Configuration

To enter values:

The first three Connector fields must be entered manually. Once the credentials in those fields are validated, you can select

values for the remaining fields from drop-down menus.

To enter values manually, click to put the cursor in the field and type the value, making sure that the case matches the value

in Xen.

To select a value from a drop-down list, click once to put the cursor in the field, and a second time to display the list of

possible values.

To add a new Connector Configuration:

On the wizard for creating a Layer or for adding a Layer Version, click the Connector tab.

Below the list of Connector Configurations, click the New button. This opens a small dialog box.

Select the Connector Type for the platform and location where you are creating the Layer or publishing the image. Then

click New to open the Connector Configuration page.

Enter the configuration Name, and the XenServer Address, User Name, and Password). For guidance, see the above field

definitions.

Click the CHECK CREDENTIALS button below the XenServer Configuration fields. The Virtual Machine Clone Settings field is

then enabled.

Select the Virtual Machine Template.

Select the Storage Repository and click the TEST button to verify that App Layering can access the location specified using

the credentials supplied.

Click Save. The new Connector Configuration should now be listed on the Connector page.

Script Configuration (Optional, Advanced feature)

When creating a new Connector Configuration, you can configure an optional Powershell script to run on any Windows

machine running an App Layering Agent. These scripts must be stored on the same machine that the Agent is installed on,

and will only be executed after a successful deployment of a Layered Image.

Some preset variables are available to enable scripts to be reusable with different template images and different connector

configurations. These variables will also contain information needed to identify the virtual machine created as part of the

published Layered Image in XenServer.

Execution of these scripts will not affect the outcome of the publish job, and progress of commands executed in the script

will not be visible. The XenServer connector logs will contain the output of the executed script.

Configure a Script (optional)

If  you want a script to run each time a Layered Image is published, complete these steps using the values described in the

sections that follow.

Complete and save the Connector Configuration as described above.

Note: Before selecting Script Configuration page, you must save (or discard) any edits to the Connector Configuration

settings,

If  the Navigation menu on the left is not open, select it and click Script Configuration to open the Script Path page.
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Complete the required fields using the values detailed herein, and click Save.

Script Configuration fields

Enable script - Select this check box to enable the remaining fields. This allows you to enter a script that will be executed

each time a Layered Image is published.

Script Agent - The agent machine where the scripts will be located and executed from.

Username (optional) - The username to impersonate when running the script. This can be used to ensure the script runs in

the context of a user that has the needed rights/permissions to perform the operations in the script.

Password (optional) - The password for the specified username.

Path - A full path and filename on the agent machine where the script file resides.

Other Script Configuration values

Powershell variables

When the script is executed the following variables will be set and can be used in the powershell script:

Value
Applies to
connector
types:

Value determined
by which code:

Description

connectorCfgName All Common code
This is the name of the connector configuration that the

script configuration is associated with.

imageName All Common code
This is the name of the layered image template that was

used to build/publish the layered image.

osType All Common code

This is the OS type of the layered image that was published.

It can be one of the following values:

Windows7

Windows764

Windows200864

Windows201264

Windows10

Windows1064

virtualInfrastructureServer All
XenServer connector

code

The XenServer host specified in the connector

configuration.

vmName All
XenServer connector

code
The name of the virtual machine that was created.

vmId All
XenServer connector

code
The virtual machine UUID (same as vmUuid)

vmUuid All
XenServer connector

code
The virtual machine UUID (same as vmId)

Definition Scope

Whether the scripts variable is set for all platform connector types or whether it is specific to a particular connector type.
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Value Source

Whether the variable value is determined by common code or by connector-specific code.
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XenServer connector configuration

Jun 29, 2017

Before you start

You can use your XenServer environment for creating Layers, and for publishing Layered Images. Each Connector

Configuration accesses a specific storage location in your XenServer environment. You may need more than one XenServer

Connector Configuration to access the correct location for each purpose. Further, you may want to publish each Layered

Image to a location convenient to the system you will be provisioning with the published image. For more about

Connectors, and Connector Configurations, see About Connectors.

Since XenServer uses a pod-like architecture where you, the administrator, interact with individual servers or clusters of

servers, rather than with a central management server, you manage these pods via command line access or GUI

management software like XenCenter which you install directly on your desktop and connect individually to each

standalone host or to clusters of hosts.

If  this is your first t ime using App Layering
If  this is your first time using App Layering and you want to create App Layers using a XenServer VM, you will need a

XenServer Connector within Unidesk. When publishing Layered Images to XenServer, you will need a Connector

Configuration for each of your publishing locations as well.

The Create Layer and Publish Layered Image wizards each ask you to select a Connector Configuration. If  you don't yet

have the right Connector Configuration for the task, you can create one by clicking New on the Connector wizard tab (see

details below).

Required information for XenServer Connector Configuration settings
The XenServer Connector Configuration wizard let's you browse for the XenCenter Server, Data Store, and Host to use for

a new configuration.

Important : The fields are case sensitive, so any values that you enter manually must match the case of the object in

XenServer, or the validation will fail.

Configuration Name - A useful name to help identify and keep track of this connector configuration.

XenServer Address - The name of the XenServer host with which the appliance will integrate.

User Name/Password - The credentials for the account that the appliance will use to connect to XenServer.

Use Secured Protocol - Lets you use SSL encryption for the API connection traff ic between the Unidesk Connector and

Citrix XenServer. This f ield is checked by default.

Allow Certif icate Errors - Enables certif icate errors to be ignored. By default, this setting is disabled.

Template - VM Template that can be used for cloning. The list of choices will only contain custom VM templates, rather

than actual VMs or any of the built-in templates. The selected template must not have any disks attached, and must

have at least one network card attached. If  it does not, you will see an error when trying to validate or save the

configuration.

Storage Repository - The storage repository for the disk that will get uploaded. The list will be f iltered to only show

repositories that can contain VHDs (ISO repositories are f iltered out).

Use HTTPS for File Transfers - Encrypts the image f ile transfers. HTTPS is checked by default for more secure uploads

and downloads, but can be unchecked for increased performance.

Virtual Machine organization
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VMs created by the XenServer Connector, whether Packaging Machines or Layered Images, can use either folders or tags

to organize the virtual machines. XenServer allows for VMs to be organized either by folder or by tag. These organizational

tools are optional when creating and managing VMs through XenCenter or other tools. Although XenServer Connector

Configurations do not allow the administrator to specify folders or tags, the VMs created by the XenServer Connector,

both Packaging Machines and published Layered Images, can utilize both organizational tools.

Caching Tags
If  the template specified in the XenServer connector configuration has any tags, then those tags will be carried over to any

VM cloned from that template. Therefore all packaging VMs or published layered images will be tagged with the same tags

that the template has. Additionally, the XenServer connector will add three tags.

Unidesk - All VMs created by the XenServer connector can be found by this tag regardless of their purpose or image.

Purpose Tag - All packaging machines will be tagged with "Unidesk Packaging Machine" while all published layered image

VMs will be tagged with "Unidesk Published Images".

Image/Layer Name - All packaging machines will be tagged with the layer name for the layer which they are generated,

while all published layered images will be tagged with the template image name.

If  you are using XenCenter, you can view your VMs by tag by selecting the "Organization Views" and then select "By

Tag".

Folder
By default VMs created by the XenServer Connector will not be placed in a folder. However, if  the template specified in the

XenServer Connector Configuration resides in a folder, then any VM that the Connector creates from that template will

also reside in the same folder. All packaging VMs and published Layered Images will be placed in that same folder. There will

not be separate subfolders for packaging VMs or published Layered Iimages.

Machine network connectivity
The virtual network settings of the source template specified in the XenServer Connector Configuration will be carried over

when creating any VMs through the XenServer Connector. There is no option in the Connector Configuration UI to override

the network settings.

XenServer Clusters
The XenServer Connector does not yet work correctly with XenServer clusters. If  the host specified in the configuration is

part of a cluster, then it must be the master host in the cluster for the connector to work. However, this means that any

time the master XenServer host goes down and a new master is elected, the XenServer configuration must be updated.

Scripts
The XenServer Connector supports script execution after publishing layered images just as the vSphere connectors do. The

following script variables will be set:

Create a Connector Configuration

To enter values:

The first three Connector fields must be entered manually. Once the credentials in those fields are validated, you can select

values for the remaining fields from drop-down menus.

To enter values manually, click to put the cursor in the field and type the value, making sure that the case matches the value

in Xen.

To select a value from a drop-down list, click once to put the cursor in the field, and a second time to display the list of

possible values.

To add a new Connector Configuration:
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On the wizard for creating a Layer or for adding a Layer Version, click the Connector tab.

Below the list of Connector Configurations, click the New button. This opens a small dialog box.

Select the Connector Type for the platform and location where you are creating the Layer or publishing the image. Then

click New to open the Connector Configuration page.

Enter the configuration Name, and the XenServer Address, User Name, and Password). For guidance, see the above field

definitions.

Click the CHECK CREDENTIALS button below the XenServer Configuration fields. The Virtual Machine Clone Settings field is

then enabled.

Select the Virtual Machine Template.

Select the Storage Repository and click the TEST button to verify that Unidesk can access the location specified using the

credentials supplied.

Click Save. The new Connector Configuration should now be listed on the Connector page.

Script Configuration (Optional, Advanced feature)

When creating a new Connector Configuration, you can configure an optional Powershell script to run on any Windows

machine running a Agent. These scripts must be stored on the same machine that the Agent is installed on, and will only be

executed after a successful deployment of a Layered Image.

Some preset variables are available to enable scripts to be reusable with different template images and different connector

configurations. These variables will also contain information needed to identify the virtual machine created as part of the

published Layered Image in XenServer.

Execution of these scripts will not affect the outcome of the publish job, and progress of commands executed in the script

will not be visible. The XenServer connector logs will contain the output of the executed script.

Configure a Script (optional)

If  you want a script to run each time a Layered Image is published, complete these steps using the values described in the

sections that follow.

Complete and save the Connector Configuration as described above.

Note: Before selecting Script Configuration page, you must save (or discard) any edits to the Connector Configuration

settings,

If  the Navigation menu on the left is not open, select it and click Script Configuration to open the Script Path page.

Complete the required fields using the values detailed herein, and click Save.

Script Configuration fields

Enable script - Select this check box to enable the remaining fields. This allows you to enter a script that will be executed

each time a Layered Image is published.

Script Agent - The agent machine where the scripts will be located and executed from.

Username (optional) - The username to impersonate when running the script. This can be used to ensure the script runs in

the context of a user that has the needed rights/permissions to perform the operations in the script.

Password (optional) - The password for the specified username.

Path - A full path and filename on the agent machine where the script file resides.

Other Script Configuration values

Powershell variables

When the script is executed the following variables will be set and can be used in the powershell script:
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Value
Applies to
connector
types:

Value determined
by which code:

Description

connectorCfgName All Common code
This is the name of the connector configuration that the

script configuration is associated with.

imageName All Common code
This is the name of the layered image template that was

used to build/publish the layered image.

osType All Common code

This is the OS type of the layered image that was published.

It can be one of the following values:

Windows7

Windows764

Windows200864

Windows201264

Windows10

Windows1064

virtualInfrastructureServer All
XenServer connector

code

The XenServer host specified in the connector

configuration.

vmName All
XenServer connector

code
The name of the virtual machine that was created.

vmId All
XenServer connector

code
The virtual machine UUID (same as vmUuid)

vmUuid All
XenServer connector

code
The virtual machine UUID (same as vmId)

Definition Scope

Whether the scripts variable is set for all platform connector types or whether it is specific to a particular connector type.

Value Source

Whether the variable value is determined by common code or by platform connector specific code.
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PVS connector configuration

Jun 29, 2017

A PVS Connector Configuration contains the credentials and storage location Unidesk needs to connect to PVS, and it

identifies the properties to be associated with the vDisk.

Each Connector Configuration is set up to access a storage location via a specific account.

Before you start

The first time you create an Image Template for publishing Layered Images to your PVS environment, add a PVS Connector

Configuration for that PVS location.

PVS requirements

PVS services must be running as a domain account

For Unidesk to work correctly with PVS, the PVS services must be running as a domain account. This is because domain

accounts have permissions to access the PVS store and the local system account does not.

If  your PVS server is configured to use the local system account, which is the default setting, you can change the account

by running the PVS configuration tool. This tool gives you an option to run as local system or use a domain account.

Choose a domain account.

PVS server and account information

For Unidesk to access the location in your PVS environment where you want to publish a Layered Image, you need to

supply the credentials and location in a PVS Connector Configuration.

The information you need for the PVS Connector Configuration includes.

Name - A useful name to help identify and keep track of this connector configuration.

Console - The name of the PVS server on which the Undesk agent is deployed. This is the server to which the vDisk will be

published.

Domain User - User name of a domain account that has permission to manage PVS. This account will be used by the agent

to run PVS Powershell commands. This account must have Read/Write access to the PVS store for writing the published

vDisk.

Password - Password for the domain user account.

Site Name - Name of the Site this vDisk is to be a member of.

Store Name - Name of the Store that this vDisk is a member of.

Write Cache - When a new Disk is being created, this value sets the Write Cache type of the new Disk. Possible values

include:

Cache on Server

Cache on Server, Persistent

Cache in Device RAM

Cache in Device RAM with Overflow on Hard Disk

Cache on Device Hard Drive

When choosing a Write Cache option, consult your PVS documentation to ensure that the PVS Servers and target devices

that use this vDisk are properly configured for the type you select.

License Mode - Sets the Windows License Mode to:
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KMS - Key Management Service

MAK - Multiple Activation Keys

None

Enable Active Directory machine account password management - Enables Active Directory (AD) password management.

The default value is Enabled.

Enable Load Balancing - Enables load balancing. for the streaming of the vDisk

Enable Printer Management - When enabled, invalid printers will be deleted from the Device.

Create a new Connector Configuration for PVS

If  you don't yet have a Connector Configuration that includes the PVS server information and credentials for the server

where the Layered Image will be published, add one now.

To add a new Connector Configuration:

In the Publish Layered Image wizard, click the Connector tab.

Below the list of Connector Configurations, click the New button. This opens a small dialog box.

Select the Connector Type for the platform and location where you are publishing the Layered Image. Then click New to

open the Connector Configuration page.

Complete the fields on the Connector Configuration page. For guidance, see the above field definitions.

Click the TEST button to verify that the appliance can access the location specified using the credentials supplied.

Click SAVE. The new Connector Configuration should now be listed on the Connector tab.

Script Configuration (Optional, Advanced feature)

When creating a new Connector Configuration, you can configure an optional Powershell script on any Windows machine

running a App Layering Agent— the same agent used on the PVS server. These scripts must be stored on the same machine

that the App Layering Agent is installed on, and will only be executed after a successful deployment of a Layered Image.

Some preset variables are available to enable scripts to be reusable with different template images and different connector

configurations. These variables will also contain information needed to identify the virtual machine created as part of the

published layered image in PVS.

Execution of these scripts will not affect the outcome of the publish job, and progress of commands executed in the script

will not be visible. The PVS connector logs will contain the output of the executed script.

Configure a Script (Remember, this is optional)

If  you want a script to run each time a Layered Image is published, complete these steps using the values described in the

sections that follow.

Complete and save the Connector Configuration as described above.

Note: Before selecting Script Configuration page, you must save (or discard) any edits to the Connector Configuration

settings,

If  the Navigation menu on the left is not open, select it and click Script Configuration to open the Script Path page.

Complete the required fields using the values detailed herein, and click Save.

Script Configuration fields

Enable script - Select this check box to enable the remaining fields. This allows you to enter a script that will be executed

each time a Layered Image is published.
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Script Agent - The agent machine where the scripts will be located and executed from.

Username (optional) - The username to impersonate when running the script. This can be used to ensure the script runs in

the context of a user that has the needed rights/permissions to perform the operations in the script.

Password (optional) - The password for the specified username.

Path - A full path and filename on the agent machine where the script file resides.

Other Script Configuration values

Powershell variables

When the script is executed the following variables will be set and can be used in the powershell script:

Value
Applies to
connector types:

Value determined by
which code:

Description

connectorCfgName All Common code
This is the name of the connector configuration that the script

configuration is associated with.

imageName All Common code
This is the name of the layered image template that was used

to build/publish the layered image.

osType All Common code

This is the OS type of the layered image that was published. It

can be one of the following values:

Windows7

Windows764

Windows200864

Windows201264

Windows10

Windows1064

diskLocatorId All PVS The internal id for the vDisk.

User Impersonation

The App Layering Agent, which runs as a service on a Windows machine, runs under either the local system account or the

network account. Either of these accounts may have some special privileges, but they often are restricted when it comes

to executing specific commands or seeing files in the file system. Therefore, Unidesk gives you the option of adding a

domain user and password that can be used to "impersonate" a user. This means that the script can be executed as if  that

user had logged onto the system so that any commands or data will be accessible subject to those user rights and

permissions. If  no user name or password is entered, the script executes using the account under which the service is

configured to run.

Script Execution Policy

Script execution policy requirements are generally up to you. If  you intend to run unsigned scripts, you must configure the

execution policy to one of the more lenient policies. However, if  you sign your own scripts accordingly, you can choose to

use a more restrictive execution policy.
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Network File Share connector configuration
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When the App Layering appliance (Enterprise Layer Manager) is installed, you set up a network file share that you can then

use as a Connector Configuration when creating layers and publishing Layered Images. This Connector Configuration

contains the appliance's Network File Share credentials and location so you can deploy a Packaging Machine to the File

Share when creating layers, or publishing Layered Images.

Each Connector Configuration is set up to access a storage location via a specific account.

Network File Share location

The name of the Network File Share Connector Configuration includes its location. Look for the App Layering folder at the

top level of the Network File Share. For details, see Configure a file share for the App Layering Appliance.

When to select the Network File Share as your Connector Configuration

When you publish Layered Images to a provisioning service for which we do not yet have a Connector, you can select the

Network File Share Connector Configuration. You can then copy the Layered Image from the network file share to the

correct location for provisioning servers.
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Create image templates

Jun 29, 2017

Select the platform you are publishing Layered Images.
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MCS for XenServer image templates

Jun 29, 2017

You can create Image Templates to publish Layered Images to your target platform where you can then use the Layered

Image to provision servers on your chosen publishing platform. An Image Template stores your Layer assignments, along

with a Layer icon and description. You can easily edit an Image Template and use it to publish new versions of your Layered

Images.

Prerequisites

OS Layer (Required)

Platform Layer (Required for cross-platform deployments)

The Platform Layer contains the software required for publishing to your environment, in this case:

Citrix XenServer

Citrix MCS Device imaging tools

XenApp VDA installed

The Platform Layer must have the same hardware settings as the OS Layer. (These settings are chosen when deploying the

VM for the OS and Platform Layers.)

App Layers (Optional)

You can create an Image Template without App Layers. This is useful for testing your OS Layer before using it to create

App Layers.

Create an Image Template

To create an Image Template:

In the App Layering Management Console (UMC), select the Images module, then click Create Template. This opens the

Create Template wizard.

In the Name and Description tab, enter a Name for the template and notes in the Description field, so you can identify the

template when choosing one for publishing a Layered Image.

In the OS Layer tab, select one of the Available OS Layers. If  there is more than one Layer Version, the most recent version

is selected by default. You can choose an older version by expanding the Layer and choosing a different one.

In the App Assignment tab, select the App Layers to include in the Layered Images that you publish using this template.

On the Connector page, select the MCS for XenServer Connector Configuration for the location where you want to

publish the Layered Image.

If  the Connector Configuration you need is not available, add one. Click New, choose the Connector Type, and follow the

instructions to Create a Connector Configuration.

In the Platform Layer tab, select a Platform Layer with the tools and hardware settings that you need to publish Layered

Images to your environment.

On the Layered Image Disk page, edit the following fields, as needed:

(Optional) Layered Image Disk File name. Enter a name for the Layered Image Disk.
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Layered Image Disk Format. Use the default format, since this is the one required for your selected environment.

Elastic Layering - Controls whether Elastic Layering on this Layered Image is allowed. Select yes to allow Elastic Layers for

users of this Layered Image.

On the Confirm and Complete tab, enter any comments you would like for this layer, and click Create Template.

The new Template icon appears in the Unidesk Images module.
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PVS image templates

Jun 29, 2017

You can create Image Templates to publish Layered Images to your target platform where you can then use the Layered

Image to provision servers on your chosen publishing platform. An Image Template stores your Layer assignments, along

with a Layer icon and description. You can easily edit an Image Template and use it to publish new versions of your Layered

Images.

Prerequisites

To create an Image Template you need:

A Platform Layer containing the software required for your environment:

When publishing images to PVS for XenApp users, the following must be installed on the Platform Layer:

Citrix PVS Device imaging tools

XenApp VDA installed

Create an Image Template

To create an Image Template:

In the App Layering Management Console (UMC), select the Images module, then click Create Template. This opens the

Create Template wizard.

In the Name and Description tab, enter a Name for the template and notes in the Description field, so you can identify the

template when choosing one for publishing a Layered Image.

In the OS Layer tab, select one of the Available OS Layers. If  there is more than one Layer Version, the most recent version

is selected by default. You can choose an older version by expanding the Layer and choosing a different one.

In the App Assignment tab, select the App Layers to include in the Layered Images that you publish using this template.

On the Connector tab, select the PVS Connector Configuration that includes the information needed to publish the

Layered Image to the correct location.

If  the Connector Configuration you need is not available, add one. Click New, choose the Connector Type, and follow the

instructions to Create a Connector Configuration.

On the Platform Layer tab, select a Platform Layer containing the tools and hardware settings that you need to publish

Layered Images to your PVS location.

On the Layered Image Disk tab, edit the following fields, as needed:

Layered Image Disk File name. Enter a name for the Layered Image Disk.

Layered Image Disk Size. The default disk size of 100 GB is recommended.

Elastic Layering - Controls whether Elastic Layering on this Layered Image is allowed. Select yes to allow Elastic Layers for

users of this Layered Image.

On the Confirm and Complete tab, enter any comments you would like for this layer, and click Create Template.

The new Template icon appears in the Unidesk Images module.
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XenServer image templates

Jun 29, 2017

ou can create Image Templates to publish Layered Images to your target platform where you can then use the Layered

Image to provision servers on your chosen publishing platform. An Image Template stores your Layer assignments, along

with a Layer icon and description. You can easily edit an Image Template and use it to publish new versions of your Layered

Images.

Prerequisites

To create an Image Template you need:

A Platform Layer containing the software required for your environment.

The Platform Layer you choose must have the same hardware settings as the OS Layer you are using. (The hardware

settings are chosen when you deploy the VM for the OS and Platform Layers.)

The Platform Layer you choose must contain the software required for your environment.

Example: When publishing images to PVS for XenApp users running in XenServer, the following must be installed on the

Platform Layer:

Citrix XenServer

Citrix PVS Device imaging tools

XenApp VDA installed

Create an Image Template

To create an Image Template:

In the App Layering Management Console (UMC), select the Images module, then click Create Template. This opens the

Create Template wizard.

In the Name and Description tab, enter a Name for the template and notes in the Description field, so you can identify the

template when choosing one for publishing a Layered Image.

In the OS Layer tab, select one of the Available OS Layers. If  there is more than one Layer Version, the most recent version

is selected by default. You can choose an older version by expanding the Layer and choosing a different one.

In the App Assignment tab, select the App Layers to include in the Layered Images that you publish using this template.

On the Connector page, select the XenServer Connector Configuration for the location where you want to publish the

Layered Image.

If  the Connector Configuration you need is not available, add one. Click New, choose the Connector Type, and follow the

instructions to Create a Connector Configuration.

In the Platform Layer tab, select a Platform Layer with the tools and hardware settings that you need to publish Layered

Images to your environment.

On the Layered Image Disk page, edit the following fields, as needed:

(Optional) Layered Image Disk File name. Enter a name for the Layered Image Disk.

Layered Image Disk Size. The default disk size of 100 GB is recommended.

Sysprep. An appropriate default value will be selected for your environment. This setting determines whether the Layered

Image will be generalized, and if  so, which script will be used to generalize the image and join a domain.
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Not Generalized - Does not generalize the image nor join a domain. Machines created from this image will be identical to

the OS Disk from which they are created.

Generalize Offline - Generalizes the Image using Unidesk code, and without booting the VM. Machines created from this

image will be unique, and will run unattend.xml to join a domain.

Elastic Layering - Controls whether Elastic Layering on this Layered Image is allowed. Select yes to allow Elastic Layers for

users of this Layered Image.

On the Confirm and Complete tab, enter any comments you would like for this layer, and click Create Template.

The new Template icon appears in the Unidesk Images module.
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Network File Share image templates

Jun 29, 2017

You can create Image Templates to publish Layered Images to your target platform where you can then use the Layered

Image to provision servers on your chosen publishing platform. An Image Template stores your Layer assignments, along

with a Layer icon and description. You can easily edit an Image Template and use it to publish new versions of your Layered

Images.

Prerequisites

To create an Image Template you need:

A Platform Layer containing the software required for your environment.

The Platform Layer you choose must have the same hardware settings as the OS Layer you are using. (The hardware

settings are chosen when you deploy the VM for the OS and Platform Layers.)

The Platform Layer you choose must contain the software required for your environment.

Example: When publishing images to PVS for XenApp users running in vSphere, the following must be installed on the

Platform Layer:

VMware vSphere

Citrix PVS Device imaging tools

XenApp VDA installed

Create an Image Template

To create an Image Template:

In the App Layering Management Console (UMC), select the Images module, then click Create Template. This opens the

Create Template wizard.

In the Name and Description tab, enter a Name for the template and notes in the Description field, so you can identify the

template when choosing one for publishing a Layered Image.

In the OS Layer tab, select one of the Available OS Layers. If  there is more than one Layer Version, the most recent version

is selected by default. You can choose an older version by expanding the Layer and choosing a different one.

In the App Assignment tab, select the App Layers to include in the Layered Images that you publish using this template.

On the Connector Configuration tab, select the Network File Share.

On the Platform Layer tab, you can select a Platform Layer that contains the tools and hardware settings that you need

to publish Layered Images to the location defined in the Connector Configuration.

On the Layered Image Disk tab:

Layered Image Disk File name. (Optional) You can change the default Layered Image Disk File name.

Layered Image Disk Format. Select the Disk Format appropriate for the environment where your servers are running. For

example, select VHD when publishing images to Azure or Hyper-V environments. Select VMDK when publishing images to

vSphere or PVS, for example, when streaming the images to vSphere servers. Or, select QCOW2 or VHD when publishing to

Nutanix AHV.

Layered Image Disk Size. The default disk size of 100 GB is recommended.

Sysprep. If  your Platform Target is a Network File Share, this option lets you choose the method for generalizing the

Layered Image. Select the method that is appropriate for your connection broker.
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Not Generalized - Does not generalize the Layered Image nor join a domain. Machines created from this image will be

identical to the OS Disk from which they are created. Machines created from this image will be identical to the OS Disk

they are created from.

Generalize Offline - Generalizes the Image using Unidesk code, and without booting the VM. Machines created from this

image will be unique, and will run unattend.xml to join a domain.

Elastic Layering - (Available when Elastic Layering is enabled) Controls whether Elastic Layering on this Layered Image is

allowed. Select yes to allow Elastic Layers for users of this Layered Image.

On the Confirm and Complete tab, enter any comments you would like for this layer, and click Create Template.

The new Template icon appears in the Unidesk Images module.
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Publish to MCS for XenServer

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to Citrix MCS in your XenServer environment and add it to a catalog

for provisioning systems. In the Connector Configuration wizard, be sure to configure a Virtual Machine Template, so that

the Layered Image you publish will be in a ready-to-use VM, the image shut down and a snapshot taken. You can use the

VM in your Horizon environment without further modifications.

Prerequisites

To publish a Layered Image to MCS, you need:

One or more Image Templates.

Publish a Layered Image

In the Images module, select one or more Image Templates that you want to publish.

From the Action menu, select Publish Layered Image.

On the Confirm and Complete page, select Publish Layered Images. For each Image Template this starts a task called,

Publishing Layered Image. When each task completes, the task description provides the information you need to navigate

to the image in your environment.

At the end of the image creation process:

Unidesk powers on the VM - This will enable the guest OS to run and execute any layer scripts via our kmssetup.cmd

functionality. This can be used to perform important layer specific steps like activating Microsoft Office which may need to

be done before the VM is used to create a view desktop pool/RDS farm or recompose them. The mechanism used to

execute these scripts can vary, including our own kmssetup.cmd functionality, run-once support, or even manual execution.

It is expected that once all scripts are run or other manual steps are taken and the VM is in the desired state, a guest OS

shutdown will be initiated either by the scripts, or by the user (if  using the kmssetup.cmd functionality there will a

documented process for initiating a shutdown after all layer scripts and other kmssetup functionality is complete).

The VM shuts down - Once the VM is in the desired state the VM shuts down and the status changes to Done.

When the task completes, the task description provides the information you need to navigate to the image in your

environment.

Use the information in the expanded Packaging Disk Task to navigate to the location in your environment where the

Layered Image has been published.

Next you can move the image to a collection or other location for provisioning servers.
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Publish to PVS

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to PVS, and stream them to the systems you want to provision.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

Publish a Layered Image

To use an Image Template to publish a Layered Image:

Log into the UMC.

Select the Images modules.

Select one or more Image Templates, then click Publish Layered Image.

On the Confirm and Complete tab, click the Publish Layered Image button. This starts a task called, Publishing Layered

Image. When the task completes, the task description provides the information you need to navigate to the image in your

environment.

Use the information in the expanded Packaging Disk Task to navigate to the location in PVS where the Layered Image has

been published.

Next you can assign the new disk to the targeted devices.

Assign the new vDisk to the targeted devices

Log into the PVS Console.

Access the target PVS server. The new vDisk should appear under the targeted PVS store (refresh may be required).

Assign the new vDisk to the targeted devices.

Using Citrix PVS best practices, test the new vDisk to ensure that the image streams to the server as expected.
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Publish to XenServer

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to XenServer and add each one to a collection, provisioning service,

or other method for provisioning your systems.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

Publish a Layered Image

In the Images module, select one or more Image Templates to publish.

From the Action menu, select Publish Layered Image.

On the Confirm and Complete page, select Publish Layered Images. For each template, this starts a task called, Publishing

Layered Image. When each task completes, the task description provides the information you need to navigate to the

image in your environment.

Use the information in the expanded Packaging Disk Task shown above to navigate to the location in XenServer where the

Layered Image has been published.

Next you can move the image to a collection or other location for provisioning servers.
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Publish to Network File Share

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to the ELM's Network File Share, copy the Image(s) to your target

environment, and use them to provision Session Hosts in your environment. This is especially useful if  Unidesk does not yet

include Connectors for the platform where you're provisioning systems.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

The Image Template you select should have the correct OS Layer and any App Layers you want in the Layered Image.

Publish a Layered Image

To use an Image Template to publish a Layered Image:

1. In the Images module, select one or more Image Template that you want to publish.

2. From the Action menu, select Publish Layered Image.

3. On the Confirm and Complete page, select Publish Layered Images. For each Image Template this starts a task

called, Publishing Layered Image. When each task completes, the task description provides the information you need to

navigate to the image in your environment.

4. Use the information in the expanded Packaging Disk Task shown above to navigate to the location where the Layered

Image has been published.

Important
When publishing a Layered Image to a file share, there will be one VMDK file option, and it will generate two

files: layer.vmdk and layer-flat.vmdk. You need to upload both of them.

Next Step

Once the Layered Image is published to the file share, you can use the image to provision servers in your environment.
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Assign layers

Jun 29, 2017

To deliver App Layers to users, you can:

Add App Layers to one or more Image Templates, then use the templates to publish Layered Images for use in

provisioning servers.

Elastically assign the App Layers to users, either through a direct user assignment, or via a machine assignment that

makes the layers available to users who log into the machine.

You can make these assignments, as long as each user is assigned a single instance of the Layer, either as part of an

image or as an elastic layer.

Do you want to assign this App Layer to one or more Image Templates for inclusion in your Layered Images? Or, do you

want to assign App Layers to users as Elastic Layers?
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Add App Layers to Image Templates

Jun 29, 2017

An Image Template is a stored selection of Layers and settings that you use to publish Layered Images. At minimum, an

Image Template contains an OS Layer, Platform Layer, and settings. Ideally, each template also contains your choice of App

Layers for a particular image, for example, an image suited for the users served by a particular silo. Once you publish a

Layered Image, you can provision systems using the image.

When you create a new App Layer, you can assign the App Layer to one or more Unidesk Image Templates, and then use

the templates to publish Layered Images that include the layer. This article explains how to assign an App Layer to one or

more Image Templates, and update the assignments when you update the Layer.

When you first update an App Layer, the new Layer Version is not assigned to any Image Templates, so you'll need to

update the Layer Assignments. Updating the assignments allows you to assign different Versions of the Layer to different

Image Templates. 

Important
 When assigning App Layers, be sure to avoid assigning the app elastically to a user, if the app is already in the Layered Image that

the user gets.

Prerequisites

One or more App Layers.

One or more Image Templates.

Add an App Layer Assignment to one or more Image Templates

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer to include in one or more of your Image Templates, and click Add Assignments.

3. In the wizard that opens, select the App Layer that you want to assign to templates.

4. On the Image Template Assignment tab, select the templates in which you want to include this App Layer Version.

5. Skip the Elastic Assignment tab.
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6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When you open each of the Image Templates you will see the App Layer Version you just assigned to the template.

Update App Layers and Image Template Assignments

When you update an application by adding a new Version to the App Layer, the new Layer Version will not inherit the

original Layer Assignments. You need to assign the new App Layer Version.

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer that has been updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new App Layer Version.

5. Click the Image Template Assignment  tab, and select the Image Templates to which you want to assign the new Layer

Version .

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out

names may appear. These Image Templates have already been assigned the Version.

6. Skip the Elastic Assignment tab.

7. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Remove Template Assignments

When you remove an App Layer's Template Assignments, the assignments for all versions of the Layer are removed. If  you

want to remove the assignments for a specific Version of the Layer, select Update Assignments instead.

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.
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Assign App Layers to users elastically (Elastic Layers)

Jun 29, 2017

Assign apps elastically

Wouldn't it be nice to drastically reduce the number of images you have to manage? What if  you could leave apps that only

a few users need out of your base image? And, assign the layers to specific users elastically on top of the base image. With

the Elastic App Layers feature, you can do just that.

An Elastic App Layer is an App Layer that you configure to be delivered to specific users and groups, based on user

entitlements, when the users log onto their session hosts or standalone desktops. With Elastic App Layers, you can give

each user his/her own unique set of applications in addition to the base Layered Image that is used across sessions in the

case of session hosts), and across floating pools/shared groups in the case of desktops.

As this diagram shows, once you add Elastic Assignments to an App Layer, a copy of the Layer is stored in the appliance's

Network File Share, and delivered to individual AD users and groups on-demand, in addition to the Layers that they receive

via the base image.

To use this feature, you'll add Elastic Assignments specifying which users and groups should receive each of the App Layers

that you would like to leave out of your base images. You'll then publish your base image(s) with the Elastic Layering For
Session Hosts selected.

How users access Elastic Layers assigned to them

When users log into their Session or Desktop, icons for their Elastic Layers will appear as shortcuts on the desktop.

A user receives an Elastic Layer in the following cases:

The user (an AD user in the Management Console) is assigned the Layer.

An AD group that the user belongs to is assigned the Layer.

A machine that the user logs into is a member of an AD Group that receives the Elastic Layer.

A machine that the user logs into is associated with an AD Group that is assigned the Layer via the Management

Console.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.117https://docs.citrix.com

If  more than one version of  the same Layer is assigned to a user

If  a Layer is assigned directly to the user and indirectly to one or more of the user's groups, the user receives the most

recent version of the Layer assigned directly to her/him. For example, if  a user is assigned Version 2, and a group that the

user belongs to is assigned Version 3, the user will get Version 2.

If  the user is assigned a Layer via one or more group assignments, the user receives the most recent version of the Layer.

If  a user has an App Layer in their Layered Image, and the Layer is also assigned to them elastically

If  a user has an App Layer in the Layered Image and the user is also assigned the Layer elastically, they will receive the

Elastic Layer, even if  the version in the base image is more recent.

Prerequisites and limitations

Prerequisites

The appliance's Network File Share must be configured correctly:

The Share must be configured using SMB technology. When using Elastic Layer assignments, NFS technology is not
supported.

The Share must be set up by the admin to be readonly for all users except for the one configured in the appliance.

This secures the Layers and other f iles stored on the Share.

The User named in this configuration must have Read/Write permissions on the root of the network f ile share.

Select System > Settings and Conf iguration and scroll to Network File Share.

Make sure that any users who will be assigned Elastic Layers have Read only access for the root directory of the

Network File Share.

.NET Framework 4.5 is required on any Layered Image where Elastic Layers are enabled.

The App Layers you want to elastically assign.

Note
App Layers must be created using the same OS Layer used to create the Layered Image that you enable to deliver the Elastic App

Layer to users.

Elastic Layering Limitations

You cannot elastically layer the following:

Microsoft Office Add-ons and extensions in individual Layers. A user must have all of their add-ons in one Layer. Note:

Please use the recipe for elastically layering MS Office.

Applications with drivers that use the driver store. For example, a printer driver.

Applications that modify the network stack or hardware. For example, a VPN client.

Applications that have boot level drivers. For example, a virus scanner.

Enable Elastic Layering in the base image
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When you publish the Layered Image that the users will log into to get the Elastic App Layer(s):

1. In the Management Console, select the Image Template used to generate the Layered Image.

2. Select the Images tab.

3. Select the Image Template on which you want to enable Elastic Layering, and select Edit Template from the Action bar.

The Edit Template wizard opens.

4. On the Layered Image Disk tab, select a value for the Elastic Layering option.

Application Layers Only - To enable Elastic Layering for your App Layers.

Application and User Layers - To enable both Elastic Layering for your App Layers, and User (personalization) Layers.

5. Finish publishing the Layered Image.

6. Provision your Session Hosts with the new base image.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Run the Elastic Fit Analyzer on App Layers (App
Layering Labs)

Before assigning an App Layer elastically, use the Elastic Fit Analyzer to determine the likelihood that the Layer assignment

will be successful.

Elastic Fit Analysis

In the Layer Details, the Elastic Fit rating indicates how likely it is that the Layer will work when elastically assigned.

Good Elastic Fit . This layer should work when deployed elastically.

Poor Elastic Fit . This layer will probably not work when deployed elastically, or may behave differently than when it

is deployed in a Layered Image.

Elastic Fit Details

You can learn more about the Elastic Fit of a Layer by expanding the Elastic Fit Analysis. If  the Elastic Fit is less than ideal,

the list of violated rules will be displayed.

Low Severity Warning. This is unlikely to cause any change in behavior or functionality for most applications.

Medium Severity Warning. This may cause minor changes in behavior or functionality for some applications.

High Severity Warning. This is likely to cause signif icant changes in behavior or functionality for many applications.
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Enable Elastic Fit in App Layering Labs

To use this App Layering Labs feature, you must enable it. To enable Elastic Fit:

1. In the Management Appliance, select System > Settings and Conf iguration.

2. Click Edit  App Layering Labs.

3. Select the Elastic Fit  check box.

4. Click Save.

Analyze an App Layer for Elastic Fit

All new Layer Versions will be analyzed for elastic layering compatibility when they are finalized. To analyze existing App

Layers for Elastic Fit:

1. Log into the Management Console.

2. Select Layers > App Layers.

3. Select the Layer to analyze, and click Analyze Layer.
4. On the Select Versions tab, choose the Layer Versions to analyze.

5. On the Confirm and Complete tab, click Analyze Layer Versions. The analysis takes seconds.

6. To see the Elastic Fit Analysis, select the App Layers module, move the mouse pointer over the Layer icon and click

the Info  icon.

7. Expand the Version Information for each Layer Version, and look for the Elastic Fit rating.

8. For a detailed report, expand the Elastic Fit Details. If  the Elastic Fit is less than ideal, the list of violated rules will be

displayed.

9. You can display the AD tree and hide the violated rules by clicking a button acknowledging that the layer is unlikely to

work as expected.

Upgrading from Earlier Releases

After upgrading from an earlier App Layering release, the Elastic Fit Detail shows that any existing Layer Version(s) have not

been analyzed. Until you run the analysis on existing Layer Versions, the Versions will have a single High severity Elastic Fit

Detail, and a Poor Elastic Fit.

Elastically assign an App Layer to AD Users and Groups

The first time you assign an App Layer elastically, we recommend starting with an app like Notepad++ or GIMP, because

they are simple to .

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer that is not going to be included in the base image, and select Add Assignments.

3. In the wizard that opens, select the Version of the App Layer that you want to assign users.

4. Skip the Image Template Assignment  tab. This tab is for assigning the Layer to an Image Template.

5. In the Elastic Assignment tab, select the users and groups who should get this App Layer.

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Elastically assign an App Layer to users via machine
assignments and associations
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Any machine running the App Layering Service (ULayer.exe) can have Elastic Layers assigned to it. You can accomplish this by

either adding the machine to or associating it with the AD Group, and then elastically assigning the App Layers to the

AD Group.

The Layers assigned to the machine will be available to every User who successfully logs into that machine. The App

Layering Service will scan for changes to the machine's AD group memberships and associations every 10 minutes. When the

users log in, they should see an icon for each Elastic App Layer they've been assigned.

Use Active Directory to add the machine to the AD Group

Assuming you have a published Layered Image booted in your environment, you can add the machine to an AD Group, and

assign Elastic Layers to the AD Group.

1. Use Active Directory (AD) to add the machine to an AD Group.

2. Select an App Layer that is not going to be included in the base image, and elastically assign the Layer(s) to an AD Group.

3. You can wait for AD to propagate the changes and be recognized by the App Layering Service, or you can force the App

Layering Service to update its list of machine groups by doing one of the following:

Wait for the App Layering Service to detect the changes (within 10 minutes by default).

Restart the App Layering Service.

Reboot the App Layering Service Machine.

Execute the refresh.groups command:

C:\Program Files\Unidesk\Layering Services\ulayer.exe refresh.groups

Example

You start with an AD User, and AD Group, and a machine that you provisioned using a Layered Image.

AD User: Kenya
Kenya has no elastic assignments.

AD Group: Marketing
The Marketing group includes the member Kenya.

Machine: ElasticTestMachine
The ElasticTestMachine base image includes the MS Office App Layer.

In this example, you elastically assign the Chrome App Layer to ElasticTestMachine:

1. In AD, you add the machine ElasticTestMachine to the Marketing AD Group.

2. In the Management Console you elastically assign the Chrome App Layer to the Marketing Group.

3. When Kenya, who is part of the Marketing group, logs into ElasticTestMachine, she receives both the MS Office App
Layer, which is in the base image, and the Chrome App Layer.

4. When any user who is not in the Marketing group logs into ElasticTestMachine, they also receive both

Layers: MS Office because it is in the base image, and Chrome because the ElasticTestMachine is a member of

the Marketing AD Group.

Use the Management Console to associate the machine with an AD Group

Associating a set of machines with an AD Group allows any machine running the App Layering Service to have Layers
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elastically assigned to it via AD group membership.

Elastic Layers granted via Machine association can be thought of as extending the layers assigned to a user. For example, if

a machine matches multiple Machine Associations, only the unique layers will be added to the ones the user already has.

In the Management Console, you use asterisk (*) wildcards in a machine name pattern to specify a set of machine names.

For example:

Machine name pattern Matches these names Does not match these names

machine*
machine01

machineindetroit

amachine

localtestmachine

*machine
amachine

localtestmachine

machine01

machineindetroit

ky*eng
ky02359eng

kytesteng

01ky_eng

testky01eng

*eng*

eng01

1eng

1eng01

en01

1en

1en01

You can create Machine Associations before or after elastically assigning App Layers to the AD Group. Also, the machines

do not need to exist when you add the associations, as the associations exist within App Layering only, and AD is not

aware of them.

Associate a set of machines with an AD Group

1. Log into the Management Console as an Admin user, and select Users > Tree.

2. Expand the Tree, select the appropriate Group and click Edit Properties in the Action bar. This opens the Edit Group

Wizard.

3. Select the checkbox, Associate machines with this AD Group. This reveals the Machine Name Pattern field:

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_notchecked.png
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4. Specify a set of machines to associate with the AD group by entering a machine name pattern. For examples, see the

above table of Machine name patterns.

5. On the Confirm and Complete tab, select Update Group. Notice the shape of a computer monitor superimposed over

the group icon. This indicates that machines are associated with the group.

When you click the group's  icon, the Detail view now includes a field called, Associate With Machines where the

pattern.

Example

You start with the machine, Mach1, the AD Group, MachineGroup, and the App Layers for Firefox and MS Office.

Machine: Mach1
AD Group: MachineGroup
App Layers: Firefox, MS Office

Further, you have elastically assigned the Firefox and MS Office Layers to the AD Group.

If  you add a Machine Association to MachineGroup with a name pattern of "Mach*", when any domain user logs

into Mach1, they will receive the Firefox and MS Office Elastic App Layers.

Manage Elastic Assignments

You can:

View a user's Elastic Layer assignments.

Update an App Layer and elastically assign the new Version of the Layer.

Remove Elastic Assignments.

Debug an Elastic Assignments.

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_checked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_details.png
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View a user's Elastic Layer assignments

1. Log into the Management Console and select Users > Tree.

2. Select an AD User or Group, and click the "i" icon to the right of the name. If  the user or group is assigned any Elastic

Layers, the Layers are listed just below the user's or group's profile information in the Details window that appears.

Update an App Layer and its Elastic Assignments

You've added Elastic Assignments to an App Layer, and users are accessing the app as expected. A new version of the

application is released, so you update it by adding a new Version to the Layer. Now you need to assign the new version to

the users who have the Layer.

1. Log into the Management Console and select Layers > App Layers.

2. Select the elastically assigned App Layer that you just updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new Version.

5. Skip the Image Template Assignment tab.

6. In the Elastic Assignment tab, there's a list of Users and Groups who have been assigned a different version of the

selected Layer. Select the users and groups to whom you want to assign the new Version of the Layer.

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show AD users and groups already at this version. A list of grayed

out names may appear. These users have already been assigned the Version.

7. On the Confirm and Complete tab, verify the Users and Groups selected to receive the new Version, and click Update
Assignments.

Remove a Layer's Elastic Assignments

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Debug an Elastic Layer

If  you have an Elastic Layering issue, you can diagnose the problem by finding out whether the layer is being delivered, and if

so, whether it is working correctly. If  needed, collect data for Support, as described here.

Is this a Delivery issue?

Are the things you'd expect to see if  this app were installed actually there as expected?

Do you see the f iles and registry entries for the layer?

If  the app is supposed to be in the Start menu, is it there?
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If  there should be a shortcut for the app on the user's desktop, is there one?

If  you discover that app delivery is an issue, you can collect the following data, open a case, and send the data to Support.

1. Collect the data from these logs:

Windows App Event log –  In the Windows Event Viewer under Windows Logs, export the Application event log as an

EVTX f ile.

App Layering Service log (ulayersvc.log) –  C:\ProgramData\Unidesk\Logs\ulayersvc.log

2. Collect the values of these Registry keys:

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:AssignmentFile

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:RepositoryPath

3. Collect the contents of the Assignment (ElasticLayerAssignments.json) and Layers (Layers.json) files from the Repository

Path.

4. Contact Support.

Is this an operational issue?

One of these issues could indicate that this is an Elastic Layering issue:

The app is being delivered but doesn't launch correctly.

An operation within the app doesn't work correctly.

A licensing problem or a security issue.

The app launches, but then misbehaves, for example, it crashes on startup, or starts up but doesn't work right.

If  the problem with the Layer is operational, test the App Layer in the base image to rule out general layering issues:

1. Add the App Layer to an Image Template, and publish a Layered Image that includes the App Layer.

2. Log in as a user who is not assigned the Layer elastically, and make sure that the application is operational in the base

image.

3. Contact Support with your f indings.
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System settings
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You can specify settings for the following system configuration parameters by clicking on the Edit button of each option,

making your changes, and clicking the Save button.

Appliance
settings

Summary

HTTP

Certificate

Settings

Displays the currently set security certificate. Use the Upload and Generate buttons to upload an existing certificate or to

generate a new one. Optionally, enter a comment that describes the changes you made.

Network File

Shares

The Network File Share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

To configure the Network File Share, you specify the:

Network File Share Type

Network File Share Path

User Name & password

Then, test the connection to the file share by clicking Test Network File Share. The test returns a message stating either

"Success" or "Failed to mount network file share path". You can enter a comment describing your changes.

Security

Settings

Specify the number of minutes of inactivity before the Management Console logs you out. Optionally, enter a comment

that describes the changes you made.

Task

Retention

Settings

Specify the number of days that the appliance should retain completed Tasks before deleting them. Optionally, enter a

comment that describes the changes you made.

Audit Log

Retention

Settings

Specify the number of days that the appliance should retain audit log files. After that time elapses, the software begins to

overwrite the audit log. Optionally, enter a comment that describes the changes you made.

Notification

Settings

Configure automatic email notification settings for yourself or other users. When you export logs, the appliance sends

the specified recipients an email notification that includes a link to the log files.

To set up email notifications:

1. In the Mail Server box, enter the name of your email server or the name of the SMTP relay server.

2. In the Mail Server port, enter the number of the port that the email server uses for communication.

3. In the User Name box, enter the user name for the email account you want to use for sending notifications. For

example, username@domain.com.

4. In the Password box, enter the password for the email account.

5. In the From box, enter an email address to identify the source of the email message. For example, if you enter

myaddress@mycompany.com, the email message displays the following in the From box of the received

notification:

App Layering Manager [myaddress@mycompany.com]

6. In the Recipient List box, enter the email addresses that should receive notifications. Use a comma or semicolon to
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6. In the Recipient List box, enter the email addresses that should receive notifications. Use a comma or semicolon to

separate the email addresses.

7. Click Test Email Configuration to verify that the settings for the email server and account work correctly. If the test

succeeds, the software displays a success message and sends the recipients a confirmation email.

8. Enter a comment, if necessary, and click Save to save the email settings. Any comments you enter will appear in the

Information view Audit History.

For more information, see Export log files.

Log File

Retention

Settings

Specify the maximum disk space to use for all logs (in megabytes) and the number of days that the log files should be

retained. Optionally, enter a comment that describes the changes you made.

Appliance
settings

Summary
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System storage
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Check the amount of free space in the appliance's local storage

The appliance's local storage is a Layer Repository where the appliance creates, composites, and stores Layers and Layered

Images. You can see how much disk space is used in the System module of the Management Appliance.

Log into the Management Console and select System > Manage Appliance.

In the Services table, the Local Storage for the Layering Service shows how much space is used and how much is free.

Notes:

Disk space is shown in 1024-based Gigabytes, not metric.

Free space is updated every time a Layering Service job completes. If  you want to make sure the page has been refreshed,

click the Refresh icon just above the Manage Appliance subtab.

When creating a Layer or adding a Version to it, extra space is temporarily required to build the Packaging Disk. You can

calculate the amount of space needed during Layer creation by adding the following Layer sizes:

The size of the OS Layer Version you're using.

The size of the writable disk you want for the App Layer.

The size of any Prerequisite Layers (if  you have any).

Add space to an existing disk in locally attached storage

You can add storage space to an existing local storage disk as follows.

Log into your hypervisor's management console, and follow the normal procedure to increase the size of the local storage

disk. (You may have more than one of these disks, and can expand each one of them.)

Log into the Management Console and select System > Manage Appliance.

Select Expand Storage. A list of expanded disks is displayed. (You might also see attached disks that are not yet part of the

layer repository, but you can ignore those.)

Notice that the New Size of the disk you expanded is larger than the Current Size.

Select the check box for the disk that you want to expand to the New Size.

On the Confirm and Complete tab, click Expand Storage.

Add a disk to locally attached storage

When you install the appliance, it comes equipped with an additional 200 GB data disk that is used as a Layer Repository.

You can expand the appliance's local storage by adding another disk to it.

Log into your management console.

Select System > Manage Appliance.

Select Expand Storage.

The Disk Selection tab is displayed of disks that are attached to the system and are not part of the layer repository.

Select the check box for each disk that you want to use to expand the layer repository.

If  a check box is grayed out and a yellow icon with an ! (exclamation point) is displayed, it means that the attached disk is

not eligible for use (for example, if  the disk is not blank). Once the attached disk is blank and unpartitioned, you will be able

to use it to expand the appliance's local storage.
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On the Confirm and Complete tab, click Expand Storage.

Add storage locations for User Layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The first storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's User

Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest priority

location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until that

point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the their User

Layer to the new highest priority location.

Create Storage Locations

To add a storage location:

Log into the management console.

Select System > Storage Locations.

Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

Select Add Storage Location, and enter a Name and Network Path for the new location.

On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to add

to the new storage location.

On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure security on user layer folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:
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Setting name Value Apply to

Creator Owner Modify Subfolders and Files only

Owner Rights Modify Subfolders and Files only

Users or group:

Create Folder/Append Data

Traverse Folder/Execute File

List Folder/Read Data

Read Attributes

Selected Folder Only

System Full Control Selected Folder, Subfolders and Files

Domain Admins, and selected Admin group Full Control Selected Folder, Subfolders and Files

Set security on the User Layer folders

1. Log into the management console.

2. Select System > Storage Locations. The f ile shares displayed are the storage locations defined for User Layers. For

example, say you've defined three Storage Locations so that you can more easily manage storage for Group1 and

Group2 separate from everyone else in the organization:

 

Default location - \\MyDefaultShare\UserLayerFolder\

Group1 - \\MyGroup1\Share\UserLayerFolder\

Group2 - \\MyGroup2\Share\UserLayerFolder\

Note: The appliance's main file share, which is used for storing OS, App, and Platform Layers, is not listed as a User Layer

Storage Location.

Create a \Users subdirectory under each file share:

 

\\MyDefaultShare\UserLayerFolder\Users\

\\MyGroup1Share\UserLayerFolder\Users\

\\MyGroup2Share\UserLayerFolder\Users\ 

Apply the security settings listed above to each /Users subdirectory.
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Firewall ports
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The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin User

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.

Destination Activity Protocol Ports

App Layering appliance 

(Enterprise Layer Manager (ELM))
Management Console TCP 80, 443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP
3000 (HTTP) 

3500 (HTTPS)

Connector for PVS Communication TCP
3009 (HTTP) 

3509 (HTTPS)

Connector for vSphere Communication TCP
3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP
3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP
3000 (HTTP) 

3500 (HTTPS)

Connector for Nutanix Communication TCP
3006 (HTTP)

3506 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161

App Layering Appliance (Enterprise Layer Manager (ELM))

Internal Connections
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By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering Appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent - refers to the App Layering Agent, which is required if  you are:

Using PVS - The Agent must be installed on you PVS server(s).

Running Connector scripts - The Agent must be installed on any server on which you want to run a Connector script, for

example, a server for your connection broker, provisioning service, hypervisor, or any other server running in your

environment.

Admin User - A Management Console user who is assigned the App Layering Admin Role.
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Source Destination Activity Protocol Ports

Agents Appliance Initial registration TCP 443

Appliance Agents Communication TCP 8016

Agents Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via ESXI

Host
TCP 443

Agent Appliance Agent communication with datastore TCP 8888

Appliance Active Directory Communication with Active Directory TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP) 

3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP) 

3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

Admin User Appliance Connector for Nutanix Communication TCP

3006

(HTTP)

3506

(HTTPS)
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External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the

destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.

Destination Activity Protocol Ports

XenCenter Communications 5900
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Manage layers and templates
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The App Layering Appliance (aka Enterprise Layer Manager (ELM)) is a virtual appliance that coordinates communication in

the App Layering environment and manages copies of your Layers and Image Templates. Based on CentOS, the appliance

hosts the Management Console, a friendly interface where you create Layers and use those Layers to publish Layered

Images.

You can log into the appliance and modify the administrator password, network address, NTP servers, and Time Zone

settings using the Appliance Configuration utility, as described here.

Before you start

Make sure that the App Layering Appliance is running in your hypervisor.

Make sure you have the password for an account with administrator privileges

Log into the appliance using an account with administrator privileges

Using either your hypervisor console or SSH, log into the appliance as administrator (default password Unidesk1).

Note: If  the appliance is in Azure, type /opt/sbin/cfg_launcher, and press Enter.

This opens the Appliance Configuration utility.

Change the administrator password

The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

administrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the password for any of the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, take a moment to

familiarize yourself  with the administrative accounts for the appliance.

2. For each account, enter the new password and then re-enter it in the Confirm Password f ield.

3. On the Confirm and Complete tab, click Change Credentials.

Configure networking (includes Static IP Address option)

You can change the appliance's IP address and/or its DNS servers. When the appliance is first deployed, the DNS settings

are retrieved through DHCP. If  DHCP is not available and you will be using static IP addresses, once you select Static, you

will be prompted to enter the IP addresses for your DNS servers.

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter C (for Configure Networking), and press Return.
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3. At the next prompt, type D for Dynamic (DHCP) or S for Static.

If  you choose Static, you will be prompted for the IP address and Subnet mask, along with default addresses for the

Gateway and DNS addresses.

4. When prompted, enter Y to save settings.

5. At the Action prompt, enter Q to quit.

6. Restart the appliance.

Synchronize the system clock with NTP servers

You can synchronize the system clock on the ELM by configuring NTP servers. You can specify how many NTP servers you

need, with 6 being the maximum. And, you can add and remove NTP servers, as needed. Where possible your existing servers

will be used as defaults.

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter N for NTP servers change, and press Return. A list of your current NTP servers is displayed.

3. At the prompt, specify how many NTP servers you need by typing a number from 0 to 6.

0 - All servers will be removed (you will be warned).

1-6 - You will be prompted to accept or replace each of the current servers. 

4. For each server, press Enter to accept the current value. Or, enter a new server address (Example: 3.pool.ntp.org). Once

the last address is entered, an NTP Server Summary is displayed.

5. Enter S to save the settings.

6. At the Action prompt, enter Q to quit.

7. Restart the appliance.

Change the Time Zone

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter T  for T imezone change, and press Return. The current time zone is displayed.

3. Press Enter to display available timezones. The f irst bunch of time zones are displayed in alphabetical order, starting with

the

4. Advance through the timezone codes until you see yours:

Enter - Advances one line at a time.

Page Up Page Down - Displays the next or previous screen full of choices.

Or search the timezones:

Type Slash (/) and part of the name you are looking for.

5. When your timezone is displayed, press Q to get to the prompt.

6. Type the number for your timezone. The timezone you entered is displayed.

7. Press Enter to complete the change.

8. At the Action prompt, enter Q to quit.

9. Restart the appliance.
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Update OS layer
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The Unidesk OS Layer contains the Windows Operating System that is assigned to any Unidesk Layered Images you create

using that OS Layer. Once created, you can use the OS Layer to build as many Layered Images as you want.

The OS Layer includes a virtual machine in your infrastructure running the Unidesk-supported Windows Operating System

that you want to use for your Layered Images.

Add a version of  an OS layer

1. In the Citrix App Layering Management Console, select Layers > OS Layers

2. Select or right-click an OS Layer icon and click Add Version. This opens the Create OS Version Wizard.

3. (Required) In the Version Details tab, enter a Version identif ier. This can be the application version, or anything you

choose.

4. In the Connector tab, select a Connector configuration for the platform where you'll be publishing your Layered Images.

You can also modify an existing configuration by selecting it and clicking Edit. If  you have not yet created a Connector

Configuration or if  the configuration you need is not present, click New to create a new Connector Configuration and

select it from this list.

5. In the Platform Layer tab, select a Platform Layer that contains the tools and hardware settings that you need to install

and package the OS when adding a Layer Version. Once created, the new Layer Version can be used in Layered Images

published to any platform.

6. In the Packaging Disk tab, enter a f ile name for the Packaging Disk, and select the disk format. This disk will be used for

the Packaging Machine (the VM) where you will install the application, as described in the next two sections.

7. Confirm and Complete tab - Verify your settings and click Create Version. Unidesk runs the task of creating a new OS

version. When the task completes, it shows a status of Action Required. When you double-click the task to expand it,

the task contains the following text (refer to the image in the next section): 

"The Packaging Disk has been published. The virtual machine '<...>' can be found in folder '<...>' in datacenter '<...>'. Power on

this virtual machine to install your application. When the installation is complete, power off  the virtual machine before

clicking Finalize on the Action bar."

Next, you can deploy a Packaging Machine for this OS Layer version.

Deploy a Packaging Machine to XenServer

The Packaging Machine is a virtual machine where you install any updates or applications you want to include in the OS

Layer. It is strongly recommended that you use a unique Packaging Machine for each Layer. The Packaging Machine is a

temporary VM that will be deleted once the OS Layer has been finalized.

The Task Description (example shown in the last step above) contains directions to navigate to the location in XenServer

where the Packaging Machine for this Layer has been created.

1. To create your Packaging Machine in XenServer, begin with the expanded Packaging Disk task shown in step 2 below.

2. Log into your XenServer web client.

3. Back in the Unidesk Management Console, use the instructions in the expanded Packaging Disk Task (example shown

below) to navigate to the Packaging Machine.

Install the OS update
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1. Remote log into the Packaging Machine in XenServer. Be sure to log in with the User account you used to create the OS

in XenServer.

2. Install any updates or applications you want to include in the new OS Layer version, such as Windows Updates or anti-

virus applications.

3. If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

4. Make sure the Packaging Machine is in the state you want it to be for the user:

If  the applications you install require any post-installation setup or application registration, complete those steps now.

Remove any settings, configurations, f iles, mapped drives, or applications that you do not want to include on the

Packaging Machine.

Next, you will shut down the Packaging Machine and verify that the Layer is ready to finalize.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, the next step is to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

1. If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

2. Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verif ication

process.

3. If  there is an outstanding operation that must be completed before the Layer can be f inalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

4. Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into
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native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground. 

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

3. Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status

3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the OS layer

Once the Packaging Machine is created and any apps or updates installed, you'll need to finalize the layer.

Note: When you finalize a new version of an OS Layer, Unidesk deletes the Packaging Machine so as not to incur more

costs.

When a layer is ready to finalize:

1. Return to the Unidesk Management Console.

2. In the Layers module, select the Layer.

3. Select Finalize in the Action bar.

4. Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.

Reference: Create OS Version Wizard values

Version - (Required) This can be the version of the OS Layer or a version you assign to the Layer. This value is displayed in the

Details view of the Layer.

Version Description - (Optional) Enter a description of the version.
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Max Layer Size - (Optional) Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 100 gigabytes. If  the version you are creating could requires more space,

change this to a realistic value.

Select a Platform Connector configuration - (Required) Specify a Unidesk Platform Connector for the platform where you'll

be publishing your Layered Images. For example, if  you're publishing to Azure RD Session Host, select the Azure RDSH

connector with the credentials required to access the account. If  the configuration you need is not listed, add a New one

and select it from this list. If  you want to change the settings of a Platform Connector configuration, select it and click

Edit.

Packaging Disk Filename - (Required) The name of the Packaging Machine you created in Azure.
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Delete OS layer

Jun 29, 2017

You can delete an OS Layer or Layer version, as long as it is not being used by another Layer, or Image Template. Deleting

the Layer itself  removes all versions, volumes, and resources from the App Layering appliance.

You can delete an entire layer or a layer version if  it is:

Not deployed to an Image Template.

Not the required OS Layer (or Layer Version) for any compatible App Layers.

Not a prerequisite for another Layer that is deployed to an Image Template.

Delete a layer or layer version

1. In the Management Console, select Layers.

2. Select an OS Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.
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Delete platform layer

Jun 29, 2017

You can delete a Platform Layer or Layer version, as long as it is not being used by an Image Template. Deleting the Layer

itself  removes all versions and resources associated with the Layer.

1. In the Management Console, select Layers > Platform Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.142https://docs.citrix.com

Delete app layer

Jun 29, 2017

You can delete an app layer or layer version, as long as it is not being used by another layer as a prerequisite, or deployed to

an image template. Deleting the layer itself  removes all versions and resources associated with the layer.

1. In the Management Console, select Layers > Application Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Manage image templates

Jun 29, 2017

When you create new layers and new versions to them, you can edit the layer selection in your image templates, and use

the templates to publish new versions of your layered images. Once created, a layered image is no longer associated with

the template used to create it. This means that you can change or delete a template without affecting any previously

published layered images.

Update image templates with a new layer version

When you add a new version to an app layer or an OS layer, you can quickly identify the image templates that include the

layer, and select which templates to update with the new version.

1. In the App Layering Management Console, select Layers > App Layers or Layers > OS Layers.

2. Select the Layer you updated, and click Update Assignments.

3. In the wizard that opens, select the new version of the layer that you want to assign. The image template assignment

tab lists the image templates that include the layer but are not yet assigned the new version.

4. On the image template assignment tab, select the image templates to which you want to assign the layer or layer

version.

Notes:

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out names

may appear. These templates have already been assigned the Version.

You can use the Search f ield to f ilter this list by Layer or Version. If  you search on part of a Layer name or Version, any

entry that contains the search string is displayed.

5. Skip the Elastic Assignment tab

6. On the Confirm and Complete tab, verify your choices and click Update Assignments.

Edit any image template setting

When you want to change the settings that you use to publish any of your layered images, you can edit the image

template you originally used to publish the layered image(s) and publish a new version of the image(s).

1. In the App Layering Management Console (UMC), select the Images module.

2. Select the template you want to edit, and click Edit Template. This opens the Edit Template wizard.

3. On the Name and Description tab, you can change the Name, Description, and Icon for the Image.

4. On the OS Layer tab, you can select a different version of your chosen OS layer by expanding the layer and choosing a

different one.

5. On the App Assignment tab, you can add or remove app layers to include in the layered images that you publish using this

template. If  there is more than one version of a layer, you can choose a different version by expanding the layer and

choosing a different one.

6. On the Connector tab, you can change the location to which the Layered Image is published by selecting a different

Connector Configuration.

7. On the Platform Layer tab, you can change the selected Platform Layer, if  for example, you are publishing to a different

environment.

8. On the Layered Image Disk tab, you can edit the Layered Image Disk details, for example, to enable Elastic Layering on

the image.

9. In the Confirm and Complete tab, enter any comments you would like for this layer, and click Edit Template.
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Delete an image template

When you no longer need an Image Template, you can remove it from the Management Console.

1. In the Management Console, select the Images module.

2. Select the template you want to delete, and click Delete Template. This opens the Delete Template wizard.

3. In the Confirm and Complete tab, enter any comments you would like, and click Delete Template.
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App Layering in Azure

Jun 29, 2017

Azure prerequisites

Before installing App Layering in Azure, be sure to meet the following prerequisites.

Network File Share (Azure specif ics)
A file share server in Azure will perform signif icantly better than an on-premise f ile share. Even though the Azure f ile share

feature is not supported, you can use an existing network f ile share or create a new file share in the Azure environment.

Using Premium Storage is strongly recommended.

Only f ixed VHD disks will deploy successfully.

Azure account and subscription
To deploy and configure the App Layering appliance, you will need the credentials for an account that has administrative

access to your Azure subscription. For more information, refer to the Microsoft Azure Sign in page.

Azure Resource Manager
App Layering is designed to work with Azure’s new Resource Management (ARM) model. It does not support Azure’s

Classic deployment model. All resources such as virtual network, f ile shares and OS machines that App Layering will work

with must be created with Azure Resource Manager. For more information, refer to the Azure Resource Manager

overview page.

Azure network topology
Before deploying the App Layering appliance, you must define and create your Azure network topology. The appliance

and its Network File Share must have network connectivity. However, the appliance does not require network

connectivity to the Session Hosts that are created. A site-to-site connection between your corporate and Azure

networks is recommended for accessing the Management Console on the appliance. For more information, refer to

the Microsoft Azure Virtual Network page.

Storage requirements

350-500 GB Storage Space
The App Layering appliance uses local storage for temporary f iles and f inalized layers. The more layers you create, the

more space you need. However, if  you run low on space, you can expand the size of the current disk, or add other disks

to the appliance when needed.

40-100 GB network f ile share (SMB)
The f ile share connected to the appliance is used for upgrades, Elastic Layers, and cross-platform publishing. This space is

easy to expand, if  needed.

Operating System requirement

OS for Layered Images

You need a supported operating system to import into an OS Layer. This OS will be used to build your Layered Images.

https://login.microsoftonline.com/common/oauth2/authorize?client_id=15689b28-1333-4213-bb64-38407dde8a5e&response_mode=form_post&response_type=code+id_token&scope=openid+profile&state=OpenIdConnect.AuthenticationProperties%3dOSkrviLmcIsemQdVPpYrqaisz4ZEp3VZznh8nvSnX5-cLHwLJpT4W6GFLY8ogIW18mYwqQ9XZ5zhwqyCaGhQY6O3aukZ-KJcQ0WVGXf5NFfSl-5jsnWNqy7WbUMqcc3VrmsBEg&nonce=636340447611655736.Yjk1NWNhY2EtZWY3MC00MDMzLWJhMDYtYzhhOWExYmQ4YzdjM2RjNGFiYjAtYTIwZi00MjAxLWFmYzItZDU1OTFlMTQ2YjQw&redirect_uri=https%3a%2f%2faccount.azure.com%2fsignup%3foffer&post_logout_redirect_uri=https%3a%2f%2faccount.azure.com&msafed=1&lw=1&fl=easi2
https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-overview
https://azure.microsoft.com/en-us/services/virtual-network/
https://www.unidesk.com/support/learn/4.2.0/citrix_app_layering/welcome_platform_support_co4
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Install

Jun 29, 2017

Before you start

To get started in Azure, you need:

An Azure subscription

A Virtual Network in Azure. Your deployment in Azure can operate in a point-to-site or site-to-site Virtual Network.

Note: If  you have not already set up a connection to an Azure Virtual Network, see Get started with Azure for more

information.

The storage and Azure requirements listed here

Azure Powershell v3 installed in the storage location where you want to install the App Layering appliance (Enterprise

Layer Manager)

Installation package

The installation package, citrix_app_layering_azure_4.x.x, includes:

File Description

Azure_x.x.x.zip VHD file for the appliance VM

AzureELMDeploymentV2.ps1 Installation Script

citrix_app_layering_agent_installer.exe App Layering Agent installer

Citrix_App_Layering_Azure_Credential_Setup.exe Azure Credentials Tool

citrix_app_layering_win_gold_image_tools.exe OS Machine Tools

DeployAzureRmVm.template.json App Layering Template

Installation script

The installation script included in the installation package does the following. It:

Copies the included VHD to the Azure location you specify.

Creates a virtual machine in Azure using the VHD,

Attaches the repository disk.

Boots the Azure appliance.

https://docs.microsoft.com/en-us/azure/?product=vpn-gateway
http://docs.citrix.com/en-us/citrix-app-layering/4/azure.html
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When you run the script:

IMPORTANT : Be sure to note the Resource group location you select, as you will need this information later. For more

information about resource groups, refer to Using the Azure Portal to manage your Azure resources.

When selecting a virtual machine size, it is strongly recommended that you create a D3 Standard machine.

The name you specify for the new virtual machine must comply with Azure naming conventions.

Select a Virtual Network in which HTTP port: 80 is accessible (Public IP can be disabled).

On the Monitoring Diagnostics entry, select Disabled.

Deploy the App Layering appliance

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to layering.cloud.com.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. At the top of the page select the hypervisor where you are deploying the App Layering service. This selection determines

which platform-specif ic installation package is downloaded in Step 2.

9. Under Step 2, click the Download for Hypervisor button to download the appliance installation package for the

hypervisor you have selected.

10. Under Step 3, right-click Instructions, open the page in a new browser tab, and select your hypervisor. The installation

instructions for your hypervisor are displayed.

11. Extract the download package, citrix_app_layering_azure_4.x.x.zip. The f iles included are listed above.

12. Extract the Azure_4.x.x zip f ile to a folder on your local drive.

13. Open an Azure Powershell window.

14. Execute the AzureELMDeploymentV2.ps1 script and answer the prompts. The script copies the VHD to the Azure

location of your choice, and attaches the repository disk. It then boots the appliance. If  the script fails, check the values

to make sure that the values are correct for your environment.

15. Back in the Cloud, under Step 4, the Documentation link opens the instructions for logging in. (The link below opens the

same article.)

https://docs.microsoft.com/en-us/azure/azure-resource-manager/resource-group-portal
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16. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions (link below) to log into the

appliance.

Install the App Layering Agent (required for PVS and Connector Scripts)

The App Layering Agent enables the App Layering appliance (Enterprise Layer Manager) or a Unidesk Packaging Machine VM

to run PowerShell commands locally. If  you supply the proper credentials, the agent can run PowerShell commands as a

specific user.

The App Layering Agent is required in cases where one of your Connector Configurations launches a PowerShell script. This

includes Connector Configurations you use to:

Publish Layered Images to a provisioning system.

Package Layers in your hypervisor environment.

The App Layering Agent installer prompts you to register the agent with a App Layering appliance. If  you do not register the

agent during installation, you can manually register it later. However, keep in mind that the PowerShell scripts will not run

until the agent is registered with the ELM.

Prerequisites

Before you install the App Layering Agent, you must have the following requirements on the system where you are

installing the App Layering Agent:

An account with administrator privileges

.NET 4.5

PowerShell 3.0 or greater

PowerShell Snap-in

Before using the App Layering Agent on a PVS server you must ensure the PowerShell Snap-in is installed. This is a

manual step.

For PVS 7.7 and later, you must install the Powershell Snap-in Citrix.PVS.Snapin.dll.

For PVS 7.6 and PVS 7.1, you must install McliPSSnapIn.dll. Use the installutil.exe to install the Snap-in.

Example (7.6):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" McliPSSnapIn.dll

Example (7.7):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" Citrix.PVS.snapin.dll

On Windows 2008 R2, you must also enable PowerShell remote commands. For background information, see this Microsoft

article: https://technet.microsoft.com/en-us/library/hh849694.aspx

If  your 2008 R2 OS does not have PowerShell remoting enabled, run the following PowerShell command on the PVS server:

Enable-PSRemoting  

Install the App Layering Agent

1. Log in as an administrator on the system where you are installing the agent.

https://technet.microsoft.com/en-us/library/hh849694.aspx


© 1999-2017 Citrix Systems, Inc. All rights reserved. p.150https://docs.citrix.com

2. Download the App Layering Agent from the Unidesk Download page.

3. Copy the Unidesk_agent_installer.exe f ile from the App Layering Agent folder to a convenient location on the PVS

server.

4. Run the Unidesk_agent_installer.exe as Administrator, and when prompted, enter the path to the directory where you

want to install the App Layering Agent. The default location is C:\\Program Files (x86)\Unidesk\Agent.

5. The App Layering Agent installer checks to see if  all Prerequisites are present. If  any prerequisites are missing, the installer

reports this and exits without installing.

6. The installer prompts you for an Agent Port number. You can accept the default port number (8016) or specify a

different one if  the default port is already in use.

7. The installer prompts you for the credentials (address, username, and password) for your App Layering appliance. Register

the App Layering Agent with the ELM by entering the IP address and login credentials for a Unidesk Management

Console (UMC) user on the ELM with Administrator privileges, (for example, the credentials you use to log into the UMC).

Note: If  the App Layering appliance is not available yet or you choose not to register with it now, you can manually

register at a later time using the procedure described in Register with the App Layering appliance manually.

8. Click Finish to exit the wizard.

Register the App Layering Agent manually

If  the App Layering Agent was not registered with a App Layering appliance during installation, you can register it later by

using the following procedure.

To manually register the App Layering Agent with the ELM:

1. As an administrator, log in to the server where you installed the App Layering Agent.

2. Open a command window (cmd.exe) as administrator and navigate to the directory where the App Layering Agent is

installed. (The default location is C:\\Program Files (x86)\Unidesk\Agent.)

3. Run the following command, using the IP address of the ELM where indicated:

Unidesk.Agent.Service.exe register /i /e:IP_address_of_ELM /u:Administrator

4. When prompted, enter the password for a user who has Administrator privileges in the Unidesk Management Console

(UMC) on the ELM.

5. When the registration process completes, a message appears informing you of the successful outcome. The App

Layering Agent registration appears in the Audit log for the Management Service in the UMC.

If  the process does not succeed, examine the \Unidesk\Agent\Logs\unidesk.agent.log file in the App Layering Agent

installation directory. You can also view Help for the App Layering Agent command line options by running the following

command: Unidesk.Agent .Service.exe /?.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.151https://docs.citrix.com

Configure

Jun 29, 2017

You can access the App Layering Management Console using the appliance's IP address entered in a web browser, or via the

Citrix Cloud. Currently, access via Citrix Cloud is in Labs, and there are a few things you should be aware of when accessing

the Management Console via the Cloud.

Default credentials for the Management Console

The first time you log into the Management Console, you must use the default user name and password, Administrator,
password Unidesk1. At that point, you will be asked to change all administrator passwords for the appliance.

Access the Management Console directly via your private network

To log directly into the Management Console hosted on the App Layering appliance:

In your hypervisor, locate the VM you created for the appliance and determine its IP address.

Using the IP address for the appliance, enter the following URL in a compatible web browser:

http://<ip_address_of new_vm>/

This displays the Login page for the Management Console.

Log into the Citrix Cloud, and select the App Layering tile. This displays the Log in page for the Management Console.

Log in to the Management Console as Administrator.

If  this is the first login on this appliance, the Set up Login Credentials wizard is displayed. Here you must change the

password for each of the appliance's administrative accounts.

Access the Management Console via Citrix Cloud (Labs)

When you log into Citrix Cloud, you can use the App Layering Manage tab to access the Management Console. Below,

please see the minor issues you may encounter when using the Manage tab to access the appliance.

In your hypervisor, locate the VM you created for the appliance and determine its IP address

In your internet browser, navigate to citrix.cloud.com and select the Manage button on the App Layering tile. This

displays the Citrix App Layering page.

Click the Manage tab, and in the window that appears, select the Resource Location, enter the Appliance Address, and

click Connect. This displays the Login page for the Management Console.

Log in to the Management Console as Administrator.

If  this is the first login on this appliance, the Set up Login Credentials wizard is displayed. Here you must change the

password for each of the appliance's administrative accounts.

Known issues and considerations with Management Console access via Citrix Cloud (Labs)

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

1.

2.

3.

4.

1.

2.

3.

4.
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Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.
Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.

Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.

Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Change administrative passwords

Jun 29, 2017

The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

adminstrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the passwords for the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, skip to Step 3.

2. Select User > Set up Login Credentials. On the About Your Credentials tab, the three administrative accounts are

described.

3. Take a moment to familiarize yourself  with the administrative accounts for the appliance.

4. For each account, enter the new password and then re-enter it in type it in the Conf irm Password f ield.

5. On the Confirm and Complete tab, click Change Credentials.
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Set up a file share for the App Layering appliance

Jun 29, 2017

The App Layering appliance must be connected to a network file share. When setting up the appliance's file share:

The file share must be configured using SMB technology.

Note: If  you used a previous (Unidesk 4.0.x) version of the product to configure an NFS file share, you can continue using

the file share, but it will not support Elastic Layer assignments.

The user credentials for the file share must have full permissions for that share.

The share must be set up by the admin to be readonly for all users except for the one configured in the appliance. This

secures the Layers and other files stored on the share.

Ensure that you have the minimum storage space requirement of 40-100GB for your file share.

Note: Storage space is expandable, as you can add space to a disk, or other disks to the appliance.

For convenience, set up a File Share hosted in your hypervisor.

For Azure: Currently, the App Layering Appliance does not support the Azure File Share feature. For best performance, it

is best to create a file share server in Azure using a fast system with a Premium Disk, for example, a DS class machine. 

Create the network file share

Configure a file share that uses Server Message Block (SMB) protocol.

Follow the vendor's instructions for setting up a file share using the SMB protocol. 

Configure the App Layering appliance to access the file share

Once you have created a file share, configure the App Layering Appliance to attach to it. You can configure the

appliance via the App Layering Management Console.

1. In the Management Console, select System > Settings and Configuration, then scroll down to the network file shares

setting and click Edit .

2. Specify a Type, Path, User name, and Password for the file share.

3. Click Test Network File Share to see if  you can connect to the file share. The test returns a message stating either

Success or Failed to mount network file share path.

4. Once the test returns a Success message, click Save.
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Open firewall ports for App Layering, as needed

Jun 29, 2017

The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin User

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.

Destination Activity Protocol Ports

App Layering appliance

(Enterprise Layer Manager (ELM))
Management Console TCP 80, 443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

Connector for PVS Communication TCP

3009 (HTTP)

3509 (HTTPS)

Connector for vSphere Communication TCP

3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP

3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161
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App Layering Appliance (Enterprise Layer Manager (ELM))

Internal Connections

By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent  - refers to the App Layering agent, which you install on

Admin User -
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Source Destination Activity Protocol Ports

Appliance Agent Communication TCP 8016

Agent Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via

ESXI Host
TCP 443

Agent Appliance
Communication with datastore via

ESXI Host
TCP 8888

Appliance Active Directory
Communication with datastore via

ESXI Host
TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP)

3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP)

3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the
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destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.

Destination Activity Protocol Ports

XenCenter Communications 5900
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Connect to a directory service

Jun 29, 2017

You can configure the appliance to connect to a directory service, for example, Active Directory. When you connect to your

directory service, you will create one or more Directory Junctions to access specific domains or OUs. The appliance does not
modify the directory service you connect to. The software caches the attributes for each directory service entry, so that if

the connection to the directory service is lost temporarily, the software can use the cached information for management

tasks.

About connecting the appliance to a directory service

The Management Console Directory Tree displays a hierarchical view of Users and Groups. Each Directory Junction that you

create specifies a starting node in the directory tree.

Overlapping directory junctions

Overlapping (or nested) directory junctions occur when you create multiple directory junctions that contain the same users

and then import the users into the directory tree. When overlapping occurs, each directory junction contains its own copy

of the duplicate users.

Example: Overlapping directory junctions

Assume you create Directory Junction A that starts at the Marketing folder in a directory service tree. Next, you create

Directory Junction B which starts at a folder above the Marketing folder. If  you browse both directory junctions, you can

see the Marketing users in both folders.

User attributes are imported f rom the directory service

The App Layering software imports and caches user and group attributes from your directory service when:

You assign administrator privileges to a user.

The values of the attributes change in the directory service.

The attributes that the software caches are read only. All changes to the attributes for directory service users come from

the directory server.

Imported attributes are synchronized regularly

The software synchronizes the information it caches for directory service users with the directory service every 12 hours. If

the software discovers that a user is no longer an object in the directory service, it classifies the user as abandoned (you can

view this information in the Information view for the user).

Create a directory junction

Create the folders where you want to place the Directory Junctions or decide which existing folder you want to use. You

can add a Directory Junction folder to any existing folder in the Management Console directory tree.

Best Practice: Avoid creating overlapping Directory Junctions, if  possible. In some circumstances, deleting an overlapping

Directory Junction can affect your ability to delete another Directory Junction that contains the same users.

1. Select Users > Directory Service.
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2. Select Create Directory Junction in the Action bar. This opens the Create Directory Junction wizard.

3. In the Connection Details tab, specify the details for the directory server.

Directory Junction Name- This name becomes the name of the folder that you see in the tree view. You can use any

name, including the name of a domain in your directory service tree.

Server address - This is the name for the server you will use for the directory service. (IP Address or DNS Name)

Port - Specify the port number for communicating with the directory server.

SSL check box - Select this if  you want to use Secure Sockets Layer (SSL) communication.

If  certificate errors occur, the wizard displays a list of these errors. If  you know it is safe to ignore them, select Ignore

Certificate Errors.

Test Connection - Click to verify that the appliance can connect to the directory service.

4. In the Authentication Details tab, enter the authentication details for a user who has permissions to search the

directory service.

Bind Distinguished Name - To determine the correct syntax for the Bind DN or user name, see the documentation for

your directory.

Examples: The following examples shows some of the ways you can specify a user for the directory service:

domain\username or username@domain.com.

Bind Password.

Test Authentication - Click to verify that the connection to the directory server is valid.

5. In the Distinguished Name Details tab, specify where the software should start searching for users and groups in the

remote directory service.

Base Distinguished Name (DN) - The software starts searching for users and groups in the remote directory service.

Once you establish a connection to the server for the directory service, the wizard displays a list of available DNs. You

can select a DN from the list or enter the DN directly in the box.

Example: Assume that you want to start the search at the Marketing Organizational Unit at the root of a domain.

You would enter the following Base DN:

OU=marketing, DC=root,DC=mydomain DC=com

Test Base DN - Click to verify that the Base DN is valid.

6. In the Folder Location tab, select the folder in the Unidesk tree where you want to add the directory junction for the

remote directory service.

7. In the Attribute Mapping tab, enter the names of directory service attributes that you want to map to the local

attributes or use the default settings.

Note: To change the mapping from local attributes back to default mappings, click Use Defaults.

8. In the Confirm and Complete tab, verify the Directory Junction settings, enter a comment if  required, and click Create

Directory Junction.

If  you enter comments, they appear in the Information view Audit History.
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Assign App Layering roles to users

Jun 29, 2017

About App Layering users, roles, and rights

Built-in administrator account

When you first install the App Layering appliance and log onto the Management Console, there is a "built-in" Administrator

account that you can use to get started. This Administrator has the rights to perform all App Layering operations. You can

edit this user's properties, including the name, password, and contact info. Be sure to change the password for this built-in

Administrator account as part of installing and configuring the appliance. 

AD user accounts

Other than the built-in Administrator account, all users are actually AD users imported via one or more directory junctions.

Once your directory junction(s) have been created, you can assign Roles to each user, as described later in this topic. You

can see which roles are assigned to a user in the User Details.

App Layering Roles defined

Roles determine which App Layering modules a user can manage. Users assigned one or more Roles can log into the

Management Console, and these users are listed on the Administrators tab (select Users > Administrators).

Note
When upgrading from version 4.0.6 or earlier, users assigned the Machine Administrator Role in earlier releases will now be

assigned the Read Only role. If the user needs more than read only access, reconfigure the user roles, as needed.

Rights by role
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Rights Role

Administrator

Can do every operation available in the Management Console.

Only users assigned the Administrator Role can edit user properties on the Users tab (Select Users
> Users).

Only administrators can configure system settings and manage licenses.

Manage App Layers Can create, edit, and delete application layers and versions.

Manage Elastic Layer

Assignments
Can add, update, and remove Elastic layer assignments.

Manage Image Templates

Can create, edit and delete Image templates.

Can add, update, and remove app layer assignments for image templates.

Can update platform layer assignments for image templates.

Can update OS layer assignments for image templates.

Manage OS Layers Can create, edit, and delete OS layers and versions.

Manage Platform Layers Can create, edit, and delete Platform layers and versions.

Publish Layered Images
Can publish layered images.

Cannot create or modify existing image templates.

Read Only

Can view information about any items in the Management Console.

Cannot launch any wizards or make any changes.

The Read Only user cannot cancel any tasks.

User credentials for logging into the Management Console

When you assign Roles to Directory Service users, they can use their Directory Service credentials to log into the

Management Console.

Who can assign App Layering Roles?

You can change a user's role if  you are logged into the Management Console as a user assigned the Administrator Role.

Assign App Layering roles to users

Log into the Management Console.

Select Users > Users.

Select a user and click Edit Properties. This opens the Edit User wizard. 

1.

2.

3.
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Skip to the Roles tab, and select one or more roles for this user. For details, see Rights by Role above.

In the Confirm and Complete tab, click Update User. Any comments you enter will appear in the Information view Audit

History.

4.

5.
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Enable Labs features

Jun 29, 2017

Want to experiment with cool new features that are under development? Through the Management Console, you can

now see which features are available in Unidesk Labs in any given release. You can enable features you're interested in, try

them out, and let us know what you think. The only caveat? Best not use Labs features in your production environment, as

they are likely to evolve with the feedback we receive from users like you!

Throughout this documentation, features that are available through App Layering Labs are marked (Labs) in the title. Most

Labs features require enabling.

To find out which Labs features are available in this release, see What's New.

Enable a Labs feature

When a release includes a Labs feature that you want to enable:

1. Log into the Management Console and select System > Settings and Conf iguration.

2. Select the check box for the feature you want to enable, and click Save. The feature's status changes to Enabled.

You can turn off  the feature at any time by deselecting the check box and clicking Save.

http://docs.citrix.com/en-us/citrix-app-layering/4/whats-new.html
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Connector essentials
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What are Connectors?
Connectors are the interfaces to environments where you create Layers and publish Layered Images. You create one or

more Connector Configurations for each platform where you intend to package Layers or publish Layered Images.

What are Connector Configurations?
A Connector Configuration is a stored set of values for connecting to a storage location in your environment. A

configuration typically includes credentials for authentication, a storage location, and any other information required to

interface with the environment where you will be creating layers or publishing images. You can create multiple Connector

Configurations, each configured to access a unique location in your environment.

What Connector Configurations do I need?
Connector Configurations for importing an OS to create an OS Layer

When you create an OS Layer, you need a Connector Configuration to give the appliance access to the location of the OS

image that you want to use for your OS Layer.

Connector Configurations for creating and updating App Layers, and adding Versions to OS Layers
When creating or updating an App Layer, or adding Versions to an OS Layer, you need a Connector Configuration for the

location in your environment where you will package the Layer. You can create as many configurations as you need, for

example, if  you have more than one storage location in the environment.

Connector Configurations for publishing Layered Images
Publishing Layered Images will require different Connector Configurations than the ones you use for creating Layers, if, for

example, you publish Layered Images to a variety of storage locations near the users being served. For example, you can

prepare your Layers for a server farm in vSphere, and publish Layered Images to Citrix PVS for streaming to servers in

vSphere. Or, you can publish Layered Images to more than one storage location in the same environment, each requiring a

different Connector Configuration. Each location is likely to require different credentials.

How and when to add a new Connector Configuration
If  this is your first time using the App Layering Service, you will need to add one or more Connector Configurations in the

process of adding Layers and publishing Layered Images. In the Management Console, the wizards for Creating Layers,

Adding Versions, and Publishing Layered Images each include a page for selecting and creating Connector Configurations.
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Upgrade

Jun 29, 2017

Automatic updates of  available package downloads

The App Layering appliance (aka Enterprise Layer Manager) automatically downloads upgrades, but the upgrades are not

automatically installed. Instead, you are notified that an upgrade is available.

The appliance periodically checks for upgrades, and when one is found, downloads the package, verifies it, and extracts the

files. Once the package is extracted, you are alerted that there is an upgrade ready.

If  you log into the Management Console as Administrator, you can apply an upgrade either by clicking the Start Upgrade

button on the notification, or by selecting System tab > Manage Appliance > Upgrade.

Notifications

Periodically, the appliance asks api.unidesk.com if  an upgrade is available. The following sections walk you through common

scenarios.

Note: If  the appliance cannot access api.unidesk.com, auto-downloading will not work. The user will not see any error.

However, there will be a note in the log that the check failed.

If  an update is not available...
Nothing happens. Another check will be made at the next scheduled interval.

If  an update is available, but there is no network file share configured...
The user will receive a pop-up (see below) to let them know there is an upgrade available, and that the administrator needs

to finish configuring a network file share before it can be downloaded and applied.

If  an update is available...
The Download Upgrade Media job is started, and it is visible in the task list. This job is responsible for:

Downloading the upgrade to local storage.

Ensuring the checksum of the successfully downloaded upgrade package is correct.

Extracting the downloaded upgrade package to the configured Network File Share. The download is extracted to the

appliance's File Share:

Location: NetworkFileShare\AppLayeringVersion

Example: \\MyServer\AppLayeringFileShare\4.0.8

If  extraction is successful, the next time any user logs in they will be notif ied that an upgrade is available.

If  at any time during this process an error is encountered that requires Administrator intervention (out of space on local

storage, out of space on the network file share, invalid file found, etc.) the job will fail with an appropriate error.

Note: If  a job fails it will be retried at the next check interval regardless of whether the Administrator has resolved the fixed.

If  another update is found before a previously downloaded one is installed...
The new upgrade will be downloaded (see above) and once successfully completed it will become the Upgrade Available.

If  one upgrade is downloading when another is made available...
The running download will be aborted and a new download (as above) will be started. In this case, all files related to the in-
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progress download will be deleted.

User notification when an upgrade is available

When logging in every user will receive a notification that an upgrade is available. However, only an Administrator will be able

to run the upgrade.

Prerequisites

Verify that a Network File Share has been configured. You can confirm that this has been done by logging into the

Management Appliance, selecting System > Settings and Configuration, and finding the Network File Share setting. If

the file share has been configured, you can upgrade the appliance. 

Download packages

Platform Package Files Included

Citrix

XenServer
app_layering_upgrade_xenserver_pkg_4.x.x.zip upgrade_xenserver_elm_4.x.x.xx.vhd

Microsoft

Azure
app_layering_upgrade_azure_pkg_4.x.x.zip upgrade_azure_elm_4.x.x.xx.vhd

Microsoft

Hyper-V
app_layering_upgrade_hyperv_pkg_4.x.x.zip upgrade_hyperv_elm_4.x.x.xx.vhd

VMware

vSphere
app_layering_upgrade_pkg_4.x.x.zip

upgrade_vmware_elm_4.x.x.xx.vhd

app_layering_agent_installer.exe

Note: An Agent upgrade is only required if you've installed the agent

for your implementation, for example, if you are using PVS, or

Connector Scripts.

Back up the appliance

Take a snapshot or checkpoint of the appliance.

Download the upgrade media to the network file share

The App layering 4 upgrade files include both the Appliance and Agent upgrades. The Agent upgrade can be used to bring

either or both of these installations up to date:

The agent on PVS servers.

Servers where Layered Images are enabled for Elastic Layers.

To download the upgrade package:

1. In a network browser, navigate to the App Layering Download page, and sign in.

2. Download the App Layering Upgrade package for your platform to the \Upgrade folder on the Network File Share.

3. Unzip the package in \Upgrade.

4. Copy the Agent upgrade to the server(s) where the agent is installed, and refer to Upgrade the App Layering Agent

http://docs.citrix.com/en-us/citrix-app-layering/4/azure/configure/set-up-a-file-share-for-the-app-layering-appliance.html
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below.

Load the App Layering upgrade

1. Log into the Management Console, select System and click the Upgrade action to launch the Upgrade Wizard.

2. On the Upgrade Disk Details tab, click Browse.

3. Navigate to the upgrade f ile, and click Choose.

4. Verify the Upgrade path, and click Upgrade. This starts the upgrade process, and opens a status page in the browser.

5. Once the upgrade has completed, the status changes to "Upgrade Status: Complete."

6. Refresh the Web page to return to the UMC.

7. Verify that the upgrade was successful by clicking the About  link in the Management Console to confirm the version

number. 

Upgrade the App Layering agent

When using PVS or Elastic Layers the Agent is required. To upgrade the App Layering Agent:

1. Uninstall the previous version of the App Layering Agent from the server(s) where they are installed.

2. Make sure that you have copied the App Layering Agent Upgrade f ile to the PVS server(s) where the agent is installed.

3. Double-click the Agent upgrade f ile, and follow the instructions for upgrading the Agent.

Create a Cloud Connector for accessing the Management Console via Citrix Cloud (Labs)

If  you want to access the Management Console via the Citrix Cloud, install a Cloud Connector as described here. For known

issues when accessing the Management Console via the Cloud, see the list of issues below.

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to the Cloud.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. Under Step 4, the Documentation link opens the instructions for logging in. 

9. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions to access the appliance. 

Known issues

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.
Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.
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Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.

Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Create layers

Jun 29, 2017

OS Layers

An OS Layer includes the software and settings for the operating system that you deploy as part of your other layers and

ultimately, your Layered Images. Once you have prepared the OS disk for deployment, you can create a Unidesk Operating

System Layer by importing the OS disk into a new Layer.

With an OS Layer, you can install your operating system once, and update it by adding a new Version to the Layer whenever

there's a new patch or update. You can deploy this layer, or a version of it, in every image you publish. This allows you to

maintain one OS image and use it to provision all of your servers.

If  you need to support more than one operating system, for example, if  you need both Windows Server 2012 R2 and

Windows Server 2008 R2, you can create more than one OS Layer. However, each App Layer is only compatible with the

OS Layer you use to create it, and if  you deploy two OS Layers, you will also need to deploy a compatible App Layer for

each one. Further, in future releases when deploying Elastic Layers to users, those layers will only be compatible with users'

desktops that use the same OS Layer.

If  you can support your users with a single OS Layer, the work associated with creating and updating App Layers will be

much reduced.

Each time you need to deploy operating system patches and updates, you will do so by adding a new Version to the

OS Layer. You can continue to publish Layered Images using any version of the OS Layer.

The prerequisites for creating an OS Layer include:

An App Layering-supported operating system

App Layering appliance and network f ile share installed and configured

 

Platform Layers

A Platform Layer is a layer that includes platform-specific configuration settings, tools, and other software required for

your OS and Apps to be installed in or to run in a particular environment.

Types of  Platform Layers

A Platform Layer for Packaging (required in some cases, see below)

Platform Layer for Publishing (always required)

Platform Layer for packaging layers and versions

The only time you need a Platform Layer for Packaging layers is when your OS image was created on a different hypervisor

than the one where you are building your other layers. When creating an App Layer or Layer Version, or OS Versions, the

purpose of the Platform Layer is to ensure that any hypervisor-related software and settings are available during the

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
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installation of the application(s) on that layer, if  needed. If  you choose to use a Platform Layer for Packaging a layer, the

hypervisor-related software will only be used during layer packaging, and has no effect on where you can publish the layer

as part of a Layered Image.

Platform Layer for publishing Layered Images

A Platform Layer for Publishing is required when you publish Layered Images. The purpose of the Platform Layer for

Publishing is to include the settings and software that the Layered Image needs to be deployed in your environment. When

creating a Platform Layer for Publishing, Unidesk removes unselected (and unnecessary) tools and software related to the

platforms you are not publishing to. This is to prevent any unnecessary platform software from slowing down the Layered

Image when it runs in the target environment.

App Layers

An App Layer is a virtual disk containing one or more applications that you can use in Layered Images. You can combine an

App Layer with any other App Layers and a Platform Layer, as long as the OS Layer used to create the App Layer is

selected.

With most applications, creating an App Layer is simple. In a few cases, it 's best to start with tips from experienced users, so

the Unidesk Forum includes Application Layer Recipes that you can search for tips about a particular application before you

start. 

To create an App Layer, you use the Create App Layer wizard to deploy a Packaging Machine in your environment and install

the application on the Packaging Machine, leaving the application in the state you want it to be in for users. Then you

finalize the Layer. 

User Layers (Unidesk Labs)

A User Layer is a virtual disk where a user's app data and configuration settings are saved. User Layers are created when you:

Publish a Layered Image with Elastic Layering set to Application and User Layers.

Users log into their desktops on the above Layered Image.

With User Layers enabled on the Layered Image, users can install applications locally on their desktops, and the apps and

their data will be saved in the User Layer.

Verifying Layers

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized. The new Layer or

Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.
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Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX
3. Enter the NGen command to execute the queued items:

ngen update /force
This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It ’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status
3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Connectors for layering

When creating Layers in a Azure environment, you need a Connector Configuration to define the hypervisor location from

which you will:

Import the OS image when creating your OS Layer.

Deploy a VM for the Layer and Install the application software or the Layer.

It is strongly recommended that you use the hypervisor where the App Layering appliance is installed. If  you decide to

create Layers on a hypervisor other than the one where the appliance is installed, you can use NFS instead of a Azure

Connector Configuration, and manually copy the file to your hypervisor and back to file share once the software for the

Layer is installed.
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See Connector essentials for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/azure/configure/connector-essentials.html
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OS layer
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Create an OS Machine in Azure

To create an OS Layer, you create a virtual machine in Azure, prepare the OS in Azure, and then import the resulting OS Disk

to create the OS Layer.

1. In the Microsoft Azure portal, create a new VM from the Windows Server Remote Desktop Session Host Windows

Server 2012 R2 image (New > Compute > Virtual Machine > From Gallery > Windows Server Remote Desktop Session

Host Windows Server 2012 R2).

2. Choose Resource Manager from the Select a deployment model option list and click Create.

Note: The App Layering software does not support the Classic option from the Select a deployment model option list.

3. Complete the Create virtual machine wizard to create the OS machine.

The name of the new server machine you specify must comply with Azure naming conventions.

The User name and Password of the new server machine you specify becomes the User name and Password of any

Packaging Machines that are subsequently created containing this OS Layer.

Be sure that the value for the Resource group location matches the Storage account location that you configured in

the Platform Connector Configuration.

Prepare a Windows Server 2012 R2 image (Session Host)

The OS Image should not be in a domain.

The OS Image should get its IP address from DHCP.

Ensure that the VM for your OS Layer is MBR partitioned, rather than GPT partitioned. Otherwise, you will not be able to

install the OS Machine Tools.

To prepare the image:

1. After the new server machine has been successfully created, reboot the machine, and log into it remotely.

2. Turn off  Windows Automatic Updates (Control Panel > System and Security > Windows Update > Change Settings).

3. From the new machine, open a web browser, navigate to the Download Center and download the OS Machine Tools.

4. Rename or delete the "Unattend.wsf" f ile in the C:\Windows\OEM directory.

Note: Do not use the Unattend.exe, as this is not needed and will cause issues with Azure.

5. On the new server machine, run the setup_x64.exe f ile to install the App Layering drivers on the OS Machine.

6. Ensure that this machine is not joined to a domain.

Note: Session Hosts will join a domain when you provision them from a Layered Image.

7. Optionally, you can shut down the new OS machine.

Notes:

Before you can import the OS Disk (as described in the following section), the state of the OS Machine must be either

Stopped, Stopped (deallocated), or Running. The OS Disk can only be imported if  the OS machine is in a Starting or

Updating state.

You must perform any pending reboots to the OS machine before importing the OS Disk.

Once you have completed these steps, you are ready to create an OS Layer.

https://login.microsoftonline.com/common/oauth2/authorize?resource=https%3a%2f%2fmanagement.core.windows.net%2f&response_mode=form_post&response_type=code+id_token&scope=user_impersonation+openid&state=OpenIdConnect.AuthenticationProperties%3dcOfafRnByaq-tjZxUCZNiFatMMjS0J8D67hrWTnMrZMIL_cdMkt52ZIRHX93iaSwhqAyTE0LUSShifhIcqabJEosuS20K8AuCPc1GWWAJeJA0UlFONonUTyEcC6FfpGVKpQuzJiGkJvP0aflWMRVM-X82e3IDancvkrkozZzmWMtG3LD&nonce=636340474924791175.ZmFiZDhhY2YtZGFjNy00ZTQ4LWIyNGMtNDE1OTY4N2E1ZjViYTgxNDY0NjItMzFjMi00OWNiLWE5OGYtNjIxMWYxZDg4NTFi&client_id=c44b4083-3bb0-49c1-b47d-974e53cbdf3c&redirect_uri=https%3a%2f%2fportal.azure.com%2fsignin%2findex%2f%3fsignIn%3d1&site_id=501430
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A Platform Layer is intended to include the platform software and settings required to deploy images in your environment.

For example, a Platform Layer for publishing to PVS in vSphere with XenApp as the broker would include the PVS Target

Device Imaging software, vmTools, and the XenApp Virtual Delivery Agent Installer (and other platform-related software as

well).

 

You can create two kinds of Platform Layers:

 

Platform Layers for publishing Layered Images (Required) - These Layers include the software and settings required for a

Layered Image to run flawlessly in your environment.

 

Platform Layers for packaging Layers (Required in some cases) - These Layers include the hypervisor software and settings

you need to easily install the software for your other layers on a VM in your hypervisor environment.

Prerequisites

When creating a Platform Layer, the software installers for your platform must be available in a location that's accessible

to the Packaging Machine VM where you are going to create the Layer. As summarized in the following table, the

prerequisites vary based on the type of Platform Layer you choose to create.

Type of
Platform Layer

Prerequisites

Publishing

Layered Images

Software installers, and settings you use for your:

Hypervisor

Provisioning service

Connection broker

Packaging

Layers

The software and settings for your:

Hypervisor

For example, your hypervisor installer and settings.

Note : You only need a Platform Layer for packaging Layers if you are creating your Layers on a different hypervisor

than the one from which you imported your OS image.

Prepare a new platform layer

Select Layers > Platform Layers and select Create Platform Layer in the Action bar. This opens the Create Platform Layer
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wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

In the OS Layer tab, select the OS Layer you want to associate with this Platform Layer.

In the Connector tab, choose a Connector Configuration for the platform where you are creating this layer. If  the

configuration you need isn't listed, add a NewConnector Configuration and select it from this list.

Example: If  you are creating the layer in a vSphere environment, select the vSphere connector with the information needed

to access the location where you will package this layer.

In the Platform Types tab, select the radio button that describes the purpose of this Platform Layer: to create and update

layers, or to publish Layered Images. For more about these choices, see Platform Layers.

From the dropdown menus, select the platform(s) you are using.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the tools, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the App Layer, enter a comment if  required, and click Create Layer.

Any comments you enter will appear in the Information view Audit History.

Expand the Tasks bar at the bottom of the UI, and double-click the Packaging Disk task to show the full task description.

Once the Packaging Disk has been created, the Task bar displays the location of the Packaging Disk in your environment.

Next, you can deploy the Packaging Machine for your Layer.

Deploy a Packaging Machine

The Packaging Machine is a virtual machine where you install the app(s) you want to include in this Layer. It is strongly

recommended that you use a unique Packaging Machine for each Layer. The Packaging Machine is a temporary VM that

will be deleted once the Layer has been finalized.

 

Deploy a Packaging Machine to Azure

The Task Description (example shown in the last step above) contains a link to the location in the Azure portal where the

Packaging Machine for this Layer has been published.

 

To create your Packaging Machine in Azure, begin with the expanded Packaging Disk Task shown in the last step above.
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Log into the Azure portal (https://portal.azure.com) from your web browser.

In the expanded Packaging Disk Task shown below, copy the full URL and paste it into the web browser where you logged

into the Azure portal. This opens the Microsoft Azure portal to the Custom deployment template where you can create

the virtual machine that you will use as your Packaging Machine.

 

Note: We recommend copying the full URL instead of using the Click here link.

 

 

 

On the Custom deployment panel, complete the required fields for customizing your Azure parameters.

 

Packaging Machine Name - must conform to Azure VM name requirements.

Size - the Azure VM size of the packaging machine.

Virtual Network and Subnet - the virtual network and subnet for deploying the Packaging Machine.

IMPORTANT: Be sure that the value for the Resource group location matches the Storage account location that you

configured in the Platform Connector Configuration. If  these locations are not the same, the Packaging Machine will fail to

deploy and you will have to reattempt deployment. If  your deployment does fail, you can simply re-paste the link into the

browser to start over.

 

 

 

Install the platform software

This section explains how to install your application(s) on the Packaging Machine you created in Azure. Keep in mind that

the state of the software before you finalize the layer is what users experience when they access it.

 

To install the application(s):

 

Remote log in to the Packaging Machine you created in Azure. Be sure to log in using the User account you used to create

the OS in Azure.

 

Install the Azure hypervisor software, along with any drivers, boot-level applications, or files that you need for packaging
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Layers in Azure.

 

Make sure the Packaging Machine is in the state you want it to be for the user:

 

If  the software you install requires any post-installation setup or registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

Next, you'll need to shut down the Packaging Machine and verify that the Layer is ready to finalize.

 

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, the next step is to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

 

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

 

 

 

To use the Shutdown For Finalize tool:

 

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

 

Layer integrity messages you may see during the finalization process
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Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

 

The new Layer or Version can only be finalized when the following conditions have been addressed:

 

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

 

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

 

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

 

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

 

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

 

Force an NGen operation to the foreground.

 

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

 

Open a command prompt as Administrator.
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Go to the Microsoft .NET Framework directory for the version currently in use:

 

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

 

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

 

Note: It’s okay if  you see several compilation failed messages!

 

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

 

Open a command prompt as Administrator.

 

Check status by running this command:

 

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

 

The .NET Runtime Optimization Service is stopped

 

Finalize the Layer

Once the Packaging Machine is created, the platform software is installed and ready to finalize, and you have shut down

the machine, you'll need to finalize the layer.

 

Note: When you finalize a Platform Layer, App Layering software deletes the Packaging Machine.
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When a layer is ready to finalize:

 

Return to the Management Console.

In the Layers module, select the layer.

Select Finalize in the Action bar.

Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.
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An App Layer is a bootable software image (virtual disk) containing one or more applications that you can use in any number

of Layered Images. When publishing a Layered Image, you can combine an App Layer with the OS Layer used to create it,

other App Layers, and a Platform Layer.

To create an App Layer, you open the Create Layer wizard, deploy a Packaging Machine in your environment, then install the

application(s). Once the application(s) are installed, you finalize the Layer.

A Packaging Machine is a VM where you install the application(s) that will be included in the Layer. The App Layering

software creates the Packaging Machine in the location and using the credentials you supply by choosing the Platform

Target (hypervisor) and selecting a Connector Configuration containing this information. If  you don't yet have the

Connector Configuration you need, you can add a new one, as described in the steps below.

Before you start

Requirements

To create an App Layer, you need:

Create an OS Layer

Optional

Before you create an App Layer, you may also want to create resources that facilitate the application installation process.

These resources are for temporary use during installation only, and will not be used to deliver the application.

Prerequisite Layer

Platform Layer (for cross-platform deployments) (Only required if  creating App Layers on a hypervisor other than the one

from which you imported your OS Layer)

Run Once Script

If  the application you install affects boot-level components, you'll need to restart the Packaging Machine as part of

finalizing the layer or version.

Prerequisite Layer

Prerequisite Layers let you include existing App Layers on the Packaging Disk when creating or adding a version to an App

Layer. Prerequisite Layers should only be used if  they are required, since it is possible that the prerequisite applications will

pull something into the Layer that is not required for the current application deployment, and which may cause conflict in

the future.

Reasons to consider using Prerequisite Layers:

The application you are installing requires another application during installation. For example, if  you are installing an

application that requires Java and you have Java in a separate layer.

The add-in or plugin you are installing adds settings to an application. For example, when installing an Office add-in, you

would use your Microsoft Office App Layer as a prerequisite layer.

Two applications modify the same registry key, and the second application must add to an existing key rather than replace

it. For example, Citrix Agent and Imprivata software both modify login keys in Windows.

Note: Some of these issues can also be handled by putting the two applications in the same layer.
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Platform Layer (for cross-platform deployments)

A Platform Layer is only required when creating App Layers on a hypervisor other than the one from which you imported

your OS Layer.

If  you are creating App Layers and Versions on a different hypervisor than the one you used to create your OS Layer, it is

strongly recommended that you create a Platform Layer containing the hypervisor tools and hardware settings you need

to seamlessly install and package applications in your environment.

Run Once Script

You can include a Run Once script in an App Layer. This allows you to run a script the first time any Layered Image that

includes the App Layer boots. If  the App Layer is elastically layered, the Run Once script runs when the App Layer Disk is

mounted. Run Once scripts are typically used for apps, such as MS Office, that require license activation on the first boot.

Prepare a new App Layer

Select Layers > App Layers and select Create Layer in the Action bar. This opens the Create Layer wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

For details, see more about these values below.

In the OS Layer tab, select the OS Layer you want to associate with this App Layer.

(Optional) In the Prerequisite Layers tab, if  the application you are layering requires other App Layers to be present during

installation, select the Include Prerequisite Layers check box, and pick the necessary App Layer(s).

Notes:

Prerequisite layers are used while installing applications, and are not included in the App Layer.

Prerequisite layers are not included by default when adding a new Version to this App Layer. So, when you add a new

Version to this App Layer, you must choose the Prerequisite Layers again, if  needed.

The App Layer you are creating and each of its Prerequisite Layers must be associated with the selected OS Layer.

In the Connector tab, choose a Platform Connector Configuration that contains the credentials for the platform where

you plan to build the Layer, along with the storage location. If  the configuration you need isn't listed, add a New Connector

Configuration and select it from this list.

Example: If  you're using the XenServer environment to create the Layer, select the XenServer connector with the

credentials and location required to access the location where you want to build the Layer.

In the Platform Layer tab you can select a Platform Layer containing the tools and hardware settings that you need to

install and package an application during Layer creation. This selection is only used during layer creation. Once created, the

Layer can be used in Layered Images published to any platform.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the application, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the App Layer, enter a comment if  required, and click Create Layer.

Any comments you enter will appear in the Information view Audit History. Once the Packaging Disk has been created, the
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Task bar displays instructions to navigate to the Packaging Machine in XenServer.

Next, you can log into the Packaging Machine for your Layer, and install the software for the layer on it.

Deploy a Packaging Machine in XenServer

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App Layer

task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenServer client.

Power on the Packaging Machine.

You can now install the applications for this layer on the Packaging Machine.

Deploy a Packaging Machine in XenServer

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App Layer

task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenServer client.

Power on the Packaging Machine.

You can now install the applications for this layer on the Packaging Machine.

Install the software on the Packaging Machine

When you've completed the Layer wizard, Unidesk creates a Packaging Machine in your environment, in the location defined

in the Connector Configuration. The Packaging Machine is a virtual machine where you install the software to be included in

the layer.

Note: The Packaging Machine is a temporary VM that will be deleted once the new Platform Layer has been finalized.

Log into the Packaging Machine

Log into your vSphere web client.

Back in the Unidesk Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App

Layer task to see the full Task Description.

Use the instructions in the Task Description to navigate to the Packaging Machine in your vSphere web client.

The Packaging Machine will be powered on.

Install the Application(s)

When installing your application(s) on the Packaging Machine, leave each application as you want users to see it when they

log in. The state of the applications when you finalize the layer is what users experience when they access the application.

More guidance about this is included in the steps below.

Remote log in to the Packaging Machine in vSphere. Be sure to log in with the User account you used to create the OS in

vSphere.

Install the applications, along with any drivers, boot-level applications, or files that the user will need with it.

If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart
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automatically.

Make sure the Packaging Machine is in the state you want it to be for the user:

If  the applications you install require any post-installation setup or application registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, it is important to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages you may see during the finalization process

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.
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Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

Open a command prompt as Administrator.

Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

Open a command prompt as Administrator.

Check status by running this command:

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the Layer

Once the software has been installed and the Packaging Machine has been verified and shut down, you are ready to

finalize the layer.

Note: When you finalize a Layer, Unidesk may delete the Packaging Machine to minimize storage space used.

When the Layer has been verified and is ready to finalize:

Return to the Management Console.

Select Layers >App Layers, and then the layer you just prepared.

Select Finalize in the Action bar. The Finalize wizard appears.

(Optional) On the Script Path wizard tab, you can enter the path to a Run Once Script located on a server on your network.

If  the App Layer is elastically assigned, the Run Once script will be executed the first time the app is used.

If  the App Layer is included in a Layered Image, the Run Once script will be executed the first time the Layered Image is

booted. 

Click Finalize to finish creating the Layer.

Monitor the Task bar to verify that the action completes successfully and that the Layer is ready to be deployed.
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Reference: create App Layer Wizard values

Layer Name - (Required) A name that will let you know what app(s) the layer will be used for.

Layer Description - (Optional) Description of the Layer

Version - (Required) This can be the version of the application or a version you assign to the Layer. This value is displayed in

the Details view of the Layer. Keep in mind that you'll add a new version to this layer whenever you update the app(s)

included in it, and this is where the version will be described.

Version Description - (Optional) Enter a description of the version.

Specify the Max Layer Size - Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 10 gigabytes. If  the application you are installing could eventually require more

space, change this to an appropriate value.
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User layer

Jun 29, 2017

User Layers let you persist user profile settings, data, and user-installed applications in non-persistent VDI environments.

User Layers are created when:

You set Elastic Layering on an Image Template to Application and User Layers, so that the Layered Image supports User

Layers.

A user logs in to their desktop for the first time, and a User Layer is created for them. From then on, the user's data and

settings are saved in the User Layer, along with any applications that the user installs locally on their desktops.

 

Before you start

Prerequisites

Create the OS Layer

Create a Platform Layer

Create App Layers

Adequate network bandwidth. Bandwidth and latency have a significant effect on the User Layer. Every write goes across

the network.

Allocate storage space for users' locally installed apps and the data and configuration settings for them. (This leaves the

main storage location solely for packaging layers, publishing Layered Images, and serving up Elastic Layers.)

Compatibility

Currently, User Layers are supported for the following platforms:

Operating systems:

Windows 7, 64-bit

Windows 10, 64-bit

Publishing platforms: VMware Horizon View and Citrix XenDesktop.

User Layer creation process

Enable User Layers in your Image Template:

Set Elastic Layering in the Image Template wizard on the Image Disk tab) to Application and User Layers.

Publish Layered Images using the above Image Template.

When a user logs on to their desktop for the first time, a User Layer is created for them.

User Layer size and location

The default size of a User Layer is 10 GB.

User Layers are created in the Users folder on the appliance's network file share, for example:

\\MyServer\MyShare\Users

Each user will have his/her own directory within the Users directory, and it will be named as follows:
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Users\domainIname\username\OS-Layer-ID-in-hex_OS-Layer-name\username.vhd

For example:

User's login name: jdoe

User's Domain: testdomain1

OS layer: MyOSLayer (ID is in hexidecimal format: 123456)

User Layer would be created in:

\\MyServer\MyShare\Users\testdomain1\jdoe\123456_MyOSLayer\jdoe.vhd

Upgrading existing User Layers to this Release

Once you upgrade the appliance to Release 4.2.0, if  you want to continue using existing User Layers, you'll need to move

them to new locations as described below in Upgrade User Layers created using a previous release.

Other Considerations

Before deploying User Layers, please consider the following guidelines and limitations.

The User Layer is delivered via the appliance's file share, therefore:

If  the host is disconnected from the User Layer storage, the user will have to log out and log in again to re-establish the

disk mount. The user will have to wait approximately 5 minutes because the user layer will be inaccessible.

Certain enterprise applications, such as MS Office and Visual Studio should be installed in Layers, not as user-installed

applications in the User Layer. In addition, the Elastic Layering limitations are applicable for User Layer. For more information

on Layering limitations, please see the Elastic Layering Limitations section.

Windows updates must be disabled on the User Layer.

VMware Horizon View:

View must be configured for non-persistent desktops, and the desktop must be set to Refresh at log off. Delete or refresh

the machine on log off. Example:

After logging off  with View set to Refresh Immediately, the desktop goes into maintenance mode. If  there is only one

machine in the pool, the pool will not be available until that machine has completed the refresh.

The first time a user logs into his/her desktop, a User Layer is created for the him/her.

If  there is problem loading the elastically assigned Layers for the user, they will still receive their User Layer.

If  you rename the user in AD, a new directory and User Layer will be created for the new name. To avoid this, rename the

directory on the file share and the VHD file in the directory structure to the new AD user name.

 

Add storage locations for user layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.
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Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The first storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's User

Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest priority

location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until that

point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the their User

Layer to the new highest priority location.

Create Storage Locations

To add a storage location:

Log into the management console.

Select System > Storage Locations.

Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

Select Add Storage Location, and enter a Name and Network Path for the new location.

On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to add

to the new storage location.

On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure security on user later folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:
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Publish layered images

Jun 29, 2017

The Citrix App Layering service lets you publish Layered Images as disks compatible with your platform. You can use a

Layered Image to provision servers, as you would with any other image.

About Layered Images

Layered Images are bootable images composited from Layers. Each Layered Image contains an OS Layer, a Platform Layer,

and any number of App Layers.

Creating and updating Layered Images

The way you specify which layers to include in a Layered Image is by saving the combination of layers you want for a

particular group of users in an Image Template. You then use this template to publish a Layered Image to your chosen

platform.

When you need to update the Layered Image, you simply edit the Image Template to add or remove layer assignments, and

publish a new version of the image.
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Connectors for publishing

Jun 29, 2017

When publishing Layered Images, you need a Connector Configuration that defines the location where you will publish the

images, preferably near the servers you intend to provision with the images. You can create as many Connection

Configurations as you need.

It is strongly recommended that Layered Images are published to the environment where the App Layering appliance is

installed, in this case, Azure. To do this, you need an Azure Connector Configuration to define the publishing location. If  you

don't yet have an Azure Connector Configuration, you can create one while in the process of publishing Layered Images.

Note: If  you decide to publish Layered Images on a hypervisor other than the one where the appliance is installed, you can

publish to the appliance's file share using the NFS Connector. Once the image is published, you can manually copy the file to

the desired location.

See Connector essentials for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/azure/configure/connector-essentials.html
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Azure Connector Configuration

Jun 29, 2017

A Connector Configuration contains the credentials and location information that the appliance needs to access a specific

location in Azure. For example, your organization may have one Azure account and several storage locations, and you will

need a Connector Configuration so the appliance can access each storage locations. For more about Connectors and

Connector Configurations, see Connectors and Connector Configurations.

 

When to add a Connector Configuration for Azure

When you create your first Layers, and later when you publish Layered Images for the first time, you will add a Connector

Configuration for each task, as described below.

Required Azure information

Your organization may have several Azure subscriptions. For the App Layering service to access your Azure subscriptions,

whether it's to import an OS Image or to publish a Layered Image, you must use the procedure below for each Azure

subscription that you want to connect to via the App Layering service.

 

Name - A name you enter for a new Connector Configuration.

Subscription ID - In order to deploy Azure virtual machines, your organization must have a subscription ID.

Tenant ID - An Azure Active Directory instance, this GUID identifies your organization's dedicated instance of Azure Active

Directory (AD).

Client ID - An identifier for the App Registration, which your organization has created for App Layering.

Client Secret - The password for the Client ID you are using. If  you have forgotten the Client Secret, you can create a new

one. Note: Each time you use a new subscription and Tenant ID, you must enter a new Client Secret. This is because client

secrets are logically associated with Azure tenants.

Storage Account Name - The Azure storage account you want to use when storing Azure virtual machine disks. This name

must adhere to Azure storage account naming restrictions. For example, the storage account name cannot contain

uppercase characters.

 

You must either create a storage account through the portal or use an existing storage account that fits the following

criteria. The account:

 

Cannot be a classic storage account.

Should be a separate storage account from the one used for the appliance. This new storage account will be used during

Layer creation and Layered Image publishing.
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Must be in the Azure location where you will deploy VMs.

Must be one of the following types:

Standard Locally Redundant storage (LRS)

Standard Geo-Redundant storage (GRS)

Standard Read-Access Geo-Redundant storage (RAGRS)

Can be located in any resource group, as long as the resource group's location is the same as the account's location.

Set up and retrieve your Azure credentials

To retrieve Azure credentials when adding a new Azure Connector Configuration:

 

Identify your Azure Subscription ID.

Create an App Registration in Azure Active Directory.

Retrieve the Azure Tenant ID, Client ID, and Client Secret from the App Registration.

Create a new storage account, or use an existing one inside the subscription. The output of this is the Storage Account

Name.

 

Identify the correct Azure Subscription ID

Go to the Azure portal at https://portal.azure.com

In the left sidebar, click Subscriptions.

If  this isn't listed, click More Services and search for Subscriptions in that window.

 

In the Subscriptions window, locate and click the Azure subscription you want to use for your deployment.

On the next menu, click Overview. The Subscription ID should be displayed in the top left of the window that appears.

Enter the information in the Subscription ID box in the App Layering Azure Connector UI.

Create an App Registration

You must create a new App Registration for each Azure Subscription you want to create App Layering connectors for. If

you want to have multiple Azure connectors in the same subscription, you can reuse the same App Registration for those.

 

Go to the Azure portal at https://portal.azure.com.

In the left sidebar, click Azure Active Directory. If  this isn't listed, click More Services and search for Azure Active Directory.
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In the menu that appears, click App registrations.

Click New application registration in top of the new window.

A new form will appear to fill out. For Name, enter something like Citrix App Layering Access.

For Application type, select Web app / API.

For Sign-on URL, enter http://nothing.

Click Create.

Back in the list of App registrations, click the new app registration that you just created. It will have the name you just

entered.

In the new window that appears, you should see the Application ID listed near the top. Enter this value into the Client ID

box in the App Layering Azure Connector UI.

In the Settings menu on the right, click Properties.

Find the App ID URI field in the Properties window that appears.

The Tenant ID you need is in the middle of the App ID URI.

The Tenant ID is everything after the https:// portion of the App ID URI, up until the next /

For example, if  your App ID URI is this:

https://helloworld.onmicrosoft.com/1234-5432-43421

 

Then your Tenant ID is this:

helloworld.onmicrosoft.com

 

Enter this Tenant ID into the Tenant ID box in the App Layering Azure Connector UI.

Back in the Settings menu, click Keys.

In the Keys window that appears, click Key description and enter something like App Layering Key 1

Click the dropdown menu under Expires and select any value.

Click Save on the top of the Keys window.

The key value will be displayed under Value. This is your Client Secret. Enter this value into the Client Secret box in the App

Layering Azure Connector UI.

Note: This key will never be displayed again after you close this window.

This key is sensitive information and should be treated like a password. If  someone gets access to this value, they can

potentially gain administrative access to your Azure subscription.
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Open the settings of the app registration you just created in “Azure Active Directory” > App registrations > [name you just

entered] > “Settings” > “Properties”

Click Subscriptions in the left sidebar. This will close all open windows and bring you to the Subscriptions window. If

Subscriptions isn't listed, click More Services and search for Subscriptions in that window

Click the subscription you are using for this connector.

In the menu that opens, click Access Control (IAM)

In the window that appears, click Add on the top bar.

The Add permissions form should appear on the right. Click the dropdown for Role and select Contributor.

In the Select box, type Citrix App Layering Access or whatever the name you entered for the Application registration (back

in step #5) and press Enter.

Citrix App Layering Access (or the name you used) should appear below. Click it.

Click Save on the bottom of this form.

You have now set up an Azure app registration that has read/write access to your Azure subscription.

 

Use an existing Storage Account, or create a new one

The storage account is where the App Layering software stores all images imported from and published to Azure (VHDs).

 

Use existing storage account

You can use an existing storage account if  you want. It must meet these requirements:

 

Must be a Standard (not premium) account.

Cannot be a classic storage account.

Must be in the same subscription you've already used in this connector.

If  all these requirements are met, enter the Name of the storage account into the Storage account name field in the App

Layering Azure Connector UI.

 

Create new storage account

If  you don't have a storage account yet, you must create one.

 

Click Storage accounts in the left sidebar. (Do not select Storage Accounts classic.)
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If  this isn't listed, click More Services and search for Storage accounts there.

 

In the Storage accounts window that appears, click Add.

For Name, enter a name that you'll remember.

For Deployment model, select Resource manager.

For Account kind, select General purpose.

For Performance, select Standard.

For Replication, any value is OK. Read more about the choices here.

For Storage service encryption, select Disabled.

For Subscription, select the same subscription you have been using throughout this process.

For Resource group, select Create New and enter a name that is similar to your Storage account's name.

For Location, select a location that is closest to your organization.

Click Create.

In the App Layering Azure Connector UI, enter the Storage account name.

Test the Connector

Once you've entered the right values into all the fields in the Connector UI, click the Test button. If  everything has been set

up correctly, this test should pass, and you can save your Connector Configuration.

 

What to do if  your Azure Client Secret is lost

If  your Azure Client Secret is lost, you can generate a new one using the steps to get your Client Secret when you Create

an App Registration.

Add a Connector Configuration

To add a new Connector Configuration:

In the wizard for creating a Layer or for adding a Layer Version, click the Connector tab.

Below the list of Connector Configurations, click the New button. This opens a small dialog box.

Select the Connector Type for the platform and location where you are creating the Layer or publishing the image. Then

click New to open the Connector Configuration page.

Complete the fields on the Connector Configuration page. For guidance, see the above field definitions.

Click the TEST button to verify that the appliance can access the location specified using the credentials supplied.

Click Save. The new Connector Configuration should now be listed on the Connector tab.
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Azure data structure (Reference)

The Azure data structure is as follows:

 

Tenant

 

Tenant ID

App Registration

Client ID

Client Secret

Subscription

Subscription ID

Storage Account

Storage Account Name

where:

 

Tenant is your Azure Active Directory instance that users and applications can use to access Azure. The Tenant is identified

by your Tenant ID. A Tenant can have access to one or more Azure Subscriptions.

The Azure Active Directory Tenant contains two types of accounts.

A User Account for logging into the Azure portal (portal.azure.com).

An App Registration for accessing the subscription has a Client ID.

The Client ID has a Client Secret, instead of a password.

Users can generate the Client Secret, and delete it.

An Azure Subscription contains everything that can be created in Azure, except for user accounts.

A Subscription contains Storage Accounts. This is where App Layering VHDs are stored. It is identified by a Storage Account

Name.
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Network File Share connector configuration

Jun 29, 2017

When the App Layering appliance (Enterprise Layer Manager) is installed, you set up a network file share that you can then

use as a Connector Configuration when creating layers and publishing Layered Images. This Connector Configuration

contains the appliance's Network File Share credentials and location so you can deploy a Packaging Machine to the File

Share when creating layers, or publishing Layered Images.

Each Connector Configuration is set up to access a storage location via a specific account.

Network File Share location

The name of the Network File Share Connector Configuration includes its location. Look for the App Layering folder at the

top level of the Network File Share. For details, see Configure a file share for the App Layering Appliance.

When you publish Layered Images to a provisioning service for which we do not yet have a Connector, you can select the

Network File Share Connector Configuration. You can then copy the Layered Image from the network file share to the

correct location for provisioning servers.

When to select the Network File Share as your Connector Configuration

When you publish Layered Images to a provisioning service for which we do not yet have a Connector, you can select the

Network File Share Connector Configuration. You can then copy the Layered Image from the network file share to the

correct location for provisioning servers.
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Create image templates

Jun 29, 2017

You can create Image Templates to use for publishing Layered Images to your target platform. You can then use the

published Layered Image to provision servers on your chosen publishing platform. An Image Template stores your Layer

assignments, along with a Layer icon and description. You can easily edit an Image Template and use it to publish new

versions of your Layered Images.

Prerequisites

To create an Image Template you need:

A Platform Layer containing the software required for your environment.

Create an Image Template

To create an Image Template:

1. In the App Layering Management Console (UMC), select the Images module, then click Create Template. This opens the

Create Template wizard.

2. In the Name and Description tab, enter a Name for the template and notes in the Description f ield, so you can identify

the template when choosing one for publishing a Layered Image.

3. In the OS Layer tab, select one of the Available OS Layers. If  there is more than one Layer Version, the most recent

version is selected by default. You can choose an older version by expanding the Layer and choosing a different one.

4. In the App Assignment tab, select the App Layers to include in the Layered Images that you publish using this template.

5. On the Connector tab, select the Connector Configuration that includes the information needed to publish the Layered

Image to the correct location.

If  the Connector Configuration you need is not available, add one. Click New, choose the Connector Type, and follow

the instructions to Create a Connector Configuration.

6. On the Platform Layer tab, select the Platform Layer that contains the tools and hardware settings required to publish

Layered Images to Azure RDS.

7. (Optional) On the Layered Image Disk tab, edit the following fields, if  needed:

Layered Image Disk File name. Enter a name for the Layered Image Disk.

Layered Image Disk Size. The default disk size of 100 GB is recommended.

Elastic Layering - Controls whether Elastic Layering on this Layered Image is allowed. Select yes to allow Elastic Layers

for users of this Layered Image.

8. On the Confirm and Complete tab, enter any comments you would like for this layer, and click Create Template.

The new Template icon appears in the Unidesk Images module.

Next step

Publish Layered Images (Azure RDSH)

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_admin_az4/itoc_3_admin_manage_layering_az4/layered_images_manage_template_az4
https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_publish_az4/itoc_3_connectors_publishing_az4/connector_config_fields_az4
https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_publish_az4/itoc_3_publish_layered_images_az4/layered_images_publish_az4
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Publish to Azure RDSH

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to your chosen platform and use them to provision systems.

 

Prerequisites

To publish Layered Images, you need:

 

One or more Image Templates.

Publish a Layered Image

To use an Image Template to publish a Layered Image:

 

In the Images module, select one or more Image Templates that you want to publish.

 

From the Action menu, select Publish Layered Image.

 

Make sure you are logged onto the Azure portal before continuing.

 

On the Confirm and Complete page, select Publish Layered Images. For each Image Template this starts a task called,

Publishing Layered Image. When each task completes, the task description provides the information you need to navigate

to the image in your environment.

 

In a web browser, log into the Azure portal and use the link in the Task description (example shown below) to open to the

location where the image has been published.

 

 

 

In the expanded Packaging Disk Task shown above, click the link to the session host template in the Azure portal. This

opens the Microsoft Azure portal to the Custom deployment template where you can provision Azure RD Session Hosts.
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The next section explains how to complete the template to provision a session host.

Provision a Session Host

In the Custom deployment template, enter the information to provision a Azure RD Session Host.

 

Note: All RDSH Session Hosts must be manually restarted before you can add RDS roles to Session Hosts using PowerShell.

 

Check the Edit Template settings, and adjust as needed.

Complete the Session Host Parameters shown below, using the host's Fully Qualified Domain Name (FQDN).

 

IMPORTANT: You must include the Domain Name (not fully qualified) in the Admin User Name field in the format,

mydom1\username. And, in the Domain Name field, enter the Fully Qualified Domain Name, for example, mydom1.local.

 

 

 

Select the Azure Resource Group.

 

 

 

Specify the Resource Group Location.

 

IMPORTANT: Be sure that the value for the Resource group location matches the Storage account location that you

configured in the Platform Connector Configuration. If  these locations are not the same, the Packaging Machine will not

be deployed and you will have to reattempt deployment.

 

Review the legal terms, and if  you accept them, click Create. This creates a Session Host provisioned with the Layered

Image in Azure.

While Azure creates the virtual machine, you can track the progress under Virtual Machines in the hub menu.

Next Step
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The next step is to power off  the Session Host, power it back on, and add it to an RDS collection. Please see the TechNet

Reference for details.
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Publish to Network File Share

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to the ELM's Network File Share, copy the Image(s) to your target

environment, and use them to provision Session Hosts in your environment. This is especially useful if  Unidesk does not yet

include Connectors for the platform where you're provisioning systems.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

The Image Template you select should have the correct OS Layer and any App Layers you want in the Layered Image.

Publish a Layered Image

To use an Image Template to publish a Layered Image:

1. In the Images module, select one or more Image Template that you want to publish.

2. From the Action menu, select Publish Layered Image.

3. On the Confirm and Complete page, select Publish Layered Images. For each Image Template this starts a task

called, Publishing Layered Image. When each task completes, the task description provides the information you need to

navigate to the image in your environment.

4. Use the information in the expanded Packaging Disk Task shown above to navigate to the location where the Layered

Image has been published.

Important
When publishing a Layered Image to a file share, there will be one VMDK file option, and it will generate two

files: layer.vmdk and layer-flat.vmdk. You need to upload both of them.

Next Step

Once the Layered Image is published to the file share, you can use the image to provision servers in your environment.
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Assign layers

Jun 29, 2017

Layer assignment essentials

To deliver App Layers to users, you can:

Add App Layers to one or more Image Templates, then use the templates to publish Layered Images for use in

provisioning servers.

Elastically assign the App Layers to users, either through a direct user assignment, or via a machine assignment that

makes the layers available to users who log into the machine.

You can make these assignments, as long as each user is assigned a single instance of the Layer, either as part of an image

or as an elastic layer.

Do you want to assign this App Layer to one or more Image Templates for inclusion in your Layered Images? Or, do you

want to assign App Layers to users as Elastic Layers?

Add an App Layer to Image Templates

An Image Template is a stored selection of Layers and settings that you use to publish Layered Images. At minimum, an

Image Template contains an OS Layer, Platform Layer, and settings. Ideally, each template also contains your choice of App

Layers for a particular image, for example, an image suited for the users served by a particular silo. Once you publish a

Layered Image, you can provision systems using the image.

When you create a new App Layer, you can assign the App Layer to one or more Unidesk Image Templates, and then use

the templates to publish Layered Images that include the layer. This article explains how to assign an App Layer to one or

more Image Templates, and update the assignments when you update the Layer.

When you first update an App Layer, the new Layer Version is not assigned to any Image Templates, so you'll need to

update the Layer Assignments. Updating the assignments allows you to assign different Versions of the Layer to different

Image Templates. You cannot assign an App Layer to
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Important
When assigning App Layers, be sure to avoid assigning the app elastically to a user, if the app is already in the Layered Image that

the user gets.

Prerequisites

One or more App Layers.

One or more Image Templates.

Add an App Layer Assignment to one or more Image Templates

1. Log into the Unidesk Management Console (UMC) as an Admin user, and select Layers > App Layers.

2. Select an App Layer to include in one or more of your Image Templates, and click Add Assignments.

3. In the wizard that opens, select the App Layer that you want to assign to templates.

4. On the Image Template Assignment tab, select the templates in which you want to include this App Layer Version.

5. Skip the Elastic Assignment tab.

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When you open each of the Image Templates you will see the App Layer Version you just assigned to the template.

Update App Layers and Image Template Assignments

When you update an application by adding a new Version to the App Layer, the new Layer Version will not inherit the

original Layer Assignments. You need to assign the new App Layer Version.

1. Log into the UMC and select Layers > App Layers.

2. Select the App Layer that has been updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new App Layer Version.

5. Click the Image Template Assignment  tab, and select the Image Templates to which you want to assign the new Layer

Version .

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out

names may appear. These Image Templates have already been assigned the Version.

6. Skip the Elastic Assignment tab.

7. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Remove Template Assignments

When you remove an App Layer's Template Assignments, the assignments for all versions of the Layer are removed. If  you

want to remove the assignments for a specific Version of the Layer, select Update Assignments instead.
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1. Log into the UMC and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Assign App Layers to users elastically (Elastic Layers)

Assign apps elastically

Wouldn't it be nice to drastically reduce the number of images you have to manage? What if  you could leave apps that only

a few users need out of your base image? And, assign the layers to specific users elastically on top of the base image. With

the Elastic App Layers feature, you can do just that.

An Elastic App Layer is a Unidesk App Layer that you configure to be delivered to specific users and groups, based on user

entitlements, when the users log onto their session hosts or standalone desktops. With Elastic App Layers, you can give

each user his/her own unique set of applications in addition to the base Layered Image that is used across sessions in the

case of session hosts), and across floating pools/shared groups in the case of desktops.

As this diagram shows, once you add Elastic Assignments to an App Layer, a copy of the Layer is stored in the ELM's

Network File Share, and delivered to individual AD users and groups on-demand, in addition to the Layers that they receive

via the base image.

To use this feature, you'll add Elastic Assignments specifying which users and groups should receive each of the App Layers

that you would like to leave out of your base images. You'll then publish your base image(s) with the Elastic Layering For
Session Hosts selected.

How users access Elastic Layers assigned to them
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A user receives an Elastic Layer in the following cases:

The user (an AD user in the Unidesk Management Console) is assigned the Layer.

An AD group that the user belongs to is assigned the Layer.

A machine that the user logs into is a member of an AD Group that receives the Elastic Layer.

A machine that the user logs into is associated (via the UMC) with an AD Group that is assigned the Layer via the UMC.

If more than one version of the same Layer is assigned to a user

If  a Layer is assigned directly to the user and indirectly to one or more of the user's groups, the user receives the most

recent version of the Layer assigned directly to her/him. For example, if  a user is assigned Version 2, and a group that the

user belongs to is assigned Version 3, the user will get Version 2.

If  the user is assigned a Layer via one or more group assignments, the user receives the most recent version of the Layer.

If a user has an App Layer in their Layered Image, and the Layer is also assigned to
them elastically

If  a user has an App Layer in the Layered Image and the user is also assigned the Layer elastically, they will receive the

Elastic Layer, even if  the version in the base image is more recent.

Prerequisites and limitations

Prerequisites

The ELM's Network File Share must be configured correctly:

The Share must be configured using SMB technology. When using Elastic Layer assignments, NFS technology is not
supported.

The Share must be set up by the admin to be readonly for all users except for the one configured in the ELM. This

secures the Layers and other f iles stored on the Share.

The User named in this configuration must have Read/Write permissions on the root of the network f ile share.

Select System > Settings and Conf iguration and scroll to Network File Share.

Make sure that any users who will be assigned Elastic Layers have Read only access for the root directory of the

Network File Share.

.NET Framework 4.5 is required on any Layered Image where Elastic Layers are enabled.

The App Layers you want to elastically assign.

Note
App Layers must be created using the same OS Layer used to create the Layered Image that you enable to deliver the Elastic App

Layer to users.

Elastic Layering Limitations

You cannot elastically layer the following:

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_apps_create_co4
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Microsoft Office Add-ons and extensions in individual Unidesk Layers. A user must have all of their add-ons in one Layer.

Note: Please use the recipe for elastically layering MS Office.

Applications with drivers that use the driver store. For example, a printer driver.

Applications that modify the network stack or hardware. For example, a VPN client.

Applications that have boot level drivers. For example, a virus scanner.

Enable Elastic Layering in the base image

When you publish the Layered Image that the users will log into to get the Elastic App Layer(s):

1. In the Image Template Wizard, on the Layered Image Disk tab, select Elastic Layering For Session Hosts.

2. Finish publishing the Layered Image.

3. Provision your Session Hosts with the new base image.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Run the Elastic Fit Analyzer on App Layers (Unidesk
Labs)

Before assigning an App Layer elastically, use the Elastic Fit Analyzer to determine the likelihood that the Layer assignment

will be successful.

Elastic Fit Analysis

In the Layer Details, the Elastic Fit rating indicates how likely it is that the Layer will work when elastically assigned.

Good Elastic Fit . This layer should work when deployed elastically.

Poor Elastic Fit . This layer will probably not work when deployed elastically, or may behave differently than when it

is deployed in a Layered Image.

Elastic Fit Details

You can learn more about the Elastic Fit of a Layer by expanding the Elastic Fit Analysis. If  the Elastic Fit is less than ideal,

the list of violated rules will be displayed.

Low Severity Warning. This is unlikely to cause any change in behavior or functionality for most applications.

Medium Severity Warning. This may cause minor changes in behavior or functionality for some applications.

High Severity Warning. This is likely to cause signif icant changes in behavior or functionality for many applications.
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Enable Elastic Fit in Unidesk Labs

To use this Unidesk Labs feature, you must enable it. To enable Elastic Fit:

1. In the Unidesk Management Appliance (UMC), select System > Settings and Conf iguration.

2. Click Edit  Unidesk Labs.

3. Select the Elastic Fit  check box.

4. Click Save.

Analyze an App Layer for Elastic Fit

All new Layer Versions will be analyzed for elastic layering compatibility when they are finalized. To analyze existing App

Layers for Elastic Fit:

1. Log into the Unidesk Management Console (UMC) .

2. Select Layers > App Layers.

3. Select the Layer to analyze, and click Analyze Layer.
4. On the Select Versions tab, choose the Layer Versions to analyze.

5. On the Confirm and Complete tab, click Analyze Layer Versions. The analysis takes seconds.

6. To see the Elastic Fit Analysis, select the App Layers module, move the mouse pointer over the Layer icon and click

the Info  icon.

7. Expand the Version Information for each Layer Version, and look for the Elastic Fit rating.

8. For a detailed report, expand the Elastic Fit Details. If  the Elastic Fit is less than ideal, the list of violated rules will be

displayed.

9. You can display the AD tree and hide the violated rules by clicking a button acknowledging that the layer is unlikely to

work as expected.

Upgrading from Earlier Releases

After upgrading from an earlier Unidesk release, the Elastic Fit Detail shows that any existing Layer Version(s) have not been

analyzed. Until you run the analysis on existing Layer Versions, the Versions will have a single High severity Elastic Fit Detail,

and a Poor Elastic Fit.

Elastically assign an App Layer to AD Users and Groups

The first time you assign an App Layer elastically, we recommend starting with an app like Notepad++ or GIMP, because

they are simple to .

1. Log into the Unidesk Management Console (UMC) as an Admin user, and select Layers > App Layers.

2. Select an App Layer that is not going to be included in the base image, and select Add Assignments.

3. In the wizard that opens, select the Version of the App Layer that you want to assign users.

4. Skip the Image Template Assignment  tab. This tab is for assigning the Layer to an Image Template.

5. In the Elastic Assignment tab, select the users and groups who should get this App Layer.

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Elastically assign an App Layer to users via machine
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assignments and associations

Any machine running the Unidesk Layering Service (ULayer.exe) can have Elastic Layers assigned to it. You can accomplish

this by either adding the machine to or associating it with the AD Group, and then elastically assigning the App Layers to

the AD Group.

The Layers assigned to the machine will be available to every User who successfully logs into that machine. The Unidesk

Layering Service will scan for changes to the machine's AD group memberships and associations every 10 minutes. When the

users log in, they should see an icon for each Elastic App Layer they've been assigned.

Use Active Directory to add the machine to the AD Group

Assuming you have a published Layered Image booted in your environment, you can add the machine to an AD Group, and

assign Elastic Layers to the AD Group.

1. Use Active Directory (AD) to add the machine to an AD Group.

2. Select an App Layer that is not going to be included in the base image, and elastically assign the Layer(s) to an AD Group.

3. You can wait for AD to propagate the changes and be recognized by the Unidesk Layering Service, or you can force the

Unidesk Layering Service to update its list of machine groups by doing one of the following:

Wait for the Unidesk Layering Service to detect the changes (within 10 minutes by default).

Restart the Unidesk Layering Service.

Reboot the Unidesk Layering Service Machine.

Execute the refresh.groups command:

C:\Program Files\Unidesk\Layering Services\ulayer.exe refresh.groups

Example

You start with an AD User, and AD Group, and a machine that you provisioned using a Layered Image.

AD User: Kenya
Kenya has no elastic assignments.

AD Group: Marketing
The Marketing group includes the member Kenya.

Machine: ElasticTestMachine
The ElasticTestMachine base image includes the MS Office App Layer.

In this example, you elastically assign the Chrome App Layer to ElasticTestMachine:

Code COPY

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co4#Assign
javascript:void(0)


© 1999-2017 Citrix Systems, Inc. All rights reserved. p.213https://docs.citrix.com

1. In AD, you add the machine ElasticTestMachine to the Marketing AD Group.

2. In the Unidesk Management Console (UMC) you elastically assign the Chrome App Layer to the Marketing Group.

3. When Kenya, who is part of the Marketing group, logs into ElasticTestMachine, she receives both the MS Office App
Layer, which is in the base image, and the Chrome App Layer.

4. When any user who is not in the Marketing group logs into ElasticTestMachine, they also receive both

Layers: MS Office because it is in the base image, and Chrome because the ElasticTestMachine is a member of

the Marketing AD Group.

Use the UMC to associate the machine with an AD Group

Associating a set of machines with an AD Group allows any machine running the Unidesk Layering Service to have Layers

elastically assigned to it via AD group membership.

Elastic Layers granted via Machine association can be thought of as extending the layers assigned to a user. For example, if

a machine matches multiple Machine Associations, only the unique layers will be added to the ones the user already has.

In the UMC, you use asterisk (*) wildcards in a machine name pattern to specify a set of machine names. For example:

Machine name pattern Matches these names Does not match these names

machine*
machine01

machineindetroit

amachine

localtestmachine

*machine
amachine

localtestmachine

machine01

machineindetroit

ky*eng
ky02359eng

kytesteng

01ky_eng

testky01eng

*eng*

eng01

1eng

1eng01

en01

1en

1en01

You can create Machine Associations before or after elastically assigning App Layers to the AD Group. Also, the machines

do not need to exist when you add the associations, as the associations exist within Unidesk only, and AD is not aware of

them.

Associate a set of  machines with an AD group

1. Log into the Unidesk Management Console (UMC) as an Admin user, and select Users > Tree.

2. Expand the Tree, select the appropriate Group and click Edit Properties in the Action bar. This opens the Edit Group

Wizard.

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co4#Assign
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3. Select the checkbox, Associate machines with this AD Group. This reveals the Machine Name Pattern field:

4. Specify a set of machines to associate with the AD group by entering a machine name pattern. For examples, see the

above table of Machine name patterns.

5. On the Confirm and Complete tab, select Update Group. Notice the shape of a computer monitor superimposed over

the group icon. This indicates that machines are associated with the group.

When you click the group's  icon, the Detail view now includes a field called, Associate With Machines where the

pattern.

Example

You start with the machine, Mach1, the AD Group, MachineGroup, and the App Layers for Firefox and MS Office.

Machine: Mach1
AD Group: MachineGroup
App Layers: Firefox, MS Office

Further, you have elastically assigned the Firefox and MS Office Layers to the AD Group.

If  you add a Machine Association to MachineGroup with a name pattern of "Mach*", when any domain user logs

into Mach1, they will receive the Firefox and MS Office Elastic App Layers.

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_notchecked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_checked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_details.png
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Manage Elastic Assignments

You can:

View a user's Elastic Layer assignments.

Update an App Layer and elastically assign the new Version of the Layer.

Remove Elastic Assignments.

Debug an Elastic Assignments.

View a user's Elastic Layer assignments

1. Log into the UMC and select Users > Tree.

2. Select an AD User or Group, and click the "i" icon to the right of the name. If  the user or group is assigned any Elastic

Layers, the Layers are listed just below the user's or group's profile information in the Details window that appears.

Update an App Layer and its Elastic Assignments

You've added Elastic Assignments to an App Layer, and users are accessing the app as expected. A new version of the

application is released, so you update it by adding a new Version to the Layer. Now you need to assign the new version to

the users who have the Layer.

1. Log into the UMC and select Layers > App Layers.

2. Select the elastically assigned App Layer that you just updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new Version.

5. Skip the Image Template Assignment tab.

6. In the Elastic Assignment tab, there's a list of Users and Groups who have been assigned a different version of the

selected Layer. Select the users and groups to whom you want to assign the new Version of the Layer.

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show AD users and groups already at this version. A list of grayed

out names may appear. These users have already been assigned the Version.

7. On the Confirm and Complete tab, verify the Users and Groups selected to receive the new Version, and click Update
Assignments.

Remove a Layer's Elastic Assignments

1. Log into the UMC and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.
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Debug an Elastic Layer

If  you have an Elastic Layering issue, you can diagnose the problem by finding out whether the layer is being delivered, and if

so, whether it is working correctly. If  needed, collect data for Unidesk Support, as described here.

Is this a Delivery issue?

Are the things you'd expect to see if  this app were installed actually there as expected?

Do you see the f iles and registry entries for the layer?

If  the app is supposed to be in the Start menu, is it there?

If  there should be a shortcut for the app on the user's desktop, is there one?

If  you discover that app delivery is an issue, you can collect the following data, open a case, and send the data to Unidesk

Support.

1. Collect the data from these logs:

Windows App Event log –  In the Windows Event Viewer under Windows Logs, export the Application event log as an

EVTX f ile.

Unidesk Layering Service log (ulayersvc.log) –  C:\ProgramData\Unidesk\Logs\ulayersvc.log

2. Collect the values of these Registry keys:

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:AssignmentFile

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:RepositoryPath

3. Collect the contents of the Assignment (ElasticLayerAssignments.json) and Layers (Layers.json) files from the Repository

Path.

4. Contact Support.

Is this an operational issue?

One of these issues could indicate that this is an Elastic Layering issue:

The app is being delivered but doesn't launch correctly.

An operation within the app doesn't work correctly.

A licensing problem or a security issue.

The app launches, but then misbehaves, for example, it crashes on startup, or starts up but doesn't work right.

If  the problem with the Layer is operational, test the App Layer in the base image to rule out general layering issues:

1. Add the App Layer to an Image Template, and publish a Layered Image that includes the App Layer.

2. Log in as a user who is not assigned the Layer elastically, and make sure that the application is operational in the base

image.

3. Contact Support with your f indings.

Not finding what you're looking for? You can...

Ask the community >

Open a support case >

https://discussions.citrix.com/forum/1671-app-layering/
https://support.citrix.com/search?searchQuery=%3F&lang=en&sort=cr_date_desc&prod=Citrix App Layering
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Add App Layers to Image Templates

Jun 29, 2017

An Image Template is a stored selection of Layers and settings that you use to publish Layered Images. At minimum, an

Image Template contains an OS Layer, Platform Layer, and settings. Ideally, each template also contains your choice of App

Layers for a particular image, for example, an image suited for the users served by a particular silo. Once you publish a

Layered Image, you can provision systems using the image.

When you create a new App Layer, you can assign the App Layer to one or more Unidesk Image Templates, and then use

the templates to publish Layered Images that include the layer. This article explains how to assign an App Layer to one or

more Image Templates, and update the assignments when you update the Layer.

When you first update an App Layer, the new Layer Version is not assigned to any Image Templates, so you'll need to

update the Layer Assignments. Updating the assignments allows you to assign different Versions of the Layer to different

Image Templates. 

Important
 When assigning App Layers, be sure to avoid assigning the app elastically to a user, if the app is already in the Layered Image that

the user gets.

Prerequisites

One or more App Layers.

One or more Image Templates.

Add an App Layer Assignment to one or more Image Templates

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer to include in one or more of your Image Templates, and click Add Assignments.

3. In the wizard that opens, select the App Layer that you want to assign to templates.

4. On the Image Template Assignment tab, select the templates in which you want to include this App Layer Version.

5. Skip the Elastic Assignment tab.
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6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When you open each of the Image Templates you will see the App Layer Version you just assigned to the template.

Update App Layers and Image Template Assignments

When you update an application by adding a new Version to the App Layer, the new Layer Version will not inherit the

original Layer Assignments. You need to assign the new App Layer Version.

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer that has been updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new App Layer Version.

5. Click the Image Template Assignment  tab, and select the Image Templates to which you want to assign the new Layer

Version .

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out

names may appear. These Image Templates have already been assigned the Version.

6. Skip the Elastic Assignment tab.

7. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Remove Template Assignments

When you remove an App Layer's Template Assignments, the assignments for all versions of the Layer are removed. If  you

want to remove the assignments for a specific Version of the Layer, select Update Assignments instead.

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.
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Assign App Layers to users elastically (Elastic Layers)

Jun 29, 2017

Assign apps elastically

Wouldn't it be nice to drastically reduce the number of images you have to manage? What if  you could leave apps that only

a few users need out of your base image? And, assign the layers to specific users elastically on top of the base image. With

the Elastic App Layers feature, you can do just that.

An Elastic App Layer is an App Layer that you configure to be delivered to specific users and groups, based on user

entitlements, when the users log onto their session hosts or standalone desktops. With Elastic App Layers, you can give

each user his/her own unique set of applications in addition to the base Layered Image that is used across sessions in the

case of session hosts), and across floating pools/shared groups in the case of desktops.

As this diagram shows, once you add Elastic Assignments to an App Layer, a copy of the Layer is stored in the appliance's

Network File Share, and delivered to individual AD users and groups on-demand, in addition to the Layers that they receive

via the base image.

To use this feature, you'll add Elastic Assignments specifying which users and groups should receive each of the App Layers

that you would like to leave out of your base images. You'll then publish your base image(s) with the Elastic Layering For
Session Hosts selected.

How users access Elastic Layers assigned to them

When users log into their Session or Desktop, icons for their Elastic Layers will appear as shortcuts on the desktop.

A user receives an Elastic Layer in the following cases:

The user (an AD user in the Management Console) is assigned the Layer.

An AD group that the user belongs to is assigned the Layer.

A machine that the user logs into is a member of an AD Group that receives the Elastic Layer.

A machine that the user logs into is associated with an AD Group that is assigned the Layer via the Management

Console.
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If  more than one version of  the same Layer is assigned to a user

If  a Layer is assigned directly to the user and indirectly to one or more of the user's groups, the user receives the most

recent version of the Layer assigned directly to her/him. For example, if  a user is assigned Version 2, and a group that the

user belongs to is assigned Version 3, the user will get Version 2.

If  the user is assigned a Layer via one or more group assignments, the user receives the most recent version of the Layer.

If  a user has an App Layer in their Layered Image, and the Layer is also assigned to them elastically

If  a user has an App Layer in the Layered Image and the user is also assigned the Layer elastically, they will receive the

Elastic Layer, even if  the version in the base image is more recent.

Prerequisites and limitations

Prerequisites

The appliance's Network File Share must be configured correctly:

The Share must be configured using SMB technology. When using Elastic Layer assignments, NFS technology is not
supported.

The Share must be set up by the admin to be readonly for all users except for the one configured in the appliance.

This secures the Layers and other f iles stored on the Share.

The User named in this configuration must have Read/Write permissions on the root of the network f ile share.

Select System > Settings and Conf iguration and scroll to Network File Share.

Make sure that any users who will be assigned Elastic Layers have Read only access for the root directory of the

Network File Share.

.NET Framework 4.5 is required on any Layered Image where Elastic Layers are enabled.

The App Layers you want to elastically assign.

Note
App Layers must be created using the same OS Layer used to create the Layered Image that you enable to deliver the Elastic App

Layer to users.

Elastic Layering Limitations

You cannot elastically layer the following:

Microsoft Office Add-ons and extensions in individual Layers. A user must have all of their add-ons in one Layer. Note:

Please use the recipe for elastically layering MS Office.

Applications with drivers that use the driver store. For example, a printer driver.

Applications that modify the network stack or hardware. For example, a VPN client.

Applications that have boot level drivers. For example, a virus scanner.

Enable Elastic Layering in the base image
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When you publish the Layered Image that the users will log into to get the Elastic App Layer(s):

1. In the Management Console, select the Image Template used to generate the Layered Image.

2. Select the Images tab.

3. Select the Image Template on which you want to enable Elastic Layering, and select Edit Template from the Action bar.

The Edit Template wizard opens.

4. On the Layered Image Disk tab, select a value for the Elastic Layering option.

Application Layers Only - To enable Elastic Layering for your App Layers.

Application and User Layers - To enable both Elastic Layering for your App Layers, and User (personalization) Layers.

5. Finish publishing the Layered Image.

6. Provision your Session Hosts with the new base image.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Run the Elastic Fit Analyzer on App Layers (App
Layering Labs)

Before assigning an App Layer elastically, use the Elastic Fit Analyzer to determine the likelihood that the Layer assignment

will be successful.

Elastic Fit Analysis

In the Layer Details, the Elastic Fit rating indicates how likely it is that the Layer will work when elastically assigned.

Good Elastic Fit . This layer should work when deployed elastically.

Poor Elastic Fit . This layer will probably not work when deployed elastically, or may behave differently than when it

is deployed in a Layered Image.

Elastic Fit Details

You can learn more about the Elastic Fit of a Layer by expanding the Elastic Fit Analysis. If  the Elastic Fit is less than ideal,

the list of violated rules will be displayed.

Low Severity Warning. This is unlikely to cause any change in behavior or functionality for most applications.

Medium Severity Warning. This may cause minor changes in behavior or functionality for some applications.

High Severity Warning. This is likely to cause signif icant changes in behavior or functionality for many applications.
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Enable Elastic Fit in App Layering Labs

To use this App Layering Labs feature, you must enable it. To enable Elastic Fit:

1. In the Management Appliance, select System > Settings and Conf iguration.

2. Click Edit  App Layering Labs.

3. Select the Elastic Fit  check box.

4. Click Save.

Analyze an App Layer for Elastic Fit

All new Layer Versions will be analyzed for elastic layering compatibility when they are finalized. To analyze existing App

Layers for Elastic Fit:

1. Log into the Management Console.

2. Select Layers > App Layers.

3. Select the Layer to analyze, and click Analyze Layer.
4. On the Select Versions tab, choose the Layer Versions to analyze.

5. On the Confirm and Complete tab, click Analyze Layer Versions. The analysis takes seconds.

6. To see the Elastic Fit Analysis, select the App Layers module, move the mouse pointer over the Layer icon and click

the Info  icon.

7. Expand the Version Information for each Layer Version, and look for the Elastic Fit rating.

8. For a detailed report, expand the Elastic Fit Details. If  the Elastic Fit is less than ideal, the list of violated rules will be

displayed.

9. You can display the AD tree and hide the violated rules by clicking a button acknowledging that the layer is unlikely to

work as expected.

Upgrading from Earlier Releases

After upgrading from an earlier App Layering release, the Elastic Fit Detail shows that any existing Layer Version(s) have not

been analyzed. Until you run the analysis on existing Layer Versions, the Versions will have a single High severity Elastic Fit

Detail, and a Poor Elastic Fit.

Elastically assign an App Layer to AD Users and Groups

The first time you assign an App Layer elastically, we recommend starting with an app like Notepad++ or GIMP, because

they are simple to .

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer that is not going to be included in the base image, and select Add Assignments.

3. In the wizard that opens, select the Version of the App Layer that you want to assign users.

4. Skip the Image Template Assignment  tab. This tab is for assigning the Layer to an Image Template.

5. In the Elastic Assignment tab, select the users and groups who should get this App Layer.

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Elastically assign an App Layer to users via machine
assignments and associations
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Any machine running the App Layering Service (ULayer.exe) can have Elastic Layers assigned to it. You can accomplish this by

either adding the machine to or associating it with the AD Group, and then elastically assigning the App Layers to the

AD Group.

The Layers assigned to the machine will be available to every User who successfully logs into that machine. The App

Layering Service will scan for changes to the machine's AD group memberships and associations every 10 minutes. When the

users log in, they should see an icon for each Elastic App Layer they've been assigned.

Use Active Directory to add the machine to the AD Group

Assuming you have a published Layered Image booted in your environment, you can add the machine to an AD Group, and

assign Elastic Layers to the AD Group.

1. Use Active Directory (AD) to add the machine to an AD Group.

2. Select an App Layer that is not going to be included in the base image, and elastically assign the Layer(s) to an AD Group.

3. You can wait for AD to propagate the changes and be recognized by the App Layering Service, or you can force the App

Layering Service to update its list of machine groups by doing one of the following:

Wait for the App Layering Service to detect the changes (within 10 minutes by default).

Restart the App Layering Service.

Reboot the App Layering Service Machine.

Execute the refresh.groups command:

C:\Program Files\Unidesk\Layering Services\ulayer.exe refresh.groups

Example

You start with an AD User, and AD Group, and a machine that you provisioned using a Layered Image.

AD User: Kenya
Kenya has no elastic assignments.

AD Group: Marketing
The Marketing group includes the member Kenya.

Machine: ElasticTestMachine
The ElasticTestMachine base image includes the MS Office App Layer.

In this example, you elastically assign the Chrome App Layer to ElasticTestMachine:

1. In AD, you add the machine ElasticTestMachine to the Marketing AD Group.

2. In the Management Console you elastically assign the Chrome App Layer to the Marketing Group.

3. When Kenya, who is part of the Marketing group, logs into ElasticTestMachine, she receives both the MS Office App
Layer, which is in the base image, and the Chrome App Layer.

4. When any user who is not in the Marketing group logs into ElasticTestMachine, they also receive both

Layers: MS Office because it is in the base image, and Chrome because the ElasticTestMachine is a member of

the Marketing AD Group.

Use the Management Console to associate the machine with an AD Group

Associating a set of machines with an AD Group allows any machine running the App Layering Service to have Layers

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co_az4#Assign
https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co_az4#Assign
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elastically assigned to it via AD group membership.

Elastic Layers granted via Machine association can be thought of as extending the layers assigned to a user. For example, if

a machine matches multiple Machine Associations, only the unique layers will be added to the ones the user already has.

In the Management Console, you use asterisk (*) wildcards in a machine name pattern to specify a set of machine names.

For example:

Machine name pattern Matches these names Does not match these names

machine*
machine01

machineindetroit

amachine

localtestmachine

*machine
amachine

localtestmachine

machine01

machineindetroit

ky*eng
ky02359eng

kytesteng

01ky_eng

testky01eng

*eng*

eng01

1eng

1eng01

en01

1en

1en01

You can create Machine Associations before or after elastically assigning App Layers to the AD Group. Also, the machines

do not need to exist when you add the associations, as the associations exist within App Layering only, and AD is not

aware of them.

Associate a set of machines with an AD Group

1. Log into the Management Console as an Admin user, and select Users > Tree.

2. Expand the Tree, select the appropriate Group and click Edit Properties in the Action bar. This opens the Edit Group

Wizard.

3. Select the checkbox, Associate machines with this AD Group. This reveals the Machine Name Pattern field:

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_notchecked.png
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4. Specify a set of machines to associate with the AD group by entering a machine name pattern. For examples, see the

above table of Machine name patterns.

5. On the Confirm and Complete tab, select Update Group. Notice the shape of a computer monitor superimposed over

the group icon. This indicates that machines are associated with the group.

When you click the group's  icon, the Detail view now includes a field called, Associate With Machines where the

pattern.

Example

You start with the machine, Mach1, the AD Group, MachineGroup, and the App Layers for Firefox and MS Office.

Machine: Mach1
AD Group: MachineGroup
App Layers: Firefox, MS Office

Further, you have elastically assigned the Firefox and MS Office Layers to the AD Group.

If  you add a Machine Association to MachineGroup with a name pattern of "Mach*", when any domain user logs

into Mach1, they will receive the Firefox and MS Office Elastic App Layers.

Manage Elastic Assignments

You can:

View a user's Elastic Layer assignments.

Update an App Layer and elastically assign the new Version of the Layer.

Remove Elastic Assignments.

Debug an Elastic Assignments.

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_checked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_details.png
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View a user's Elastic Layer assignments

1. Log into the Management Console and select Users > Tree.

2. Select an AD User or Group, and click the "i" icon to the right of the name. If  the user or group is assigned any Elastic

Layers, the Layers are listed just below the user's or group's profile information in the Details window that appears.

Update an App Layer and its Elastic Assignments

You've added Elastic Assignments to an App Layer, and users are accessing the app as expected. A new version of the

application is released, so you update it by adding a new Version to the Layer. Now you need to assign the new version to

the users who have the Layer.

1. Log into the Management Console and select Layers > App Layers.

2. Select the elastically assigned App Layer that you just updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new Version.

5. Skip the Image Template Assignment tab.

6. In the Elastic Assignment tab, there's a list of Users and Groups who have been assigned a different version of the

selected Layer. Select the users and groups to whom you want to assign the new Version of the Layer.

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show AD users and groups already at this version. A list of grayed

out names may appear. These users have already been assigned the Version.

7. On the Confirm and Complete tab, verify the Users and Groups selected to receive the new Version, and click Update
Assignments.

Remove a Layer's Elastic Assignments

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Debug an Elastic Layer

If  you have an Elastic Layering issue, you can diagnose the problem by finding out whether the layer is being delivered, and if

so, whether it is working correctly. If  needed, collect data for Support, as described here.

Is this a Delivery issue?

Are the things you'd expect to see if  this app were installed actually there as expected?

Do you see the f iles and registry entries for the layer?

If  the app is supposed to be in the Start menu, is it there?
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If  there should be a shortcut for the app on the user's desktop, is there one?

If  you discover that app delivery is an issue, you can collect the following data, open a case, and send the data to Support.

1. Collect the data from these logs:

Windows App Event log –  In the Windows Event Viewer under Windows Logs, export the Application event log as an

EVTX f ile.

App Layering Service log (ulayersvc.log) –  C:\ProgramData\Unidesk\Logs\ulayersvc.log

2. Collect the values of these Registry keys:

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:AssignmentFile

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:RepositoryPath

3. Collect the contents of the Assignment (ElasticLayerAssignments.json) and Layers (Layers.json) files from the Repository

Path.

4. Contact Support.

Is this an operational issue?

One of these issues could indicate that this is an Elastic Layering issue:

The app is being delivered but doesn't launch correctly.

An operation within the app doesn't work correctly.

A licensing problem or a security issue.

The app launches, but then misbehaves, for example, it crashes on startup, or starts up but doesn't work right.

If  the problem with the Layer is operational, test the App Layer in the base image to rule out general layering issues:

1. Add the App Layer to an Image Template, and publish a Layered Image that includes the App Layer.

2. Log in as a user who is not assigned the Layer elastically, and make sure that the application is operational in the base

image.

3. Contact Support with your f indings.
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System settings

Jun 29, 2017

You can specify settings for the following system configuration parameters by clicking on the Edit button of each option,

making your changes, and clicking the Save button.

Appliance
settings

Summary

HTTP

Certificate

Settings

Displays the currently set security certificate. Use the Upload and Generate buttons to upload an existing certificate or to

generate a new one. Optionally, enter a comment that describes the changes you made.

Network File

Shares

The Network File Share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

To configure the Network File Share, you specify the:

Network File Share Type

Network File Share Path

User Name & password

Then, test the connection to the file share by clicking Test Network File Share. The test returns a message stating either

"Success" or "Failed to mount network file share path". You can enter a comment describing your changes.

Security

Settings

Specify the number of minutes of inactivity before the Management Console logs you out. Optionally, enter a comment

that describes the changes you made.

Task

Retention

Settings

Specify the number of days that the appliance should retain completed Tasks before deleting them. Optionally, enter a

comment that describes the changes you made.

Audit Log

Retention

Settings

Specify the number of days that the appliance should retain audit log files. After that time elapses, the software begins to

overwrite the audit log. Optionally, enter a comment that describes the changes you made.

Notification

Settings

Configure automatic email notification settings for yourself or other users. When you export logs, the appliance sends

the specified recipients an email notification that includes a link to the log files.

To set up email notifications:

1. In the Mail Server box, enter the name of your email server or the name of the SMTP relay server.

2. In the Mail Server port, enter the number of the port that the email server uses for communication.

3. In the User Name box, enter the user name for the email account you want to use for sending notifications. For

example, username@domain.com.

4. In the Password box, enter the password for the email account.

5. In the From box, enter an email address to identify the source of the email message. For example, if you enter

myaddress@mycompany.com, the email message displays the following in the From box of the received

notification:

App Layering Manager [myaddress@mycompany.com]

6. In the Recipient List box, enter the email addresses that should receive notifications. Use a comma or semicolon to
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6. In the Recipient List box, enter the email addresses that should receive notifications. Use a comma or semicolon to

separate the email addresses.

7. Click Test Email Configuration to verify that the settings for the email server and account work correctly. If the test

succeeds, the software displays a success message and sends the recipients a confirmation email.

8. Enter a comment, if necessary, and click Save to save the email settings. Any comments you enter will appear in the

Information view Audit History.

For more information, see Export log files.

Log File

Retention

Settings

Specify the maximum disk space to use for all logs (in megabytes) and the number of days that the log files should be

retained. Optionally, enter a comment that describes the changes you made.

Appliance
settings

Summary
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System storage

Jun 29, 2017

Check the amount of free space in the appliance's local storage

The appliance's local storage is a Layer Repository where the appliance creates, composites, and stores Layers and Layered

Images. You can see how much disk space is used in the System module of the Management Appliance.

Log into the Management Console and select System > Manage Appliance.

In the Services table, the Local Storage for the Layering Service shows how much space is used and how much is free.

Notes:

Disk space is shown in 1024-based Gigabytes, not metric.

Free space is updated every time a Layering Service job completes. If  you want to make sure the page has been refreshed,

click the Refresh icon just above the Manage Appliance subtab.

When creating a Layer or adding a Version to it, extra space is temporarily required to build the Packaging Disk. You can

calculate the amount of space needed during Layer creation by adding the following Layer sizes:

The size of the OS Layer Version you're using.

The size of the writable disk you want for the App Layer.

The size of any Prerequisite Layers (if  you have any).

Add space to an existing disk in locally attached storage

You can add storage space to an existing local storage disk as follows.

Log into your hypervisor's management console, and follow the normal procedure to increase the size of the local storage

disk. (You may have more than one of these disks, and can expand each one of them.)

Log into the Management Console and select System > Manage Appliance.

Select Expand Storage. A list of expanded disks is displayed. (You might also see attached disks that are not yet part of the

layer repository, but you can ignore those.)

Notice that the New Size of the disk you expanded is larger than the Current Size.

Select the check box for the disk that you want to expand to the New Size.

On the Confirm and Complete tab, click Expand Storage.

Add a disk to locally attached storage

When you install the appliance, it comes equipped with an additional 200 GB data disk that is used as a Layer Repository.

You can expand the appliance's local storage by adding another disk to it.

Log into your management console.

Select System > Manage Appliance.

Select Expand Storage.

The Disk Selection tab is displayed of disks that are attached to the system and are not part of the layer repository.

Select the check box for each disk that you want to use to expand the layer repository.

If  a check box is grayed out and a yellow icon with an ! (exclamation point) is displayed, it means that the attached disk is

not eligible for use (for example, if  the disk is not blank). Once the attached disk is blank and unpartitioned, you will be able

to use it to expand the appliance's local storage.
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On the Confirm and Complete tab, click Expand Storage.

Add storage locations for User Layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The first storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's User

Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest priority

location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until that

point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the their User

Layer to the new highest priority location.

Create Storage Locations

To add a storage location:

Log into the management console.

Select System > Storage Locations.

Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

Select Add Storage Location, and enter a Name and Network Path for the new location.

On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to add

to the new storage location.

On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure security on user layer folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:
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Setting name Value Apply to

Creator Owner Modify Subfolders and Files only

Owner Rights Modify Subfolders and Files only

Users or group:

Create Folder/Append Data

Traverse Folder/Execute File

List Folder/Read Data

Read Attributes

Selected Folder Only

System Full Control Selected Folder, Subfolders and Files

Domain Admins, and selected Admin group Full Control Selected Folder, Subfolders and Files

Set security on the User Layer folders

1. Log into the management console.

2. Select System > Storage Locations. The f ile shares displayed are the storage locations defined for User Layers. For

example, say you've defined three Storage Locations so that you can more easily manage storage for Group1 and

Group2 separate from everyone else in the organization:

 

Default location - \\MyDefaultShare\UserLayerFolder\

Group1 - \\MyGroup1\Share\UserLayerFolder\

Group2 - \\MyGroup2\Share\UserLayerFolder\

Note: The appliance's main file share, which is used for storing OS, App, and Platform Layers, is not listed as a User Layer

Storage Location.

Create a \Users subdirectory under each file share:

 

\\MyDefaultShare\UserLayerFolder\Users\

\\MyGroup1Share\UserLayerFolder\Users\

\\MyGroup2Share\UserLayerFolder\Users\ 

Apply the security settings listed above to each /Users subdirectory.
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Firewall ports

Jun 29, 2017

The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin user

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.

Destination Activity Protocol Ports

App Layering appliance 

(Enterprise Layer Manager (ELM))
Management Console TCP 80, 443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP
3000 (HTTP) 

3500 (HTTPS)

Connector for PVS Communication TCP
3009 (HTTP) 

3509 (HTTPS)

Connector for vSphere Communication TCP
3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP
3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP
3000 (HTTP) 

3500 (HTTPS)

Connector for Nutanix Communication TCP
3006 (HTTP)

3506 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161
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App Layering Appliance (Enterprise Layer Manager
(ELM))

Internal Connections

By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering Appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent - refers to the App Layering Agent, which is required if  you are:

Using PVS - The Agent must be installed on you PVS server(s).

Running Connector scripts - The Agent must be installed on any server on which you want to run a Connector script,

for example, a server for your connection broker, provisioning service, hypervisor, or any other server running in your

environment.

Admin User - A Management Console user who is assigned the App Layering Admin Role.

Source Destination Activity Protocol Ports

Agents Appliance Initial registration TCP 443

Appliance Agents Communication TCP 8016

Agents Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via

ESXI Host
TCP 443

Agent Appliance Agent communication with datastore TCP 8888

Appliance Active Dir Communication with Active Directory TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP) 

3500
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3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP) 

3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

Admin User Appliance Connector for Nutanix Communication TCP

3006

(HTTP)

3506

(HTTPS)

Source Destination Activity Protocol Ports

External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the

destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.
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Destination Activity Protocol Port

XenCenter Communications 5900

Next step

If  you are in the process of setting up the App Layering appliance, the next step is to:

Connect to a Directory Service

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_admin_az4/get_started_dir_service_az4
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Manage layers and templates

Jun 29, 2017

The App Layering Appliance (aka Enterprise Layer Manager (ELM)) is a virtual appliance that coordinates communication in

the App Layering environment and manages copies of your Layers and Image Templates. Based on CentOS, the appliance

hosts the Management Console, a friendly interface where you create Layers and use those Layers to publish Layered

Images.

You can log into the appliance and modify the administrator password, network address, NTP servers, and Time Zone

settings using the Appliance Configuration utility, as described here.

Before you start

Make sure that the App Layering Appliance is running in your hypervisor.

Make sure you have the password for an account with administrator privileges

Log into the appliance using an account with administrator privileges

Using either your hypervisor console or SSH, log into the appliance as administrator (default password Unidesk1).

Note: If  the appliance is in Azure, type /opt/sbin/cfg_launcher, and press Enter.

This opens the Appliance Configuration utility.

Change the administrator password

The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

administrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the password for any of the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, take a moment to

familiarize yourself  with the administrative accounts for the appliance.

2. For each account, enter the new password and then re-enter it in the Confirm Password f ield.

3. On the Confirm and Complete tab, click Change Credentials.

Configure networking (includes Static IP Address option)

You can change the appliance's IP address and/or its DNS servers. When the appliance is first deployed, the DNS settings

are retrieved through DHCP. If  DHCP is not available and you will be using static IP addresses, once you select Static, you

will be prompted to enter the IP addresses for your DNS servers.

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter C (for Configure Networking), and press Return.
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3. At the next prompt, type D for Dynamic (DHCP) or S for Static.

If  you choose Static, you will be prompted for the IP address and Subnet mask, along with default addresses for the

Gateway and DNS addresses.

4. When prompted, enter Y to save settings.

5. At the Action prompt, enter Q to quit.

6. Restart the appliance.

Synchronize the system clock with NTP servers

You can synchronize the system clock on the ELM by configuring NTP servers. You can specify how many NTP servers you

need, with 6 being the maximum. And, you can add and remove NTP servers, as needed. Where possible your existing servers

will be used as defaults.

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter N for NTP servers change, and press Return. A list of your current NTP servers is displayed.

3. At the prompt, specify how many NTP servers you need by typing a number from 0 to 6.

0 - All servers will be removed (you will be warned).

1-6 - You will be prompted to accept or replace each of the current servers. 

4. For each server, press Enter to accept the current value. Or, enter a new server address (Example: 3.pool.ntp.org). Once

the last address is entered, an NTP Server Summary is displayed.

5. Enter S to save the settings.

6. At the Action prompt, enter Q to quit.

7. Restart the appliance.

Change the Time Zone

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter T  for T imezone change, and press Return. The current time zone is displayed.

3. Press Enter to display available timezones. The f irst bunch of time zones are displayed in alphabetical order, starting with

the

4. Advance through the timezone codes until you see yours:

Enter - Advances one line at a time.

Page Up Page Down - Displays the next or previous screen full of choices.

Or search the timezones:

Type Slash (/) and part of the name you are looking for.

5. When your timezone is displayed, press Q to get to the prompt.

6. Type the number for your timezone. The timezone you entered is displayed.

7. Press Enter to complete the change.

8. At the Action prompt, enter Q to quit.

9. Restart the appliance.
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Update OS layer

Jun 29, 2017

The Unidesk OS Layer contains the Windows Operating System that is assigned to any Unidesk Layered Images you create

using that OS Layer. Once created, you can use the OS Layer to build as many Layered Images as you want.

The OS Layer includes a virtual machine in your infrastructure running the Unidesk-supported Windows Operating System

that you want to use for your Layered Images.

Add a version of  an OS layer

To add a version of an OS Layer, take the following steps:

1. In the Unidesk UMC, select Layers > OS Layers.

2. Select or right-click an OS Layer icon and click Add Version. This opens the Create OS Version Wizard.

3. (Required) In the Version Details tab, enter a version identif ier. This can be the application version, or anything you

choose.

4. In the Connector tab, select a Connector Configuration for the platform where you'll be publishing your Layered Images.

If  you have not yet created a Platform Connector configuration or if  the configuration you need is not present, click

New to create a new Connector Configuration and select it from this list.

5. Packaging Disk tab - Specify the f ile name and format of the packaging disk.

6. Confirm and Complete tab - Verify your settings and click Create Version. Unidesk runs the task of creating a new OS

version. When the task completes, it shows a status of Action Required and contains the following text:

"The Packaging Disk has been published to Azure. Click here to create a Packaging Machine and install your app. When

the app installation is complete, f inish creating the new Layer Version by clicking Finalize on the Action bar."

7. Expand the Tasks bar at the bottom of the UI, and double-click the Packaging Disk task. In the description, either Click

here, or copy the link to Azure portal where the Packaging Disk has been published. Click the link in the task to open the

Custom deployment window in Azure. Unidesk has pre-populated the f ields of the Custom VM window with default

values. Log into Azure and create the VM.

8. Log into the new VM and install any apps on it that you want to include in the new version of the OS, such as Windows

Updates or anti-virus software.

Next, you can deploy a Packaging Machine for this OS Layer.

Deploy a Packaging Machine

The Packaging Machine is a virtual machine where you install any applications or updates you want to include in this Layer.

Typically, we recommend using a unique VM for each Layer.

Azure environment

To deploy your Packaging Machine to Azure:

Click the link (shown in red below) in the Unidesk Management Console task to open the Azure portal to the Custom

deployment area where you can create the virtual machine that you will use as your Unidesk Packaging Machine.

Note: We recommend that you log into the Microsoft Azure account that has the same Subscription before clicking the

link or pasting it into a browser.
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Complete the required fields for customizing your Azure parameters.

Notes:

 

Unidesk does not recommend using less than two CPUs for the Packaging Machine. Consequently, the machine size must

be at least A2.

On the Custom deployment panel, ensure that the value for the Resource Group location matches the Storage location

you specified earlier.

Install your changes

This section explains how to install your changes on the Packaging Machine you created in Azure.

1. To make changes to this version of the OS Layer:

1. Remote log into the Packaging Machine you created in Azure.

1. Note: The User Name and Password to use when you log into the Packaging Machine are the same User Name and

Password that were used when the OS Machine was created for the current OS Layer.

1. Install any updates or applications you want to include in the new OS Layer version, such as Windows Updates or anti-

virus applications.

1. If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

1. Make sure the Packaging Machine is in the state you want it to be for the user:

1. If  the applications you install require any post-installation setup or application registration, complete those steps now.

1. Remove any settings, configurations, f iles, mapped drives, or applications that you do not want to include on the

Packaging Machine.

1. Next, shut down the Packaging Machine when you have verif ied that the Layer is ready to f inalize as described in the

following section.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, the next step is to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

1. If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

2. Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verif ication

process.

3. If  there is an outstanding operation that must be completed before the Layer can be f inalized, you are prompted to
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complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

4. Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground. 

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

3. Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status
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3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the OS layer

Once the Packaging Machine is created and any apps or updates installed, you'll need to finalize the layer.

Note: When you finalize a new version of an OS Layer, Unidesk deletes the Packaging Machine so as not to incur more

costs.

When a layer is ready to finalize:

1. Return to the Unidesk Management Console.

2. In the Layers module, select the Layer.

3. Select Finalize in the Action bar.

4. Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.

Reference: Create OS Version Wizard values

Version - (Required) This can be the version of the OS Layer or a version you assign to the Layer. This value is displayed in the

Details view of the Layer.

Version Description - (Optional) Enter a description of the version.

Max Layer Size - (Optional) Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 100 gigabytes. If  the version you are creating could requires more space,

change this to a realistic value.

Select a Platform Connector configuration - (Required) Specify a Unidesk Platform Connector for the platform where you'll

be publishing your Layered Images. For example, if  you're publishing to Azure RD Session Host, select the Azure RDSH

connector with the credentials required to access the account. If  the configuration you need is not listed, add a New one

and select it from this list. If  you want to change the settings of a Platform Connector configuration, select it and click

Edit.

Packaging Disk Filename - (Required) The name of the Packaging Machine you created in Azure.
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Delete OS layer

Jun 29, 2017

You can delete an OS Layer or Layer version, as long as it is not being used by another Layer, or Image Template. Deleting

the Layer itself  removes all versions, volumes, and resources from the App Layering appliance.

You can delete an entire layer or a layer version if  it is:

Not deployed to an Image Template.

Not the required OS Layer (or Layer Version) for any compatible App Layers.

Not a prerequisite for another Layer that is deployed to an Image Template.

Delete a layer or layer version

1. In the Management Console, select Layers.

2. Select an OS Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.
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Delete platform layer

Jun 29, 2017

You can delete a Platform Layer or Layer version, as long as it is not being used by an Image Template. Deleting the Layer

itself  removes all versions and resources associated with the Layer.

1. In the Management Console, select Layers > Platform Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Delete app layer
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You can delete an app layer or layer version, as long as it is not being used by another layer as a prerequisite, or deployed to

an image template. Deleting the layer itself  removes all versions and resources associated with the layer.

1. In the Management Console, select Layers > Application Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Manage image templates
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When you create new layers and new versions to them, you can edit the layer selection in your image templates, and use

the templates to publish new versions of your layered images. Once created, a layered image is no longer associated with

the template used to create it. This means that you can change or delete a template without affecting any previously

published layered images.

Update image templates with a new layer version

When you add a new version to an app layer or an OS layer, you can quickly identify the image templates that include the

layer, and select which templates to update with the new version.

1. In the App Layering Management Console, select Layers > App Layers or Layers > OS Layers.

2. Select the Layer you updated, and click Update Assignments.

3. In the wizard that opens, select the new version of the layer that you want to assign. The image template assignment

tab lists the image templates that include the layer but are not yet assigned the new version.

4. On the image template assignment tab, select the image templates to which you want to assign the layer or layer

version.

Notes:

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out names

may appear. These templates have already been assigned the Version.

You can use the Search f ield to f ilter this list by Layer or Version. If  you search on part of a Layer name or Version, any

entry that contains the search string is displayed.

5. Skip the Elastic Assignment tab

6. On the Confirm and Complete tab, verify your choices and click Update Assignments.

Edit any image template setting

When you want to change the settings that you use to publish any of your layered images, you can edit the image

template you originally used to publish the layered image(s) and publish a new version of the image(s).

1. In the App Layering Management Console (UMC), select the Images module.

2. Select the template you want to edit, and click Edit Template. This opens the Edit Template wizard.

3. On the Name and Description tab, you can change the Name, Description, and Icon for the Image.

4. On the OS Layer tab, you can select a different version of your chosen OS layer by expanding the layer and choosing a

different one.

5. On the App Assignment tab, you can add or remove app layers to include in the layered images that you publish using this

template. If  there is more than one version of a layer, you can choose a different version by expanding the layer and

choosing a different one.

6. On the Connector tab, you can change the location to which the Layered Image is published by selecting a different

Connector Configuration.

7. On the Platform Layer tab, you can change the selected Platform Layer, if  for example, you are publishing to a different

environment.

8. On the Layered Image Disk tab, you can edit the Layered Image Disk details, for example, to enable Elastic Layering on

the image.

9. In the Confirm and Complete tab, enter any comments you would like for this layer, and click Edit Template.
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Delete an image template

When you no longer need an Image Template, you can remove it from the Management Console.

1. In the Management Console, select the Images module.

2. Select the template you want to delete, and click Delete Template. This opens the Delete Template wizard.

3. In the Confirm and Complete tab, enter any comments you would like, and click Delete Template.
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App Layering in Hyper-V

Jun 29, 2017

Hyper-V prerequisites

Be sure the Hyper-V VM where you are installing the appliance meets the following prerequisites.

A Windows Hyper-V 2012 R2 server

A Virtual Network in Hyper-V

Storage requirements

350-500 GB Storage Space
The App Layering appliance uses local storage for temporary f iles and f inalized layers. The more layers you create, the

more space you need. However, if  you run low on space, you can expand the size of the current disk, or add other disks

to the appliance when needed.

40-100 GB network f ile share (SMB)
The f ile share connected to the appliance is used for upgrades, Elastic Layers, and cross-platform publishing. This space is

easy to expand, if  needed.

Operating System requirement

OS for Layered Images

You need a supported operating system to import into an OS Layer. This OS will be used to build your Layered Images.

https://www.unidesk.com/support/learn/4.2.0/citrix_app_layering/welcome_platform_support_co4
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Install

Jun 29, 2017

Before you start

To get started, you need:

An App Layering account.

A supported version of Citrix XenServer.

A Virtual Network in XenServer.

Storage requirements and XenServer requirements listed here.

A XenCenter Client.

Installation package

The installation package, citrix_app_layering_xenserver_4.x.x, includes:

File Description

xenserver_x.x.x.ova OVA file for the appliance VM

citrix_app_layering_agent_installer.exe App Layering Agent installer

citrix_app_layering_win_gold_image_tools.exe OS Machine Tools

Deploy the App Layering appliance

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to layering.cloud.com.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. At the top of the page select the hypervisor where you are deploying the App Layering service. This selection determines

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
http://docs.citrix.com/en-us/citrix-app-layering/4/hyper-v.html
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which platform-specif ic installation package is downloaded in Step 2.

9. Under Step 2, click the Download for Hypervisor button to download the appliance installation package for the

hypervisor you have selected.

10. Under Step 3, right-click Instructions, open the page in a new browser tab, and select your hypervisor. The installation

instructions for your hypervisor are displayed.

11. Extract the download package, citrix_app_layering_xenserver_4.1.0.zip. The f iles included are listed above.

12. Extract the xenserver_elm_4.x.x.x.ova f ile to a folder on your local drive.

13. In your XenCenter Client, select File > Import .

14. In the wizard that opens, select the following values:

Import Source - Browse to your unique location.

Location - Choose the XenServer where you want to deploy the appliance.

Storage - Use the default value to put storage disks on the Local XenServer Storage.

Networking - Select the correct network for your XenServer configuration.

Security - This tab should be grayed out. Click Next to continue.

OS Fixup Settings - Select Don't use Operating System Fixup.

Transfer VM Settings - Choose the correct network , and choose DHCP.

Finish - Review your settings and select Finish.

 

15. Switch to Notif ication view and wait for deployment to complete. This takes about 20-35 minutes.

16. Switch to Infrastructure view.

17. Rename your new appliance:

1. Select your new appliance, which will be named CentOS-7_x86_64_build_template_xenserver.
2. Click Properties, and enter a good name and description for your new appliance.

The new VM has 8 GB of memory and 4 CPUs.

 

18. Under Step 4, the Documentation link opens the instructions for logging in.

19. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions to log into the appliance.

 

Install the App Layering Agent (required for PVS and Connector Scripts)

The App Layering Agent enables the App Layering appliance (Enterprise Layer Manager) or a Unidesk Packaging Machine VM

to run PowerShell commands locally. If  you supply the proper credentials, the agent can run PowerShell commands as a

specific user.

The App Layering Agent is required in cases where one of your Connector Configurations launches a PowerShell script. This

includes Connector Configurations you use to:

Publish Layered Images to a provisioning system.
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Package Layers in your hypervisor environment.

The App Layering Agent installer prompts you to register the agent with a App Layering appliance. If  you do not register the

agent during installation, you can manually register it later. However, keep in mind that the PowerShell scripts will not run

until the agent is registered with the ELM.

Prerequisites

Before you install the App Layering Agent, you must have the following requirements on the system where you are

installing the App Layering Agent:

An account with administrator privileges

.NET 4.5

PowerShell 3.0 or greater

PowerShell Snap-in

Before using the App Layering Agent on a PVS server you must ensure the PowerShell Snap-in is installed. This is a

manual step.

For PVS 7.7 and later, you must install the Powershell Snap-in Citrix.PVS.Snapin.dll.

For PVS 7.6 and PVS 7.1, you must install McliPSSnapIn.dll. Use the installutil.exe to install the Snap-in.

Example (7.6):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" McliPSSnapIn.dll

Example (7.7):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" Citrix.PVS.snapin.dll

On Windows 2008 R2, you must also enable PowerShell remote commands. For background information, see this Microsoft

article: https://technet.microsoft.com/en-us/library/hh849694.aspx

If  your 2008 R2 OS does not have PowerShell remoting enabled, run the following PowerShell command on the PVS server:

Enable-PSRemoting  

Install the App Layering Agent

1. Log in as an administrator on the system where you are installing the agent.

2. Download the App Layering Agent from the Unidesk Download page.

3. Copy the Unidesk_agent_installer.exe f ile from the App Layering Agent folder to a convenient location on the PVS

server.

4. Run the Unidesk_agent_installer.exe as Administrator, and when prompted, enter the path to the directory where you

want to install the App Layering Agent. The default location is C:\\Program Files (x86)\Unidesk\Agent.

5. The App Layering Agent installer checks to see if  all Prerequisites are present. If  any prerequisites are missing, the installer

reports this and exits without installing.

6. The installer prompts you for an Agent Port number. You can accept the default port number (8016) or specify a

https://technet.microsoft.com/en-us/library/hh849694.aspx
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different one if  the default port is already in use.

7. The installer prompts you for the credentials (address, username, and password) for your App Layering appliance. Register

the App Layering Agent with the ELM by entering the IP address and login credentials for a Unidesk Management

Console (UMC) user on the ELM with Administrator privileges, (for example, the credentials you use to log into the UMC).

Note: If  the App Layering appliance is not available yet or you choose not to register with it now, you can manually

register at a later time using the procedure described in Register with the App Layering appliance manually.

8. Click Finish to exit the wizard.

Register the App Layering Agent manually

If  the App Layering Agent was not registered with a App Layering appliance during installation, you can register it later by

using the following procedure.

To manually register the App Layering Agent with the ELM:

1. As an administrator, log in to the server where you installed the App Layering Agent.

2. Open a command window (cmd.exe) as administrator and navigate to the directory where the App Layering Agent is

installed. (The default location is C:\\Program Files (x86)\Unidesk\Agent.)

3. Run the following command, using the IP address of the ELM where indicated:

Unidesk.Agent.Service.exe register /i /e:IP_address_of_ELM /u:Administrator

4. When prompted, enter the password for a user who has Administrator privileges in the Unidesk Management Console

(UMC) on the ELM.

5. When the registration process completes, a message appears informing you of the successful outcome. The App

Layering Agent registration appears in the Audit log for the Management Service in the UMC.

If  the process does not succeed, examine the \Unidesk\Agent\Logs\unidesk.agent.log file in the App Layering Agent

installation directory. You can also view Help for the App Layering Agent command line options by running the following

command: Unidesk.Agent .Service.exe /?.
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Configure
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You can access the App Layering Management Console using the appliance's IP address entered in a web browser, or via the

Citrix Cloud. Currently, access via Citrix Cloud is in Labs, and there are a few things you should be aware of when accessing

the Management Console via the Cloud.

Access the Management Console directly via your private network

To log directly into the Management Console hosted on the App Layering appliance:

In your hypervisor, locate the VM you created for the appliance and determine its IP address.

Using the IP address for the appliance, enter the following URL in a compatible web browser:

http://<ip_address_of new_vm>/

This displays the Login page for the Management Console.

Log into the Citrix Cloud, and select the App Layering tile. This displays the Log in page for the Management Console.

Log in to the Management Console as Administrator.

If  this is the first login on this appliance, the Set up Login Credentials wizard is displayed. Here you must change the

password for each of the appliance's administrative accounts.

Access the Management Console via Citrix Cloud (Labs)

When you log into Citrix Cloud, you can use the App Layering Manage tab to access the Management Console. Below,

please see the minor issues you may encounter when using the Manage tab to access the appliance.

In your hypervisor, locate the VM you created for the appliance and determine its IP address

In your internet browser, navigate to citrix.cloud.com and select the Manage button on the App Layering tile. This

displays the Citrix App Layering page.

Click the Manage tab, and in the window that appears, select the Resource Location, enter the Appliance Address, and

click Connect. This displays the Login page for the Management Console.

Log in to the Management Console as Administrator.

If  this is the first login on this appliance, the Set up Login Credentials wizard is displayed. Here you must change the

password for each of the appliance's administrative accounts.

Known issues and considerations with Management Console access via Citrix Cloud (Labs)

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.

1.

2.

3.

4.

1.

2.

3.

4.
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Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.

Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.

Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Change administrative passwords
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The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

adminstrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the passwords for the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, skip to Step 3.

2. Select User > Set up Login Credentials. On the About Your Credentials tab, the three administrative accounts are

described.

3. Take a moment to familiarize yourself  with the administrative accounts for the appliance.

4. For each account, enter the new password and then re-enter it in type it in the Conf irm Password f ield.

5. On the Confirm and Complete tab, click Change Credentials.
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Set up a file share for the App Layering appliance
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The App Layering appliance must be connected to a network file share. When setting up the appliance's file share:

The file share must be configured using SMB technology.

Note: If  you used a previous (Unidesk 4.0.x) version of the product to configure an NFS file share, you can continue using

the file share, but it will not support Elastic Layer assignments.

The user credentials for the file share must have full permissions for that share.

The share must be set up by the admin to be readonly for all users except for the one configured in the appliance. This

secures the Layers and other files stored on the share.

Ensure that you have the minimum storage space requirement of 40-100GB for your file share.

Note: Storage space is expandable, as you can add space to a disk, or other disks to the appliance.

For convenience, set up a File Share hosted in your hypervisor.

For Azure: Currently, the App Layering Appliance does not support the Azure File Share feature. For best performance, it

is best to create a file share server in Azure using a fast system with a Premium Disk, for example, a DS class machine. 

Create the network file share

Configure a file share that uses Server Message Block (SMB) protocol.

Follow the vendor's instructions for setting up a file share using the SMB protocol. 

Configure the App Layering appliance to access the file share

Once you have created a file share, configure the App Layering Appliance to attach to it. You can configure the

appliance via the App Layering Management Console.

1. In the Management Console, select System > Settings and Configuration, then scroll down to the network file shares

setting and click Edit .

2. Specify a Type, Path, User name, and Password for the file share.

3. Click Test Network File Share to see if  you can connect to the file share. The test returns a message stating either

Success or Failed to mount network file share path.

4. Once the test returns a Success message, click Save.
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Open firewall ports for App Layering, as needed
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The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin User

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.

Destination Activity Protocol Ports

App Layering appliance (Enterprise Layer Manager (ELM)) Management Console TCP 80,443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

Connector for PVS Communication TCP

3009 (HTTP)

3509 (HTTPS)

Connector for vSphere Communication TCP

3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP

3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161
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App Layering Appliance (Enterprise Layer Manager (ELM))

Internal Connections

By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent  - refers to the App Layering agent, which you install on

Admin User -
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Source Destination Activity Protocol Ports

Appliance Agent Communication TCP 8016

Agent Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via

ESXI Host
TCP 443

Agent Appliance
Communication with datastore via

ESXI Host
TCP 8888

Appliance Active Directory
Communication with datastore via

ESXI Host
TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP)

3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP)

3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the
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destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.

Destination Activity Protocol Ports

XenCenter Communications 5900
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Connect to a directory service
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You can configure the appliance to connect to a directory service, for example, Active Directory. When you connect to your

directory service, you will create one or more Directory Junctions to access specific domains or OUs. The appliance does not
modify the directory service you connect to. The software caches the attributes for each directory service entry, so that if

the connection to the directory service is lost temporarily, the software can use the cached information for management

tasks.

About connecting the appliance to a directory service

The Management Console Directory Tree displays a hierarchical view of Users and Groups. Each Directory Junction that you

create specifies a starting node in the directory tree.

Overlapping directory junctions

Overlapping (or nested) directory junctions occur when you create multiple directory junctions that contain the same users

and then import the users into the directory tree. When overlapping occurs, each directory junction contains its own copy

of the duplicate users.

Example: Overlapping directory junctions

Assume you create Directory Junction A that starts at the Marketing folder in a directory service tree. Next, you create

Directory Junction B which starts at a folder above the Marketing folder. If  you browse both directory junctions, you can

see the Marketing users in both folders.

User attributes are imported f rom the directory service

The App Layering software imports and caches user and group attributes from your directory service when:

You assign administrator privileges to a user.

The values of the attributes change in the directory service.

The attributes that the software caches are read only. All changes to the attributes for directory service users come from

the directory server.

Imported attributes are synchronized regularly

The software synchronizes the information it caches for directory service users with the directory service every 12 hours. If

the software discovers that a user is no longer an object in the directory service, it classifies the user as abandoned (you can

view this information in the Information view for the user).

Create a directory junction

Create the folders where you want to place the Directory Junctions or decide which existing folder you want to use. You

can add a Directory Junction folder to any existing folder in the Management Console directory tree.

Best Practice: Avoid creating overlapping Directory Junctions, if  possible. In some circumstances, deleting an overlapping

Directory Junction can affect your ability to delete another Directory Junction that contains the same users.

1. Select Users > Directory Service.
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2. Select Create Directory Junction in the Action bar. This opens the Create Directory Junction wizard.

3. In the Connection Details tab, specify the details for the directory server.

Directory Junction Name- This name becomes the name of the folder that you see in the tree view. You can use any

name, including the name of a domain in your directory service tree.

Server address - This is the name for the server you will use for the directory service. (IP Address or DNS Name)

Port - Specify the port number for communicating with the directory server.

SSL check box - Select this if  you want to use Secure Sockets Layer (SSL) communication.

If  certificate errors occur, the wizard displays a list of these errors. If  you know it is safe to ignore them, select Ignore

Certificate Errors.

Test Connection - Click to verify that the appliance can connect to the directory service.

4. In the Authentication Details tab, enter the authentication details for a user who has permissions to search the

directory service.

Bind Distinguished Name - To determine the correct syntax for the Bind DN or user name, see the documentation for

your directory.

Examples: The following examples shows some of the ways you can specify a user for the directory service:

domain\username or username@domain.com.

Bind Password.

Test Authentication - Click to verify that the connection to the directory server is valid.

5. In the Distinguished Name Details tab, specify where the software should start searching for users and groups in the

remote directory service.

Base Distinguished Name (DN) - The software starts searching for users and groups in the remote directory service.

Once you establish a connection to the server for the directory service, the wizard displays a list of available DNs. You

can select a DN from the list or enter the DN directly in the box.

Example: Assume that you want to start the search at the Marketing Organizational Unit at the root of a domain.

You would enter the following Base DN:

OU=marketing, DC=root,DC=mydomain DC=com

Test Base DN - Click to verify that the Base DN is valid.

6. In the Folder Location tab, select the folder in the Unidesk tree where you want to add the directory junction for the

remote directory service.

7. In the Attribute Mapping tab, enter the names of directory service attributes that you want to map to the local

attributes or use the default settings.

Note: To change the mapping from local attributes back to default mappings, click Use Defaults.

8. In the Confirm and Complete tab, verify the Directory Junction settings, enter a comment if  required, and click Create

Directory Junction.

If  you enter comments, they appear in the Information view Audit History.
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Assign App Layering roles to users
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About App Layering users, roles, and rights

Built-in administrator account

When you first install the App Layering appliance and log onto the Management Console, there is a "built-in" Administrator

account that you can use to get started. This Administrator has the rights to perform all App Layering operations. You can

edit this user's properties, including the name, password, and contact info. Be sure to change the password for this built-in

Administrator account as part of installing and configuring the appliance. 

AD user accounts

Other than the built-in Administrator account, all users are actually AD users imported via one or more directory junctions.

Once your directory junction(s) have been created, you can assign Roles to each user, as described later in this topic. You

can see which roles are assigned to a user in the User Details.

App Layering Roles defined

Roles determine which App Layering modules a user can manage. Users assigned one or more Roles can log into the

Management Console, and these users are listed on the Administrators tab (select Users > Administrators).

Note
When upgrading from version 4.0.6 or earlier, users assigned the Machine Administrator Role in earlier releases will now be

assigned the Read Only role. If the user needs more than read only access, reconfigure the user roles, as needed.

Rights by role
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Rights Role

Administrator

Can do every operation available in the Management Console.

Only users assigned the Administrator Role can edit user properties on the Users tab (Select Users
> Users).

Only administrators can configure system settings and manage licenses.

Manage App Layers Can create, edit, and delete application layers and versions.

Manage Elastic Layer

Assignments
Can add, update, and remove Elastic layer assignments.

Manage Image Templates

Can create, edit and delete Image templates.

Can add, update, and remove app layer assignments for image templates.

Can update platform layer assignments for image templates.

Can update OS layer assignments for image templates.

Manage OS Layers Can create, edit, and delete OS layers and versions.

Manage Platform Layers Can create, edit, and delete Platform layers and versions.

Publish Layered Images
Can publish layered images.

Cannot create or modify existing image templates.

Read Only

Can view information about any items in the Management Console.

Cannot launch any wizards or make any changes.

The Read Only user cannot cancel any tasks.

User credentials for logging into the Management Console

When you assign Roles to Directory Service users, they can use their Directory Service credentials to log into the

Management Console.

Who can assign App Layering Roles?

You can change a user's role if  you are logged into the Management Console as a user assigned the Administrator Role.

Assign App Layering roles to users

Log into the Management Console.

Select Users > Users.

Select a user and click Edit Properties. This opens the Edit User wizard. 

1.

2.

3.
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Skip to the Roles tab, and select one or more roles for this user. For details, see Rights by Role above.

In the Confirm and Complete tab, click Update User. Any comments you enter will appear in the Information view Audit

History.

4.

5.
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Enable Labs features
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Want to experiment with cool new features that are under development? Through the Management Console, you can

now see which features are available in Unidesk Labs in any given release. You can enable features you're interested in, try

them out, and let us know what you think. The only caveat? Best not use Labs features in your production environment, as

they are likely to evolve with the feedback we receive from users like you!

Throughout this documentation, features that are available through App Layering Labs are marked (Labs) in the title. Most

Labs features require enabling.

To find out which Labs features are available in this release, see What's New.

Enable a Labs feature

When a release includes a Labs feature that you want to enable:

1. Log into the Management Console and select System > Settings and Conf iguration.

2. Select the check box for the feature you want to enable, and click Save. The feature's status changes to Enabled.

You can turn off  the feature at any time by deselecting the check box and clicking Save.

http://docs.citrix.com/en-us/citrix-app-layering/4/whats-new.html


© 1999-2017 Citrix Systems, Inc. All rights reserved. p.267https://docs.citrix.com

Connector essentials

Jun 29, 2017

What are Connectors?
Connectors are the interfaces to environments where you create Layers and publish Layered Images. You create one or

more Connector Configurations for each platform where you intend to package Layers or publish Layered Images.

What are Connector Configurations?
A Connector Configuration is a stored set of values for connecting to a storage location in your environment. A

configuration typically includes credentials for authentication, a storage location, and any other information required to

interface with the environment where you will be creating layers or publishing images. You can create multiple Connector

Configurations, each configured to access a unique location in your environment.

What Connector Configurations do I need?
Connector Configurations for importing an OS to create an OS Layer

When you create an OS Layer, you need a Connector Configuration to give the appliance access to the location of the OS

image that you want to use for your OS Layer.

Connector Configurations for creating and updating App Layers, and adding Versions to OS Layers
When creating or updating an App Layer, or adding Versions to an OS Layer, you need a Connector Configuration for the

location in your environment where you will package the Layer. You can create as many configurations as you need, for

example, if  you have more than one storage location in the environment.

Connector Configurations for publishing Layered Images
Publishing Layered Images will require different Connector Configurations than the ones you use for creating Layers, if, for

example, you publish Layered Images to a variety of storage locations near the users being served. For example, you can

prepare your Layers for a server farm in vSphere, and publish Layered Images to Citrix PVS for streaming to servers in

vSphere. Or, you can publish Layered Images to more than one storage location in the same environment, each requiring a

different Connector Configuration. Each location is likely to require different credentials.

How and when to add a new Connector Configuration
If  this is your first time using the App Layering Service, you will need to add one or more Connector Configurations in the

process of adding Layers and publishing Layered Images. In the Management Console, the wizards for Creating Layers,

Adding Versions, and Publishing Layered Images each include a page for selecting and creating Connector Configurations.
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Prerequisites

Verify that a Network File Share has been configured. You can confirm that this has been done by logging into the

Management Appliance, selecting System > Settings and Configuration, and finding the Network File Share setting. If

the file share has been configured, you can upgrade the appliance. 

Download packages

Platform Package Files Included

Citrix

XenServer
app_layering_upgrade_xenserver_pkg_4.x.x.zip upgrade_xenserver_elm_4.x.x.xx.vhd

Microsoft

Azure
app_layering_upgrade_azure_pkg_4.x.x.zip upgrade_azure_elm_4.x.x.xx.vhd

Microsoft

Hyper-V
app_layering_upgrade_hyperv_pkg_4.x.x.zip upgrade_hyperv_elm_4.x.x.xx.vhd

VMware

vSphere
app_layering_upgrade_pkg_4.x.x.zip

upgrade_vmware_elm_4.x.x.xx.vhd

app_layering_agent_installer.exe

Note: An Agent upgrade is only required if you've installed the agent

for your implementation, for example, if you are using PVS, or

Connector Scripts.

Back up the appliance

Take a snapshot or checkpoint of the appliance.

Download the upgrade media to the network file share

The App layering 4 upgrade files include both the Appliance and Agent upgrades. The Agent upgrade can be used to bring

either or both of these installations up to date:

The agent on PVS servers.

Servers where Layered Images are enabled for Elastic Layers.

To download the upgrade package:

1. In a network browser, navigate to the App Layering Download page, and sign in.

2. Download the App Layering Upgrade package for your platform to the \Upgrade folder on the Network File Share.

3. Unzip the package in \Upgrade.

4. Copy the Agent upgrade to the server(s) where the agent is installed, and refer to Upgrade the App Layering Agent

below.

http://docs.citrix.com/en-us/citrix-app-layering/4/hyper-v/configure/set-up-a-file-share-for-the-app-layering-appliance.html
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Load the App Layering upgrade

1. Log into the Management Console, select System and click the Upgrade action to launch the Upgrade Wizard.

2. On the Upgrade Disk Details tab, click Browse.

3. Navigate to the upgrade f ile, and click Choose.

4. Verify the Upgrade path, and click Upgrade. This starts the upgrade process, and opens a status page in the browser.

5. Once the upgrade has completed, the status changes to "Upgrade Status: Complete."

6. Refresh the Web page to return to the UMC.

7. Verify that the upgrade was successful by clicking the About  link in the Management Console to confirm the version

number. 

Upgrade the App Layering agent

When using PVS or Elastic Layers the Agent is required. To upgrade the App Layering Agent:

1. Uninstall the previous version of the App Layering Agent from the server(s) where they are installed.

2. Make sure that you have copied the App Layering Agent Upgrade f ile to the PVS server(s) where the agent is installed.

3. Double-click the Agent upgrade f ile, and follow the instructions for upgrading the Agent.

Create a Cloud Connector for accessing the Management Console via Citrix Cloud (Labs)

If  you want to access the Management Console via the Citrix Cloud, install a Cloud Connector as described here. For known

issues when accessing the Management Console via the Cloud, see the list of issues below.

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to the Cloud.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. Under Step 4, the Documentation link opens the instructions for logging in. 

9. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions to access the appliance. 

Known issues

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.
Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.

Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.
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Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Create layers
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OS Layers

An OS Layer includes the software and settings for the operating system that you deploy as part of your other layers and

ultimately, your Layered Images. Once you have prepared the OS disk for deployment, you can create a Unidesk Operating

System Layer by importing the OS disk into a new Layer.

With an OS Layer, you can install your operating system once, and update it by adding a new Version to the Layer whenever

there's a new patch or update. You can deploy this layer, or a version of it, in every image you publish. This allows you to

maintain one OS image and use it to provision all of your servers.

If  you need to support more than one operating system, for example, if  you need both Windows Server 2012 R2 and

Windows Server 2008 R2, you can create more than one OS Layer. However, each App Layer is only compatible with the

OS Layer you use to create it, and if  you deploy two OS Layers, you will also need to deploy a compatible App Layer for

each one. Further, in future releases when deploying Elastic Layers to users, those layers will only be compatible with users'

desktops that use the same OS Layer.

If  you can support your users with a single OS Layer, the work associated with creating and updating App Layers will be

much reduced.

Each time you need to deploy operating system patches and updates, you will do so by adding a new Version to the

OS Layer. You can continue to publish Layered Images using any version of the OS Layer.

The prerequisites for creating an OS Layer include:

An App Layering-supported operating system

App Layering appliance and network f ile share installed and configured

 

Platform Layers

A Platform Layer is a layer that includes platform-specific configuration settings, tools, and other software required for

your OS and Apps to be installed in or to run in a particular environment.

Types of  Platform Layers

A Platform Layer for Packaging (required in some cases, see below)

Platform Layer for Publishing (always required)

Platform Layer for packaging layers and versions

The only time you need a Platform Layer for Packaging layers is when your OS image was created on a different hypervisor

than the one where you are building your other layers. When creating an App Layer or Layer Version, or OS Versions, the

purpose of the Platform Layer is to ensure that any hypervisor-related software and settings are available during the

installation of the application(s) on that layer, if  needed. If  you choose to use a Platform Layer for Packaging a layer, the

hypervisor-related software will only be used during layer packaging, and has no effect on where you can publish the layer

as part of a Layered Image.

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
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Platform Layer for publishing Layered Images

A Platform Layer for Publishing is required when you publish Layered Images. The purpose of the Platform Layer for

Publishing is to include the settings and software that the Layered Image needs to be deployed in your environment. When

creating a Platform Layer for Publishing, Unidesk removes unselected (and unnecessary) tools and software related to the

platforms you are not publishing to. This is to prevent any unnecessary platform software from slowing down the Layered

Image when it runs in the target environment.

App Layers

An App Layer is a virtual disk containing one or more applications that you can use in Layered Images. You can combine an

App Layer with any other App Layers and a Platform Layer, as long as the OS Layer used to create the App Layer is

selected.

With most applications, creating an App Layer is simple. In a few cases, it 's best to start with tips from experienced users, so

the Unidesk Forum includes Application Layer Recipes that you can search for tips about a particular application before you

start. 

To create an App Layer, you use the Create App Layer wizard to deploy a Packaging Machine in your environment and install

the application on the Packaging Machine, leaving the application in the state you want it to be in for users. Then you

finalize the Layer. 

User Layers (Unidesk Labs)

A User Layer is a virtual disk where a user's app data and configuration settings are saved. User Layers are created when you:

Publish a Layered Image with Elastic Layering set to Application and User Layers.

Users log into their desktops on the above Layered Image.

With User Layers enabled on the Layered Image, users can install applications locally on their desktops, and the apps and

their data will be saved in the User Layer.

Verifying Layers

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized. The new Layer or

Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the
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foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX
3. Enter the NGen command to execute the queued items:

ngen update /force
This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It ’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status
3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Connectors for layering

When creating Layers in a Hyper-V environment, you must use NFS (the appliance's file share) instead of a Connector

Configuration.

When you complete the Create Layer (or Add Version) wizard, the file will be saved to the file share. From there you must

manually copy the file to your hypervisor and back to file share once the software for the Layer is installed.

See Connector essentials for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/hyper-v/configure/connector-essentials.html
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OS layer

Jun 29, 2017

This topic explains how to prepare an OS Image for layering, using the OS Machine Tools available for download. 

Notes:

The OS Image should not be in a domain.

The OS Image should get its IP address from DHCP.

Using Third-party optimization scripts can have adverse effects for layering, as they can change services and features

that the App Layering service uses, for example, Universal Plug and Play and the 8.3 f ile names setting. Use the

optimization tools in the Installer download to optimize your image.

Ensure that the VM for your OS Layer is MBR partitioned, rather than GPT partitioned. Otherwise, you will not be able to

install the Unidesk OS Machine Tools.

XenCenter uses Port 5900 to access the console on each VM. Make sure that this port is open on your OS image.

Otherwise, the packaging machines or publish images the console will not work until you reboot the VM.

Choose the operating system you are using for the OS Image:

Windows Server 2012 R2 (Session Host)

Windows Server 2008 R2

Windows 10

Windows 7

Prepare a Windows Server 2012 R2 image (Session Host)

STEP 1: Set up a Windows Server 2012 R2 OS Image on a virtual machine

In the XenServer client:

Create a VM for the OS image.

Configure the virtual machine hardware settings, for example, the NIC and video memory.

Configure a virtual hard disk that is large enough for a Windows operating system installation, and make sure it is accessible

by the Management Appliance.

Install Windows Server 2012 R2.

Disable Windows System Restore and Windows Automatic Updates. The system handles restore points for you, and layer

versions allow you to control when updates occur.

Install XenServer Tools on your OS image.

STEP 2: Copy the OS Machine Tools onto the OS Image

Download the Citrix_App_Layering_OS_Machine_Tools ZIP file onto the OS Image.

Extract the Citrix_App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct KMS

activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine Tools

download, as described in the next step. To configure scripts for KMS:
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In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script file in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

In the c:\windows\setup\scripts folder, right-click the unattend.hta tool and choose Run as administrator. The unattend

builder form opens.

Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK. 

Domain Join

Select Enable if  you want to configure the unattend.xml file to join desktops to a specific domain. If  you plan to use AD join

scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we recommend

that you use an alternate OU for Unidesk desktops, both to segregate the desktop from other machines and to avoid

applying virtual desktop-specific GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml files in different application layers. 

Local Administrator account

If  you want to use the unattend.xml file to enable the Administrator account on each desktop, select Enable. Remember to

also enable this account in your OS Image or Operating System Layer revision. It is possible to enable the Administrator

account for your OS Image and then have it disabled in the deployed desktops by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This account

cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed. 

T ime zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone, not the

display setting. A list of time zone settings can be found here. 

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

In the c:\windows\setup\scripts folder, run the optimize.hta executable to create a .cmd file (optimization.cmd) that will be

run to optimize the image during Desktop creation.

Follow the instructions to run the optimize.cmd file on the OS Image. This removes installation-specific drivers and settings.

If  you are using the optimization script and you are enabling the View Persona feature, you must go to the section of the

optimize.hta script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable Offline File

Service, and click Save File. This is because View Persona folder redirection requires Offline files to be enabled, and by

default, the Optimizer turns off  Offline files, which are not a requirement for Unidesk.
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STEP 6: Create a snapshot of the OS Image

Once the OS Image is ready, create a snapshot of it, so that you can return to this state at any time.

Important: It is critical to create a snapshot before installing the App Layering software onto the OS Image. Without this

snapshot, returning to this state requires rebuilding the image.

STEP 7: Install the OS Machine Tools onto the OS Image

In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS Layer.

Prepare a Windows 2008 R2 image

STEP 1: Set up a Windows Server 2008 R2 OS Image on a virtual machine

In the XenServer client:

Create a VM for your OS image, making sure to choose the default cluster allocation size of 4K.

Configure the virtual machine hardware settings, for example, the NIC and video memory.

If  you are using Citrix PVS or VMware Horizon View, install Windows Server 2008 R2 Service Pack 1 (SP1).

Notes:

When creating the image, be sure to choose the default cluster allocation size of 4K.

If  using PVS:

Install KB255098 hitfix.

Reboot the VM.

Enter the commands:

set devmgr_show_nonpresent_devices=1

devmgmt.msc

Uninstall any dead (ghost) NICs.

Reboot the system.

Disable Windows System Restore and Windows Automatic Updates. The system handles restore points for you, and

Unidesk layer versions allow you to control when updates occur.

Install XenTools on the OS image.

STEP 2: Copy the OS Machine Tools onto the OS Image

Download the App_Layering_Citrix_App_Layering_OS_Machine_Tools ZIP file onto the OS Image.

Extract the App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation
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If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct KMS

activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine Tools

download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script file in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

In the c:\windows\setup\scripts folder, right-click the unattend.hta tool and choose Run as administrator. The unattend

builder form opens.

Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK. 

Domain Join

Select Enable if  you want to configure the unattend.xml file to join desktops to a specific domain. If  you plan to use AD join

scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we recommend

that you use an alternate OU for Unidesk desktops, both to segregate the desktop from other machines and to avoid

applying virtual desktop-specific GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml files in different application layers. 

Local Administrator account

If  you want to use the unattend.xml file to enable the Administrator account on each desktop, select Enable. Remember to

also enable this account in your OS Image or Operating System Layer revision. It is possible to enable the Administrator

account for your OS Image and then have it disabled in the deployed desktops by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This account

cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed. 

T ime zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone, not the

display setting. A list of time zone settings can be found here. 

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

In the c:\windows\setup\scripts folder, run the optimize.hta executable to create a .cmd file that will be run to optimize the

image during desktop creation.

Follow the instructions to run the optimize file on the image. This removes installation-specific drivers and settings.

If  you are using the Optimizer script and you are enabling the View Persona feature, you must go to the section of the
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Optimizer script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable Offline File

Service, and click Save File. This is because View Persona folder redirection requires Offline files to be enabled, and by

default, the Optimizer turns off  Offline files, which are not a requirement for layering.

STEP 6: Install the OS Machine Tools onto the OS Image

In the App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS Layer.

Prepare a Windows 10 image

When preparing the OS Image for import into an OS Layer, you can speed up start times by removing Windows 10 built-in

applications. If  you do, we recommend removing these applications either on the OS Image itself, or on the OS Layer.

STEP 1: Set up a Windows 10 image on a virtual machine

In the XenServer client:

Create a VM for your OS image.

Important: When creating the image, be sure to choose the default cluster allocation size of 4K.

Configure the virtual machine hardware settings, for example, the NIC and video memory.

Disable Windows System Restore and Windows Automatic Updates:

Log into the VM.

Select Computer Config > Administrative Templates > Windows Components > Windows Updates > Config Auto Updates.

Set this to Disabled.

The App Layering system handles restore points for you, and layer versions allow you to control when updates occur.

If  using KMS licensing, run a command window as Administrator, and enter these commands:

slmgr /skms <kmsserverhost>

slmgr /rearm

reboot

slmgr /ipk XXXX-YOUR-KMS-KEY-XXXX

slmgr /ato

Install the VMware Tools on the OS image.

If  you are including the Windows Store in your Windows 10 image, get the latest updates for all Store Apps.

Launch the Windows Store application, click the Sign in icon (top right), then select Downloads and Updates.

Check for Updates, and click Update All. This should be repeated at least twice to ensure that the latest updates have been

pulled.

Important: Avoid finalizing the OS Layer while download or update processes are running, as this may cause deployed

images (and every user) to experience a continuation of those operations each time they log in.
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STEP 2: Copy the OS Machine Tools onto the OS Image

Download the Citrix_App_Layering_OS_Machine_Tools ZIP file onto the OS Image.

Extract the Citrix_App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct KMS

activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine Tools

download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script file in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

In the c:\windows\setup\scripts folder, right-click the unattend.hta tool and choose Run as administrator. The unattend

builder form opens.

Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK. 

Domain Join

Select Enable if  you want to configure the unattend.xml file to join desktops to a specific domain. If  you plan to use AD join

scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we recommend

that you use an alternate OU for Unidesk desktops, both to segregate the desktop from other machines and to avoid

applying virtual desktop-specific GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml files in different application layers. 

Local Administrator account

If  you want to use the unattend.xml file to enable the Administrator account on each desktop, select Enable. Remember to

also enable this account in your OS Image or Operating System Layer revision. It is possible to enable the Administrator

account for your OS Image and then have it disabled in the deployed desktops by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This account

cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed. 

T ime zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone, not the

display setting. A list of time zone settings can be found here. 

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.
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In the c:\windows\setup\scripts folder, right-click the optimizations.exe tool and choose Run as administrator. This creates

a .cmd file (optimizations.cmd) that will be run during Desktop creation to optimize the image.

Follow the instructions to run the optimizations.cmd file on the OS Image. This removes installation-specific drivers and

settings.

If  you are using the Optimization script and you are enabling the View Persona feature, you must go to the section of the

Optimization script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable Offline

File Service, and click Save File. This is because View Persona folder redirection requires Offline files to be enabled, and by

default, the optimization script turns off  Offline files, which are not a requirement for App Layering.

STEP 6: Install .Net Framework 3.5.1

The .Net Framework is a software framework provided by Microsoft that is required for many 3rd party applications to run.

To install this feature, follow the steps below.

On the Start menu, select Control Panel > Programs and Features.

In the left panel select Turn Windows features on or off. A window opens.

Select .NET Framework 3.5, click OK, and wait for the installation to complete.

Important: Even if  .NET is already installed, continue with the rest of these steps.

Exit the Control Panel.

In Notifications in the right-side of your taskbar, click All Settings, and open the Windows 10 Settings app.

Select Settings > Update & Security.

Check for updates, and install all updates available.

Exit Settings.

Open an administrator-level command prompt, and enter the following commands:

cd \windows\Microsoft.Net\Framework\v4.nnnnn

ngen update /force

Wait for the command to complete, and enter the following commands:

cd \windows\Microsoft.Net\Framework64\v4.nnnnn

ngen update /force

Exit the command prompt.

STEP 7: If  using PVS, follow these steps to avoid ghost NICs.

Enter the commands:

set devmgr_show_nonpresent_devices=

devmgmt.msc

Remove any ghost NICs.
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Reboot the system.

STEP 8: Install the OS Machine Tools onto the OS Image

Run setup_x64.exe from c:\Windows\setup\scripts.

Once this is done, you are ready to create a Unidesk Operating System Layer.

Prepare a Windows 7 image

STEP 1: Set up a Windows 7 OS Image on a virtual machine

In the XenServer client:

Create a VM for your OS Image.

Important: When creating the image, be sure to choose the default cluster allocation size of 4K.

Configure the virtual machine hardware settings, for example, the NIC and video memory.

Disable Windows System Restore and Windows Automatic Updates. The App Layering system handles restore points for

you, and layer versions allow you to control when updates occur.

Make sure you have installed VMware Tools on the OS image.

STEP 2: Mount or copy the Citrix App Layering OS Machine Tools onto the OS Image

Download the Citrix_App_Layering_OS_Machine_Tools ZIP file onto the OS Image.

Extract the citrix_app_layering_os_machine_tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct KMS

activation script when the system starts, or by running the Unattend file included in the Citrix App Layering OS Machine

Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script file in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation

In the c:\windows\setup\scripts folder, right-click the unattend.hta tool and choose Run as administrator. The unattend

builder form opens.

Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml file to join desktops to a specific domain. If  you plan to use AD join

scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we recommend
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that you use an alternate OU for Unidesk desktops, both to segregate the desktop from other machines and to avoid

applying virtual desktop-specific GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml files in different application layers.

Local Administrator account

If  you want to use the unattend.xml file to enable the Administrator account on each Unidesk desktop, select Enable.

Remember to also enable this account in your OS Image or Operating System Layer revision. It is possible to enable the

Administrator account for your OS Image and then have it disabled in the deployed desktops by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This account

cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone, not the

display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool.

Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

In the c:\windows\setup\scripts folder, run the optimize.hta executable to create a .cmd file that will be run to optimize the

image during desktop creation.

Follow the instructions to run the optimize.hta file on the OS Image. This removes installation-specific drivers and settings.

If  you are using the Optimization script and you are enabling the View Persona feature, you must go to the section of the

Optimization script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable Offline

File Service, and click Save File. This is because View Persona folder redirection requires Offline files to be enabled, and by

default, the optimization script turns off  Offline files, which are not a requirement for App Layering.

STEP 6: If  using PVS, follow these steps to avoid ghost NICs

Install KB2550978 hotfix.

Reboot the VM,

Enter the commands:

set devmgr_show_nonpresent_devices=1

devmgmt.msc

Remove any ghost NICs.

Reboot the system.

STEP 7: Install the Citrix App Layering OS Machine Tools onto the OS Image

In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).
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The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS Layer.
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http://docs.citrix.com/en-us/citrix-app-layering/4/hyper-v/configure/connector-essentials.html


© 1999-2017 Citrix Systems, Inc. All rights reserved. p.302https://docs.citrix.com

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_layer_az4/itoc_3_connectors_layer_az4/connectors_about_co4
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http://www.vhersey.com/2014/03/citrix-pvs-write-cache-design-considerations/
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https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_admin_ah4/itoc_3_admin_manage_layering_ah4/layer_delete_co_ah4/layered_images_manage_template_ah4
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https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_publish_layered_images_ah4/layered_images_create_template_ah_mc4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_connectors_publishing_ah4/connector_config_fields_ah_mc4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_connectors_publishing_ah4/connector_config_fields_ah_mc4
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https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co_az4#Assign
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https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co_az4#Assign
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https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_notchecked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_checked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_details.png
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Update OS layer

Jun 29, 2017

The Unidesk OS Layer contains the Windows Operating System that is assigned to any Unidesk Layered Images you create

using that OS Layer. Once created, you can use the OS Layer to build as many Layered Images as you want.

The OS Layer includes a virtual machine in your infrastructure running the Unidesk-supported Windows Operating System

that you want to use for your Layered Images.

Add a version of  an OS layer

1. In the Citrix App Layering Management Console, select Layers > OS Layers

2. Select or right-click an OS Layer icon and click Add Version. This opens the Create OS Version Wizard.

3. (Required) In the Version Details tab, enter a Version identif ier. This can be the application version, or anything you

choose.

4. In the Connector tab, select a Connector configuration for the platform where you'll be publishing your Layered Images.

You can also modify an existing configuration by selecting it and clicking Edit. If  you have not yet created a Connector

Configuration or if  the configuration you need is not present, click New to create a new Connector Configuration and

select it from this list.

5. In the Platform Layer tab, select a Platform Layer that contains the tools and hardware settings that you need to install

and package the OS when adding a Layer Version. Once created, the new Layer Version can be used in Layered Images

published to any platform.

6. In the Packaging Disk tab, enter a f ile name for the Packaging Disk, and select the disk format. This disk will be used for

the Packaging Machine (the VM) where you will install the application, as described in the next two sections.

7. Confirm and Complete tab - Verify your settings and click Create Version. Unidesk runs the task of creating a new OS

version. When the task completes, it shows a status of Action Required. When you double-click the task to expand it,

the task contains the following text (refer to the image in the next section): 

"The Packaging Disk has been published. The virtual machine '<...>' can be found in folder '<...>' in datacenter '<...>'. Power on

this virtual machine to install your application. When the installation is complete, power off  the virtual machine before

clicking Finalize on the Action bar."

Next, you can deploy a Packaging Machine for this OS Layer version.

Deploy a Packaging Machine to XenServer

The Packaging Machine is a virtual machine where you install any updates or applications you want to include in the OS

Layer. It is strongly recommended that you use a unique Packaging Machine for each Layer. The Packaging Machine is a

temporary VM that will be deleted once the OS Layer has been finalized.

The Task Description (example shown in the last step above) contains directions to navigate to the location in XenServer

where the Packaging Machine for this Layer has been created.

1. To create your Packaging Machine in XenServer, begin with the expanded Packaging Disk task shown in step 2 below.

2. Log into your XenServer web client.

3. Back in the Unidesk Management Console, use the instructions in the expanded Packaging Disk Task (example shown

below) to navigate to the Packaging Machine.

Install the OS update
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1. Remote log into the Packaging Machine in XenServer. Be sure to log in with the User account you used to create the OS

in XenServer.

2. Install any updates or applications you want to include in the new OS Layer version, such as Windows Updates or anti-

virus applications.

3. If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

4. Make sure the Packaging Machine is in the state you want it to be for the user:

If  the applications you install require any post-installation setup or application registration, complete those steps now.

Remove any settings, configurations, f iles, mapped drives, or applications that you do not want to include on the

Packaging Machine.

Next, you will shut down the Packaging Machine and verify that the Layer is ready to finalize.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, the next step is to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

1. If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

2. Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verif ication

process.

3. If  there is an outstanding operation that must be completed before the Layer can be f inalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

4. Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into
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native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground. 

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

3. Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status

3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the OS layer

Once the Packaging Machine is created and any apps or updates installed, you'll need to finalize the layer.

Note: When you finalize a new version of an OS Layer, Unidesk deletes the Packaging Machine so as not to incur more

costs.

When a layer is ready to finalize:

1. Return to the Unidesk Management Console.

2. In the Layers module, select the Layer.

3. Select Finalize in the Action bar.

4. Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.

Reference: Create OS Version Wizard values

Version - (Required) This can be the version of the OS Layer or a version you assign to the Layer. This value is displayed in the

Details view of the Layer.

Version Description - (Optional) Enter a description of the version.
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Max Layer Size - (Optional) Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 100 gigabytes. If  the version you are creating could requires more space,

change this to a realistic value.

Select a Platform Connector configuration - (Required) Specify a Unidesk Platform Connector for the platform where you'll

be publishing your Layered Images. For example, if  you're publishing to Azure RD Session Host, select the Azure RDSH

connector with the credentials required to access the account. If  the configuration you need is not listed, add a New one

and select it from this list. If  you want to change the settings of a Platform Connector configuration, select it and click

Edit.

Packaging Disk Filename - (Required) The name of the Packaging Machine you created in Azure.
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Delete OS layer

Jun 29, 2017

You can delete an OS Layer or Layer version, as long as it is not being used by another Layer, or Image Template. Deleting

the Layer itself  removes all versions, volumes, and resources from the App Layering appliance.

You can delete an entire layer or a layer version if  it is:

Not deployed to an Image Template.

Not the required OS Layer (or Layer Version) for any compatible App Layers.

Not a prerequisite for another Layer that is deployed to an Image Template.

Delete a layer or layer version

1. In the Management Console, select Layers.

2. Select an OS Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.
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Delete platform layer

Jun 29, 2017

You can delete a Platform Layer or Layer version, as long as it is not being used by an Image Template. Deleting the Layer

itself  removes all versions and resources associated with the Layer.

1. In the Management Console, select Layers > Platform Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Delete app layer

Jun 29, 2017

You can delete an app layer or layer version, as long as it is not being used by another layer as a prerequisite, or deployed to

an image template. Deleting the layer itself  removes all versions and resources associated with the layer.

1. In the Management Console, select Layers > Application Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Manage image templates

Jun 29, 2017

When you create new layers and new versions to them, you can edit the layer selection in your image templates, and use

the templates to publish new versions of your layered images. Once created, a layered image is no longer associated with

the template used to create it. This means that you can change or delete a template without affecting any previously

published layered images.

Update image templates with a new layer version

When you add a new version to an app layer or an OS layer, you can quickly identify the image templates that include the

layer, and select which templates to update with the new version.

1. In the App Layering Management Console, select Layers > App Layers or Layers > OS Layers.

2. Select the Layer you updated, and click Update Assignments.

3. In the wizard that opens, select the new version of the layer that you want to assign. The image template assignment

tab lists the image templates that include the layer but are not yet assigned the new version.

4. On the image template assignment tab, select the image templates to which you want to assign the layer or layer

version.

Notes:

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out names

may appear. These templates have already been assigned the Version.

You can use the Search f ield to f ilter this list by Layer or Version. If  you search on part of a Layer name or Version, any

entry that contains the search string is displayed.

5. Skip the Elastic Assignment tab

6. On the Confirm and Complete tab, verify your choices and click Update Assignments.

Edit any image template setting

When you want to change the settings that you use to publish any of your layered images, you can edit the image

template you originally used to publish the layered image(s) and publish a new version of the image(s).

1. In the App Layering Management Console (UMC), select the Images module.

2. Select the template you want to edit, and click Edit Template. This opens the Edit Template wizard.

3. On the Name and Description tab, you can change the Name, Description, and Icon for the Image.

4. On the OS Layer tab, you can select a different version of your chosen OS layer by expanding the layer and choosing a

different one.

5. On the App Assignment tab, you can add or remove app layers to include in the layered images that you publish using this

template. If  there is more than one version of a layer, you can choose a different version by expanding the layer and

choosing a different one.

6. On the Connector tab, you can change the location to which the Layered Image is published by selecting a different

Connector Configuration.

7. On the Platform Layer tab, you can change the selected Platform Layer, if  for example, you are publishing to a different

environment.

8. On the Layered Image Disk tab, you can edit the Layered Image Disk details, for example, to enable Elastic Layering on

the image.

9. In the Confirm and Complete tab, enter any comments you would like for this layer, and click Edit Template.
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Delete an image template

When you no longer need an Image Template, you can remove it from the Management Console.

1. In the Management Console, select the Images module.

2. Select the template you want to delete, and click Delete Template. This opens the Delete Template wizard.

3. In the Confirm and Complete tab, enter any comments you would like, and click Delete Template.
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App Layering in Nutanix AHV

Jun 29, 2017

Nutanix AHV requirements for installing the App
Layering Appliance

If  you are installing the appliance and building your Layers on Nutanix VMs, or you are publishing Layered Images that will be

used in a Nutanix environment, you need:

Nutanix account and privileges

An existing or new Nutanix AHV account to use for App Layering.

The account must have Nutanix AHV privileges to:

Create and remove virtual disks.

Copy and delete layers on virtual disks using Nutanix f ile APIs.

Nutanix software and settings

Access to the Nutanix Tools to install on the layer.

Nutanix resource information

The info listed in Nutanix AHV Connector Configuration.

Storage requirements

350-500 GB Storage Space

The App Layering appliance uses local storage for temporary files and finalized layers. The more layers you create, the more

space you need. However, if  you run low on space, you can expand the size of the current disk, or add other disks to the

appliance when needed.

40-100 GB network file share (SMB)

The file share connected to the appliance is used for upgrades, Elastic Layers, and cross-platform publishing. This space is

easy to expand, if  needed.

Operating System requirement

OS for Layered Images

You need a supported operating system to import into an OS Layer. This OS will be used to build your Layered Images.

https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_connectors_publishing_ah4/connector_config_fields_ah4
https://www.unidesk.com/support/learn/4.2.0/citrix_app_layering/welcome_platform_support_co4
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Install

Jun 29, 2017

Before you start

To get started with App Layering, you will need:

A Citrix Cloud account

A supported version of Nutanix AHV

A virtual network in Nutanix AHV

Storage requirements and Nutanix AHV requirements listed here.

Installation package

The installation package, citrix_app_layering_nutanix_4.x.x, includes:

File Description

Nutanix_x.x.x.zip IMG files for the appliance VM

citrix_app_layering_agent_installer.exe App Layering Agent installer

citrix_app_layering_win_gold_image_tools.exe OS Machine Tools

Deploy the App Layering Appliance (Nutanix AHV)

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to layering.cloud.com.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. At the top of the page select the hypervisor where you are deploying the App Layering service. This selection determines

which platform-specific installation package will be downloaded in Step 2.

9. Under Step 2, click the Download for Hypervisor button to download the appliance installation package for the

hypervisor you have selected.

https://www.unidesk.com/support/learn/4.2.0/citrix_app_layering/welcome_platform_support_co4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_install_ah4/get_started_prerequisites_ah4
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10. Under Step 3, right-click Instructions, open the page in a new browser tab, and select your hypervisor. The installation

instructions for your hypervisor are displayed.

11. Extract the download package, citrix_app_layering_nutanix_4.x.x.zip. The files included are listed above.

12. Next, unzip the nutanix_4.x.x zip file, containing two IMG files.

13. In the Nutanix Prism console, select the Tools menu in the top right corner of the UI, and choose Image Configuration.

14. Click the Upload Image button, and name the disk.

15. Select the Disk Image Type.

16. Select the Upload a File option, browse to your file share, and choose the App Layering Boot Disk (the "system" IMG).

Wait for the upload to complete.

17. Repeat steps 13 - 16 for the Local Storage Disk (the "repository" IMG).

18. Select Tasks and make sure that for each of the disks, both the Image Create and Image Update tasks are complete.

Once this is done, you can create the VM.

19. Select the VM tab on the top left dropdown menu, and click the Create VM button.

20. Complete the Name and Description of  the new VM.

21. Set VCPU(S) to 1.

22. Set Number of Cores per VCPU to 4 .

23. Set Memory to 8 GB.

24. To add the Disks to the VM, click Add new disk and choose type Disk.

25. In the Operation drop-down, choose Clone f rom Image Service.

26. In the Bus Type drop-down select IDE.

27. In the Image Box select the Boot disk that you uploaded, and click Add.

28. Repeat the above steps for the following disks:

Boot Disk: citrix_applayering_nutanix-system.img

Repository Disk: citrix_applayering_nutanix-repository.img

29. Add NIC by clicking on Add new NIC.

30. Click Save to complete dialog and create VM.

31. Power on the VM.

32. Back in the Cloud, under Step 4, the Documentation link opens the instructions for logging in. (The link below opens the

same article.)

33. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions (link below) to log into the

https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_install_ah4/get_started_deploy_unidesk_elm_ah4#Before
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appliance.

If you receive the error: "Cannot create UUID from string "undefined""

Ensure that you have waited for both tasks for each disk to be completed before attempting to create the VM.

Install the App Layering Agent (required for PVS and Connector Scripts)

The App Layering Agent enables the App Layering appliance (Enterprise Layer Manager) or a Unidesk Packaging Machine VM

to run PowerShell commands locally. If  you supply the proper credentials, the agent can run PowerShell commands as a

specific user.

The App Layering Agent is required in cases where one of your Connector Configurations launches a PowerShell script. This

includes Connector Configurations you use to:

Publish Layered Images to a provisioning system.

Package Layers in your hypervisor environment.

The App Layering Agent installer prompts you to register the agent with a App Layering appliance. If  you do not register the

agent during installation, you can manually register it later. However, keep in mind that the PowerShell scripts will not run

until the agent is registered with the ELM.

Prerequisites

Before you install the App Layering Agent, you must have the following requirements on the system where you are

installing the App Layering Agent:

An account with administrator privileges

.NET 4.5

PowerShell 3.0 or greater

PowerShell Snap-in

Before using the App Layering Agent on a PVS server you must ensure the PowerShell Snap-in is installed. This is a

manual step.

For PVS 7.7 and later, you must install the Powershell Snap-in Citrix.PVS.Snapin.dll.

For PVS 7.6 and PVS 7.1, you must install McliPSSnapIn.dll. Use the installutil.exe to install the Snap-in.

Example (7.6):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" McliPSSnapIn.dll

Example (7.7):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" Citrix.PVS.snapin.dll

On Windows 2008 R2, you must also enable PowerShell remote commands. For background information, see this Microsoft

article: https://technet.microsoft.com/en-us/library/hh849694.aspx

If  your 2008 R2 OS does not have PowerShell remoting enabled, run the following PowerShell command on the PVS server:

Enable-PSRemoting  

Install the App Layering Agent

https://technet.microsoft.com/en-us/library/hh849694.aspx
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1. Log in as an administrator on the system where you are installing the agent.

2. Download the App Layering Agent from the Unidesk Download page.

3. Copy the Unidesk_agent_installer.exe f ile from the App Layering Agent folder to a convenient location on the PVS

server.

4. Run the Unidesk_agent_installer.exe as Administrator, and when prompted, enter the path to the directory where you

want to install the App Layering Agent. The default location is C:\\Program Files (x86)\Unidesk\Agent.

5. The App Layering Agent installer checks to see if  all Prerequisites are present. If  any prerequisites are missing, the installer

reports this and exits without installing.

6. The installer prompts you for an Agent Port number. You can accept the default port number (8016) or specify a

different one if  the default port is already in use.

7. The installer prompts you for the credentials (address, username, and password) for your App Layering appliance. Register

the App Layering Agent with the ELM by entering the IP address and login credentials for a Unidesk Management

Console (UMC) user on the ELM with Administrator privileges, (for example, the credentials you use to log into the UMC).

Note: If  the App Layering appliance is not available yet or you choose not to register with it now, you can manually

register at a later time using the procedure described in Register with the App Layering appliance manually.

8. Click Finish to exit the wizard.

Register the App Layering Agent manually

If  the App Layering Agent was not registered with a App Layering appliance during installation, you can register it later by

using the following procedure.

To manually register the App Layering Agent with the ELM:

1. As an administrator, log in to the server where you installed the App Layering Agent.

2. Open a command window (cmd.exe) as administrator and navigate to the directory where the App Layering Agent is

installed. (The default location is C:\\Program Files (x86)\Unidesk\Agent.)

3. Run the following command, using the IP address of the ELM where indicated:

Unidesk.Agent.Service.exe register /i /e:IP_address_of_ELM /u:Administrator

4. When prompted, enter the password for a user who has Administrator privileges in the Unidesk Management Console

(UMC) on the ELM.

5. When the registration process completes, a message appears informing you of the successful outcome. The App

Layering Agent registration appears in the Audit log for the Management Service in the UMC.

If  the process does not succeed, examine the \Unidesk\Agent\Logs\unidesk.agent.log file in the App Layering Agent

installation directory. You can also view Help for the App Layering Agent command line options by running the following

command: Unidesk.Agent .Service.exe /?.
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Configure

Jun 29, 2017

You can access the App Layering Management Console using the appliance's IP address entered in a web browser, or via the

Citrix Cloud. Currently, access via Citrix Cloud is in Labs, and there are a few things you should be aware of when accessing

the Management Console via the Cloud.

Access the Management Console directly via your private network

To log directly into the Management Console hosted on the App Layering appliance:

In your hypervisor, locate the VM you created for the appliance and determine its IP address.

Using the IP address for the appliance, enter the following URL in a compatible web browser:

http://<ip_address_of new_vm>/

This displays the Login page for the Management Console.

Log into the Citrix Cloud, and select the App Layering tile. This displays the Log in page for the Management Console.

Log in to the Management Console as Administrator.

If  this is the first login on this appliance, the Set up Login Credentials wizard is displayed. Here you must change the

password for each of the appliance's administrative accounts.

Access the Management Console via Citrix Cloud (Labs)

When you log into Citrix Cloud, you can use the App Layering Manage tab to access the Management Console. Below,

please see the minor issues you may encounter when using the Manage tab to access the appliance.

In your hypervisor, locate the VM you created for the appliance and determine its IP address

In your internet browser, navigate to citrix.cloud.com and select the Manage button on the App Layering tile. This

displays the Citrix App Layering page.

Click the Manage tab, and in the window that appears, select the Resource Location, enter the Appliance Address, and

click Connect. This displays the Login page for the Management Console.

Log in to the Management Console as Administrator.

If  this is the first login on this appliance, the Set up Login Credentials wizard is displayed. Here you must change the

password for each of the appliance's administrative accounts.

Known issues and considerations with Management Console access via Citrix Cloud (Labs)

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.

1.

2.

3.

4.

1.

2.

3.

4.
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Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.

Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.

Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Change administrative passwords
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The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

adminstrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the passwords for the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, skip to Step 3.

2. Select User > Set up Login Credentials. On the About Your Credentials tab, the three administrative accounts are

described.

3. Take a moment to familiarize yourself  with the administrative accounts for the appliance.

4. For each account, enter the new password and then re-enter it in type it in the Conf irm Password f ield.

5. On the Confirm and Complete tab, click Change Credentials.
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Set up a file share for the App Layering appliance
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The App Layering appliance must be connected to a network file share. When setting up the appliance's file share:

The file share must be configured using SMB technology.

Note: If  you used a previous (Unidesk 4.0.x) version of the product to configure an NFS file share, you can continue using

the file share, but it will not support Elastic Layer assignments.

The user credentials for the file share must have full permissions for that share.

The share must be set up by the admin to be readonly for all users except for the one configured in the appliance. This

secures the Layers and other files stored on the share.

Ensure that you have the minimum storage space requirement of 40-100GB for your file share.

Note: Storage space is expandable, as you can add space to a disk, or other disks to the appliance.

For convenience, set up a File Share hosted in your hypervisor.

For Azure: Currently, the App Layering Appliance does not support the Azure File Share feature. For best performance, it

is best to create a file share server in Azure using a fast system with a Premium Disk, for example, a DS class machine. 

Create the network file share

Configure a file share that uses Server Message Block (SMB) protocol.

Follow the vendor's instructions for setting up a file share using the SMB protocol. 

Configure the App Layering appliance to access the file share

Once you have created a file share, configure the App Layering Appliance to attach to it. You can configure the

appliance via the App Layering Management Console.

1. In the Management Console, select System > Settings and Configuration, then scroll down to the network file shares

setting and click Edit .

2. Specify a Type, Path, User name, and Password for the file share.

3. Click Test Network File Share to see if  you can connect to the file share. The test returns a message stating either

Success or Failed to mount network file share path.

4. Once the test returns a Success message, click Save.
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Open firewall ports for App Layering, as needed

Jun 29, 2017

The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin User

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.

Destination Activity Protocol Ports

App Layering appliance (Enterprise Layer Manager (ELM)) Management Console TCP 80,443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

Connector for PVS Communication TCP

3009 (HTTP)

3509 (HTTPS)

Connector for vSphere Communication TCP

3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP

3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161
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App Layering Appliance (Enterprise Layer Manager (ELM))

Internal Connections

By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent  - refers to the App Layering agent, which you install on

Admin User -
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Source Destination Activity Protocol Ports

Appliance Agent Communication TCP 8016

Agent Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via

ESXI Host
TCP 443

Agent Appliance
Communication with datastore via

ESXI Host
TCP 8888

Appliance Active Directory
Communication with datastore via

ESXI Host
TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP)

3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP)

3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the
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destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.

Destination Activity Protocol Ports

XenCenter Communications 5900
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Connect to a directory service

Jun 29, 2017

You can configure the appliance to connect to a directory service, for example, Active Directory. When you connect to your

directory service, you will create one or more Directory Junctions to access specific domains or OUs. The appliance does not
modify the directory service you connect to. The software caches the attributes for each directory service entry, so that if

the connection to the directory service is lost temporarily, the software can use the cached information for management

tasks.

About connecting the appliance to a directory service

The Management Console Directory Tree displays a hierarchical view of Users and Groups. Each Directory Junction that you

create specifies a starting node in the directory tree.

Overlapping directory junctions

Overlapping (or nested) directory junctions occur when you create multiple directory junctions that contain the same users

and then import the users into the directory tree. When overlapping occurs, each directory junction contains its own copy

of the duplicate users.

Example: Overlapping directory junctions

Assume you create Directory Junction A that starts at the Marketing folder in a directory service tree. Next, you create

Directory Junction B which starts at a folder above the Marketing folder. If  you browse both directory junctions, you can

see the Marketing users in both folders.

User attributes are imported f rom the directory service

The App Layering software imports and caches user and group attributes from your directory service when:

You assign administrator privileges to a user.

The values of the attributes change in the directory service.

The attributes that the software caches are read only. All changes to the attributes for directory service users come from

the directory server.

Imported attributes are synchronized regularly

The software synchronizes the information it caches for directory service users with the directory service every 12 hours. If

the software discovers that a user is no longer an object in the directory service, it classifies the user as abandoned (you can

view this information in the Information view for the user).

Create a directory junction

Create the folders where you want to place the Directory Junctions or decide which existing folder you want to use. You

can add a Directory Junction folder to any existing folder in the Management Console directory tree.

Best Practice: Avoid creating overlapping Directory Junctions, if  possible. In some circumstances, deleting an overlapping

Directory Junction can affect your ability to delete another Directory Junction that contains the same users.

1. Select Users > Directory Service.
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2. Select Create Directory Junction in the Action bar. This opens the Create Directory Junction wizard.

3. In the Connection Details tab, specify the details for the directory server.

Directory Junction Name- This name becomes the name of the folder that you see in the tree view. You can use any

name, including the name of a domain in your directory service tree.

Server address - This is the name for the server you will use for the directory service. (IP Address or DNS Name)

Port - Specify the port number for communicating with the directory server.

SSL check box - Select this if  you want to use Secure Sockets Layer (SSL) communication.

If  certificate errors occur, the wizard displays a list of these errors. If  you know it is safe to ignore them, select Ignore

Certificate Errors.

Test Connection - Click to verify that the appliance can connect to the directory service.

4. In the Authentication Details tab, enter the authentication details for a user who has permissions to search the

directory service.

Bind Distinguished Name - To determine the correct syntax for the Bind DN or user name, see the documentation for

your directory.

Examples: The following examples shows some of the ways you can specify a user for the directory service:

domain\username or username@domain.com.

Bind Password.

Test Authentication - Click to verify that the connection to the directory server is valid.

5. In the Distinguished Name Details tab, specify where the software should start searching for users and groups in the

remote directory service.

Base Distinguished Name (DN) - The software starts searching for users and groups in the remote directory service.

Once you establish a connection to the server for the directory service, the wizard displays a list of available DNs. You

can select a DN from the list or enter the DN directly in the box.

Example: Assume that you want to start the search at the Marketing Organizational Unit at the root of a domain.

You would enter the following Base DN:

OU=marketing, DC=root,DC=mydomain DC=com

Test Base DN - Click to verify that the Base DN is valid.

6. In the Folder Location tab, select the folder in the Unidesk tree where you want to add the directory junction for the

remote directory service.

7. In the Attribute Mapping tab, enter the names of directory service attributes that you want to map to the local

attributes or use the default settings.

Note: To change the mapping from local attributes back to default mappings, click Use Defaults.

8. In the Confirm and Complete tab, verify the Directory Junction settings, enter a comment if  required, and click Create

Directory Junction.

If  you enter comments, they appear in the Information view Audit History.
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Assign App Layering roles to users
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About App Layering users, roles, and rights

Built-in administrator account

When you first install the App Layering appliance and log onto the Management Console, there is a "built-in" Administrator

account that you can use to get started. This Administrator has the rights to perform all App Layering operations. You can

edit this user's properties, including the name, password, and contact info. Be sure to change the password for this built-in

Administrator account as part of installing and configuring the appliance. 

AD user accounts

Other than the built-in Administrator account, all users are actually AD users imported via one or more directory junctions.

Once your directory junction(s) have been created, you can assign Roles to each user, as described later in this topic. You

can see which roles are assigned to a user in the User Details.

App Layering Roles defined

Roles determine which App Layering modules a user can manage. Users assigned one or more Roles can log into the

Management Console, and these users are listed on the Administrators tab (select Users > Administrators).

Note
When upgrading from version 4.0.6 or earlier, users assigned the Machine Administrator Role in earlier releases will now be

assigned the Read Only role. If the user needs more than read only access, reconfigure the user roles, as needed.

Rights by role
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Rights Role

Administrator

Can do every operation available in the Management Console.

Only users assigned the Administrator Role can edit user properties on the Users tab (Select Users
> Users).

Only administrators can configure system settings and manage licenses.

Manage App Layers Can create, edit, and delete application layers and versions.

Manage Elastic Layer

Assignments
Can add, update, and remove Elastic layer assignments.

Manage Image Templates

Can create, edit and delete Image templates.

Can add, update, and remove app layer assignments for image templates.

Can update platform layer assignments for image templates.

Can update OS layer assignments for image templates.

Manage OS Layers Can create, edit, and delete OS layers and versions.

Manage Platform Layers Can create, edit, and delete Platform layers and versions.

Publish Layered Images
Can publish layered images.

Cannot create or modify existing image templates.

Read Only

Can view information about any items in the Management Console.

Cannot launch any wizards or make any changes.

The Read Only user cannot cancel any tasks.

User credentials for logging into the Management Console

When you assign Roles to Directory Service users, they can use their Directory Service credentials to log into the

Management Console.

Who can assign App Layering Roles?

You can change a user's role if  you are logged into the Management Console as a user assigned the Administrator Role.

Assign App Layering roles to users

Log into the Management Console.

Select Users > Users.

Select a user and click Edit Properties. This opens the Edit User wizard. 

1.

2.

3.
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Skip to the Roles tab, and select one or more roles for this user. For details, see Rights by Role above.

In the Confirm and Complete tab, click Update User. Any comments you enter will appear in the Information view Audit

History.

4.

5.
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Enable Labs features
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Want to experiment with cool new features that are under development? Through the Management Console, you can

now see which features are available in Unidesk Labs in any given release. You can enable features you're interested in, try

them out, and let us know what you think. The only caveat? Best not use Labs features in your production environment, as

they are likely to evolve with the feedback we receive from users like you!

Throughout this documentation, features that are available through App Layering Labs are marked (Labs) in the title. Most

Labs features require enabling.

To find out which Labs features are available in this release, see What's New.

Enable a Labs feature

When a release includes a Labs feature that you want to enable:

1. Log into the Management Console and select System > Settings and Conf iguration.

2. Select the check box for the feature you want to enable, and click Save. The feature's status changes to Enabled.

You can turn off  the feature at any time by deselecting the check box and clicking Save.

http://docs.citrix.com/en-us/citrix-app-layering/4/whats-new.html
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Connector essentials
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What are Connectors?
Connectors are the interfaces to environments where you create Layers and publish Layered Images. You create one or

more Connector Configurations for each platform where you intend to package Layers or publish Layered Images.

What are Connector Configurations?
A Connector Configuration is a stored set of values for connecting to a storage location in your environment. A

configuration typically includes credentials for authentication, a storage location, and any other information required to

interface with the environment where you will be creating layers or publishing images. You can create multiple Connector

Configurations, each configured to access a unique location in your environment.

What Connector Configurations do I need?
Connector Configurations for importing an OS to create an OS Layer

When you create an OS Layer, you need a Connector Configuration to give the appliance access to the location of the OS

image that you want to use for your OS Layer.

Connector Configurations for creating and updating App Layers, and adding Versions to OS Layers
When creating or updating an App Layer, or adding Versions to an OS Layer, you need a Connector Configuration for the

location in your environment where you will package the Layer. You can create as many configurations as you need, for

example, if  you have more than one storage location in the environment.

Connector Configurations for publishing Layered Images
Publishing Layered Images will require different Connector Configurations than the ones you use for creating Layers, if, for

example, you publish Layered Images to a variety of storage locations near the users being served. For example, you can

prepare your Layers for a server farm in vSphere, and publish Layered Images to Citrix PVS for streaming to servers in

vSphere. Or, you can publish Layered Images to more than one storage location in the same environment, each requiring a

different Connector Configuration. Each location is likely to require different credentials.

How and when to add a new Connector Configuration
If  this is your first time using the App Layering Service, you will need to add one or more Connector Configurations in the

process of adding Layers and publishing Layered Images. In the Management Console, the wizards for Creating Layers,

Adding Versions, and Publishing Layered Images each include a page for selecting and creating Connector Configurations.
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Upgrade
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Prerequisites

Verify that a Network File Share has been configured. You can confirm that this has been done by logging into the

Management Appliance, selecting System > Settings and Configuration, and finding the Network File Share setting. If

the file share has been configured, you can upgrade the appliance. 

Download packages

Platform Package Files Included

Citrix

XenServer
app_layering_upgrade_xenserver_pkg_4.x.x.zip upgrade_xenserver_elm_4.x.x.xx.vhd

Microsoft

Azure
app_layering_upgrade_azure_pkg_4.x.x.zip upgrade_azure_elm_4.x.x.xx.vhd

Microsoft

Hyper-V
app_layering_upgrade_hyperv_pkg_4.x.x.zip upgrade_hyperv_elm_4.x.x.xx.vhd

VMware

vSphere
app_layering_upgrade_pkg_4.x.x.zip

upgrade_vmware_elm_4.x.x.xx.vhd

app_layering_agent_installer.exe

Note: An Agent upgrade is only required if you've installed the agent

for your implementation, for example, if you are using PVS, or

Connector Scripts.

Back up the appliance

Take a snapshot or checkpoint of the appliance.

Download the upgrade media to the network file share

The App layering 4 upgrade files include both the Appliance and Agent upgrades. The Agent upgrade can be used to bring

either or both of these installations up to date:

The agent on PVS servers.

Servers where Layered Images are enabled for Elastic Layers.

To download the upgrade package:

1. In a network browser, navigate to the App Layering Download page, and sign in.

2. Download the App Layering Upgrade package for your platform to the \Upgrade folder on the Network File Share.

3. Unzip the package in \Upgrade.

4. Copy the Agent upgrade to the server(s) where the agent is installed, and refer to Upgrade the App Layering Agent

below.

http://docs.citrix.com/en-us/citrix-app-layering/4/nutanix-ahv/configure/set-up-a-file-share-for-the-app-layering-appliance.html
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Load the App Layering upgrade

1. Log into the Management Console, select System and click the Upgrade action to launch the Upgrade Wizard.

2. On the Upgrade Disk Details tab, click Browse.

3. Navigate to the upgrade f ile, and click Choose.

4. Verify the Upgrade path, and click Upgrade. This starts the upgrade process, and opens a status page in the browser.

5. Once the upgrade has completed, the status changes to "Upgrade Status: Complete."

6. Refresh the Web page to return to the UMC.

7. Verify that the upgrade was successful by clicking the About  link in the Management Console to confirm the version

number. 

Upgrade the App Layering agent

When using PVS or Elastic Layers the Agent is required. To upgrade the App Layering Agent:

1. Uninstall the previous version of the App Layering Agent from the server(s) where they are installed.

2. Make sure that you have copied the App Layering Agent Upgrade f ile to the PVS server(s) where the agent is installed.

3. Double-click the Agent upgrade f ile, and follow the instructions for upgrading the Agent.

Create a Cloud Connector for accessing the Management Console via Citrix Cloud (Labs)

If  you want to access the Management Console via the Citrix Cloud, install a Cloud Connector as described here. For known

issues when accessing the Management Console via the Cloud, see the list of issues below.

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to the Cloud.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. Under Step 4, the Documentation link opens the instructions for logging in. 

9. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions to access the appliance. 

Known issues

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.
Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.

Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.
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Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Create layers

Jun 29, 2017

OS Layers

An OS Layer includes the software and settings for the operating system that you deploy as part of your other layers and

ultimately, your Layered Images. Once you have prepared the OS disk for deployment, you can create a Unidesk Operating

System Layer by importing the OS disk into a new Layer.

With an OS Layer, you can install your operating system once, and update it by adding a new Version to the Layer whenever

there's a new patch or update. You can deploy this layer, or a version of it, in every image you publish. This allows you to

maintain one OS image and use it to provision all of your servers.

If  you need to support more than one operating system, for example, if  you need both Windows Server 2012 R2 and

Windows Server 2008 R2, you can create more than one OS Layer. However, each App Layer is only compatible with the

OS Layer you use to create it, and if  you deploy two OS Layers, you will also need to deploy a compatible App Layer for

each one. Further, in future releases when deploying Elastic Layers to users, those layers will only be compatible with users'

desktops that use the same OS Layer.

If  you can support your users with a single OS Layer, the work associated with creating and updating App Layers will be

much reduced.

Each time you need to deploy operating system patches and updates, you will do so by adding a new Version to the

OS Layer. You can continue to publish Layered Images using any version of the OS Layer.

The prerequisites for creating an OS Layer include:

An App Layering-supported operating system

App Layering appliance and network f ile share installed and configured

 

Platform Layers

A Platform Layer is a layer that includes platform-specific configuration settings, tools, and other software required for

your OS and Apps to be installed in or to run in a particular environment.

Types of  Platform Layers

A Platform Layer for Packaging (required in some cases, see below)

Platform Layer for Publishing (always required)

Platform Layer for packaging layers and versions

The only time you need a Platform Layer for Packaging layers is when your OS image was created on a different hypervisor

than the one where you are building your other layers. When creating an App Layer or Layer Version, or OS Versions, the

purpose of the Platform Layer is to ensure that any hypervisor-related software and settings are available during the

installation of the application(s) on that layer, if  needed. If  you choose to use a Platform Layer for Packaging a layer, the

hypervisor-related software will only be used during layer packaging, and has no effect on where you can publish the layer

as part of a Layered Image.

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
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Platform Layer for publishing Layered Images

A Platform Layer for Publishing is required when you publish Layered Images. The purpose of the Platform Layer for

Publishing is to include the settings and software that the Layered Image needs to be deployed in your environment. When

creating a Platform Layer for Publishing, Unidesk removes unselected (and unnecessary) tools and software related to the

platforms you are not publishing to. This is to prevent any unnecessary platform software from slowing down the Layered

Image when it runs in the target environment.

App Layers

An App Layer is a virtual disk containing one or more applications that you can use in Layered Images. You can combine an

App Layer with any other App Layers and a Platform Layer, as long as the OS Layer used to create the App Layer is

selected.

With most applications, creating an App Layer is simple. In a few cases, it 's best to start with tips from experienced users, so

the Unidesk Forum includes Application Layer Recipes that you can search for tips about a particular application before you

start. 

To create an App Layer, you use the Create App Layer wizard to deploy a Packaging Machine in your environment and install

the application on the Packaging Machine, leaving the application in the state you want it to be in for users. Then you

finalize the Layer. 

User Layers (Unidesk Labs)

A User Layer is a virtual disk where a user's app data and configuration settings are saved. User Layers are created when you:

Publish a Layered Image with Elastic Layering set to Application and User Layers.

Users log into their desktops on the above Layered Image.

With User Layers enabled on the Layered Image, users can install applications locally on their desktops, and the apps and

their data will be saved in the User Layer.

Verifying Layers

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized. The new Layer or

Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the
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foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX
3. Enter the NGen command to execute the queued items:

ngen update /force
This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It ’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status
3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Connectors for layering

When creating Layers in a Nutanix environment, you need a Connector Configuration to define the hypervisor location from

which you will:

Import the OS image when creating your OS Layer.

Deploy a VM for the Layer and Install the application software or the Layer.

It is strongly recommended that you use the hypervisor where the App Layering appliance is installed. If  you decide to

create Layers on a hypervisor other than the one where the appliance is installed, you can use NFS instead of a Nutanix

Connector Configuration, and manually copy the file to your hypervisor and back to file share once the software for the

Layer is installed.

See Connector essentials for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/nutanix-ahv/configure/connector-essentials.html
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OS layer
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This topic explains how to prepare an OS Image for layering, using the OS Machine Tools available for download. 

Notes:

The OS Image should not be in a domain.

The OS Image should get its IP address from DHCP.

Using Third-party optimization scripts can have adverse effects for layering, as they can change services and features

that the App Layering service uses, for example, Universal Plug and Play and the 8.3 f ile names setting. Use the

optimization tools in the Installer download to optimize your image.

Ensure that the VM for your OS Layer is MBR partitioned, rather than GPT partitioned. Otherwise, you will not be able to

install the Unidesk OS Machine Tools.

XenCenter uses Port 5900 to access the console on each VM. Make sure that this port is open on your OS image.

Otherwise, the packaging machines or publish images the console will not work until you reboot the VM.

Choose the operating system you are using for the OS Image:

Windows Server 2012 R2 (Session Host)

Windows Server 2008 R2

Windows 10

Windows 7

Prepare a Windows Server 2012 R2 image (Session Host)

STEP 1: Set up a Windows Server 2012 R2 OS Image on a virtual machine

In the XenServer client:

Create a VM for the OS image.

Configure the virtual machine hardware settings, for example, the NIC and video memory.

Configure a virtual hard disk that is large enough for a Windows operating system installation, and make sure it is accessible

by the Management Appliance.

Install Windows Server 2012 R2.

Disable Windows System Restore and Windows Automatic Updates. The system handles restore points for you, and layer

versions allow you to control when updates occur.

Install XenServer Tools on your OS image.

STEP 2: Copy the OS Machine Tools onto the OS Image

Download the Citrix_App_Layering_OS_Machine_Tools ZIP file onto the OS Image.

Extract the Citrix_App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct KMS

activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine Tools

download, as described in the next step. To configure scripts for KMS:
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In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script file in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

In the c:\windows\setup\scripts folder, right-click the unattend.hta tool and choose Run as administrator. The unattend

builder form opens.

Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK. 

Domain Join

Select Enable if  you want to configure the unattend.xml file to join desktops to a specific domain. If  you plan to use AD join

scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we recommend

that you use an alternate OU for Unidesk desktops, both to segregate the desktop from other machines and to avoid

applying virtual desktop-specific GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml files in different application layers. 

Local Administrator account

If  you want to use the unattend.xml file to enable the Administrator account on each desktop, select Enable. Remember to

also enable this account in your OS Image or Operating System Layer revision. It is possible to enable the Administrator

account for your OS Image and then have it disabled in the deployed desktops by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This account

cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed. 

T ime zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone, not the

display setting. A list of time zone settings can be found here. 

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

In the c:\windows\setup\scripts folder, run the optimize.hta executable to create a .cmd file (optimization.cmd) that will be

run to optimize the image during Desktop creation.

Follow the instructions to run the optimize.cmd file on the OS Image. This removes installation-specific drivers and settings.

If  you are using the optimization script and you are enabling the View Persona feature, you must go to the section of the

optimize.hta script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable Offline File

Service, and click Save File. This is because View Persona folder redirection requires Offline files to be enabled, and by

default, the Optimizer turns off  Offline files, which are not a requirement for Unidesk.
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STEP 6: Create a snapshot of the OS Image

Once the OS Image is ready, create a snapshot of it, so that you can return to this state at any time.

Important: It is critical to create a snapshot before installing the App Layering software onto the OS Image. Without this

snapshot, returning to this state requires rebuilding the image.

STEP 7: Install the OS Machine Tools onto the OS Image

In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS Layer.

Prepare a Windows 2008 R2 image

STEP 1: Set up a Windows Server 2008 R2 OS Image on a virtual machine

In the XenServer client:

Create a VM for your OS image, making sure to choose the default cluster allocation size of 4K.

Configure the virtual machine hardware settings, for example, the NIC and video memory.

If  you are using Citrix PVS or VMware Horizon View, install Windows Server 2008 R2 Service Pack 1 (SP1).

Notes:

When creating the image, be sure to choose the default cluster allocation size of 4K.

If  using PVS:

Install KB255098 hitfix.

Reboot the VM.

Enter the commands:

set devmgr_show_nonpresent_devices=1

devmgmt.msc

Uninstall any dead (ghost) NICs.

Reboot the system.

Disable Windows System Restore and Windows Automatic Updates. The system handles restore points for you, and

Unidesk layer versions allow you to control when updates occur.

Install XenTools on the OS image.

STEP 2: Copy the OS Machine Tools onto the OS Image

Download the App_Layering_Citrix_App_Layering_OS_Machine_Tools ZIP file onto the OS Image.

Extract the App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation
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If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct KMS

activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine Tools

download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script file in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

In the c:\windows\setup\scripts folder, right-click the unattend.hta tool and choose Run as administrator. The unattend

builder form opens.

Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK. 

Domain Join

Select Enable if  you want to configure the unattend.xml file to join desktops to a specific domain. If  you plan to use AD join

scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we recommend

that you use an alternate OU for Unidesk desktops, both to segregate the desktop from other machines and to avoid

applying virtual desktop-specific GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml files in different application layers. 

Local Administrator account

If  you want to use the unattend.xml file to enable the Administrator account on each desktop, select Enable. Remember to

also enable this account in your OS Image or Operating System Layer revision. It is possible to enable the Administrator

account for your OS Image and then have it disabled in the deployed desktops by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This account

cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed. 

T ime zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone, not the

display setting. A list of time zone settings can be found here. 

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

In the c:\windows\setup\scripts folder, run the optimize.hta executable to create a .cmd file that will be run to optimize the

image during desktop creation.

Follow the instructions to run the optimize file on the image. This removes installation-specific drivers and settings.

If  you are using the Optimizer script and you are enabling the View Persona feature, you must go to the section of the
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Optimizer script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable Offline File

Service, and click Save File. This is because View Persona folder redirection requires Offline files to be enabled, and by

default, the Optimizer turns off  Offline files, which are not a requirement for layering.

STEP 6: Install the OS Machine Tools onto the OS Image

In the App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS Layer.

Prepare a Windows 10 image

When preparing the OS Image for import into an OS Layer, you can speed up start times by removing Windows 10 built-in

applications. If  you do, we recommend removing these applications either on the OS Image itself, or on the OS Layer.

STEP 1: Set up a Windows 10 image on a virtual machine

In the XenServer client:

Create a VM for your OS image.

Important: When creating the image, be sure to choose the default cluster allocation size of 4K.

Configure the virtual machine hardware settings, for example, the NIC and video memory.

Disable Windows System Restore and Windows Automatic Updates:

Log into the VM.

Select Computer Config > Administrative Templates > Windows Components > Windows Updates > Config Auto Updates.

Set this to Disabled.

The App Layering system handles restore points for you, and layer versions allow you to control when updates occur.

If  using KMS licensing, run a command window as Administrator, and enter these commands:

slmgr /skms <kmsserverhost>

slmgr /rearm

reboot

slmgr /ipk XXXX-YOUR-KMS-KEY-XXXX

slmgr /ato

Install the VMware Tools on the OS image.

If  you are including the Windows Store in your Windows 10 image, get the latest updates for all Store Apps.

Launch the Windows Store application, click the Sign in icon (top right), then select Downloads and Updates.

Check for Updates, and click Update All. This should be repeated at least twice to ensure that the latest updates have been

pulled.

Important: Avoid finalizing the OS Layer while download or update processes are running, as this may cause deployed

images (and every user) to experience a continuation of those operations each time they log in.
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STEP 2: Copy the OS Machine Tools onto the OS Image

Download the Citrix_App_Layering_OS_Machine_Tools ZIP file onto the OS Image.

Extract the Citrix_App_Layering_OS_Machine_Tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct KMS

activation script when the system starts, or by running the Unattend file included in the App Layering OS Machine Tools

download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script file in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

In the c:\windows\setup\scripts folder, right-click the unattend.hta tool and choose Run as administrator. The unattend

builder form opens.

Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK. 

Domain Join

Select Enable if  you want to configure the unattend.xml file to join desktops to a specific domain. If  you plan to use AD join

scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we recommend

that you use an alternate OU for Unidesk desktops, both to segregate the desktop from other machines and to avoid

applying virtual desktop-specific GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml files in different application layers. 

Local Administrator account

If  you want to use the unattend.xml file to enable the Administrator account on each desktop, select Enable. Remember to

also enable this account in your OS Image or Operating System Layer revision. It is possible to enable the Administrator

account for your OS Image and then have it disabled in the deployed desktops by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This account

cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed. 

T ime zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone, not the

display setting. A list of time zone settings can be found here. 

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool. Click Save File.

Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.
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In the c:\windows\setup\scripts folder, right-click the optimizations.exe tool and choose Run as administrator. This creates

a .cmd file (optimizations.cmd) that will be run during Desktop creation to optimize the image.

Follow the instructions to run the optimizations.cmd file on the OS Image. This removes installation-specific drivers and

settings.

If  you are using the Optimization script and you are enabling the View Persona feature, you must go to the section of the

Optimization script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable Offline

File Service, and click Save File. This is because View Persona folder redirection requires Offline files to be enabled, and by

default, the optimization script turns off  Offline files, which are not a requirement for App Layering.

STEP 6: Install .Net Framework 3.5.1

The .Net Framework is a software framework provided by Microsoft that is required for many 3rd party applications to run.

To install this feature, follow the steps below.

On the Start menu, select Control Panel > Programs and Features.

In the left panel select Turn Windows features on or off. A window opens.

Select .NET Framework 3.5, click OK, and wait for the installation to complete.

Important: Even if  .NET is already installed, continue with the rest of these steps.

Exit the Control Panel.

In Notifications in the right-side of your taskbar, click All Settings, and open the Windows 10 Settings app.

Select Settings > Update & Security.

Check for updates, and install all updates available.

Exit Settings.

Open an administrator-level command prompt, and enter the following commands:

cd \windows\Microsoft.Net\Framework\v4.nnnnn

ngen update /force

Wait for the command to complete, and enter the following commands:

cd \windows\Microsoft.Net\Framework64\v4.nnnnn

ngen update /force

Exit the command prompt.

STEP 7: If  using PVS, follow these steps to avoid ghost NICs.

Enter the commands:

set devmgr_show_nonpresent_devices=

devmgmt.msc

Remove any ghost NICs.
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Reboot the system.

STEP 8: Install the OS Machine Tools onto the OS Image

Run setup_x64.exe from c:\Windows\setup\scripts.

Once this is done, you are ready to create a Unidesk Operating System Layer.

Prepare a Windows 7 image

STEP 1: Set up a Windows 7 OS Image on a virtual machine

In the XenServer client:

Create a VM for your OS Image.

Important: When creating the image, be sure to choose the default cluster allocation size of 4K.

Configure the virtual machine hardware settings, for example, the NIC and video memory.

Disable Windows System Restore and Windows Automatic Updates. The App Layering system handles restore points for

you, and layer versions allow you to control when updates occur.

Make sure you have installed VMware Tools on the OS image.

STEP 2: Mount or copy the Citrix App Layering OS Machine Tools onto the OS Image

Download the Citrix_App_Layering_OS_Machine_Tools ZIP file onto the OS Image.

Extract the citrix_app_layering_os_machine_tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct KMS

activation script when the system starts, or by running the Unattend file included in the Citrix App Layering OS Machine

Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script file in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation

In the c:\windows\setup\scripts folder, right-click the unattend.hta tool and choose Run as administrator. The unattend

builder form opens.

Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml file to join desktops to a specific domain. If  you plan to use AD join

scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we recommend
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that you use an alternate OU for Unidesk desktops, both to segregate the desktop from other machines and to avoid

applying virtual desktop-specific GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml files in different application layers.

Local Administrator account

If  you want to use the unattend.xml file to enable the Administrator account on each Unidesk desktop, select Enable.

Remember to also enable this account in your OS Image or Operating System Layer revision. It is possible to enable the

Administrator account for your OS Image and then have it disabled in the deployed desktops by clearing the check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This account

cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone, not the

display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool.

Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

In the c:\windows\setup\scripts folder, run the optimize.hta executable to create a .cmd file that will be run to optimize the

image during desktop creation.

Follow the instructions to run the optimize.hta file on the OS Image. This removes installation-specific drivers and settings.

If  you are using the Optimization script and you are enabling the View Persona feature, you must go to the section of the

Optimization script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable Offline

File Service, and click Save File. This is because View Persona folder redirection requires Offline files to be enabled, and by

default, the optimization script turns off  Offline files, which are not a requirement for App Layering.

STEP 6: If  using PVS, follow these steps to avoid ghost NICs

Install KB2550978 hotfix.

Reboot the VM,

Enter the commands:

set devmgr_show_nonpresent_devices=1

devmgmt.msc

Remove any ghost NICs.

Reboot the system.

STEP 7: Install the Citrix App Layering OS Machine Tools onto the OS Image

In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).
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The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS Layer.
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Platform layer

Jun 29, 2017

Select the Connector for the platform to which you are publishing Layered Images.
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XenServer connector

Jun 29, 2017

A Platform Layer should include the platform software and settings required to deploy images in your environment, given

your choice of hypervisor, provisioning service, and connection broker.

You can create two kinds of Platform Layers:

Platform Layers for publishing Layered Images (Required) - A Platform Layer for publishing is used in Image Templates to

ensure that your published Layered Images include the software and settings required to run flawlessly in your

environment.

Platform Layers for packaging Layers (Required in some cases) - A Platform Layer for packaging is used for creating App

Layers and OS Layer Versions in your hypervisor environment. This Layer includes the hypervisor software and settings

required to easily install the app or OS update on a VM in the selected hypervisor. 

Prerequisites

When creating a Platform Layer, the software installers for your platform must be available in a location that's accessible

to the Packaging Machine VM where you are going to create the Layer. As summarized in the following table, the

prerequisites vary based on the type of Platform Layer you choose to create.

Type of
Platform Layer

Prerequisites

Publishing

Layered Images

Software installers, and settings you use for your:

Hypervisor

Provisioning service

Connection broker  

Packaging

Layers

The software and settings for your:

Hypervisor

For example, your hypervisor installer and settings.

Note: You only need a Platform Layer for packaging Layers if you are creating your Layers on a different hypervisor

than the one from which you imported your OS image.

Citrix XenServer prerequisites

XenServer account and privileges

A XenServer account (new or existing) to use for App layering service.

The account must have XenServer privileges to:

Create and remove virtual disks.

Copy and delete layers on virtual disks using XenServer file APIs.

Citrix XenServer software and settings



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.377https://docs.citrix.com

Access to the XenServer Tools to install on the layer.

XenServer resource information

The XenServer info listed in Citrix XenServer Connector Configuration.

 

Prepare a new platform layer

Select Layers > Platform Layers and select Create Platform Layer in the Action bar. This opens the Create Platform Layer

wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

In the OS Layer tab, select the OS Layer you want to associate with this Platform Layer.

In the Connector tab, choose a Connector Configuration for the platform where you are creating this layer. If  the

configuration you need isn't listed, Click New, select your platform from this list, and Add a Configuration for it.

Example: If  you are creating the layer in a XenServer environment, select the XenServer connector with the information

needed to access the location where you will package this layer.

In the Platform Types tab, select the radio button that describes the purpose of this Platform Layer: to create and update

layers, or to publish Layered Images. For more about these choices, see Platform Layers.

From the dropdown menus, select the platform(s) you are using.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the tools, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the Layer, enter a comment if  required, and click Create Layer. Any

comments you enter will appear in the Information view Audit History.

At the bottom of the UI, expand the Tasks bar and double-click the task to show the full task description.

Once the task is complete, the location of the Packaging Disk is shown (example task message shown below).

Next, you can deploy the Packaging Machine for your Layer. The Packaging Machine is a temporary virtual machine where

you install the software to include in the Layer being created.

Power on the Packaging Machine in XenServer

Log into your XenServer client.

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create Platform

Layer task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenCenter client.

While in the Infrastructure View, select your Packaging Machine's VM from the list of machines.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.378https://docs.citrix.com

In the XenCenter UI in the panel on the right, choose the Console option for the VM.

Power on the VM.

Select the Click here to create a DVD drive link.

Power cycle the VM (yes, you have to in order to get the DVD Drive).

At the top of the console window, click the DVD Drive 1 drop down menu and select the xs-tools.iso.

Install the XenTools. This will require multiple reboots as part of the tools installation. Once complete, you should see that

you have access to all XenTools, as well as all of the data available under the Performance tab for your VM.

Note: The XenCenter console uses RFB for it's console connection, which uses Port 5900. On Windows 2008 and Windows

7, this port is closed in the Firewall by default and should be opened so you can use the console to access any VMs

Install the platform tools on the Packaging Machine

Whether you are creating a Platform Layer or adding a version to it:

Remote log in to the Packaging Machine. Be sure to log in using the User account you used to create the OS.

Install the platform software and tools, along with any drivers, boot-level applications, or files needed. Keep in mind that

the state of the software before you finalize the layer is what the image will use.

If  this Platform Layer is going to be used for packaging new layers, install and configure your hypervisor tools and settings.

If  this Platform Layer is going to be used for publishing Layered Images, install and configure your hypervisor, provisioning

service, and connection broker tools and settings.

If  a software installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

Make sure the Packaging Machine is in the state you want it to be in for users:

If  the tools you install require any post-installation setup or registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

When using PVS, if  your OS image was activated using KMS, rearm KMS just before you shut down

Verify the Rearm count on the OS by running slmgr /dlv from a command prompt. The Rearm count must not be zero.

slmgr /dlv

Rearm KMS:

slmgr /rearm

Verify the Layer and shut down the Packaging Machine

Once the software is installed on the Packaging Machine, it is important to verify that the Layer is ready to be finalized. To

be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.
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Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation. For details, see Verifying Layers.

If  you are using KMS licensing, once any pending operations are complete, be sure to rearm KMS yet again just before you

shutdown. First, enter this command to verify that the Rearm count is > 0:

slmgr /dlv

Then, rearm KMS:

slmgr /rearm

Double-click the Shutdown For Finalize icon again to shut down the Packaging Machine.

The Layer should be ready to finalize.

During the shutdown for finalization

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

Open a command prompt as Administrator.
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Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

Open a command prompt as Administrator.

Check status by running this command:

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

 

Finalize the Layer

To finalize the Layer, you import the installed software into the Platform Layer you prepared in the Management Console.

Return to the Management Console.

Select Layers > Platform Layers.

Select Finalize in the Action bar.

Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.
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App layer
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An App Layer is a bootable software image (virtual disk) containing one or more applications that you can use in any number

of Layered Images. When publishing a Layered Image, you can combine an App Layer with the OS Layer used to create it,

other App Layers, and a Platform Layer.

To create an App Layer, you open the Create Layer wizard, deploy a Packaging Machine in your environment, then install the

application(s). Once the application(s) are installed, you finalize the Layer.

A Packaging Machine is a VM where you install the application(s) that will be included in the Layer. The App Layering

software creates the Packaging Machine in the location and using the credentials you supply by choosing the Platform

Target (hypervisor) and selecting a Connector Configuration containing this information. If  you don't yet have the

Connector Configuration you need, you can add a new one, as described in the steps below.

Before you start

Requirements

To create an App Layer, you need:

Create an OS Layer

Optional

Before you create an App Layer, you may also want to create resources that facilitate the application installation process.

These resources are for temporary use during installation only, and will not be used to deliver the application.

Prerequisite Layer

Platform Layer (for cross-platform deployments) (Only required if  creating App Layers on a hypervisor other than the one

from which you imported your OS Layer)

Run Once Script

If  the application you install affects boot-level components, you'll need to restart the Packaging Machine as part of

finalizing the layer or version.

Prerequisite Layer

Prerequisite Layers let you include existing App Layers on the Packaging Disk when creating or adding a version to an App

Layer. Prerequisite Layers should only be used if  they are required, since it is possible that the prerequisite applications will

pull something into the Layer that is not required for the current application deployment, and which may cause conflict in

the future.

Reasons to consider using Prerequisite Layers:

The application you are installing requires another application during installation. For example, if  you are installing an

application that requires Java and you have Java in a separate layer.

The add-in or plugin you are installing adds settings to an application. For example, when installing an Office add-in, you

would use your Microsoft Office App Layer as a prerequisite layer.

Two applications modify the same registry key, and the second application must add to an existing key rather than replace

it. For example, Citrix Agent and Imprivata software both modify login keys in Windows.

Note: Some of these issues can also be handled by putting the two applications in the same layer.
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Platform Layer (for cross-platform deployments)

A Platform Layer is only required when creating App Layers on a hypervisor other than the one from which you imported

your OS Layer.

If  you are creating App Layers and Versions on a different hypervisor than the one you used to create your OS Layer, it is

strongly recommended that you create a Platform Layer containing the hypervisor tools and hardware settings you need

to seamlessly install and package applications in your environment.

Run Once Script

You can include a Run Once script in an App Layer. This allows you to run a script the first time any Layered Image that

includes the App Layer boots. If  the App Layer is elastically layered, the Run Once script runs when the App Layer Disk is

mounted. Run Once scripts are typically used for apps, such as MS Office, that require license activation on the first boot.

Prepare a new App Layer

Select Layers > App Layers and select Create Layer in the Action bar. This opens the Create Layer wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

For details, see more about these values below.

In the OS Layer tab, select the OS Layer you want to associate with this App Layer.

(Optional) In the Prerequisite Layers tab, if  the application you are layering requires other App Layers to be present during

installation, select the Include Prerequisite Layers check box, and pick the necessary App Layer(s).

Notes:

Prerequisite layers are used while installing applications, and are not included in the App Layer.

Prerequisite layers are not included by default when adding a new Version to this App Layer. So, when you add a new

Version to this App Layer, you must choose the Prerequisite Layers again, if  needed.

The App Layer you are creating and each of its Prerequisite Layers must be associated with the selected OS Layer.

In the Connector tab, choose a Platform Connector Configuration that contains the credentials for the platform where

you plan to build the Layer, along with the storage location. If  the configuration you need isn't listed, add a New Connector

Configuration and select it from this list.

Example: If  you're using the XenServer environment to create the Layer, select the XenServer connector with the

credentials and location required to access the location where you want to build the Layer.

In the Platform Layer tab you can select a Platform Layer containing the tools and hardware settings that you need to

install and package an application during Layer creation. This selection is only used during layer creation. Once created, the

Layer can be used in Layered Images published to any platform.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the application, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the App Layer, enter a comment if  required, and click Create Layer.

Any comments you enter will appear in the Information view Audit History. Once the Packaging Disk has been created, the
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Task bar displays instructions to navigate to the Packaging Machine in XenServer.

Next, you can log into the Packaging Machine for your Layer, and install the software for the layer on it.

Deploy a Packaging Machine in XenServer

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App Layer

task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenServer client.

Power on the Packaging Machine.

You can now install the applications for this layer on the Packaging Machine.

Deploy a Packaging Machine in XenServer

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App Layer

task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenServer client.

Power on the Packaging Machine.

You can now install the applications for this layer on the Packaging Machine.

Install the software on the Packaging Machine

When you've completed the Layer wizard, Unidesk creates a Packaging Machine in your environment, in the location defined

in the Connector Configuration. The Packaging Machine is a virtual machine where you install the software to be included in

the layer.

Note: The Packaging Machine is a temporary VM that will be deleted once the new Platform Layer has been finalized.

Log into the Packaging Machine

Log into your vSphere web client.

Back in the Unidesk Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App

Layer task to see the full Task Description.

Use the instructions in the Task Description to navigate to the Packaging Machine in your vSphere web client.

The Packaging Machine will be powered on.

Install the Application(s)

When installing your application(s) on the Packaging Machine, leave each application as you want users to see it when they

log in. The state of the applications when you finalize the layer is what users experience when they access the application.

More guidance about this is included in the steps below.

Remote log in to the Packaging Machine in vSphere. Be sure to log in with the User account you used to create the OS in

vSphere.

Install the applications, along with any drivers, boot-level applications, or files that the user will need with it.

If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart
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automatically.

Make sure the Packaging Machine is in the state you want it to be for the user:

If  the applications you install require any post-installation setup or application registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, it is important to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages you may see during the finalization process

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.
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Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

Open a command prompt as Administrator.

Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

Open a command prompt as Administrator.

Check status by running this command:

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the Layer

Once the software has been installed and the Packaging Machine has been verified and shut down, you are ready to

finalize the layer.

Note: When you finalize a Layer, Unidesk may delete the Packaging Machine to minimize storage space used.

When the Layer has been verified and is ready to finalize:

Return to the Management Console.

Select Layers >App Layers, and then the layer you just prepared.

Select Finalize in the Action bar. The Finalize wizard appears.

(Optional) On the Script Path wizard tab, you can enter the path to a Run Once Script located on a server on your network.

If  the App Layer is elastically assigned, the Run Once script will be executed the first time the app is used.

If  the App Layer is included in a Layered Image, the Run Once script will be executed the first time the Layered Image is

booted. 

Click Finalize to finish creating the Layer.

Monitor the Task bar to verify that the action completes successfully and that the Layer is ready to be deployed.
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Reference: create App Layer Wizard values

Layer Name - (Required) A name that will let you know what app(s) the layer will be used for.

Layer Description - (Optional) Description of the Layer

Version - (Required) This can be the version of the application or a version you assign to the Layer. This value is displayed in

the Details view of the Layer. Keep in mind that you'll add a new version to this layer whenever you update the app(s)

included in it, and this is where the version will be described.

Version Description - (Optional) Enter a description of the version.

Specify the Max Layer Size - Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 10 gigabytes. If  the application you are installing could eventually require more

space, change this to an appropriate value.
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User layer

Jun 29, 2017

User Layers let you persist user profile settings, data, and user-installed applications in non-persistent VDI environments.

User Layers are created when:

You set Elastic Layering on an Image Template to Application and User Layers, so that the Layered Image supports User

Layers.

A user logs in to their desktop for the first time, and a User Layer is created for them. From then on, the user's data and

settings are saved in the User Layer, along with any applications that the user installs locally on their desktops.

 

Before you start

Prerequisites

Create the OS Layer

Create a Platform Layer

Create App Layers

Adequate network bandwidth. Bandwidth and latency have a significant effect on the User Layer. Every write goes across

the network.

Allocate storage space for users' locally installed apps and the data and configuration settings for them. (This leaves the

main storage location solely for packaging layers, publishing Layered Images, and serving up Elastic Layers.)

Compatibility

Currently, User Layers are supported for the following platforms:

Operating systems:

Windows 7, 64-bit

Windows 10, 64-bit

Publishing platforms: VMware Horizon View and Citrix XenDesktop.

User Layer creation process

Enable User Layers in your Image Template:

Set Elastic Layering in the Image Template wizard on the Image Disk tab) to Application and User Layers.

Publish Layered Images using the above Image Template.

When a user logs on to their desktop for the first time, a User Layer is created for them.

User Layer size and location

The default size of a User Layer is 10 GB.

User Layers are created in the Users folder on the appliance's network file share, for example:

\\MyServer\MyShare\Users

Each user will have his/her own directory within the Users directory, and it will be named as follows:
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Users\domainIname\username\OS-Layer-ID-in-hex_OS-Layer-name\username.vhd

For example:

User's login name: jdoe

User's Domain: testdomain1

OS layer: MyOSLayer (ID is in hexidecimal format: 123456)

User Layer would be created in:

\\MyServer\MyShare\Users\testdomain1\jdoe\123456_MyOSLayer\jdoe.vhd

Upgrading existing User Layers to this Release

Once you upgrade the appliance to Release 4.2.0, if  you want to continue using existing User Layers, you'll need to move

them to new locations as described below in Upgrade User Layers created using a previous release.

Other Considerations

Before deploying User Layers, please consider the following guidelines and limitations.

The User Layer is delivered via the appliance's file share, therefore:

If  the host is disconnected from the User Layer storage, the user will have to log out and log in again to re-establish the

disk mount. The user will have to wait approximately 5 minutes because the user layer will be inaccessible.

Certain enterprise applications, such as MS Office and Visual Studio should be installed in Layers, not as user-installed

applications in the User Layer. In addition, the Elastic Layering limitations are applicable for User Layer. For more information

on Layering limitations, please see the Elastic Layering Limitations section.

Windows updates must be disabled on the User Layer.

VMware Horizon View:

View must be configured for non-persistent desktops, and the desktop must be set to Refresh at log off. Delete or refresh

the machine on log off. Example:

After logging off  with View set to Refresh Immediately, the desktop goes into maintenance mode. If  there is only one

machine in the pool, the pool will not be available until that machine has completed the refresh.

The first time a user logs into his/her desktop, a User Layer is created for the him/her.

If  there is problem loading the elastically assigned Layers for the user, they will still receive their User Layer.

If  you rename the user in AD, a new directory and User Layer will be created for the new name. To avoid this, rename the

directory on the file share and the VHD file in the directory structure to the new AD user name.

 

Add storage locations for user layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.
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Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The first storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's User

Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest priority

location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until that

point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the their User

Layer to the new highest priority location.

Create Storage Locations

To add a storage location:

Log into the management console.

Select System > Storage Locations.

Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

Select Add Storage Location, and enter a Name and Network Path for the new location.

On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to add

to the new storage location.

On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure security on user later folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:
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Publish layered images

Jun 29, 2017

Prerequisites

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to Nutanix AHV, and add each one to a collection, provisioning

service, or other method for provisioning your systems.

Prerequisites

Create Image Templates (Nutanix AHV)

Publish a Layered Image

1. In the Images module, select one or more Image Templates to publish.

2. From the Action menu, select Publish Layered Image.

3. On the Confirm and Complete page, select Publish Layered Images. For each template, this starts a task

called, Publishing Layered Image. When each task completes, the task description provides the information you need to

navigate to the image in your environment.

4. Use the information in the expanded Packaging Disk Task shown above to navigate to the location in Nutanix AHV

where the Layered Image has been published.

5. In the Prism console, power on the Packaging Machine VM. This enables the Guest OS to run and execute any Layer

scripts via Unidesk's kmssetup.cmd functionality.

You can use scripts to perform important Layer-specific steps, for example, activating Microsoft Office, which may need

to be done before the VM is used to create or update an MCS catalog.

Note: You can execute Layer scripts using Unidesk's kmssetup.cmd functionality, Unidesk's Run-once script support, or

even manual execution.

6. Once the VM is in the desired state the VM must be shut down. If  you need to shut it down manually, do so now.

Otherwise, wait for the script you've configured to do so.

Next Step

Use the image to provision Nutanix AHV servers.

https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_publish_create_template_co_ah4/layered_images_create_template_ah4
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Connectors for publishing

Jun 29, 2017

When publishing Layered Images, you need a Connector Configuration that defines the location where you will publish the

images, preferably near the servers you intend to provision with the images. You can create as many Connection

Configurations as you need.

It is strongly recommended that Layered Images are published to the environment where the App Layering appliance is

installed, in this case, Nutanix. To do this, you need a Nutanix Connector Configuration to define the publishing location. If

you don't yet have an Nutanix Connector Configuration, you can create one while in the process of publishing Layered

Images.

Note
If you decide to publish Layered Images on a hypervisor other than the one where the appliance is installed, you can publish to the

appliance's file share using the NFS Connector. Once the image is published, you can manually copy the file to the desired location.

See Connector essentials for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/nutanix-ahv/configure/connector-essentials.html
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Create image templates

Jun 29, 2017

You can create Image Templates to publish Layered Images to your target platform where you can then use the Layered

Image to provision servers on your chosen publishing platform. An Image Template stores your Layer assignments, along

with a Layer icon and description. You can easily edit an Image Template and use it to publish new versions of your Layered

Images.

Prerequisites

OS Layer (Required)

Platform Layer (Required for cross-platform deployments)

The Platform Layer contains the software required for publishing to your environment, in this case:

Nutanix Acropolis VM Mobility

Citrix MCS Device imaging tools

The Platform Layer must have the same hardware settings as the OS Layer. You choose these settings when deploying

the VM for the OS and Platform Layers.

App Layers (Optional)

You can create an Image Template without App Layers. This is useful for testing your OS Layer before using it to create

App Layers.

Create an Image Template

To create an Image Template:

1. In the App Layering Management Console, select the Images module, then click Create Template. This opens the

Create Template wizard.

2. In the Name and Description tab, enter a Name for the template and notes in the Description f ield, so you can identify

the template when choosing one for publishing a Layered Image.

3. In the OS Layer tab, select one of the Available OS Layers. If  there is more than one Layer Version, the most recent

version is selected by default. You can choose an older version by expanding the Layer and choosing a different one.

4. In the App Assignment tab, select the App Layers to include in the Layered Images that you publish using this template.

5. On the Connector page, select a Citrix MCS for Nutanix AHV Connector Configuration for the location where you want

to publish the Layered Image.

If  you do not yet have a Connector Configuration for Citrix MCS for Nutanix AHV, add one. Click New, choose the

Connector Type, and follow the instructions to Create a Connector Configuration.

6. In the Platform Layer tab, select a Platform Layer with the tools and hardware settings that you need to publish

Layered Images to your environment. For details, click here.

https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_admin_ah4/itoc_3_admin_manage_layering_ah4/layer_delete_co_ah4/layered_images_manage_template_ah4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_layer_ah4/itoc_3_layer_os_ah4/layer_os_create_ah4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_publish_create_template_co_ah4/layer_platform_create_ah4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_layer_ah4/itoc_3_layer_apps_ah4/layer_apps_create_ah4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_connectors_publishing_ah4/connector_config_fields_ah_mc4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_publish_create_template_co_ah4/layered_images_create_template_ah4#platform_layer_prereqs
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7. On the Layered Image Disk page, edit the following fields, as needed:

(Optional) Layered Image Disk File name. Enter a name for the Layered Image Disk.

Layered Image Disk Size. The default disk size of 100 GB is recommended.

Layered Image Disk Format. The default disk format is VHD, but you can also select VMDK or QCOW2.

Sysprep. An appropriate default value is selected for your environment. This setting determines whether the Layered

Image will be generalized, and if  so, which script will be used to generalize the image and join a domain. Since MCS

uses its own built in technology to perform the operations generally performed by sysprep, MCS requires the VMs

used with their catalogs not be generalized so they do not go through the sysprep steps when f irst powered on in

the catalog.

Elastic Layering - Controls whether Elastic Layering on this Layered Image is allowed, and whether the user's app data

and configuration settings are saved in a User Layer . , select one of the following values:

Application Layers only. Allows Elastic Layers for users who log into this Layered Image. Available for both Session

Hosts and Desktops.

Application and User Layers (Unidesk Labs). Enables Elastic Layer assignments and User Layers on the Layered

Image. User Layers preserve users' application data and configuration settings. Currently, User Layers can be used

on Windows 7 Layered Images only, not on Windows 10, nor on Session Hosts.

None. Elastic Layers and User Layers are disabled.

8. On the Confirm and Complete tab, enter any comments you would like for this layer, and click Create Template.

The new Template icon appears in the Unidesk Images module.
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Publish to MCS for XenServer

Jun 29, 2017

You can create Image Templates to publish Layered Images to your target platform where you can then use the Layered

Image to provision servers on your chosen publishing platform. An Image Template stores your Layer assignments, along

with a Layer icon and description. You can publish new versions of your Layered Images by editing the Image Template and

using it to publish them again.

Prerequisites

To create an Image Template you need:

A Platform Layer containing the software required for your environment.

The Platform Layer must include:

The same hardware settings as the OS Layer you are using. (You choose the hardware settings when deploying the

VM for the OS and Platform Layers.)

The software and settings required for your environment.

Create an Image Template

To create an Image Template:

1. In the App Layering Management Console, select the Images module, then click Create Template. This opens the

Create Template wizard.

2. In the Name and Description tab, enter a Name for the template and notes in the Description f ield, so you can identify

the template when choosing one for publishing a Layered Image.

3. In the OS Layer tab, select one of the Available OS Layers. If  there is more than one Layer Version, the most recent

version is selected by default. You can choose an older version by expanding the Layer and choosing a different one.

4. In the App Assignment tab, select the App Layers to include in the Layered Images that you publish using this template.

5. On the Connector page, select the Citrix MCS for Nutanix Connector Configuration for the location where you want to

publish the Layered Image.

If  the Connector Configuration you need is not available, add one. Click New, choose the Connector Type, and follow

the instructions to Create a Connector Configuration.

6. In the Platform Layer tab, select a Platform Layer with the tools and hardware settings that you need to publish

Layered Images to your environment.

7. On the Layered Image Disk page, edit the following fields, as needed:

(Optional) Layered Image Disk File name. Enter a name for the Layered Image Disk.

Layered Image Disk Format. Use the default format, since this is the one required for your selected environment.

Elastic Layering - Controls whether Elastic Layering on this Layered Image is allowed. Select yes to allow Elastic Layers

for users of this Layered Image.

8. On the Confirm and Complete tab, enter any comments you would like for this layer, and click Create Template.

https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_connectors_publishing_ah4/connector_config_fields_ah_mc4
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The new Template icon appears in the Unidesk Images module.
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Publish to PVS

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to PVS, and stream them to the systems you want to provision.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

Publish a layered image

To use an Image Template to publish a Layered Image:

1. Log into the UMC.

2. Select the Images modules.

3. Select one or more Image Templates, then click Publish Layered Image.

4. On the Confirm and Complete tab, click the Publish Layered Image button. This starts a task called, Publishing Layered
Image. When the task completes, the task description provides the information you need to navigate to the image in

your environment.

5. Use the information in the expanded Packaging Disk Task to navigate to the location in PVS where the Layered Image

has been published.

Next you can assign the new disk to the targeted devices.

Assign the new vDisk to the targeted devices

1. Log into the PVS Console.

2. Access the target PVS server. The new vDisk should appear under the targeted PVS store (refresh may be required).

3. Assign the new vDisk to the targeted devices.

4. Using Citrix PVS best practices, test the new vDisk to ensure that the image streams to the server as expected.
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Publish to XenServer

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to XenServer and add each one to a collection, provisioning service,

or other method for provisioning your systems.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

Publish a Layered Image

1. In the Images module, select one or more Image Templates to publish.

2. From the Action menu, select Publish Layered Image.

3. On the Confirm and Complete page, select Publish Layered Images. For each template, this starts a task

called, Publishing Layered Image. When each task completes, the task description provides the information you need to

navigate to the image in your environment.

4. Use the information in the expanded Packaging Disk Task shown above to navigate to the location in XenServer where

the Layered Image has been published.

Next you can move the image to a collection or other location for provisioning servers.
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Publish to Network File Share

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to the ELM's Network File Share, copy the Image(s) to your target

environment, and use them to provision Session Hosts in your environment. This is especially useful if  Unidesk does not yet

include Connectors for the platform where you're provisioning systems.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

The Image Template you select should have the correct OS Layer and any App Layers you want in the Layered Image.

Publish a Layered Image

To use an Image Template to publish a Layered Image:

1. In the Images module, select one or more Image Template that you want to publish.

2. From the Action menu, select Publish Layered Image.

3. On the Confirm and Complete page, select Publish Layered Images. For each Image Template this starts a task

called, Publishing Layered Image. When each task completes, the task description provides the information you need to

navigate to the image in your environment.

4. Use the information in the expanded Packaging Disk Task shown above to navigate to the location where the Layered

Image has been published.

Important
When publishing a Layered Image to a file share, there will be one VMDK file option, and it will generate two

files: layer.vmdk and layer-flat.vmdk. You need to upload both of them.

Next Step

Once the Layered Image is published to the file share, you can use the image to provision servers in your environment.
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Assign layers

Jun 29, 2017

Layer assignment essentials

To deliver App Layers to users, you can:

Add App Layers to one or more Image Templates, then use the templates to publish Layered Images for use in

provisioning servers.

Elastically assign the App Layers to users, either through a direct user assignment, or via a machine assignment that

makes the layers available to users who log into the machine.

You can make these assignments, as long as each user is assigned a single instance of the Layer, either as part of an image

or as an elastic layer.

Do you want to assign this App Layer to one or more Image Templates for inclusion in your Layered Images? Or, do you

want to assign App Layers to users as Elastic Layers?

Add an App Layer to Image Templates

An Image Template is a stored selection of Layers and settings that you use to publish Layered Images. At minimum, an

Image Template contains an OS Layer, Platform Layer, and settings. Ideally, each template also contains your choice of App

Layers for a particular image, for example, an image suited for the users served by a particular silo. Once you publish a

Layered Image, you can provision systems using the image.

When you create a new App Layer, you can assign the App Layer to one or more Unidesk Image Templates, and then use

the templates to publish Layered Images that include the layer. This article explains how to assign an App Layer to one or

more Image Templates, and update the assignments when you update the Layer.

When you first update an App Layer, the new Layer Version is not assigned to any Image Templates, so you'll need to

update the Layer Assignments. Updating the assignments allows you to assign different Versions of the Layer to different

Image Templates. 
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Important
When assigning App Layers, be sure to avoid assigning the app elastically to a user, if the app is already in the Layered Image that

the user gets.

Prerequisites

One or more App Layers.

One or more Image Templates.

Add an App Layer Assignment to one or more Image
Templates

1. Log into the Unidesk Management Console (UMC) as an Admin user, and select Layers > App Layers.

2. Select an App Layer to include in one or more of your Image Templates, and click Add Assignments.

3. In the wizard that opens, select the App Layer that you want to assign to templates.

4. On the Image Template Assignment tab, select the templates in which you want to include this App Layer Version.

5. Skip the Elastic Assignment tab.

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When you open each of the Image Templates you will see the App Layer Version you just assigned to the template.

Update App Layers and Image Template Assignments

When you update an application by adding a new Version to the App Layer, the new Layer Version will not inherit the

original Layer Assignments. You need to assign the new App Layer Version.

1. Log into the UMC and select Layers > App Layers.

2. Select the App Layer that has been updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new App Layer Version.

5. Click the Image Template Assignment  tab, and select the Image Templates to which you want to assign the new Layer

Version .

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out

names may appear. These Image Templates have already been assigned the Version.
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6. Skip the Elastic Assignment tab.

7. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Remove Template Assignments

When you remove an App Layer's Template Assignments, the assignments for all versions of the Layer are removed. If  you

want to remove the assignments for a specific Version of the Layer, select Update Assignments instead.

1. Log into the UMC and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Assign App Layers to users elastically (Elastic Layers)

Assign apps elastically

Wouldn't it be nice to drastically reduce the number of images you have to manage? What if  you could leave apps that only

a few users need out of your base image? And, assign the layers to specific users elastically on top of the base image. With

the Elastic App Layers feature, you can do just that.

An Elastic App Layer is an App Layer that you configure to be delivered to specific users and groups, based on user

entitlements, when the users log onto their session hosts or standalone desktops. With Elastic App Layers, you can give

each user his/her own unique set of applications in addition to the base Layered Image that is used across sessions in the

case of session hosts), and across floating pools/shared groups in the case of desktops.

As this diagram shows, once you add Elastic Assignments to an App Layer, a copy of the Layer is stored in the appliance's

Network File Share, and delivered to individual AD users and groups on-demand, in addition to the Layers that they receive

via the base image.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.402https://docs.citrix.com

To use this feature, you'll add Elastic Assignments specifying which users and groups should receive each of the App Layers

that you would like to leave out of your base images. You'll then publish your base image(s) with the Elastic Layering For
Session Hosts selected.

How users access Elastic Layers assigned to them

When users log into their Session or Desktop, icons for their Elastic Layers will appear as shortcuts on the desktop.

A user receives an Elastic Layer in the following cases:

The user (an AD user in the Management Console) is assigned the Layer.

An AD group that the user belongs to is assigned the Layer.

A machine that the user logs into is a member of an AD Group that receives the Elastic Layer.

A machine that the user logs into is associated with an AD Group that is assigned the Layer via the Management

Console.

If  more than one version of  the same Layer is assigned to a user

If  a Layer is assigned directly to the user and indirectly to one or more of the user's groups, the user receives the most

recent version of the Layer assigned directly to her/him. For example, if  a user is assigned Version 2, and a group that the

user belongs to is assigned Version 3, the user will get Version 2.

If  the user is assigned a Layer via one or more group assignments, the user receives the most recent version of the Layer.

If  a user has an App Layer in their Layered Image, and the Layer is also assigned to them elastically

If  a user has an App Layer in the Layered Image and the user is also assigned the Layer elastically, they will receive the

Elastic Layer, even if  the version in the base image is more recent.

Prerequisites and limitations

Prerequisites

The appliance's Network File Share must be configured correctly:

The Share must be configured using SMB technology. When using Elastic Layer assignments, NFS technology is not
supported.
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The Share must be set up by the admin to be readonly for all users except for the one configured in the appliance.

This secures the Layers and other f iles stored on the Share.

The User named in this configuration must have Read/Write permissions on the root of the network f ile share.

Select System > Settings and Conf iguration and scroll to Network File Share.

Make sure that any users who will be assigned Elastic Layers have Read only access for the root directory of the

Network File Share.

.NET Framework 4.5 is required on any Layered Image where Elastic Layers are enabled.

The App Layers you want to elastically assign.

Note
App Layers must be created using the same OS Layer used to create the Layered Image that you enable to deliver the Elastic App

Layer to users.

Elastic Layering Limitations

You cannot elastically layer the following:

Microsoft Office Add-ons and extensions in individual Layers. A user must have all of their add-ons in one Layer. Note:

Please use the recipe for elastically layering MS Office.

Applications with drivers that use the driver store. For example, a printer driver.

Applications that modify the network stack or hardware. For example, a VPN client.

Applications that have boot level drivers. For example, a virus scanner.

Enable Elastic Layering in the base image

When you publish the Layered Image that the users will log into to get the Elastic App Layer(s):

1. In the Management Console, select the Image Template used to generate the Layered Image.

2. Select the Images tab.

3. Select the Image Template on which you want to enable Elastic Layering, and select Edit Template from the Action bar.

The Edit Template wizard opens.

4. On the Layered Image Disk tab, select a value for the Elastic Layering option.

Application Layers Only - To enable Elastic Layering for your App Layers.

Application and User Layers - To enable both Elastic Layering for your App Layers, and User (personalization) Layers.

5. Finish publishing the Layered Image.

6. Provision your Session Hosts with the new base image.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Run the Elastic Fit Analyzer on App Layers (App
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Layering Labs)

Before assigning an App Layer elastically, use the Elastic Fit Analyzer to determine the likelihood that the Layer assignment

will be successful.

Elastic Fit Analysis

In the Layer Details, the Elastic Fit rating indicates how likely it is that the Layer will work when elastically assigned.

Good Elastic Fit . This layer should work when deployed elastically.

Poor Elastic Fit . This layer will probably not work when deployed elastically, or may behave differently than when it

is deployed in a Layered Image.

Elastic Fit Details

You can learn more about the Elastic Fit of a Layer by expanding the Elastic Fit Analysis. If  the Elastic Fit is less than ideal,

the list of violated rules will be displayed.

Low Severity Warning. This is unlikely to cause any change in behavior or functionality for most applications.

Medium Severity Warning. This may cause minor changes in behavior or functionality for some applications.

High Severity Warning. This is likely to cause signif icant changes in behavior or functionality for many applications.

Enable Elastic Fit in App Layering Labs

To use this App Layering Labs feature, you must enable it. To enable Elastic Fit:

1. In the Management Appliance, select System > Settings and Conf iguration.

2. Click Edit  App Layering Labs.

3. Select the Elastic Fit  check box.

4. Click Save.

Analyze an App Layer for Elastic Fit

All new Layer Versions will be analyzed for elastic layering compatibility when they are finalized. To analyze existing App

Layers for Elastic Fit:

1. Log into the Management Console.

2. Select Layers > App Layers.

3. Select the Layer to analyze, and click Analyze Layer.
4. On the Select Versions tab, choose the Layer Versions to analyze.

5. On the Confirm and Complete tab, click Analyze Layer Versions. The analysis takes seconds.

6. To see the Elastic Fit Analysis, select the App Layers module, move the mouse pointer over the Layer icon and click
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the Info  icon.

7. Expand the Version Information for each Layer Version, and look for the Elastic Fit rating.

8. For a detailed report, expand the Elastic Fit Details. If  the Elastic Fit is less than ideal, the list of violated rules will be

displayed.

9. You can display the AD tree and hide the violated rules by clicking a button acknowledging that the layer is unlikely to

work as expected.

Upgrading from Earlier Releases

After upgrading from an earlier App Layering release, the Elastic Fit Detail shows that any existing Layer Version(s) have not

been analyzed. Until you run the analysis on existing Layer Versions, the Versions will have a single High severity Elastic Fit

Detail, and a Poor Elastic Fit.

Elastically assign an App Layer to AD Users and Groups

The first time you assign an App Layer elastically, we recommend starting with an app like Notepad++ or GIMP, because

they are simple to .

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer that is not going to be included in the base image, and select Add Assignments.

3. In the wizard that opens, select the Version of the App Layer that you want to assign users.

4. Skip the Image Template Assignment  tab. This tab is for assigning the Layer to an Image Template.

5. In the Elastic Assignment tab, select the users and groups who should get this App Layer.

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Elastically assign an App Layer to users via machine
assignments and associations

Any machine running the App Layering Service (ULayer.exe) can have Elastic Layers assigned to it. You can accomplish this by

either adding the machine to or associating it with the AD Group, and then elastically assigning the App Layers to the

AD Group.

The Layers assigned to the machine will be available to every User who successfully logs into that machine. The App

Layering Service will scan for changes to the machine's AD group memberships and associations every 10 minutes. When the

users log in, they should see an icon for each Elastic App Layer they've been assigned.

Use Active Directory to add the machine to the AD Group

Assuming you have a published Layered Image booted in your environment, you can add the machine to an AD Group, and

assign Elastic Layers to the AD Group.

1. Use Active Directory (AD) to add the machine to an AD Group.

2. Select an App Layer that is not going to be included in the base image, and elastically assign the Layer(s) to an AD Group.

3. You can wait for AD to propagate the changes and be recognized by the App Layering Service, or you can force the App

https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_assign_ah4/layer_assign_apps_elastic_co_ah4#Assign
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Layering Service to update its list of machine groups by doing one of the following:

Wait for the App Layering Service to detect the changes (within 10 minutes by default).

Restart the App Layering Service.

Reboot the App Layering Service Machine.

Execute the refresh.groups command:

C:\Program Files\Unidesk\Layering Services\ulayer.exe refresh.groups

Example

You start with an AD User, and AD Group, and a machine that you provisioned using a Layered Image.

AD User: Kenya
Kenya has no elastic assignments.

AD Group: Marketing
The Marketing group includes the member Kenya.

Machine: ElasticTestMachine
The ElasticTestMachine base image includes the MS Office App Layer.

In this example, you elastically assign the Chrome App Layer to ElasticTestMachine:

1. In AD, you add the machine ElasticTestMachine to the Marketing AD Group.

2. In the Management Console you elastically assign the Chrome App Layer to the Marketing Group.

3. When Kenya, who is part of the Marketing group, logs into ElasticTestMachine, she receives both the MS Office App
Layer, which is in the base image, and the Chrome App Layer.

4. When any user who is not in the Marketing group logs into ElasticTestMachine, they also receive both

Layers: MS Office because it is in the base image, and Chrome because the ElasticTestMachine is a member of

the Marketing AD Group.

Use the Management Console to associate the machine with an AD Group

Associating a set of machines with an AD Group allows any machine running the App Layering Service to have Layers

elastically assigned to it via AD group membership.

Elastic Layers granted via Machine association can be thought of as extending the layers assigned to a user. For example, if

a machine matches multiple Machine Associations, only the unique layers will be added to the ones the user already has.

In the Management Console, you use asterisk (*) wildcards in a machine name pattern to specify a set of machine names.

For example:

Code COPY

javascript:void(0)
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_assign_ah4/layer_assign_apps_elastic_co_ah4#Assign
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Machine name pattern Matches these names Does not match these names

machine*
machine01

machineindetroit

amachine

localtestmachine

*machine
amachine

localtestmachine

machine01

machineindetroit

ky*eng
ky02359eng

kytesteng

01ky_eng

testky01eng

*eng*

eng01

1eng

1eng01

en01

1en

1en01

You can create Machine Associations before or after elastically assigning App Layers to the AD Group. Also, the machines

do not need to exist when you add the associations, as the associations exist within Unidesk only, and AD is not aware of

them.

Associate a set of  machines with an AD group

1. Log into the Unidesk Management Console (UMC) as an Admin user, and select Users > Tree.

2. Expand the Tree, select the appropriate Group and click Edit Properties in the Action bar. This opens the Edit Group

Wizard.

3. Select the checkbox, Associate machines with this AD Group. This reveals the Machine Name Pattern field:

4. Specify a set of machines to associate with the AD group by entering a machine name pattern. For examples, see the

above table of Machine name patterns.

5. On the Confirm and Complete tab, select Update Group. Notice the shape of a computer monitor superimposed over

the group icon. This indicates that machines are associated with the group.

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_notchecked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_checked.png
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When you click the group's  icon, the Detail view now includes a field called, Associate With Machines where the

pattern.

Example

You start with the machine, Mach1, the AD Group, MachineGroup, and the App Layers for Firefox and MS Office.

Machine: Mach1
AD Group: MachineGroup
App Layers: Firefox, MS Office

Further, you have elastically assigned the Firefox and MS Office Layers to the AD Group.

If  you add a Machine Association to MachineGroup with a name pattern of "Mach*", when any domain user logs

into Mach1, they will receive the Firefox and MS Office Elastic App Layers.

Manage Elastic Assignments

You can:

View a user's Elastic Layer assignments.

Update an App Layer and elastically assign the new Version of the Layer.

Remove Elastic Assignments.

Debug an Elastic Assignments.

View a user's Elastic Layer assignments

1. Log into the UMC and select Users > Tree.

2. Select an AD User or Group, and click the "i" icon to the right of the name. If  the user or group is assigned any Elastic

Layers, the Layers are listed just below the user's or group's profile information in the Details window that appears.

Update an App Layer and its Elastic Assignments

You've added Elastic Assignments to an App Layer, and users are accessing the app as expected. A new version of the

application is released, so you update it by adding a new Version to the Layer. Now you need to assign the new version to

the users who have the Layer.

1. Log into the UMC and select Layers > App Layers.

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_details.png
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2. Select the elastically assigned App Layer that you just updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new Version.

5. Skip the Image Template Assignment tab.

6. In the Elastic Assignment tab, there's a list of Users and Groups who have been assigned a different version of the

selected Layer. Select the users and groups to whom you want to assign the new Version of the Layer.

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show AD users and groups already at this version. A list of grayed

out names may appear. These users have already been assigned the Version.

7. On the Confirm and Complete tab, verify the Users and Groups selected to receive the new Version, and click Update
Assignments.

Remove a Layer's Elastic Assignments

1. Log into the UMC and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Debug an Elastic Layer

If  you have an Elastic Layering issue, you can diagnose the problem by finding out whether the layer is being delivered, and if

so, whether it is working correctly. If  needed, collect data for Unidesk Support, as described here.

Is this a Delivery issue?

Are the things you'd expect to see if  this app were installed actually there as expected?

Do you see the f iles and registry entries for the layer?

If  the app is supposed to be in the Start menu, is it there?

If  there should be a shortcut for the app on the user's desktop, is there one?

If  you discover that app delivery is an issue, you can collect the following data, open a case, and send the data to Unidesk

Support.

1. Collect the data from these logs:

Windows App Event log –  In the Windows Event Viewer under Windows Logs, export the Application event log as an

EVTX f ile.

Unidesk Layering Service log (ulayersvc.log) –  C:\ProgramData\Unidesk\Logs\ulayersvc.log

2. Collect the values of these Registry keys:

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:AssignmentFile
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HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:RepositoryPath

3. Collect the contents of the Assignment (ElasticLayerAssignments.json) and Layers (Layers.json) files from the Repository

Path.

4. Contact Support.

Is this an operational issue?

One of these issues could indicate that this is an Elastic Layering issue:

The app is being delivered but doesn't launch correctly.

An operation within the app doesn't work correctly.

A licensing problem or a security issue.

The app launches, but then misbehaves, for example, it crashes on startup, or starts up but doesn't work right.

If  the problem with the Layer is operational, test the App Layer in the base image to rule out general layering issues:

1. Add the App Layer to an Image Template, and publish a Layered Image that includes the App Layer.

2. Log in as a user who is not assigned the Layer elastically, and make sure that the application is operational in the base

image.

3. Contact Support with your f indings.
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Assign App Layers to Image Templates

Jun 29, 2017

An Image Template is a stored selection of Layers and settings that you use to publish Layered Images. At minimum, an

Image Template contains an OS Layer, Platform Layer, and settings. Ideally, each template also contains your choice of App

Layers for a particular image, for example, an image suited for the users served by a particular silo. Once you publish a

Layered Image, you can provision systems using the image.

When you create a new App Layer, you can assign the App Layer to one or more Unidesk Image Templates, and then use

the templates to publish Layered Images that include the layer. This article explains how to assign an App Layer to one or

more Image Templates, and update the assignments when you update the Layer.

When you first update an App Layer, the new Layer Version is not assigned to any Image Templates, so you'll need to

update the Layer Assignments. Updating the assignments allows you to assign different Versions of the Layer to different

Image Templates. 

Important
 When assigning App Layers, be sure to avoid assigning the app elastically to a user, if the app is already in the Layered Image that

the user gets.

Prerequisites

One or more App Layers.

One or more Image Templates.

Add an App Layer Assignment to one or more Image Templates

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer to include in one or more of your Image Templates, and click Add Assignments.

3. In the wizard that opens, select the App Layer that you want to assign to templates.

4. On the Image Template Assignment tab, select the templates in which you want to include this App Layer Version.

5. Skip the Elastic Assignment tab.
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6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When you open each of the Image Templates you will see the App Layer Version you just assigned to the template.

Update App Layers and Image Template Assignments

When you update an application by adding a new Version to the App Layer, the new Layer Version will not inherit the

original Layer Assignments. You need to assign the new App Layer Version.

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer that has been updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new App Layer Version.

5. Click the Image Template Assignment  tab, and select the Image Templates to which you want to assign the new Layer

Version .

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out

names may appear. These Image Templates have already been assigned the Version.

6. Skip the Elastic Assignment tab.

7. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Remove Template Assignments

When you remove an App Layer's Template Assignments, the assignments for all versions of the Layer are removed. If  you

want to remove the assignments for a specific Version of the Layer, select Update Assignments instead.

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.
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Assign Layers to users elastically (Elastic Layers)

Jun 29, 2017

Assign apps elastically

Wouldn't it be nice to drastically reduce the number of images you have to manage? What if  you could leave apps that only

a few users need out of your base image? And, assign the layers to specific users elastically on top of the base image. With

the Elastic App Layers feature, you can do just that.

An Elastic App Layer is an App Layer that you configure to be delivered to specific users and groups, based on user

entitlements, when the users log onto their session hosts or standalone desktops. With Elastic App Layers, you can give

each user his/her own unique set of applications in addition to the base Layered Image that is used across sessions in the

case of session hosts), and across floating pools/shared groups in the case of desktops.

As this diagram shows, once you add Elastic Assignments to an App Layer, a copy of the Layer is stored in the appliance's

Network File Share, and delivered to individual AD users and groups on-demand, in addition to the Layers that they receive

via the base image.

To use this feature, you'll add Elastic Assignments specifying which users and groups should receive each of the App Layers

that you would like to leave out of your base images. You'll then publish your base image(s) with the Elastic Layering For
Session Hosts selected.

How users access Elastic Layers assigned to them

When users log into their Session or Desktop, icons for their Elastic Layers will appear as shortcuts on the desktop.

A user receives an Elastic Layer in the following cases:

The user (an AD user in the Management Console) is assigned the Layer.

An AD group that the user belongs to is assigned the Layer.

A machine that the user logs into is a member of an AD Group that receives the Elastic Layer.

A machine that the user logs into is associated with an AD Group that is assigned the Layer via the Management

Console.
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If  more than one version of  the same Layer is assigned to a user

If  a Layer is assigned directly to the user and indirectly to one or more of the user's groups, the user receives the most

recent version of the Layer assigned directly to her/him. For example, if  a user is assigned Version 2, and a group that the

user belongs to is assigned Version 3, the user will get Version 2.

If  the user is assigned a Layer via one or more group assignments, the user receives the most recent version of the Layer.

If  a user has an App Layer in their Layered Image, and the Layer is also assigned to them elastically

If  a user has an App Layer in the Layered Image and the user is also assigned the Layer elastically, they will receive the

Elastic Layer, even if  the version in the base image is more recent.

Prerequisites and limitations

Prerequisites

The appliance's Network File Share must be configured correctly:

The Share must be configured using SMB technology. When using Elastic Layer assignments, NFS technology is not
supported.

The Share must be set up by the admin to be readonly for all users except for the one configured in the appliance.

This secures the Layers and other f iles stored on the Share.

The User named in this configuration must have Read/Write permissions on the root of the network f ile share.

Select System > Settings and Conf iguration and scroll to Network File Share.

Make sure that any users who will be assigned Elastic Layers have Read only access for the root directory of the

Network File Share.

.NET Framework 4.5 is required on any Layered Image where Elastic Layers are enabled.

The App Layers you want to elastically assign.

Note
App Layers must be created using the same OS Layer used to create the Layered Image that you enable to deliver the Elastic App

Layer to users.

Elastic Layering Limitations

You cannot elastically layer the following:

Microsoft Office Add-ons and extensions in individual Layers. A user must have all of their add-ons in one Layer. Note:

Please use the recipe for elastically layering MS Office.

Applications with drivers that use the driver store. For example, a printer driver.

Applications that modify the network stack or hardware. For example, a VPN client.

Applications that have boot level drivers. For example, a virus scanner.

Enable Elastic Layering in the base image
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When you publish the Layered Image that the users will log into to get the Elastic App Layer(s):

1. In the Management Console, select the Image Template used to generate the Layered Image.

2. Select the Images tab.

3. Select the Image Template on which you want to enable Elastic Layering, and select Edit Template from the Action bar.

The Edit Template wizard opens.

4. On the Layered Image Disk tab, select a value for the Elastic Layering option.

Application Layers Only - To enable Elastic Layering for your App Layers.

Application and User Layers - To enable both Elastic Layering for your App Layers, and User (personalization) Layers.

5. Finish publishing the Layered Image.

6. Provision your Session Hosts with the new base image.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Run the Elastic Fit Analyzer on App Layers (App
Layering Labs)

Before assigning an App Layer elastically, use the Elastic Fit Analyzer to determine the likelihood that the Layer assignment

will be successful.

Elastic Fit Analysis

In the Layer Details, the Elastic Fit rating indicates how likely it is that the Layer will work when elastically assigned.

Good Elastic Fit . This layer should work when deployed elastically.

Poor Elastic Fit . This layer will probably not work when deployed elastically, or may behave differently than when it

is deployed in a Layered Image.

Elastic Fit Details

You can learn more about the Elastic Fit of a Layer by expanding the Elastic Fit Analysis. If  the Elastic Fit is less than ideal,

the list of violated rules will be displayed.

Low Severity Warning. This is unlikely to cause any change in behavior or functionality for most applications.

Medium Severity Warning. This may cause minor changes in behavior or functionality for some applications.

High Severity Warning. This is likely to cause signif icant changes in behavior or functionality for many applications.
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Enable Elastic Fit in App Layering Labs

To use this App Layering Labs feature, you must enable it. To enable Elastic Fit:

1. In the Management Appliance, select System > Settings and Conf iguration.

2. Click Edit  App Layering Labs.

3. Select the Elastic Fit  check box.

4. Click Save.

Analyze an App Layer for Elastic Fit

All new Layer Versions will be analyzed for elastic layering compatibility when they are finalized. To analyze existing App

Layers for Elastic Fit:

1. Log into the Management Console.

2. Select Layers > App Layers.

3. Select the Layer to analyze, and click Analyze Layer.
4. On the Select Versions tab, choose the Layer Versions to analyze.

5. On the Confirm and Complete tab, click Analyze Layer Versions. The analysis takes seconds.

6. To see the Elastic Fit Analysis, select the App Layers module, move the mouse pointer over the Layer icon and click

the Info  icon.

7. Expand the Version Information for each Layer Version, and look for the Elastic Fit rating.

8. For a detailed report, expand the Elastic Fit Details. If  the Elastic Fit is less than ideal, the list of violated rules will be

displayed.

9. You can display the AD tree and hide the violated rules by clicking a button acknowledging that the layer is unlikely to

work as expected.

Upgrading from Earlier Releases

After upgrading from an earlier App Layering release, the Elastic Fit Detail shows that any existing Layer Version(s) have not

been analyzed. Until you run the analysis on existing Layer Versions, the Versions will have a single High severity Elastic Fit

Detail, and a Poor Elastic Fit.

Elastically assign an App Layer to AD Users and Groups

The first time you assign an App Layer elastically, we recommend starting with an app like Notepad++ or GIMP, because

they are simple to .

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer that is not going to be included in the base image, and select Add Assignments.

3. In the wizard that opens, select the Version of the App Layer that you want to assign users.

4. Skip the Image Template Assignment  tab. This tab is for assigning the Layer to an Image Template.

5. In the Elastic Assignment tab, select the users and groups who should get this App Layer.

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Elastically assign an App Layer to users via machine
assignments and associations
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Any machine running the App Layering Service (ULayer.exe) can have Elastic Layers assigned to it. You can accomplish this by

either adding the machine to or associating it with the AD Group, and then elastically assigning the App Layers to the

AD Group.

The Layers assigned to the machine will be available to every User who successfully logs into that machine. The App

Layering Service will scan for changes to the machine's AD group memberships and associations every 10 minutes. When the

users log in, they should see an icon for each Elastic App Layer they've been assigned.

Use Active Directory to add the machine to the AD Group

Assuming you have a published Layered Image booted in your environment, you can add the machine to an AD Group, and

assign Elastic Layers to the AD Group.

1. Use Active Directory (AD) to add the machine to an AD Group.

2. Select an App Layer that is not going to be included in the base image, and elastically assign the Layer(s) to an AD Group.

3. You can wait for AD to propagate the changes and be recognized by the App Layering Service, or you can force the App

Layering Service to update its list of machine groups by doing one of the following:

Wait for the App Layering Service to detect the changes (within 10 minutes by default).

Restart the App Layering Service.

Reboot the App Layering Service Machine.

Execute the refresh.groups command:

C:\Program Files\Unidesk\Layering Services\ulayer.exe refresh.groups

Example

You start with an AD User, and AD Group, and a machine that you provisioned using a Layered Image.

AD User: Kenya
Kenya has no elastic assignments.

AD Group: Marketing
The Marketing group includes the member Kenya.

Machine: ElasticTestMachine
The ElasticTestMachine base image includes the MS Office App Layer.

In this example, you elastically assign the Chrome App Layer to ElasticTestMachine:

1. In AD, you add the machine ElasticTestMachine to the Marketing AD Group.

2. In the Management Console you elastically assign the Chrome App Layer to the Marketing Group.

3. When Kenya, who is part of the Marketing group, logs into ElasticTestMachine, she receives both the MS Office App
Layer, which is in the base image, and the Chrome App Layer.

4. When any user who is not in the Marketing group logs into ElasticTestMachine, they also receive both

Layers: MS Office because it is in the base image, and Chrome because the ElasticTestMachine is a member of

the Marketing AD Group.

Use the Management Console to associate the machine with an AD Group

Associating a set of machines with an AD Group allows any machine running the App Layering Service to have Layers

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co_az4#Assign
https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co_az4#Assign
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elastically assigned to it via AD group membership.

Elastic Layers granted via Machine association can be thought of as extending the layers assigned to a user. For example, if

a machine matches multiple Machine Associations, only the unique layers will be added to the ones the user already has.

In the Management Console, you use asterisk (*) wildcards in a machine name pattern to specify a set of machine names.

For example:

Machine name pattern Matches these names Does not match these names

machine*
machine01

machineindetroit

amachine

localtestmachine

*machine
amachine

localtestmachine

machine01

machineindetroit

ky*eng
ky02359eng

kytesteng

01ky_eng

testky01eng

*eng*

eng01

1eng

1eng01

en01

1en

1en01

You can create Machine Associations before or after elastically assigning App Layers to the AD Group. Also, the machines

do not need to exist when you add the associations, as the associations exist within App Layering only, and AD is not

aware of them.

Associate a set of machines with an AD Group

1. Log into the Management Console as an Admin user, and select Users > Tree.

2. Expand the Tree, select the appropriate Group and click Edit Properties in the Action bar. This opens the Edit Group

Wizard.

3. Select the checkbox, Associate machines with this AD Group. This reveals the Machine Name Pattern field:

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_notchecked.png
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4. Specify a set of machines to associate with the AD group by entering a machine name pattern. For examples, see the

above table of Machine name patterns.

5. On the Confirm and Complete tab, select Update Group. Notice the shape of a computer monitor superimposed over

the group icon. This indicates that machines are associated with the group.

When you click the group's  icon, the Detail view now includes a field called, Associate With Machines where the

pattern.

Example

You start with the machine, Mach1, the AD Group, MachineGroup, and the App Layers for Firefox and MS Office.

Machine: Mach1
AD Group: MachineGroup
App Layers: Firefox, MS Office

Further, you have elastically assigned the Firefox and MS Office Layers to the AD Group.

If  you add a Machine Association to MachineGroup with a name pattern of "Mach*", when any domain user logs

into Mach1, they will receive the Firefox and MS Office Elastic App Layers.

Manage Elastic Assignments

You can:

View a user's Elastic Layer assignments.

Update an App Layer and elastically assign the new Version of the Layer.

Remove Elastic Assignments.

Debug an Elastic Assignments.

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_checked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_details.png
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View a user's Elastic Layer assignments

1. Log into the Management Console and select Users > Tree.

2. Select an AD User or Group, and click the "i" icon to the right of the name. If  the user or group is assigned any Elastic

Layers, the Layers are listed just below the user's or group's profile information in the Details window that appears.

Update an App Layer and its Elastic Assignments

You've added Elastic Assignments to an App Layer, and users are accessing the app as expected. A new version of the

application is released, so you update it by adding a new Version to the Layer. Now you need to assign the new version to

the users who have the Layer.

1. Log into the Management Console and select Layers > App Layers.

2. Select the elastically assigned App Layer that you just updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new Version.

5. Skip the Image Template Assignment tab.

6. In the Elastic Assignment tab, there's a list of Users and Groups who have been assigned a different version of the

selected Layer. Select the users and groups to whom you want to assign the new Version of the Layer.

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show AD users and groups already at this version. A list of grayed

out names may appear. These users have already been assigned the Version.

7. On the Confirm and Complete tab, verify the Users and Groups selected to receive the new Version, and click Update
Assignments.

Remove a Layer's Elastic Assignments

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Debug an Elastic Layer

If  you have an Elastic Layering issue, you can diagnose the problem by finding out whether the layer is being delivered, and if

so, whether it is working correctly. If  needed, collect data for Support, as described here.

Is this a Delivery issue?

Are the things you'd expect to see if  this app were installed actually there as expected?

Do you see the f iles and registry entries for the layer?

If  the app is supposed to be in the Start menu, is it there?
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If  there should be a shortcut for the app on the user's desktop, is there one?

If  you discover that app delivery is an issue, you can collect the following data, open a case, and send the data to Support.

1. Collect the data from these logs:

Windows App Event log –  In the Windows Event Viewer under Windows Logs, export the Application event log as an

EVTX f ile.

App Layering Service log (ulayersvc.log) –  C:\ProgramData\Unidesk\Logs\ulayersvc.log

2. Collect the values of these Registry keys:

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:AssignmentFile

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:RepositoryPath

3. Collect the contents of the Assignment (ElasticLayerAssignments.json) and Layers (Layers.json) files from the Repository

Path.

4. Contact Support.

Is this an operational issue?

One of these issues could indicate that this is an Elastic Layering issue:

The app is being delivered but doesn't launch correctly.

An operation within the app doesn't work correctly.

A licensing problem or a security issue.

The app launches, but then misbehaves, for example, it crashes on startup, or starts up but doesn't work right.

If  the problem with the Layer is operational, test the App Layer in the base image to rule out general layering issues:

1. Add the App Layer to an Image Template, and publish a Layered Image that includes the App Layer.

2. Log in as a user who is not assigned the Layer elastically, and make sure that the application is operational in the base

image.

3. Contact Support with your f indings.
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System settings

Jun 29, 2017

You can specify settings for the following system configuration parameters by clicking on the Edit  button of each option,

making your changes, and clicking the Save button.
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Appliance
settings

Summary

HTTP

Certificate

Settings

Displays the currently set security certificate. Use the Upload and Generate  buttons to upload an existing certificate or to

generate a new one. Optionally, enter a comment that describes the changes you made.

Network

File Shares

After you specify a Network File Share Type , Network File Share Path, User name , and Password, click Test
Network File Share  to see if you can connect to the file share. The test returns a message stating either "Success" or

"Failed to mount network file share path". Optionally, enter a comment that describes the changes you made.

Security

Settings

Specify the number of minutes of inactivity before the Management Console logs you out. Optionally, enter a comment

that describes the changes you made.

Task

Retention

Settings

Specify the number of days that the appliance should retain completed Tasks before deleting them. Optionally, enter a

comment that describes the changes you made.

Audit Log

Retention

Settings

Specify the number of days that the appliance should retain audit log files. After that time elapses, the software begins to

overwrite the audit log. Optionally, enter a comment that describes the changes you made.

Notification

Settings

Configure automatic email notification settings for yourself or other users. When you export logs, the appliance sends

the specified recipients an email notification that includes a link to the log files.

To set up email notifications:

1. In the Mail Server box, enter the name of your email server or the name of the SMTP relay server.

2. In the Mail Server port, enter the number of the port that the email server uses for communication.

3. In the User Name box, enter the user name for the email account you want to use for sending notifications. For

example, username@domain.com.

4. In the Password box, enter the password for the email account.

5. In the From box, enter an email address to identify the source of the email message. For example, if you enter

myaddress@mycompany.com, the email message displays the following in the From box of the received notification:

App Layering Manager [myaddress@mycompany.com]

6. In the Recipient List box, enter the email addresses that should receive notifications. Use a comma or semicolon to

separate the email addresses.

7. Click Test Email Configuration to verify that the settings for the email server and account work correctly. If the test

succeeds, the software displays a success message and sends the recipients a confirmation email.

8. Enter a comment, if necessary, and click Save to save the email settings. Any comments you enter will appear in the

Information view Audit History.

For more information, see Export log files.

Log File

Retention

Settings

Specify the maximum disk space to use for all logs (in megabytes) and the number of days that the log files should be

retained. Optionally, enter a comment that describes the changes you made.

https://www.unidesk.com/support/learn/4.2.0/citrix_app_layering/itoc_2_support_co4/logs_export_co4
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System storage

Jun 29, 2017

This article provides information about system storage.

Check the amount of free space in the appliance's
local storage

The appliance's local storage is a Layer Repository where the appliance creates, composites, and stores Layers and Layered

Images. You can see how much disk space is used in the System module of the Management Appliance.

1. Log into the Management Console and select System > Manage Appliance.

2. In the Services table, the Local Storage for the Layering Service shows how much space is used and how much is free.

Notes:

Disk space is shown in 1024-based Gigabytes, not metric.

Free space is updated every time a Layering Service job completes. If  you want to make sure the page has been

refreshed, click the Refresh icon just above the Manage Appliance subtab.

When creating a Layer or adding a Version to it, extra space is temporarily required to build the Packaging Disk. You

can calculate the amount of space needed during Layer creation by adding the following Layer sizes:

The size of the OS Layer Version you're using.

The size of the writable disk you want for the App Layer.

The size of any Prerequisite Layers (if  you have any).

Add space to an existing disk in locally attached storage

You can add storage space to an existing local storage disk as follows.

1. Log into your hypervisor's management console, and follow the normal procedure to increase the size of the local

storage disk. (You may have more than one of these disks, and can expand each one of them.)

2. Log into the Management Console and select System > Manage Appliance.

3. Select Expand Storage. A list of expanded disks is displayed. (You might also see attached disks that are not yet part of

the layer repository, but you can ignore those.)

4. Notice that the New Size of the disk you expanded is larger than the Current Size.

5. Select the check box for the disk that you want to expand to the New Size.

6. On the Confirm and Complete tab, click Expand Storage.

Add a disk to locally attached storage

When you install the appliance, it comes equipped with an additional 200 GB data disk that is used as a Layer Repository.

You can expand the appliance's local storage by adding another disk to it.

1. Log into your management console.

2. Select System > Manage Appliance.
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3. Select Expand Storage.

The Disk Selection tab is displayed of disks that are attached to the system and are not part of the layer repository.

4. Select the check box for each disk that you want to use to expand the layer repository.

If  a check box is grayed out and a yellow icon with an ! (exclamation point) is displayed, it means that the attached disk

is not eligible for use (for example, if  the disk is not blank). Once the attached disk is blank and unpartitioned, you will be

able to use it to expand the appliance's local storage.

5. On the Confirm and Complete tab, click Expand Storage.

Add storage locations for User Layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS f ile share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The f irst storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's

User Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest

priority location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until

that point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the

their User Layer to the new highest priority location.

Create Storage Locations

To add a storage location:

1. Log into the management console.

2. Select System > Storage Locations.

3. Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

4. Select Add Storage Location, and enter a Name and Network Path for the new location.

5. On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to

add to the new storage location.
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6. On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure Security on User Layer folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:

Setting name Value Apply to

Creator Owner Modify Subfolders and Files only

Owner Rights Modify Subfolders and Files only

Users or Group

Create Folder/Append Data

Traverse Folder/Execute File

List Folder/Read Data

Read Attributes

Selected Folder Only

System Full Control Selected Folder, Subfolders and Files

Domain Admins, and selected Admin group Full Control Selected Folder, Subfolders and Files

Set security on the User Layer folders

1. Log into the management console.

2. Select System > Storage Locations. The file shares displayed are the storage locations defined for User Layers. For

example, say you've defined three Storage Locations so that you can more easily manage storage for Group1 and

Group2 separate from everyone else in the organization:

Default location - \\MyDefaultShare\UserLayerFolder\

Group1 - \\MyGroup1\Share\UserLayerFolder\

Group2 - \\MyGroup2\Share\UserLayerFolder\

Note: The appliance's main file share, which is used for storing OS, App, and Platform Layers, is not listed as a User Layer

Storage Location.

3. Create a \Users subdirectory under each file share:

Code COPY

javascript:void(0)
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\\MyDefaultShare\UserLayerFolder\Users\

\\MyGroup1Share\UserLayerFolder\Users\

\\MyGroup2Share\UserLayerFolder\Users\ 

4.  Apply the security settings listed above to each /Users subdirectory.
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Firewall ports

Jun 29, 2017

The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin user

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.
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Destination Activity Protocol Ports

App Layering appliance (Enterprise Layer Manager (ELM) Management Console TCP 80,443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP

3000 (HTTP) 

3500 (HTTPS)

Connector for PVS Communication TCP

3009 (HTTP) 

3509 (HTTPS)

Connector for vSphere Communication TCP

3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP

3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP

3000 (HTTP) 

3500 (HTTPS)

Connector for Nutanix Communication TCP
3006 (HTTP)

3506 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161

App Layering Appliance (Enterprise Layer Manager
(ELM))
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Internal Connections

By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering Appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent - refers to the App Layering Agent, which is required if  you are:

Using PVS - The Agent must be installed on you PVS server(s).

Running Connector scripts - The Agent must be installed on any server on which you want to run a Connector script,

for example, a server for your connection broker, provisioning service, hypervisor, or any other server running in your

environment.

Admin User - A Management Console user who is assigned the App Layering Admin Role.

Source Destination Activity Protocol Ports

Agents Appliance Initial registration TCP 443

Appliance Agents Communication TCP 8016

Agents Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via

ESXI Host
TCP 443

Agent Appliance Agent communication with datastore TCP 8888

Appliance Active Dir Communication with Active Directory TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP) 

3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP) 

3509
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user /Publishing
3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

Admin User Appliance Connector for Nutanix Communication TCP

3006

(HTTP)

3506

(HTTPS)

Source Destination Activity Protocol Ports

External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the

destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.

Destination Activity Protocol Port

XenCenter Communications 5900
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Manage layers and templates

Jun 29, 2017

The App Layering Appliance (aka Enterprise Layer Manager (ELM)) is a virtual appliance that coordinates communication in

the App Layering environment and manages copies of your Layers and Image Templates. Based on CentOS, the appliance

hosts the Management Console, a friendly interface where you create Layers and use those Layers to publish Layered

Images.

You can log into the appliance and modify the administrator password, network address, NTP servers, and Time Zone

settings using the Appliance Configuration utility, as described here.

Before you start

Make sure that the App Layering Appliance is running in your hypervisor.

Make sure you have the password for an account with administrator privileges

Log into the appliance using an account with administrator privileges

Using either your hypervisor console or SSH, log into the appliance as administrator (default password Unidesk1).

Note: If  the appliance is in Azure, type /opt/sbin/cfg_launcher, and press Enter.

This opens the Appliance Configuration utility.

Change the administrator password

The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

administrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the password for any of the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, take a moment to

familiarize yourself  with the administrative accounts for the appliance.

2. For each account, enter the new password and then re-enter it in the Confirm Password f ield.

3. On the Confirm and Complete tab, click Change Credentials.

Configure networking (includes Static IP Address option)

You can change the appliance's IP address and/or its DNS servers. When the appliance is first deployed, the DNS settings

are retrieved through DHCP. If  DHCP is not available and you will be using static IP addresses, once you select Static, you

will be prompted to enter the IP addresses for your DNS servers.

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter C (for Configure Networking), and press Return.
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3. At the next prompt, type D for Dynamic (DHCP) or S for Static.

If  you choose Static, you will be prompted for the IP address and Subnet mask, along with default addresses for the

Gateway and DNS addresses.

4. When prompted, enter Y to save settings.

5. At the Action prompt, enter Q to quit.

6. Restart the appliance.

Synchronize the system clock with NTP servers

You can synchronize the system clock on the ELM by configuring NTP servers. You can specify how many NTP servers you

need, with 6 being the maximum. And, you can add and remove NTP servers, as needed. Where possible your existing servers

will be used as defaults.

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter N for NTP servers change, and press Return. A list of your current NTP servers is displayed.

3. At the prompt, specify how many NTP servers you need by typing a number from 0 to 6.

0 - All servers will be removed (you will be warned).

1-6 - You will be prompted to accept or replace each of the current servers. 

4. For each server, press Enter to accept the current value. Or, enter a new server address (Example: 3.pool.ntp.org). Once

the last address is entered, an NTP Server Summary is displayed.

5. Enter S to save the settings.

6. At the Action prompt, enter Q to quit.

7. Restart the appliance.

Change the Time Zone

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter T  for T imezone change, and press Return. The current time zone is displayed.

3. Press Enter to display available timezones. The f irst bunch of time zones are displayed in alphabetical order, starting with

the

4. Advance through the timezone codes until you see yours:

Enter - Advances one line at a time.

Page Up Page Down - Displays the next or previous screen full of choices.

Or search the timezones:

Type Slash (/) and part of the name you are looking for.

5. When your timezone is displayed, press Q to get to the prompt.

6. Type the number for your timezone. The timezone you entered is displayed.

7. Press Enter to complete the change.

8. At the Action prompt, enter Q to quit.

9. Restart the appliance.
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Update OS layer

Jun 29, 2017

The Unidesk OS Layer contains the Windows Operating System that is assigned to any Unidesk Layered Images you create

using that OS Layer. Once created, you can use the OS Layer to build as many Layered Images as you want.

The OS Layer includes a virtual machine in your infrastructure running the Unidesk-supported Windows Operating System

that you want to use for your Layered Images.

Add a version of  an OS layer

1. In the Citrix App Layering Management Console, select Layers > OS Layers

2. Select or right-click an OS Layer icon and click Add Version. This opens the Create OS Version Wizard.

3. (Required) In the Version Details tab, enter a Version identif ier. This can be the application version, or anything you

choose.

4. In the Connector tab, select a Connector configuration for the platform where you'll be publishing your Layered Images.

You can also modify an existing configuration by selecting it and clicking Edit. If  you have not yet created a Connector

Configuration or if  the configuration you need is not present, click New to create a new Connector Configuration and

select it from this list.

5. In the Platform Layer tab, select a Platform Layer that contains the tools and hardware settings that you need to install

and package the OS when adding a Layer Version. Once created, the new Layer Version can be used in Layered Images

published to any platform.

6. In the Packaging Disk tab, enter a f ile name for the Packaging Disk, and select the disk format. This disk will be used for

the Packaging Machine (the VM) where you will install the application, as described in the next two sections.

7. Confirm and Complete tab - Verify your settings and click Create Version. Unidesk runs the task of creating a new OS

version. When the task completes, it shows a status of Action Required. When you double-click the task to expand it,

the task contains the following text (refer to the image in the next section): 

"The Packaging Disk has been published. The virtual machine '<...>' can be found in folder '<...>' in datacenter '<...>'. Power on

this virtual machine to install your application. When the installation is complete, power off  the virtual machine before

clicking Finalize on the Action bar."

Next, you can deploy a Packaging Machine for this OS Layer version.

Deploy a Packaging Machine to XenServer

The Packaging Machine is a virtual machine where you install any updates or applications you want to include in the OS

Layer. It is strongly recommended that you use a unique Packaging Machine for each Layer. The Packaging Machine is a

temporary VM that will be deleted once the OS Layer has been finalized.

The Task Description (example shown in the last step above) contains directions to navigate to the location in XenServer

where the Packaging Machine for this Layer has been created.

1. To create your Packaging Machine in XenServer, begin with the expanded Packaging Disk task shown in step 2 below.

2. Log into your XenServer web client.

3. Back in the Unidesk Management Console, use the instructions in the expanded Packaging Disk Task (example shown

below) to navigate to the Packaging Machine.

Install the OS update
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1. Remote log into the Packaging Machine in XenServer. Be sure to log in with the User account you used to create the OS

in XenServer.

2. Install any updates or applications you want to include in the new OS Layer version, such as Windows Updates or anti-

virus applications.

3. If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

4. Make sure the Packaging Machine is in the state you want it to be for the user:

If  the applications you install require any post-installation setup or application registration, complete those steps now.

Remove any settings, configurations, f iles, mapped drives, or applications that you do not want to include on the

Packaging Machine.

Next, you will shut down the Packaging Machine and verify that the Layer is ready to finalize.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, the next step is to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

1. If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

2. Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verif ication

process.

3. If  there is an outstanding operation that must be completed before the Layer can be f inalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

4. Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into
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native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground. 

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

3. Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status

3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the OS layer

Once the Packaging Machine is created and any apps or updates installed, you'll need to finalize the layer.

Note: When you finalize a new version of an OS Layer, Unidesk deletes the Packaging Machine so as not to incur more

costs.

When a layer is ready to finalize:

1. Return to the Unidesk Management Console.

2. In the Layers module, select the Layer.

3. Select Finalize in the Action bar.

4. Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.

Reference: Create OS Version Wizard values

Version - (Required) This can be the version of the OS Layer or a version you assign to the Layer. This value is displayed in the

Details view of the Layer.

Version Description - (Optional) Enter a description of the version.
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Max Layer Size - (Optional) Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 100 gigabytes. If  the version you are creating could requires more space,

change this to a realistic value.

Select a Platform Connector configuration - (Required) Specify a Unidesk Platform Connector for the platform where you'll

be publishing your Layered Images. For example, if  you're publishing to Azure RD Session Host, select the Azure RDSH

connector with the credentials required to access the account. If  the configuration you need is not listed, add a New one

and select it from this list. If  you want to change the settings of a Platform Connector configuration, select it and click

Edit.

Packaging Disk Filename - (Required) The name of the Packaging Machine you created in Azure.
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Delete OS layer

Jun 29, 2017

You can delete an OS Layer or Layer version, as long as it is not being used by another Layer, or Image Template. Deleting

the Layer itself  removes all versions, volumes, and resources from the App Layering appliance.

You can delete an entire layer or a layer version if  it is:

Not deployed to an Image Template.

Not the required OS Layer (or Layer Version) for any compatible App Layers.

Not a prerequisite for another Layer that is deployed to an Image Template.

Delete a layer or layer version

1. In the Management Console, select Layers.

2. Select an OS Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.
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Delete platform layer

Jun 29, 2017

You can delete a Platform Layer or Layer version, as long as it is not being used by an Image Template. Deleting the Layer

itself  removes all versions and resources associated with the Layer.

1. In the Management Console, select Layers > Platform Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Delete app layer

Jun 29, 2017

You can delete an app layer or layer version, as long as it is not being used by another layer as a prerequisite, or deployed to

an image template. Deleting the layer itself  removes all versions and resources associated with the layer.

1. In the Management Console, select Layers > Application Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Manage image templates

Jun 29, 2017

When you create new layers and new versions to them, you can edit the layer selection in your image templates, and use

the templates to publish new versions of your layered images. Once created, a layered image is no longer associated with

the template used to create it. This means that you can change or delete a template without affecting any previously

published layered images.

Update image templates with a new layer version

When you add a new version to an app layer or an OS layer, you can quickly identify the image templates that include the

layer, and select which templates to update with the new version.

1. In the App Layering Management Console, select Layers > App Layers or Layers > OS Layers.

2. Select the Layer you updated, and click Update Assignments.

3. In the wizard that opens, select the new version of the layer that you want to assign. The image template assignment

tab lists the image templates that include the layer but are not yet assigned the new version.

4. On the image template assignment tab, select the image templates to which you want to assign the layer or layer

version.

Notes:

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out names

may appear. These templates have already been assigned the Version.

You can use the Search f ield to f ilter this list by Layer or Version. If  you search on part of a Layer name or Version, any

entry that contains the search string is displayed.

5. Skip the Elastic Assignment tab

6. On the Confirm and Complete tab, verify your choices and click Update Assignments.

Edit any image template setting

When you want to change the settings that you use to publish any of your layered images, you can edit the image

template you originally used to publish the layered image(s) and publish a new version of the image(s).

1. In the App Layering Management Console (UMC), select the Images module.

2. Select the template you want to edit, and click Edit Template. This opens the Edit Template wizard.

3. On the Name and Description tab, you can change the Name, Description, and Icon for the Image.

4. On the OS Layer tab, you can select a different version of your chosen OS layer by expanding the layer and choosing a

different one.

5. On the App Assignment tab, you can add or remove app layers to include in the layered images that you publish using this

template. If  there is more than one version of a layer, you can choose a different version by expanding the layer and

choosing a different one.

6. On the Connector tab, you can change the location to which the Layered Image is published by selecting a different

Connector Configuration.

7. On the Platform Layer tab, you can change the selected Platform Layer, if  for example, you are publishing to a different

environment.

8. On the Layered Image Disk tab, you can edit the Layered Image Disk details, for example, to enable Elastic Layering on

the image.

9. In the Confirm and Complete tab, enter any comments you would like for this layer, and click Edit Template.
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Delete an image template

When you no longer need an Image Template, you can remove it from the Management Console.

1. In the Management Console, select the Images module.

2. Select the template you want to delete, and click Delete Template. This opens the Delete Template wizard.

3. In the Confirm and Complete tab, enter any comments you would like, and click Delete Template.
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App Layering in VMware vSphere

Jun 29, 2017

vSphere Prerequisites

If  you are installing the App Layering appliance in vSphere and building your layers on vSphere VMs or publishing Layered

Images to vSphere, you need:

Network access to Tools download

You need access from the Packaging Machine VM in vSphere to the Tools download (available on the Download page).

vCenter account and privileges

An existing or new vCenter account to use for App Layering.

The account must have vCenter privileges to: Create and remove VMDKs, and to copy and delete layers on VMDKs

using vSphere f ile APIs (see detailed list of vCenter permissions below).

Dedicated vCenter role for App Layering (optional)

To set up a new role:

1. In the vSphere Client, navigate to Home > Administration > Roles.

2. Click Add Role.

3. Enter a name. Example: UDAdmin.

4. Set the privileges for this account.

Privileges set for the vCenter role you are using for the App Layering service

Add the required vCenter permissions (detailed permissions list below).

1. Open the Assign Permissions window.

2. In the vSphere Client, navigate to Home > Inventory > Hosts and Clusters.

3. Select your vCenter, right-click, and select Add permission.

4. In the Assign Permissions window, under Assigned Role, expand All Privileges.

5. Select the permissions listed below, make sure that the Propogate to Child Objects check box is selected, and click

OK. displayed.

The App Layering role associated with the administrator account

Associate the App Layering role with the administrator account:

1. Add the administrator account and assign the App Layering role to it.

2. Allow the permissions to propagate to the entire Datacenter.

Note: If  you want to restrict this use from accessing specific folders in the Datacenter, grant the user more restrictive

permissions for those folders.

vCenter permissions

App Layering requires vCenter-level privileges to request information about the execution status of tasks. Without those

privileges, the tasks would fail.
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Expand All Privileges, and each of  the
following...

Then select...

Datastore

Allocate space

Browse datastore

Low level file operations

Folder
Create folder

Delete folder

Global Cancel task

Host > Configuration System Management

Network Assign network

Resource Assign virtual machine to resource pool

vApp

Export

Import

vApp application configuration

Virtual machine > Configuration

Add existing disk

Add new disk

Add or remove device

Advanced

Change CPU count

Change resource

Configure managedBy

Disk change tracking

Memory

Modify device settings

Remove disk

Rename

Reset guest information

Set annotation

Settings

Swapfile placement

Upgrade virtual hardware

Virtual machine > Interaction

Answer question

Configure CD media

Console interaction

Device connection

Power off
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Virtual machine > Interaction Power off

Power on

Reset

Suspend

Virtual machine > Inventory

Create from existing

Create new

Register

Remove

Unregister

Virtual machine > Provisioning

Clone template (optional, but required to use a vSphere template as the

source VM)

Clone virtual machine

Customize

Deploy template

Mark as template

Virtual machine > Snapshot management
Create snapshot

Remove Snapshot

Expand All Privileges, and each of  the
following...

Then select...

Storage requirements

350-500 GB Storage Space
The App Layering appliance uses local storage for temporary f iles and f inalized layers. The more layers you create, the

more space you need. However, if  you run low on space, you can expand the size of the current disk, or add other disks

to the appliance when needed.

40-100 GB network f ile share (SMB)
The f ile share connected to the appliance is used for upgrades, Elastic Layers, and cross-platform publishing. This space is

easy to expand, if  needed.

Operating System requirement

OS for Layered Images

You need a supported operating system to import into an OS Layer. This OS will be used to build your Layered Images.
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Install

Jun 29, 2017

To get started with Unidesk, you will need:

A Citrix Cloud account

A supported version of VMware vSphere

A Virtual Network in vSphere

Storage requirements and vSphere requirements listed here.

Installation package

The installation package, citrix_app_layering_vmware_4.x.x, includes:

File Description

vmware_x.x.x.ova OVA file for the appliance VM

citrix_app_layering_agent_installer.exe App Layering Agent installer

citrix_app_layering_os_machine_tools.exe OS Machine Tools

Deploy the App Layering appliance

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to layering.cloud.com.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. At the top of the page select the hypervisor where you are deploying the App Layering service. This selection determines

which platform-specif ic installation package will be downloaded in Step 2.

9. Under Step 2, click the Download for Hypervisor button to download the appliance installation package for the

hypervisor you have selected.

10. Under Step 3, right-click Instructions, open the page in a new browser tab, and select your hypervisor. The installation

instructions for your hypervisor are displayed.

11. Extract the download package, citrix_app_layering_xenserver_4.x.x.zip. The f iles included are listed above.

12. Extract the vmware_4.x.xx.ova to a folder on your local drive.

13. In the vSphere Web Client you are using, navigate to the VMs and Templates page.

14. Right-click the folder in vSphere where you want to deploy the template and select Deploy OVF Template. The Deploy

OVF Template wizard appears.

https://www.unidesk.com/support/learn/4.2.0/citrix_app_layering/welcome_platform_support_co4
https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_install_vs4/get_started_prerequisites_vs4
https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_install_vs4/get_started_deploy_unidesk_elm_vs4#Before
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15. In the Deploy OVF Template wizard, do the following:

On the Select source page, select the Local f ile option, and browse to the Unidesk_ELM.ova f ile to select it.

On the Select name and folder page, designate a name and location for the deployed OVF template.

On the Select a resource page, select a location to run the deployed OVF template.

On the Select storage page, select the Thick Provision Lazy Zeroed setting of the Select virtual disk format  option,

select a storage policy, and specify a storage location.

On the Setup networks page, select your vSphere virtual network in the Destination column and select the IPv4  setting

of the IP protocol option.

On the Ready to complete page, review the template settings and click Finish when you are satisf ied with the settings.

On the Citrix Cloud App Layering page, click the Log into Appliance button. This opens the Manage tab. Follow the

instructions to log into the appliance.

Install the App Layering Agent (required for PVS and Connector Scripts)

The App Layering Agent enables the App Layering appliance (Enterprise Layer Manager) or a Unidesk Packaging Machine VM

to run PowerShell commands locally. If  you supply the proper credentials, the agent can run PowerShell commands as a

specific user.

The App Layering Agent is required in cases where one of your Connector Configurations launches a PowerShell script. This

includes Connector Configurations you use to:

Publish Layered Images to a provisioning system.

Package Layers in your hypervisor environment.

The App Layering Agent installer prompts you to register the agent with a App Layering appliance. If  you do not register the

agent during installation, you can manually register it later. However, keep in mind that the PowerShell scripts will not run

until the agent is registered with the ELM.

Prerequisites

Before you install the App Layering Agent, you must have the following requirements on the system where you are

installing the App Layering Agent:

An account with administrator privileges

.NET 4.5

PowerShell 3.0 or greater

PowerShell Snap-in

Before using the App Layering Agent on a PVS server you must ensure the PowerShell Snap-in is installed. This is a

manual step.

For PVS 7.7 and later, you must install the Powershell Snap-in Citrix.PVS.Snapin.dll.

For PVS 7.6 and PVS 7.1, you must install McliPSSnapIn.dll. Use the installutil.exe to install the Snap-in.

Example (7.6):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" McliPSSnapIn.dll

Example (7.7):

From a command prompt, go to: c:\program files\citrix\provisioning services console
Run this command: "C:\Windows\Microsoft .NET\Framework64\v4 .0.30319\InstallUtil.exe" Citrix.PVS.snapin.dll
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On Windows 2008 R2, you must also enable PowerShell remote commands. For background information, see this Microsoft

article: https://technet.microsoft.com/en-us/library/hh849694.aspx

If  your 2008 R2 OS does not have PowerShell remoting enabled, run the following PowerShell command on the PVS server:

Enable-PSRemoting  

Install the App Layering Agent

1. Log in as an administrator on the system where you are installing the agent.

2. Download the App Layering Agent from the Unidesk Download page.

3. Copy the Unidesk_agent_installer.exe f ile from the App Layering Agent folder to a convenient location on the PVS

server.

4. Run the Unidesk_agent_installer.exe as Administrator, and when prompted, enter the path to the directory where you

want to install the App Layering Agent. The default location is C:\\Program Files (x86)\Unidesk\Agent.

5. The App Layering Agent installer checks to see if  all Prerequisites are present. If  any prerequisites are missing, the installer

reports this and exits without installing.

6. The installer prompts you for an Agent Port number. You can accept the default port number (8016) or specify a

different one if  the default port is already in use.

7. The installer prompts you for the credentials (address, username, and password) for your App Layering appliance. Register

the App Layering Agent with the ELM by entering the IP address and login credentials for a Unidesk Management

Console (UMC) user on the ELM with Administrator privileges, (for example, the credentials you use to log into the UMC).

Note: If  the App Layering appliance is not available yet or you choose not to register with it now, you can manually

register at a later time using the procedure described in Register with the App Layering appliance manually.

8. Click Finish to exit the wizard.

Register the App Layering Agent manually

If  the App Layering Agent was not registered with a App Layering appliance during installation, you can register it later by

using the following procedure.

To manually register the App Layering Agent with the ELM:

1. As an administrator, log in to the server where you installed the App Layering Agent.

2. Open a command window (cmd.exe) as administrator and navigate to the directory where the App Layering Agent is

installed. (The default location is C:\\Program Files (x86)\Unidesk\Agent.)

3. Run the following command, using the IP address of the ELM where indicated:

Unidesk.Agent.Service.exe register /i /e:IP_address_of_ELM /u:Administrator

4. When prompted, enter the password for a user who has Administrator privileges in the Unidesk Management Console

(UMC) on the ELM.

https://technet.microsoft.com/en-us/library/hh849694.aspx
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5. When the registration process completes, a message appears informing you of the successful outcome. The App

Layering Agent registration appears in the Audit log for the Management Service in the UMC.

If  the process does not succeed, examine the \Unidesk\Agent\Logs\unidesk.agent.log file in the App Layering Agent

installation directory. You can also view Help for the App Layering Agent command line options by running the following

command: Unidesk.Agent .Service.exe /?.
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Configure

Jun 29, 2017

You can access the App Layering Management Console using the appliance's IP address entered in a web browser, or via the

Citrix Cloud, if  you have a subscription. Currently, access via Citrix Cloud is a Labs feature, so check What's new for what to

be aware of when accessing the Management Console via the Cloud.

Default credentials for the Management Console

The first time you log into the Management Console, you must use the default user name and password, Administrator,
password Unidesk1. At that point, you will be asked to change all administrator passwords for the appliance.

Access the Management Console directly via your private network

To log directly into the Management Console hosted on the App Layering appliance.

1. In your hypervisor, locate the VM you created for the appliance and determine its IP address.

2. Using the IP address for the appliance, enter the following URL in a compatible web browser:

http://<ip_address_of new_vm>/

3. Log in to the Management Console using the default user name and password (see above).

Again, if  this is the first time anyone has logged into the Management Console, you are asked to change the password

for each of the appliance's administrative accounts. It is strongly recommended that you record the new passwords in a

safe place.

Access the Management Console via Citrix Cloud (Labs)

When you log into Citrix Cloud, you can use the App Layering Manage tab to access the Management Console. Below,

please see the minor issues you may encounter when using the Manage tab to access the appliance.

1. In your hypervisor, locate the VM you created for the appliance and determine its IP address

2. In your internet browser, navigate to citrix.cloud.com and select the Manage button on the App Layering tile. This

displays the Citrix App Layering page.

3. Click the Manage tab, and in the window that appears, select the Resource Location, enter the Appliance Address,

and click Connect . This displays the Login page for the Management Console.

4. Log in to the Management Console as Administrator. If  this is the first login after installation, use the default

password, Unidesk1.

Again, if  this is the first time anyone has logged into the Management Console, you are asked to change the password

for each of the appliance's administrative accounts. It is strongly recommended that you record the new passwords in a

safe place.

Known issues and considerations with Management Console access via Citrix Cloud (Labs)

As a Labs feature, you may encounter a few behaviors that are either not optimal or not yet implemented.

Accessing the console. Accessing the console via the Cloud in can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.
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Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.
Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.

Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.

Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.

Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Change administrative passwords

Jun 29, 2017

The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

adminstrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the password for any of the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, take a moment to

familiarize yourself  with the administrative accounts for the appliance.

2. For each account, enter the new password and then re-enter it in the Conf irm Password f ield.

3. On the Confirm and Complete tab, click Change Credentials.
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Set up a file share for the App Layering appliance

Jun 29, 2017

The App Layering appliance must be connected to a network file share.

File Share requirements and recommendations

Requirements

When setting up the appliance's file share:

The file share must be configured using SMB technology.

Note: If  you used a Unidesk 4.0.x version of the product to configure an NFS file share, you can continue using the file

share, but it will not support Elastic Layer assignments.

The user credentials for the file share must have full permissions for that share.

The share must be set up by the admin to be readonly for all users except for the one configured in the appliance. This

secures the Layers and other files stored on the share.

Ensure that you have the minimum storage space requirement of 40-100GB for your file share.

Note: Storage space is expandable, as you can add space to a disk, or other disks to the appliance.

Recommendations

For convenience, set up a File Share hosted in your hypervisor.

For Azure: Currently, the App Layering Appliance does not support the Azure File Share feature. For best performance, it

is best to create a f ile share server in Azure using a fast system with a Premium Disk, for example, a DS class machine.

Create the network file share

Configure a file share that uses Server Message Block (SMB) protocol.

Follow the vendor's instructions for setting up a file share using the SMB protocol.

Configure the App Layering Appliance to access the
file share

Once you have created a file share, configure the App Layering Appliance to attach to it. You can configure the

appliance via the App Layering Management Console.

1. In the Management Console, select System > Settings and Configuration, then scroll down to the network file shares

setting and click Edit .
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2. Specify a Type, Path, User name, and Password for the file share.

3. Click Test Network File Share to see if  you can connect to the file share. The test returns a message stating either

Success or Failed to mount network file share path.

4. Once the test returns a Success message, click Save.
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Open firewall ports for App Layering, as needed

Jun 29, 2017

The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin User

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.

Destination Activity Protocol Ports

App Layering appliance (Enterprise Layer Manager (ELM)) Management Console TCP 80,443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

Connector for PVS Communication TCP

3009 (HTTP)

3509 (HTTPS)

Connector for vSphere Communication TCP

3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP

3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP

3000 (HTTP)

3500 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161
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App Layering Appliance (Enterprise Layer Manager (ELM))

Internal Connections

By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent  - refers to the App Layering agent, which you install on

Admin User - A Management Console user who is assigned the App Layering Admin Role.
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Source Destination Activity Protocol Ports

Appliance Agent Communication TCP 8016

Agent Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via

ESXI Host
TCP 443

Agent Appliance
Communication with datastore via

ESXI Host
TCP 8888

Appliance Active Directory
Communication with datastore via

ESXI Host
TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP)

3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP)

3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the
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destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.

Destination Activity Protocol Ports

XenCenter Communications 5900
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Connect to a directory service

Jun 29, 2017

You can configure the appliance to connect to a directory service, for example, Active Directory. When you connect to your

directory service, you will create one or more Directory Junctions to access specific domains or OUs. The appliance does not
modify the directory service you connect to. The software caches the attributes for each directory service entry, so that if

the connection to the directory service is lost temporarily, the software can use the cached information for management

tasks.

About connecting the appliance to a directory service

The Management Console Directory Tree displays a hierarchical view of Users and Groups. Each Directory Junction that you

create specifies a starting node in the directory tree.

Overlapping directory junctions

Overlapping (or nested) directory junctions occur when you create multiple directory junctions that contain the same users

and then import the users into the directory tree. When overlapping occurs, each directory junction contains its own copy

of the duplicate users.

Example: Overlapping directory junctions

Assume you create Directory Junction A that starts at the Marketing folder in a directory service tree. Next, you create

Directory Junction B which starts at a folder above the Marketing folder. If  you browse both directory junctions, you can

see the Marketing users in both folders.

User attributes are imported f rom the directory service

The App Layering software imports and caches user and group attributes from your directory service when:

You assign administrator privileges to a user.

The values of the attributes change in the directory service.

The attributes that the software caches are read only. All changes to the attributes for directory service users come from

the directory server.

Imported attributes are synchronized regularly

The software synchronizes the information it caches for directory service users with the directory service every 12 hours. If

the software discovers that a user is no longer an object in the directory service, it classifies the user as abandoned (you can

view this information in the Information view for the user).

Create a directory junction

Create the folders where you want to place the Directory Junctions or decide which existing folder you want to use. You

can add a Directory Junction folder to any existing folder in the Management Console directory tree.

Best Practice: Avoid creating overlapping Directory Junctions, if  possible. In some circumstances, deleting an overlapping

Directory Junction can affect your ability to delete another Directory Junction that contains the same users.

1. Select Users > Directory Service.
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2. Select Create Directory Junction in the Action bar. This opens the Create Directory Junction wizard.

3. In the Connection Details tab, specify the details for the directory server.

Directory Junction Name- This name becomes the name of the folder that you see in the tree view. You can use any

name, including the name of a domain in your directory service tree.

Server address - This is the name for the server you will use for the directory service. (IP Address or DNS Name)

Port - Specify the port number for communicating with the directory server.

SSL check box - Select this if  you want to use Secure Sockets Layer (SSL) communication.

If  certificate errors occur, the wizard displays a list of these errors. If  you know it is safe to ignore them, select Ignore

Certificate Errors.

Test Connection - Click to verify that the appliance can connect to the directory service.

4. In the Authentication Details tab, enter the authentication details for a user who has permissions to search the

directory service.

Bind Distinguished Name - To determine the correct syntax for the Bind DN or user name, see the documentation for

your directory.

Examples: The following examples shows some of the ways you can specify a user for the directory service:

domain\username or username@domain.com.

Bind Password.

Test Authentication - Click to verify that the connection to the directory server is valid.

5. In the Distinguished Name Details tab, specify where the software should start searching for users and groups in the

remote directory service.

Base Distinguished Name (DN) - The software starts searching for users and groups in the remote directory service.

Once you establish a connection to the server for the directory service, the wizard displays a list of available DNs. You

can select a DN from the list or enter the DN directly in the box.

Example: Assume that you want to start the search at the Marketing Organizational Unit at the root of a domain.

You would enter the following Base DN:

OU=marketing, DC=root,DC=mydomain DC=com

Test Base DN - Click to verify that the Base DN is valid.

6. In the Folder Location tab, select the folder in the Unidesk tree where you want to add the directory junction for the

remote directory service.

7. In the Attribute Mapping tab, enter the names of directory service attributes that you want to map to the local

attributes or use the default settings.

Note: To change the mapping from local attributes back to default mappings, click Use Defaults.

8. In the Confirm and Complete tab, verify the Directory Junction settings, enter a comment if  required, and click Create

Directory Junction.

If  you enter comments, they appear in the Information view Audit History.
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Assign App Layering roles to users

Jun 29, 2017

About App Layering users, roles, and rights

Built-in administrator account

When you first install the App Layering appliance and log onto the Management Console, there is a "built-in" Administrator

account that you can use to get started. This Administrator has the rights to perform all App Layering operations. You can

edit this user's properties, including the name, password, and contact info. Be sure to change the password for this built-in

Administrator account as part of installing and configuring the appliance. 

AD user accounts

Other than the built-in Administrator account, all users are actually AD users imported via one or more directory junctions.

Once your directory junction(s) have been created, you can assign Roles to each user, as described later in this topic. You

can see which roles are assigned to a user in the User Details.

App Layering Roles defined

Roles determine which App Layering modules a user can manage. Users assigned one or more Roles can log into the

Management Console, and these users are listed on the Administrators tab (select Users > Administrators).

Note
When upgrading from version 4.0.6 or earlier, users assigned the Machine Administrator Role in earlier releases will now be

assigned the Read Only role. If the user needs more than read only access, reconfigure the user roles, as needed.

Rights by role
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Rights Role

Administrator

Can do every operation available in the Management Console.

Only users assigned the Administrator Role can edit user properties on the Users tab (Select Users
> Users).

Only administrators can configure system settings and manage licenses.

Manage App Layers Can create, edit, and delete application layers and versions.

Manage Elastic Layer

Assignments
Can add, update, and remove Elastic layer assignments.

Manage Image Templates

Can create, edit and delete Image templates.

Can add, update, and remove app layer assignments for image templates.

Can update platform layer assignments for image templates.

Can update OS layer assignments for image templates.

Manage OS Layers Can create, edit, and delete OS layers and versions.

Manage Platform Layers Can create, edit, and delete Platform layers and versions.

Publish Layered Images
Can publish layered images.

Cannot create or modify existing image templates.

Read Only

Can view information about any items in the Management Console.

Cannot launch any wizards or make any changes.

The Read Only user cannot cancel any tasks.

User credentials for logging into the Management Console

When you assign Roles to Directory Service users, they can use their Directory Service credentials to log into the

Management Console.

Who can assign App Layering Roles?

You can change a user's role if  you are logged into the Management Console as a user assigned the Administrator Role.

Assign App Layering roles to users

Log into the Management Console.

Select Users > Users.

Select a user and click Edit Properties. This opens the Edit User wizard. 

1.

2.

3.
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Skip to the Roles tab, and select one or more roles for this user. For details, see Rights by Role above.

In the Confirm and Complete tab, click Update User. Any comments you enter will appear in the Information view Audit

History.

4.

5.
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Enable Labs features
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Want to experiment with cool new features that are under development? Through the Management Console, you can

now see which features are available in Unidesk Labs in any given release. You can enable features you're interested in, try

them out, and let us know what you think. The only caveat? Best not use Labs features in your production environment, as

they are likely to evolve with the feedback we receive from users like you!

Throughout this documentation, features that are available through App Layering Labs are marked (Labs) in the title. Most

Labs features require enabling.

To find out which Labs features are available in this release, see What's New.

Enable a Labs feature

When a release includes a Labs feature that you want to enable:

1. Log into the Management Console and select System > Settings and Conf iguration.

2. Select the check box for the feature you want to enable, and click Save. The feature's status changes to Enabled.

You can turn off  the feature at any time by deselecting the check box and clicking Save.

http://docs.citrix.com/en-us/citrix-app-layering/4/whats-new.html
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Connector essentials
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What are Connectors?
Connectors are the interfaces to environments where you create Layers and publish Layered Images. You create one or

more Connector Configurations for each platform where you intend to package Layers or publish Layered Images.

What are Connector Configurations?
A Connector Configuration is a stored set of values for connecting to a storage location in your environment. A

configuration typically includes credentials for authentication, a storage location, and any other information required to

interface with the environment where you will be creating layers or publishing images. You can create multiple Connector

Configurations, each configured to access a unique location in your environment.

What Connector Configurations do I need?
Connector Configurations for importing an OS to create an OS Layer

When you create an OS Layer, you need a Connector Configuration to give the appliance access to the location of the OS

image that you want to use for your OS Layer.

Connector Configurations for creating and updating App Layers, and adding Versions to OS Layers
When creating or updating an App Layer, or adding Versions to an OS Layer, you need a Connector Configuration for the

location in your environment where you will package the Layer. You can create as many configurations as you need, for

example, if  you have more than one storage location in the environment.

Connector Configurations for publishing Layered Images
Publishing Layered Images will require different Connector Configurations than the ones you use for creating Layers, if, for

example, you publish Layered Images to a variety of storage locations near the users being served. For example, you can

prepare your Layers for a server farm in vSphere, and publish Layered Images to Citrix PVS for streaming to servers in

vSphere. Or, you can publish Layered Images to more than one storage location in the same environment, each requiring a

different Connector Configuration. Each location is likely to require different credentials.

How and when to add a new Connector Configuration
If  this is your first time using the App Layering Service, you will need to add one or more Connector Configurations in the

process of adding Layers and publishing Layered Images. In the Management Console, the wizards for Creating Layers,

Adding Versions, and Publishing Layered Images each include a page for selecting and creating Connector Configurations.
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Upgrade
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App Layering updates are automatically downloaded

The App Layering appliance (aka Enterprise Layer Manager) automatically downloads upgrades, but the upgrades are not
automatically installed. Instead, you are notified that an upgrade is available, and you are responsible for running the actual

update.

The appliance periodically checks for upgrades, and when one is found, downloads the package, verifies it, and extracts the

files. Once the package is extracted, you are alerted that there is an upgrade ready.

If  you log into the Management Console as Administrator, you can apply an upgrade either by clicking the Start Upgrade
button on the notification, or by selecting System tab > Manage Appliance > Upgrade.

Notifications

Periodically, the appliance asks api.unidesk.com if  an upgrade is available. The following sections walk you through common

scenarios.

Note
If the appliance cannot access api.unidesk.com, auto-downloading will not work. The user will not see any error. However, there will

be a note in the log that the check failed.

If an update is not available...

Nothing happens. Another check will be made at the next scheduled interval.

If an update is available, but there is no network file share configured...

The user will receive a pop-up (see below) to let them know there is an upgrade available, and that the administrator needs

to finish configuring a network file share before it can be downloaded and applied.

If an update is available...

The Download Upgrade Media job is started, and it is visible in the task list. This job is responsible for:

Downloading the upgrade to local storage.

Ensuring the checksum of the successfully downloaded upgrade package is correct.

Extracting the downloaded upgrade package to the configured Network File Share. The download is extracted to the

appliance's File Share:

Location: NetworkFileShare\AppLayeringVersion
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Example: \\MyServer\AppLayeringFileShare\4.0.8

If  extraction is successful, the next time any user logs in they will be notif ied that an upgrade is available.

If  at any time during this process an error is encountered that requires Administrator intervention (out of space on local

storage, out of space on the network file share, invalid file found, etc.) the job will fail with an appropriate error.

Note
If a job fails it will be retried at the next check interval regardless of whether the Administrator has resolved the fixed.

If another update is found before a previously downloaded one is installed...

The new upgrade will be downloaded (see above) and once successfully completed it will become the Upgrade Available.

If one upgrade is downloading when another is made available...

The running download will be aborted and a new download (as above) will be started. In this case, all files related to the in-

progress download will be deleted.

User notification when an upgrade is available

When logging in every user will receive a notification that an upgrade is available. However, only an Administrator will be able

to run the upgrade.

Download Packages

Platform Package Files Included

Citrix

XenServer
app_layering_upgrade_xenserver_pkg_4.x.x.zip upgrade_xenserver_elm_4.x.x.xx.vhd

Microsoft

Azure
app_layering_upgrade_azure_pkg_4.x.x.zip upgrade_azure_elm_4.x.x.xx.vhd

Microsoft

Hyper-V
app_layering_upgrade_hyperv_pkg_4.x.x.zip upgrade_hyperv_elm_4.x.x.xx.vhd

VMware

vSphere
app_layering_upgrade_pkg_4.x.x.zip

upgrade_vmware_elm_4.x.x.xx.vhd

app_layering_agent_installer.exe

Note: An Agent upgrade is only required if you've installed the agent

for your implementation, for example, if you are using PVS, or

Connector Scripts.

Back up the appliance

Take a snapshot or checkpoint of the appliance.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.468https://docs.citrix.com

Check for available upgrades (Optional)

Under normal circumstances you will be notified of available updates, and the update package is automatically downloaded.

You can, however, check for updates.

1. Log in as Administrator. The following message is displayed:

2. Click the Start Upgrade button to open the Upgrade Wizard, where the downloaded information is displayed in the

Upgrade Disk field.

Note
As Administrator, you can select a different Upgrade Disk. You can also run the Upgrade "manually" by going to the System tab and

selecting the Upgrade  action as before. If an upgrade is available, the Upgrade Disk is displayed.

Non-Administrator Logon

When a non-Administrator logs in, they will see the following pop-up:

A non-Administrator cannot click the Start Upgrade button nor launch the Upgrade wizard. They will need to report the

available upgrade to their Administrator.

Load the App Layering upgrade

1. Log into the Management Console, select System and click the Upgrade action to launch the Upgrade Wizard.

2. On the Upgrade Disk Details tab, click Browse.

3. Navigate to the upgrade f ile, and click Choose.

4. Verify the Upgrade path, and click Upgrade. This starts the upgrade process, and opens a status page in the browser.

5. Once the upgrade has completed, the status changes to "Upgrade Status: Complete."

6. Refresh the Web page to return to the Management Console.

7. Verify that the upgrade was successful by clicking the About  link in the Management Console to confirm the version

number.

Upgrade the App Layering agent

When using PVS or Elastic Layers the Agent is required. To upgrade the App Layering Agent:

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/get_started_upgrade_available2.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/get_started_upgrade_available1.png
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1. Uninstall the previous version of the App Layering Agent from the server(s) where they are installed.

2. Make sure that you have copied the App Layering Agent Upgrade f ile to the PVS server(s) where the agent is installed.

3. Double-click the Agent upgrade f ile, and follow the instructions for upgrading the Agent.

(Optional) Create a Citrix Cloud Connector for accessing the Management Console (App Layering Labs)

If  you are upgrading from 4.0.x to 4.1.0 or later, you can access the App Layering Management Console via the Citrix Cloud,

but you'll need a Citrix Cloud Connector to do so. If  you don't yet have a Cloud Connector, you can create one as described

here. For known issues when accessing the Management Console via the Cloud, see the list of issues below.

1. Log in to the Citrix Cloud. A Citrix App Layering tile should be displayed at the bottom of the page.

2. On the Citrix App Layering tile, click Request Trial, and check your email for a message from Citrix Cloud.

3. In the message you received, click the Sign In button. This returns you to the Cloud.

4. Click Manage on the App Layering tile. The Citrix App Layering page is displayed.

5. Get familiar with the service by reading the Overview. When ready, click the Get Started button to open the Getting

Started tab.

6. Under Step 1, click the Get Cloud Connector button, and for instructions click the Documentation link.

7. Use the Connector documentation to install a Cloud Connector, then return to the Getting Started tab.

8. Under Step 4, the Documentation link opens the instructions for logging in. (The link below opens the same article.)

9. Click the Log into Appliance button. This opens the Manage tab. Follow the instructions to access the appliance.

Known issues and considerations with Management Console access via Citrix Cloud (App Layering Labs)

As an App Layering Labs feature (not intended for use in production), you may encounter a few behaviors that are either

not optimal or not yet implemented.

Accessing the console. Accessing the console via the Cloud can take up to one minute. As the console is being

launched, the page is white. And every time you log in, you must re-enter the IP address.

Session timeout error. If  you see a session timeout error, click within the window and press Control-R to refresh.

Hidden controls and tabs.
Expanding menu. Near the top of the page, there is an expandable menu where you can access Receiver and other

options. Click the Receiver icon to expand the menu.

Browser tab bar. Toward the bottom of the page, hover over the black bar. A browser tab bar is revealed, where

each page you have open is displayed in a tab in the black bar. For example, when you open the documentation, you

can use the Browser tab bar to return to the Management Console.

Remember Me feature. The Remember Me feature does not save your user name.

Session Timeout. A System Settings T imeout longer than 10 minutes is currently not honored.

Uploads. Layer and Image Icons, and Certif icates must be uploaded when accessing the Management Console via a web

browser, rather than via the Cloud.

Export Log Files requires Email Send Option. When you export App Layering log f iles, you must select the Email
option on the Send Options tab, as the logs cannot be downloaded via the cloud.

vSphere packaging links during Layer Creation. In the Management Console Taskbar, vSphere packaging links are

broken.
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Copy and Paste. Copy and Paste between the Receiver window and the local clipboard must be performed using the

Receiver clipboard.

Access via Tablets and Phones. Tablet and phone usage is not supported. This is designed for the full browser

experience.
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Create layers
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OS Layers

An OS Layer includes the software and settings for the operating system that you deploy as part of your other layers and

ultimately, your Layered Images. Once you have prepared the OS disk for deployment, you can create a Unidesk Operating

System Layer by importing the OS disk into a new Layer.

With an OS Layer, you can install your operating system once, and update it by adding a new Version to the Layer whenever

there's a new patch or update. You can deploy this layer, or a version of it, in every image you publish. This allows you to

maintain one OS image and use it to provision all of your servers.

If  you need to support more than one operating system, for example, if  you need both Windows Server 2012 R2 and

Windows Server 2008 R2, you can create more than one OS Layer. However, each App Layer is only compatible with the

OS Layer you use to create it, and if  you deploy two OS Layers, you will also need to deploy a compatible App Layer for

each one. Further, in future releases when deploying Elastic Layers to users, those layers will only be compatible with users'

desktops that use the same OS Layer.

If  you can support your users with a single OS Layer, the work associated with creating and updating App Layers will be

much reduced.

Each time you need to deploy operating system patches and updates, you will do so by adding a new Version to the

OS Layer. You can continue to publish Layered Images using any version of the OS Layer.

The prerequisites for creating an OS Layer include:

An App Layering-supported operating system

App Layering appliance and network f ile share installed and configured

 

Platform Layers

A Platform Layer is a layer that includes platform-specific configuration settings, tools, and other software required for

your OS and Apps to be installed in or to run in a particular environment.

Types of  Platform Layers

A Platform Layer for Packaging (required in some cases, see below)

Platform Layer for Publishing (always required)

Platform Layer for packaging layers and versions

The only time you need a Platform Layer for Packaging layers is when your OS image was created on a different hypervisor

than the one where you are building your other layers. When creating an App Layer or Layer Version, or OS Versions, the

purpose of the Platform Layer is to ensure that any hypervisor-related software and settings are available during the

installation of the application(s) on that layer, if  needed. If  you choose to use a Platform Layer for Packaging a layer, the

hypervisor-related software will only be used during layer packaging, and has no effect on where you can publish the layer

as part of a Layered Image.

http://docs.citrix.com/en-us/citrix-app-layering/4/system-requirements.html
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Platform Layer for publishing Layered Images

A Platform Layer for Publishing is required when you publish Layered Images. The purpose of the Platform Layer for

Publishing is to include the settings and software that the Layered Image needs to be deployed in your environment. When

creating a Platform Layer for Publishing, Unidesk removes unselected (and unnecessary) tools and software related to the

platforms you are not publishing to. This is to prevent any unnecessary platform software from slowing down the Layered

Image when it runs in the target environment.

App Layers

An App Layer is a virtual disk containing one or more applications that you can use in Layered Images. You can combine an

App Layer with any other App Layers and a Platform Layer, as long as the OS Layer used to create the App Layer is

selected.

With most applications, creating an App Layer is simple. In a few cases, it 's best to start with tips from experienced users, so

the Unidesk Forum includes Application Layer Recipes that you can search for tips about a particular application before you

start. 

To create an App Layer, you use the Create App Layer wizard to deploy a Packaging Machine in your environment and install

the application on the Packaging Machine, leaving the application in the state you want it to be in for users. Then you

finalize the Layer. 

User Layers (Unidesk Labs)

A User Layer is a virtual disk where a user's app data and configuration settings are saved. User Layers are created when you:

Publish a Layered Image with Elastic Layering set to Application and User Layers.

Users log into their desktops on the above Layered Image.

With User Layers enabled on the Layered Image, users can install applications locally on their desktops, and the apps and

their data will be saved in the User Layer.

Verifying Layers

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized. The new Layer or

Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the
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foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX
3. Enter the NGen command to execute the queued items:

ngen update /force
This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It ’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status
3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Connectors for layering

When creating Layers in a vSphere environment, you need a Connector Configuration to define the hypervisor location from

which you will:

Import the OS image when creating your OS Layer.

Deploy a VM for the Layer and Install the application software or the Layer.

It is strongly recommended that you use the hypervisor where the App Layering appliance is installed. If  you decide to

create Layers on a hypervisor other than the one where the appliance is installed, you can use NFS instead of a vSphere

Connector Configuration, and manually copy the file to your hypervisor and back to file share once the software for the

Layer is installed.

See Connector essentials for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/vmware-vsphere/configure/connector-essentials.html
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OS layer

Jun 29, 2017

This topic explains how to prepare an OS Image for layering. OS Optimization tools are included in the installation

download package.

Before you start

Locate the OS Machine Tools in the App Layering download package.

When you prepare the OS Image for import:

Start with an OS that has been freshly installed from ISO.

Make sure that the OS Image is not in a domain, and that it gets its IP address from DHCP.

Ensure that the VM for your OS Layer is MBR partitioned, rather than GPT partitioned. This is required for installing the

Citrix App Layering OS Machine Tools.

The Paravirtual SCSI controller is not supported. You must use the default controller (SCSI BusLogic). The LSI Logic SAS

controller type is supported. If  you change the SCSI controller type to anything else, the OS Layer import will fail.

Avoid using third-party optimization scripts, because they can change services and features that the App Layering

software uses, for example, Universal Plug and Play and the 8.3 f ile names setting.

Whether creating a new Windows 10 OS Layer or adding a new Version to an existing Layer, always include the latest

Windows Store App updates in the OS Layer. Normally, Windows 10 pulls App updates gradually over time, but this can

also be initiated manually through the Windows Store application. These updates are important because they establish

the Store Apps available to all users of the deployed image. Users will not have the ability to update or install new Store

Apps with persistence. Details are included in the steps for Windows 10 below.

Which operating system are you using?

Choose the operating system you are using for the OS Image:

Windows Server 2016 R2 or Windows Server 2012 R2 (Session Host)

Windows Server 2008 R2

Windows 10

Windows 7

Prepare a Windows 2016 R2 or Windows Server 2012 R2 image (Session Host)

STEP 1: Set up a Windows Server 2016 R2 or Windows Server 2012 R2 OS Image on
a virtual machine

In the vSphere client:

1. Create a VM for the OS image.

2. Configure the virtual machine hardware settings, for example, the NIC and video memory.
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Important: You can have just one network device for the virtual machine, and it must be the VMXNET 3 network

adapter, as the default E1000 adapter (or even a ghost NIC leftover from an E1000 adapter) can cause customization

timeout errors on the VM when attempting to boot the image in environments such as Citrix PVS, Citrix MCS, or VMware

Horizon View.

3. Configure a virtual hard disk that is large enough for a Windows operating system installation, and make sure it is

accessible by the Management Appliance.

4. Install the OS.

5. Disable Windows System Restore and Windows Automatic Updates. The App Layering system handles restore points for

you, and layer versions allow you to control when updates occur.

6. Install VMware Tools on your OS image.

STEP 2: Copy the Citrix App Layering OS Machine Tools onto the OS Image

1. Download the Citrix_App_Layering_OS_Machine_Tools ZIP f ile onto the OS Image.

2. Extract the citrix_app_layering_os_machine_tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct

KMS activation script when the system starts, or by running the Unattend file included in the Citrix App Layering

OS Machine Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script f ile in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

1. In the c:\windows\setup\scripts folder, right-click the unattend.exe tool and choose Run as administrator. The

unattend builder form opens.

2. Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml f ile to join desktops to a specif ic domain. If  you plan to use

AD join scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we

recommend that you use an alternate OU for Layered Images, both to segregate the desktop from other machines

and to avoid applying virtual desktop-specif ic GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml f iles in different application layers.

Local Administrator account

If  you want to use the unattend.xml f ile to enable the Administrator account on each desktop, select Enable.

Remember to also enable this account in your OS Image or Operating System Layer revision. It is possible to enable

the Administrator account for your OS Image and then have it disabled in the deployed desktops by clearing the

https://www.unidesk.com/support/downloads
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check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This

account cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone,

not the display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool.

3. Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

1. In the c:\windows\setup\scripts folder, run the Optimize executable to create a .cmd file (optimization.cmd) that will be

run to optimize the image during Desktop creation.

2. Follow the instructions to run the optimize.hta file on the OS Image. This removes installation-specific drivers and

settings.

If  you are using the Optimizer script and you are enabling the View Persona feature, you must go to the section of the

Optimizer script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to Disable
Offline File Service, and click Save File. This is because View Persona folder redirection requires Offline files to be

enabled, and by default, the Citrix App Layering Optimizer turns off  Offline files, which are not a requirement for Citrix

App Layering.

STEP 6: Install the App Layering tools onto the OS Image

1. In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

2. The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

3. Once this is done, you are ready to create an OS Layer.

Prepare a Windows 2008 R2 image

STEP 1: Set up a Windows Server 2008 R2 OS Image on a virtual machine

In the vSphere client:

1. Create a VM for your OS image, making sure to choose the default cluster allocation size of 4K.

2. Configure the virtual machine hardware settings, for example, the NIC and video memory.

Important: You can have just one network device for the virtual machine, and it must be the VMXNET 3 network

adapter, as the default E1000 adapter (or even a ghost NIC leftover from an E1000 adapter) can cause customization

timeout errors on the VM when attempting to boot the image in environments such as Citrix PVS, Citrix MCS, or VMware

Horizon View.

3. If  you are using Citrix PVS or VMware Horizon View, install Windows Server 2008 R2 Service Pack 1 (SP1).

https://technet.microsoft.com/en-us/library/cc749073(v=ws.10).aspx
https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/itoc_3_layer_os_vs4/layer_os_create_vs4
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Notes:

If  you do not install SP1, an error occurs when you try to install View Agent in the virtual machine.

When creating the image, be sure to choose the default cluster allocation size of 4K.

4. If  using PVS:

1. In the VM properties, make sure the PCI slot number is 192, as shown below (mouse over the image to enlarge it):

2. Install KB2550978 hotfix:

https://support.microsoft.com/en-us/kb/2550978

3. Run cmd as Administrator, and enter the following commands:

set devmgr_show_nonpresent_devices=1

run devmgmt.msc in the same cmd window

Note: You must run these commands, or the next command will not show hidden devices (ghost NICs)

4. Select View >Show hidden devices in Device Manager. This shows dead NICs as grayed out.

5. Uninstall the dead NIC and reboot the system.

5. Install VMware Tools on the OS image.

STEP 2: Copy the Citrix App Layering OS Machine Tools onto the OS Image

1. Download the Citrix_App_Layering_OS_Machine_Tools ZIP f ile onto the OS Image.

2. Extract the citrix_app_layering_os_machine_tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct

KMS activation script when the system starts, or by running the Unattend file included in the Citrix App Layering

OS Machine Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script f ile in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

1. In the c:\windows\setup\scripts folder, right-click the unattend.exe tool and choose Run as administrator. The

unattend builder form opens.

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/layers_os_2008_1.PNG
https://www.unidesk.com/support/downloads
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2. Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml f ile to join desktops to a specif ic domain. If  you plan to use

AD join scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we

recommend that you use an alternate OU for Layered Images, both to segregate the desktop from other machines

and to avoid applying virtual desktop-specif ic GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml f iles in different application layers.

Local Administrator account

If  you want to use the unattend.xml f ile to enable the Administrator account on each desktop, select Enable.

Remember to also enable this account in your OS Image or Operating System Layer revision. It is possible to enable

the Administrator account for your OS Image and then have it disabled in the deployed desktops by clearing the

check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This

account cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone,

not the display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool.

3. Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

1. In the c:\windows\setup\scripts folder, run the Optimize executable to create a .cmd file (optimize.hta) that will be run

to optimize the image during desktop creation.

2. Follow the instructions to run the optimize.hta file on the OS Image. This removes installation-specific drivers and

settings.

If  you are using the Citrix App Layering Optimizer script and you are enabling the View Persona feature, you must go to

the section of the Optimizer script called Disable Unnecessary Services to Save Memory and CPU, deselect the

option to Disable Offline File Service, and click Save File. This is because View Persona folder redirection requires

Offline files to be enabled, and by default, the Citrix App Layering Optimizer turns off  Offline files, which are not a

requirement for Citrix App Layering.

STEP 6: Install the App Layering tools onto the OS Image

https://technet.microsoft.com/en-us/library/cc749073(v=ws.10).aspx
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1. In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

2. The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

3. Once this is done, you are ready to create an OS Layer.

Prepare a Windows 10 image

When preparing the OS Image for import into an OS Layer, you can speed up start times by removing the Windows 10

Store. If  you do, we recommend removing this either on the OS Image itself  before importing it, or on the OS Layer.

If  you include the Store, be sure to get the latest version of all Store Apps, whether you are creating a new OS Layer or

adding a Version to it.

STEP 1: Set up a Windows 10 image on a virtual machine

In the vSphere client:

1. Create a VM for your OS image.

Important: When creating the image, be sure to choose the default cluster allocation size of 4K.

2. Configure the virtual machine hardware settings, for example, the NIC and video memory.

3. Disable Windows System Restore and Windows Automatic Updates:

1. Log into the VM.

2. Select Computer Conf ig > Administrative Templates > Windows Components > Windows Updates > Conf ig
Auto Updates.

3. Set this to Disabled.

The App Layering system handles restore points for you, and layer versions allow you to control when updates occur.

4. If  using KMS licensing, run a command window as Administrator, and enter these commands:

slmgr /skms <kmsserverhost>

slmgr /rearm

reboot

slmgr /ipk XXXX-YOUR-KMS-KEY-XXXX

slmgr /ato

5. Install the VMware Tools on the OS image.

6. If  you are including the Windows Store in your Windows 10 image, get the latest updates for all Store Apps.

1. Launch the Windows Store application, click the Sign in icon (top right), then select Downloads and Updates.

https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/itoc_3_layer_os_vs4/layer_os_create_vs4
http://www.howtogeek.com/224798/how-to-uninstall-windows-10s-built-in-apps-and-how-to-reinstall-them/
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/layers_os_prep_win10_store.png
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2. Check for Updates, and click Update All. This should be repeated at least twice to ensure that the latest updates

have been pulled.

Important
Avoid finalizing the OS Layer while download or update processes are running, as this may cause deployed images (and every user)

to experience a continuation of those operations each time they log in.

STEP 2: Copy the Citrix App Layering OS Machine Tools onto the OS Image

1. Download the Citrix_App_Layering_OS_Machine_Tools ZIP f ile onto the OS Image.

2. Extract the citrix_app_layering_os_machine_tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct

KMS activation script when the system starts, or by running the Unattend file included in the Citrix App Layering

OS Machine Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script f ile in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

1. In the c:\windows\setup\scripts folder, right-click the unattend.exe tool and choose Run as administrator. The

unattend builder form opens.

2. Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml f ile to join desktops to a specif ic domain. If  you plan to use

AD join scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we

recommend that you use an alternate OU for Layered Images, both to segregate the desktop from other machines

and to avoid applying virtual desktop-specif ic GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml f iles in different application layers.

Local Administrator account

If  you want to use the unattend.xml f ile to enable the Administrator account on each desktop, select Enable.

Remember to also enable this account in your OS Image or Operating System Layer revision. It is possible to enable

the Administrator account for your OS Image and then have it disabled in the deployed desktops by clearing the

check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This

https://www.unidesk.com/support/downloads
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account cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone,

not the display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool.

3. Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

1. In the c:\windows\setup\scripts folder, right-click the optimizations.exe tool and choose Run as administrator. This

creates a .cmd file (optimizations.cmd) that will be run during Desktop creation to optimize the image.

2. Follow the instructions to run the optimizations.cmd file on the OS Image. This removes installation-specific drivers and

settings.

If  you are using the Optimization script and you are enabling the View Persona feature, you must go to the section of

the Optimization script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to

Disable Offline File Service, and click Save File. This is because View Persona folder redirection requires Offline files to

be enabled, and by default, the optimization script turns off  Offline files, which are not a requirement for App Layering.

STEP 6: Install .Net Framework 3.5.1

The .Net Framework is a software framework provided by Microsoft that is required for many 3rd party applications to run.

To install this feature, follow the steps below.

1. On the Start menu, select Control Panel > Programs and Features.

2. In the left panel select Turn Windows features on or of f. A window opens.

3. Select .NET Framework 3.5, click OK, and wait for the installation to complete.

Important: Even if  .NET is already installed, continue with the rest of these steps.

4. Exit the Control Panel.

5. In Notifications in the right-side of your taskbar, click All Settings, and open the Windows 10 Settings app.

6. Select Settings > Update & Security.

7. Check for updates, and install all updates available.

8. Exit Settings.

9. Open an administrator-level command prompt, and enter the following commands:

cd \windows\Microsoft.Net\Framework\v4.nnnnn

ngen update /force

https://technet.microsoft.com/en-us/library/cc749073(v=ws.10).aspx
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10. Wait for the command to complete, and enter the following commands:

cd \windows\Microsoft.Net\Framework64\v4.nnnnn

ngen update /force

11. Exit the command prompt.

STEP 7: If using PVS, follow these steps to avoid ghost NICs

1. Install KB2550978 hotfix.

2. Reboot the VM,

3. Enter the commands:

set devmgr_show_nonpresent_devices=

devmgmt.msc

4. Remove any ghost NICs.

5. Reboot the system.

STEP 8: Install the Citrix App Layering software onto the OS Image

Run setup_x64.exe from c:\Windows\setup\scripts.

Once this is done, you are ready to create an OS Layer.

Prepare a Windows 7 image

STEP 1: Set up a Windows 7 OS Image on a virtual machine

In the vSphere client:

1. Create a VM for your OS Image.

Important: When creating the image, be sure to choose the default cluster allocation size of 4K.

2. Configure the virtual machine hardware settings, for example, the NIC and video memory.

3. Disable Windows System Restore and Windows Automatic Updates. The App Layering system handles restore points for

you, and layer versions allow you to control when updates occur.

4. Make sure you have installed VMware Tools on the OS image.

STEP 2: Mount or copy the OS Machine Tools onto the OS Image

1. Download the Citrix_App_Layering_OS_Machine_Tools ZIP f ile onto the OS Image.

2. Extract the citrix_app_layering_os_machine_tools_x.x.x to c:\windows\setup\scripts.

STEP 3: (Optional) Configure Scripts for KMS Activation

If  using KMS Activation, you can configure scripts for KMS activation either by creating a script file to call the correct

KMS activation script when the system starts, or by running the Unattend file included in the Citrix App Layering

https://www.unidesk.com/support/downloads
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OS Machine Tools download, as described in the next step. To configure scripts for KMS:

In the c:\windows\setup\scripts folder run SetKMSVersion.exe as Administrator. This creates a script f ile in the

c:\windows\setup\scripts\kmsdir folder to call the appropriate KMS activation script when the OS starts.

STEP 4: (Optional) Create an answer file for unattended installation on desktops

1. In the c:\windows\setup\scripts folder, right-click the unattend.exe tool and choose Run as administrator. The

unattend builder form opens.

2. Complete the unattend form.

Product key activation

For KMS activation, select KMS Server.

For KMS with a Multiple Activation Key (MAK), select KMS with MAK and enter the MAK.

For Retail Licensing with a MAK, select Retail with MAK, and the MAK.

Domain Join

Select Enable if  you want to configure the unattend.xml f ile to join desktops to a specif ic domain. If  you plan to use

AD join scripts, ensure Enable is not selected.

You can add desktops to the Computer's container in Active Directory by deleting the OU entry. However, we

recommend that you use an alternate OU for Layered Images, both to segregate the desktop from other machines

and to avoid applying virtual desktop-specif ic GPOs to other types of machines.

If  you are supporting multiple OUs within one or more domains, you can join machines in different Domains or OUs by

creating different unattend.xml f iles in different application layers.

Local Administrator account

If  you want to use the unattend.xml f ile to enable the Administrator account on each desktop, select Enable.

Remember to also enable this account in your OS Image or Operating System Layer revision. It is possible to enable

the Administrator account for your OS Image and then have it disabled in the deployed desktops by clearing the

check box.

If  you want to add an alternate Administrator account, select Enable and enter the account information. This

account cannot be pre-configured in the OS Image.

You can create a desktop where the Administrator is disabled and the alternate administrator is created and enabled.

However for this to work, the Administrator account must be enabled in the OS Image and it cannot be renamed.

Time zone

Select the time zone. If  your time zone is not listed, you can add it to the Other box. Be sure to use the time zone,

not the display setting. A list of time zone settings can be found here.

Disabling automatic activation

Select this option if  you plan to use the Microsoft Volume Activation Management Tool.

3. Click Save File.

STEP 5: (Optional) Optimize the OS Image for layering

The Optimization script lets you enable services you need and disable others that you don't need to save memory and CPU.

1. In the c:\windows\setup\scripts folder, run the Optimize executable to create a .cmd file (optimize.hta) that will be run

to optimize the image during desktop creation.

2. Follow the instructions to run the optimize.hta file on the OS Image. This removes installation-specific drivers and

settings.

https://technet.microsoft.com/en-us/library/cc749073(v=ws.10).aspx
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If  you are using the Optimization script and you are enabling the View Persona feature, you must go to the section of

the Optimization script called Disable Unnecessary Services to Save Memory and CPU, deselect the option to

Disable Offline File Service, and click Save File. This is because View Persona folder redirection requires Offline files to

be enabled, and by default, the optimization script turns off  Offline files, which are not a requirement for App Layering.

STEP 6: If using PVS, follow these steps to avoid ghost NICs

1. Install KB2550978 hotfix.

2. Reboot the VM,

3. Enter the commands:

set devmgr_show_nonpresent_devices=1

devmgmt.msc

4. Remove any ghost NICs.

5. Reboot the system.

STEP 7: Install the App Layering software onto the OS Image

1. In the Citrix_App_Layering_OS_Machine_Tools folder, run the setup_x86.exe (32-bit) or setup_x64.exe (64-bit).

2. The installation prompts for the location of the unattend.xml file (the default location is c:\windows\panther).

Once this is done, you are ready to create an OS Layer.

https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/itoc_3_layer_os_vs4/layer_os_create_vs4
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Platform layer
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A Platform Layer is intended to include the platform software and settings required to deploy images in your environment.

For example, a Platform Layer for publishing to PVS in vSphere with XenApp as the broker would include the PVS Target

Device Imaging software, vmTools, and the XenApp Virtual Delivery Agent Installer (and other platform-related software as

well).

You can create two kinds of Platform Layers:

Platform Layers for publishing Layered Images (Required) - These Layers include the software and settings required for a

Layered Image to run flawlessly in your environment.

Platform Layers for packaging Layers (Required in some cases) - These Layers include the hypervisor software and

settings you need to easily install the software for your other layers on a VM in your hypervisor environment.

The general steps for creating a Platform Layer are:

1. Prepare a Platform Layer

2. Connect to and log into the Packaging Machine

3. Install the Platform Software

4. Verify the Layer and Shutdown the Packaging Machine

5. Copy the Packaging Machine to the appliance's Network File Share (if  needed)

6. Finalize the Layer

Prerequisites

vSphere prerequisites

Network access to Unidesk Tools

Access from the Packaging Machine VM in vSphere to the Unidesk Tools download (available on the Unidesk

Download page).

vSphere software and settings

Access to the vSphere software to install on the layer.

vSphere resource information

The vSphere info listed in vSphere Connector Configuration.

Other prerequisites

If  you are creating a Platform Layer to use when publishing Layered Images, you need the above prerequisites plus the

prerequisites for the provisioning service and connection broker software for your environment.

Prepare a new Platform Layer

https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_publish_vs4/itoc_3_connectors_publishing_vs4/connector_config_fields_vs4
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1. Select Layers > Platform Layers and select Create Platform Layer in the Action bar. This opens the Create Platform

Layer wizard.

2. In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other

values.

3. In the OS Layer tab, select the OS Layer you want to associate with this Platform Layer.

4. In the Connector tab, choose a Connector Configuration for the platform where you are creating this layer. If  the

configuration you need isn't listed, Click New, select your platform from this list, and Add a Configuration for it.

Example: If  you are creating the layer in a vSphere environment, select the vSphere connector with the information

needed to access the location where you will package this layer.

5. In the Platform Types tab, select the radio button that describes the purpose of this Platform Layer: to create and

update layers, or to publish Layered Images. For more about these choices, see Platform Layers.

6. From the dropdown menus, select the platform(s) you are using.

7. In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for

the Packaging Machine (the VM) where you will install the tools, as described in the next two sections.

8. In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

9. In the Confirm and Complete tab, review the details of the App Layer, enter a comment if  required, and click Create
Layer. Any comments you enter will appear in the Information view Audit History.

10. Expand the Tasks bar at the bottom of the UI, and double-click the Packaging Disk task to show the full task

description.

Once the Packaging Disk has been created, the Task bar displays the location of the Packaging Disk in your environment

(example task message shown below).

Next, you can deploy the Packaging Machine for your Layer.

The Packaging Machine is a virtual machine where you install the tools for your selected environment(s). It is a temporary

VM that will be deleted once the new Platform Layer has been finalized. When the App Layering software powers on the

Packaging Machine for you.

Connect to and log into the Packaging Machine

Expand the Tasks bar at the bottom of the UI, and double-click the Packaging Disk task to show the full task description.

https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/itoc_3_layer_platform_create_vs4/connector_config_create_co4
https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/layer_about_vs4
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/layers_app_action_required_vs.png
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Once the Packaging Disk has been created, the Task bar displays the location of the Packaging Disk in your environment

(example task message shown below).

Install the required platform tools

This section explains how to install your platform software onto the Packaging Machine. Keep in mind that the state of

the software before you finalize the layer is what the image will use.

To install the tools for the selected platform:

1. Remote log in to the Packaging Machine you created. Be sure to log in using the User account you used to create the

OS.

2. Install the platform software and tools, along with any drivers, boot-level applications, or files needed.

If  this Platform Layer is going to be used for packaging new layers, install and configure your hypervisor tools and

settings.

If  this Platform Layer is going to be used for publishing Layered Images, install and configure your hypervisor,

provisioning service, and connection broker tools and settings.

If  a software installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

3. Make sure the Packaging Machine is in the state you want it to be in when the image is booted:

If  the tools you install require any post-installation setup or registration, complete those steps now.

Remove any settings, configurations, f iles, mapped drives, or applications that you do not want to include on the

Packaging Machine.

Next, you'll need to shut down the Packaging Machine and verify that the Platform Layer is ready to finalize.

Verify the Layer and shut down the Packaging Machine

Once the tools are installed on the Packaging Machine, the next step is to verify that the Layer is ready to finalize. At this

point, any required post-installation processing needs to be completed. For example, a reboot may be required, or a

Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/layers_app_action_required_vs.png
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1. If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

2. Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verif ication

process.

3. If  there is an outstanding operation that must be completed before the Layer can be f inalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

4. Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages you may see during the finalization process

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

Microsoft NGen operation is in progress in the background.

Note
 If a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/itoc_3_layer_platform_create_vs4/layer_platform_create_vs4#Layer_Integrity_Check
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cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

3. Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It ’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status

3. When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the Layer

To finalize the Layer, you import the installed software into the Platform Layer you prepared in the Management Console.

1. Return to the Management Console.

2. Select Layers > Platform Layers.

3. Select Finalize in the Action bar.

4. Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.
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XenServer connector
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A Platform Layer should include the platform software and settings required to deploy images in your environment, given

your choice of hypervisor, provisioning service, and connection broker.

You can create two kinds of Platform Layers:

Platform Layers for publishing Layered Images (Required) - A Platform Layer for publishing is used in Image Templates to

ensure that your published Layered Images include the software and settings required to run flawlessly in your

environment.

Platform Layers for packaging Layers (Required in some cases) - A Platform Layer for packaging is used for creating App

Layers and OS Layer Versions in your hypervisor environment. This Layer includes the hypervisor software and settings

required to easily install the app or OS update on a VM in the selected hypervisor. 

Prerequisites

When creating a Platform Layer, the software installers for your platform must be available in a location that's accessible

to the Packaging Machine VM where you are going to create the Layer. As summarized in the following table, the

prerequisites vary based on the type of Platform Layer you choose to create.

Type of
Platform Layer

Prerequisites

Publishing

Layered Images

Software installers, and settings you use for your:

Hypervisor

Provisioning service

Connection broker  

Packaging

Layers

The software and settings for your:

Hypervisor

For example, your hypervisor installer and settings.

Note: You only need a Platform Layer for packaging Layers if you are creating your Layers on a different hypervisor

than the one from which you imported your OS image.

Citrix XenServer prerequisites

XenServer account and privileges

A XenServer account (new or existing) to use for App layering service.

The account must have XenServer privileges to:

Create and remove virtual disks.

Copy and delete layers on virtual disks using XenServer file APIs.

Citrix XenServer software and settings
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Access to the XenServer Tools to install on the layer.

XenServer resource information

The XenServer info listed in Citrix XenServer Connector Configuration.

 

Prepare a new platform layer

Select Layers > Platform Layers and select Create Platform Layer in the Action bar. This opens the Create Platform Layer

wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

In the OS Layer tab, select the OS Layer you want to associate with this Platform Layer.

In the Connector tab, choose a Connector Configuration for the platform where you are creating this layer. If  the

configuration you need isn't listed, Click New, select your platform from this list, and Add a Configuration for it.

Example: If  you are creating the layer in a XenServer environment, select the XenServer connector with the information

needed to access the location where you will package this layer.

In the Platform Types tab, select the radio button that describes the purpose of this Platform Layer: to create and update

layers, or to publish Layered Images. For more about these choices, see Platform Layers.

From the dropdown menus, select the platform(s) you are using.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the tools, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the Layer, enter a comment if  required, and click Create Layer. Any

comments you enter will appear in the Information view Audit History.

At the bottom of the UI, expand the Tasks bar and double-click the task to show the full task description.

Once the task is complete, the location of the Packaging Disk is shown (example task message shown below).

Next, you can deploy the Packaging Machine for your Layer. The Packaging Machine is a temporary virtual machine where

you install the software to include in the Layer being created.

Power on the Packaging Machine in XenServer

Log into your XenServer client.

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create Platform

Layer task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenCenter client.

While in the Infrastructure View, select your Packaging Machine's VM from the list of machines.
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In the XenCenter UI in the panel on the right, choose the Console option for the VM.

Power on the VM.

Select the Click here to create a DVD drive link.

Power cycle the VM (yes, you have to in order to get the DVD Drive).

At the top of the console window, click the DVD Drive 1 drop down menu and select the xs-tools.iso.

Install the XenTools. This will require multiple reboots as part of the tools installation. Once complete, you should see that

you have access to all XenTools, as well as all of the data available under the Performance tab for your VM.

Note: The XenCenter console uses RFB for it's console connection, which uses Port 5900. On Windows 2008 and Windows

7, this port is closed in the Firewall by default and should be opened so you can use the console to access any VMs

Install the platform tools on the Packaging Machine

Whether you are creating a Platform Layer or adding a version to it:

Remote log in to the Packaging Machine. Be sure to log in using the User account you used to create the OS.

Install the platform software and tools, along with any drivers, boot-level applications, or files needed. Keep in mind that

the state of the software before you finalize the layer is what the image will use.

If  this Platform Layer is going to be used for packaging new layers, install and configure your hypervisor tools and settings.

If  this Platform Layer is going to be used for publishing Layered Images, install and configure your hypervisor, provisioning

service, and connection broker tools and settings.

If  a software installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

Make sure the Packaging Machine is in the state you want it to be in for users:

If  the tools you install require any post-installation setup or registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

When using PVS, if  your OS image was activated using KMS, rearm KMS just before you shut down

Verify the Rearm count on the OS by running slmgr /dlv from a command prompt. The Rearm count must not be zero.

slmgr /dlv

Rearm KMS:

slmgr /rearm

Verify the Layer and shut down the Packaging Machine

Once the software is installed on the Packaging Machine, it is important to verify that the Layer is ready to be finalized. To

be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.
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Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation. For details, see Verifying Layers.

If  you are using KMS licensing, once any pending operations are complete, be sure to rearm KMS yet again just before you

shutdown. First, enter this command to verify that the Rearm count is > 0:

slmgr /dlv

Then, rearm KMS:

slmgr /rearm

Double-click the Shutdown For Finalize icon again to shut down the Packaging Machine.

The Layer should be ready to finalize.

During the shutdown for finalization

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

Open a command prompt as Administrator.
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Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

Open a command prompt as Administrator.

Check status by running this command:

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

 

Finalize the Layer

To finalize the Layer, you import the installed software into the Platform Layer you prepared in the Management Console.

Return to the Management Console.

Select Layers > Platform Layers.

Select Finalize in the Action bar.

Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.
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App layer
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An App Layer is a bootable software image (virtual disk) containing one or more applications that you can use in any number

of Layered Images. When publishing a Layered Image, you can combine an App Layer with the OS Layer used to create it,

other App Layers, and a Platform Layer.

To create an App Layer, you open the Create Layer wizard, deploy a Packaging Machine in your environment, then install the

application(s). Once the application(s) are installed, you finalize the Layer.

A Packaging Machine is a VM where you install the application(s) that will be included in the Layer. The App Layering

software creates the Packaging Machine in the location and using the credentials you supply by choosing the Platform

Target (hypervisor) and selecting a Connector Configuration containing this information. If  you don't yet have the

Connector Configuration you need, you can add a new one, as described in the steps below.

Before you start

Requirements

To create an App Layer, you need:

Create an OS Layer

Optional

Before you create an App Layer, you may also want to create resources that facilitate the application installation process.

These resources are for temporary use during installation only, and will not be used to deliver the application.

Prerequisite Layer

Platform Layer (for cross-platform deployments) (Only required if  creating App Layers on a hypervisor other than the one

from which you imported your OS Layer)

Run Once Script

If  the application you install affects boot-level components, you'll need to restart the Packaging Machine as part of

finalizing the layer or version.

Prerequisite Layer

Prerequisite Layers let you include existing App Layers on the Packaging Disk when creating or adding a version to an App

Layer. Prerequisite Layers should only be used if  they are required, since it is possible that the prerequisite applications will

pull something into the Layer that is not required for the current application deployment, and which may cause conflict in

the future.

Reasons to consider using Prerequisite Layers:

The application you are installing requires another application during installation. For example, if  you are installing an

application that requires Java and you have Java in a separate layer.

The add-in or plugin you are installing adds settings to an application. For example, when installing an Office add-in, you

would use your Microsoft Office App Layer as a prerequisite layer.

Two applications modify the same registry key, and the second application must add to an existing key rather than replace

it. For example, Citrix Agent and Imprivata software both modify login keys in Windows.

Note: Some of these issues can also be handled by putting the two applications in the same layer.
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Platform Layer (for cross-platform deployments)

A Platform Layer is only required when creating App Layers on a hypervisor other than the one from which you imported

your OS Layer.

If  you are creating App Layers and Versions on a different hypervisor than the one you used to create your OS Layer, it is

strongly recommended that you create a Platform Layer containing the hypervisor tools and hardware settings you need

to seamlessly install and package applications in your environment.

Run Once Script

You can include a Run Once script in an App Layer. This allows you to run a script the first time any Layered Image that

includes the App Layer boots. If  the App Layer is elastically layered, the Run Once script runs when the App Layer Disk is

mounted. Run Once scripts are typically used for apps, such as MS Office, that require license activation on the first boot.

Prepare a new App Layer

Select Layers > App Layers and select Create Layer in the Action bar. This opens the Create Layer wizard.

In the Layer Details tab, enter a Layer Name and Version, both required values. Optionally, you can also enter other values.

For details, see more about these values below.

In the OS Layer tab, select the OS Layer you want to associate with this App Layer.

(Optional) In the Prerequisite Layers tab, if  the application you are layering requires other App Layers to be present during

installation, select the Include Prerequisite Layers check box, and pick the necessary App Layer(s).

Notes:

Prerequisite layers are used while installing applications, and are not included in the App Layer.

Prerequisite layers are not included by default when adding a new Version to this App Layer. So, when you add a new

Version to this App Layer, you must choose the Prerequisite Layers again, if  needed.

The App Layer you are creating and each of its Prerequisite Layers must be associated with the selected OS Layer.

In the Connector tab, choose a Platform Connector Configuration that contains the credentials for the platform where

you plan to build the Layer, along with the storage location. If  the configuration you need isn't listed, add a New Connector

Configuration and select it from this list.

Example: If  you're using the XenServer environment to create the Layer, select the XenServer connector with the

credentials and location required to access the location where you want to build the Layer.

In the Platform Layer tab you can select a Platform Layer containing the tools and hardware settings that you need to

install and package an application during Layer creation. This selection is only used during layer creation. Once created, the

Layer can be used in Layered Images published to any platform.

In the Packaging Disk tab, enter a file name for the Packaging Disk, and select the disk format. This disk will be used for the

Packaging Machine (the VM) where you will install the application, as described in the next two sections.

In the Icon Assignment tab, select an icon to assign to the layer. This icon represents the layer in the Layers Module.

To use an existing image, select an image in the image box.

To import a new image, click Browse and select an image in PNG or JPG format.

In the Confirm and Complete tab, review the details of the App Layer, enter a comment if  required, and click Create Layer.

Any comments you enter will appear in the Information view Audit History. Once the Packaging Disk has been created, the
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Task bar displays instructions to navigate to the Packaging Machine in XenServer.

Next, you can log into the Packaging Machine for your Layer, and install the software for the layer on it.

Deploy a Packaging Machine in XenServer

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App Layer

task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenServer client.

Power on the Packaging Machine.

You can now install the applications for this layer on the Packaging Machine.

Deploy a Packaging Machine in XenServer

Back in the Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App Layer

task to see the full Task Description (example below).

Use the instructions in the Task Description to navigate to the Packaging Machine in your XenServer client.

Power on the Packaging Machine.

You can now install the applications for this layer on the Packaging Machine.

Install the software on the Packaging Machine

When you've completed the Layer wizard, Unidesk creates a Packaging Machine in your environment, in the location defined

in the Connector Configuration. The Packaging Machine is a virtual machine where you install the software to be included in

the layer.

Note: The Packaging Machine is a temporary VM that will be deleted once the new Platform Layer has been finalized.

Log into the Packaging Machine

Log into your vSphere web client.

Back in the Unidesk Management Console, expand the Tasks bar at the bottom of the UI, and double-click the Create App

Layer task to see the full Task Description.

Use the instructions in the Task Description to navigate to the Packaging Machine in your vSphere web client.

The Packaging Machine will be powered on.

Install the Application(s)

When installing your application(s) on the Packaging Machine, leave each application as you want users to see it when they

log in. The state of the applications when you finalize the layer is what users experience when they access the application.

More guidance about this is included in the steps below.

Remote log in to the Packaging Machine in vSphere. Be sure to log in with the User account you used to create the OS in

vSphere.

Install the applications, along with any drivers, boot-level applications, or files that the user will need with it.

If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart
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automatically.

Make sure the Packaging Machine is in the state you want it to be for the user:

If  the applications you install require any post-installation setup or application registration, complete those steps now.

Remove any settings, configurations, files, mapped drives, or applications that you do not want to include on the Packaging

Machine.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, it is important to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verification

process.

If  there is an outstanding operation that must be completed before the Layer can be finalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages you may see during the finalization process

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into

native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.
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Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

Force an NGen operation to the foreground.

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this:

Open a command prompt as Administrator.

Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete, or re-

run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

Check the status of an NGen operation

Open a command prompt as Administrator.

Check status by running this command:

ngen queue status

When you receive the following status, the NGen is complete, and you can finalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the Layer

Once the software has been installed and the Packaging Machine has been verified and shut down, you are ready to

finalize the layer.

Note: When you finalize a Layer, Unidesk may delete the Packaging Machine to minimize storage space used.

When the Layer has been verified and is ready to finalize:

Return to the Management Console.

Select Layers >App Layers, and then the layer you just prepared.

Select Finalize in the Action bar. The Finalize wizard appears.

(Optional) On the Script Path wizard tab, you can enter the path to a Run Once Script located on a server on your network.

If  the App Layer is elastically assigned, the Run Once script will be executed the first time the app is used.

If  the App Layer is included in a Layered Image, the Run Once script will be executed the first time the Layered Image is

booted. 

Click Finalize to finish creating the Layer.

Monitor the Task bar to verify that the action completes successfully and that the Layer is ready to be deployed.
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Reference: create App Layer Wizard values

Layer Name - (Required) A name that will let you know what app(s) the layer will be used for.

Layer Description - (Optional) Description of the Layer

Version - (Required) This can be the version of the application or a version you assign to the Layer. This value is displayed in

the Details view of the Layer. Keep in mind that you'll add a new version to this layer whenever you update the app(s)

included in it, and this is where the version will be described.

Version Description - (Optional) Enter a description of the version.

Specify the Max Layer Size - Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 10 gigabytes. If  the application you are installing could eventually require more

space, change this to an appropriate value.
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User layer

Jun 29, 2017

User Layers let you persist user profile settings, data, and user-installed applications in non-persistent VDI environments.

User Layers are created when:

You set Elastic Layering on an Image Template to Application and User Layers, so that the Layered Image supports User

Layers.

A user logs in to their desktop for the f irst time, and a User Layer is created for them. From then on, the user's data and

settings are saved in the User Layer, along with any applications that the user installs locally on their desktops.

Before you start

Prerequisites

Create the OS Layer

Create a Platform Layer

Create App Layers

Adequate network bandwidth. Bandwidth and latency have a signif icant effect on the User Layer. Every write goes

across the network.

Allocate storage space for users' locally installed apps and the data and configuration settings for them. (This leaves the

main storage location solely for packaging layers, publishing Layered Images, and serving up Elastic Layers.)

Compatibility

Currently, User Layers are supported for the following platforms:

Operating systems:

Windows 7, 64-bit

Windows 10, 64-bit

Publishing platforms: VMware Horizon View and Citrix XenDesktop.

User Layer creation process

Enable User Layers in your Image Template:

Set Elastic Layering in the Image Template wizard on the Image Disk tab) to Application and User Layers.

Publish Layered Images using the above Image Template.

When a user logs on to their desktop for the first time, a User Layer is created for them.

User Layer size and location

The default size of a User Layer is 10 GB.

User Layers are created in the Users folder on the appliance's network file share, for example:

\\MyServer\MyShare\Users
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Each user will have his/her own directory within the Users directory, and it will be named as follows:

Users\domainIname\username\OS-Layer-ID-in-hex_OS-Layer-name\username.vhd

For example:

User's login name: jdoe
User's Domain: testdomain1
OS layer: MyOSLayer (ID is in hexidecimal format: 123456)

User Layer would be created in:

\\MyServer\MyShare\Users\testdomain1\jdoe\123456_MyOSLayer\jdoe.vhd

Upgrading existing User Layers to this Release

Once you upgrade the appliance to Release 4.2.0, if  you want to continue using existing User Layers, you'll need to move

them to new locations as described below in Upgrade User Layers created using a previous release.

Other Considerations

Before deploying User Layers, please consider the following guidelines and limitations.

The User Layer is delivered via the appliance's f ile share, therefore:

If  the host is disconnected from the User Layer storage, the user will have to log out and log in again to re-establish

the disk mount. The user will have to wait approximately 5 minutes because the user layer will be inaccessible.

Certain enterprise applications, such as MS Office and Visual Studio should be installed in App Layers, not as user-

installed applications in the User Layer. User Layers are based on the same technology as Elastic Layers, and therefore

share the same limitations.

Windows updates must be disabled on the User Layer.

VMware Horizon View:

View must be configured for non-persistent desktops, and the desktop must be set to Refresh at log off . Delete or

refresh the machine on log off. Example:

After logging off  with View set to Refresh Immediately, the desktop goes into maintenance mode. If  there is only

one machine in the pool, the pool will not be available until that machine has completed the refresh.

The f irst time a user logs into his/her desktop, a User Layer is created for the him/her.

If  there is problem loading the elastically assigned Layers for the user, they will still receive their User Layer.

If  you rename the user in AD, a new directory and User Layer will be created for the new name. To avoid this, rename the

https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/layer_user_enable_co_vs4#Upgrade
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directory on the f ile share and the VHD file in the directory structure to the new AD user name.

Add storage locations for User Layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS f ile share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The f irst storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's

User Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest

priority location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until

that point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the

their User Layer to the new highest priority location.

Create Storage Locations

To add a storage location:

1. Log into the management console.

2. Select System > Storage Locations.

3. Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

4. Select Add Storage Location, and enter a Name and Network Path for the new location.

5. On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to

add to the new storage location.

6. On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure Security on User Layer folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:
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Create the OS Layer

Create a Platform Layer

Create App Layers

Adequate network bandwidth. Bandwidth and latency have a signif icant effect on the User Layer. Every write goes

across the network.

Allocate storage space for users' locally installed apps and the data and configuration settings for them. (This leaves the

main storage location solely for packaging layers, publishing Layered Images, and serving up Elastic Layers.)

Compatibility

Currently, User Layers are supported for the following platforms:

Operating systems:

Windows 7, 64-bit

Windows 10, 64-bit

Publishing platforms: VMware Horizon View and Citrix XenDesktop.

User Layer creation process

Enable User Layers in your Image Template:

Set Elastic Layering in the Image Template wizard on the Image Disk tab) to Application and User Layers.

Publish Layered Images using the above Image Template.

When a user logs on to their desktop for the first time, a User Layer is created for them.

User Layer size and location

The default size of a User Layer is 10 GB.

User Layers are created in the Users folder on the appliance's network file share, for example:

\\MyServer\MyShare\Users

Each user will have his/her own directory within the Users directory, and it will be named as follows:

Users\domainIname\username\OS-Layer-ID-in-hex_OS-Layer-name\username.vhd

For example:

User's login name: jdoe

User's Domain: testdomain1

OS layer: MyOSLayer (ID is in hexidecimal format: 123456)

User Layer would be created in:

\\MyServer\MyShare\Users\testdomain1\jdoe\123456_MyOSLayer\jdoe.vhd

Upgrading existing User Layers to this Release

Once you upgrade the appliance to Release 4.2.0, if  you want to continue using existing User Layers, you'll need to move

them to new locations as described below in Upgrade User Layers created using a previous release.

Other Considerations

Before deploying User Layers, please consider the following guidelines and limitations.
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The User Layer is delivered via the appliance's file share, therefore:

If  the host is disconnected from the User Layer storage, the user will have to log out and log in again to re-establish the

disk mount. The user will have to wait approximately 5 minutes because the user layer will be inaccessible.

Certain enterprise applications, such as MS Office and Visual Studio should be installed in Layers, not as user-installed

applications in the User Layer. In addition, the Elastic Layering limitations are applicable for User Layer. For more information

on Layering limitations, please see the Elastic Layering Limitations section.

Windows updates must be disabled on the User Layer.

VMware Horizon View:

View must be configured for non-persistent desktops, and the desktop must be set to Refresh at log off. Delete or refresh

the machine on log off. Example:

After logging off  with View set to Refresh Immediately, the desktop goes into maintenance mode. If  there is only one

machine in the pool, the pool will not be available until that machine has completed the refresh.

The first time a user logs into his/her desktop, a User Layer is created for the him/her.

If  there is problem loading the elastically assigned Layers for the user, they will still receive their User Layer.

If  you rename the user in AD, a new directory and User Layer will be created for the new name. To avoid this, rename the

directory on the file share and the VHD file in the directory structure to the new AD user name.

 

Add storage locations for user layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The first storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's User

Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest priority

location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until that

point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the their User

Layer to the new highest priority location.

Create Storage Locations

To add a storage location:
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Log into the management console.

Select System > Storage Locations.

Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

Select Add Storage Location, and enter a Name and Network Path for the new location.

On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to add

to the new storage location.

On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure security on user later folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:

Setting name Value Apply to

Creator Owner Modify Subfolders and Files only

Owner Rights Modify Subfolders and Files only

Users or group:

Create Folder/Append Data

Traverse Folder/Execute File

List Folder/Read Data

Read Attributes

Selected Folder Only

System Full Control Selected Folder, Subfolders and Files

Domain Admins, and selected Admin group Full Control Selected Folder, Subfolders and Files

Set security on the User Layer folders

1. Log into the management console.

2. Select System > Storage Locations. The file shares displayed are the storage locations defined for User Layers. For

example, say you've defined three Storage Locations so that you can more easily manage storage for Group1 and

Group2 separate from everyone else in the organization:

Default location - \\MyDefaultShare\UserLayerFolder\
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Group1 - \\MyGroup1\Share\UserLayerFolder\

Group2 - \\MyGroup2\Share\UserLayerFolder\

Note: The appliance's main file share, which is used for storing OS, App, and Platform Layers, is not listed as a User Layer

Storage Location.

3. Create a \Users subdirectory under each file share:

\\MyDefaultShare\UserLayerFolder\Users\

\\MyGroup1Share\UserLayerFolder\Users\

\\MyGroup2Share\UserLayerFolder\Users\

4. Apply the security settings listed above to each /Users subdirectory.

Customize User Layer messages for users

You can customize notification messages sent to users when their User Layer is not available. The message is displayed to

the user upon login.

The App Layering software displays messages for end users when the software is unable to:

Read configuration (json) f iles from the configuration f ile share.

Attach a User Layer because it is in use.

Attach a User Layer for any other reason.

The messages are displayed as needed in the App Layering Management Console when you add a new storage location or

modify an existing one.

User Layer In Use (customizable message)

We were unable to attach your User Layer because it is in use. Any changes you make to application settings or data will

not be saved. Be sure to save any work to a shared network location.

User Layer Unavailable (customizable message)

We were unable to attach your User Layer. Any changes you make to application settings or data will not be saved. Be

sure to save any work to a shared network location.

Review Permissions on Users folder, all subfolders and files

Unable to read json files from the config share

We were unable to load the required configuration files. You may not be able to access some of your applications. And,

any changes you make to application settings or data will not be saved. Be sure to save any work to a shared network

location.

When logged into the appliance as Administrator, you can customize the first two of the above messages. To do so:

1. Log into the Management Console as Administrator.

2. Select Add Storage Location if  creating a new location, or Edit Storage Location if  customizing messages for an

existing location.

3. In the Add/Edit Storage Location wizard, select the User Layer Messages tab and the Override check box.
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4. Enter the messages exactly as you want them to be displayed. The message can be in any language.

5. Use the Conf irm and Complete tab to save your changes.

Disable Store Apps (Optional)

On Windows 10 Enterprise editions (not Windows Professional), you can disable the Windows Store by creating an OS

Version specifically for that purpose. A script is provided that uninstalls all Store Apps for all users. Once complete, users will

have access to Edge and Cortana only.

To disable Store Apps, add a new OS Version, and:

1. From an administrator prompt, run this command:

C:\Windows\Setup\Scripts\RemoveStoreApps.cmd

2. Finalize and deploy the image based on this new version of the OS Layer. For new users, the Start menu will look like this:

Enable User Layers in the Layered Image

1. Log into the Management Console as an Admin user.

2. Select Images.

3. Select the Image Template from which you will publish the Layered Image(s), and click Edit Template. This opens the

Edit Image Template wizard.

4. On the Layered Image Disk tab, set Elastic Layering to Application and User Layers.

5. On the Confirm and Complete tab, click Save Template Changes.

6. Publish your Layered Images.

Upgrade User Layers created using a previous release

Once you upgrade the appliance to Release 4.2.0, if  you want to continue using existing User Layers, you'll need to move

them to new locations as described below.

In this release, the User Layer directory structure has been collapsed by one level, as shown below:

Previous: ...\Users\DomainUser\LayerId_OsName\User.vhd

New: ..\Users\Domain_User\LayerId_OsName\User.vhd

For example, move the following User Layer VHD file.

From:

\\Root\Engineering\Users\Domain1\User1\32_Win7\User1.vhd

To:

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/layer_os_prep_win10_disable_store.png
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\\Root\Engineering\Users\Domain1_User1\32_Win7\User1.vhd

If  you want to continue using the current User Layers, you must move each Storage Location and the main file share to the

new location.

Important: All of these steps must be completed while all users are logged out. Although no data will be lost if  a user logs

in during this procedure, failure to finish all steps will result in existing users not being able to access their previously created

user layers. No data will be lost, but users will be confused.

To upgrade the User Layers:

1. Using your Image Templates, republish each of your Layered Images that uses Elastic Layering and/or User Layers.

2. Move existing User Layers to the new location, as explained below.

3. Verify the security settings on each renamed folder and on the /User folder, as described above.

Move existing User Layers to the new location

Copy each User Layer Storage Location to its new location:

1. Make sure the User Layer is not in use.

If  a user logs in before you move his/her User Layer, a new User Layer will be created. No data will be lost, but you will

need to delete the newly created User Layer, and copy it to the new directory, ensuring that the user's ACLs are

preserved.

2. Browse to the directory containing the User Layer VHD file.

3. Using the following command, copy each of the User Layer VHD files from the previous location to the new one

xcopy Domain1\User1 Domain1_User1\ /O /X /E /H /K

4. Verify that all permissions are correct on the following directories, and files within them:

\\Root\Engineering\Users

\\Root\Engineering\Users\Domain1_User1\...

\\Root\Engineering\Users\Domain2_User2\...

Let users create new User Layers and remove the previous ones

If  you choose to let users create new User Layers, you must manually clean up the original directories and files from your

share.

https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/layer_user_enable_co_vs4#Move
https://www.unidesk.com/support/learn/4.2.0/vmware_vsphere/itoc_2_layer_vs4/layer_user_enable_co_vs4#storage_locations_user_layers
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Publish layered images

Jun 29, 2017

The Citrix App Layering service lets you publish Layered Images as disks compatible with your platform. You can use a

Layered Image to provision servers, as you would with any other image.

About Layered Images

Layered Images are bootable images composited from an OS Layer, a Platform Layer, and any number of App Layers.

Creating and updating Layered Images

The way you specify which layers to include in a Layered Image is by saving the combination of layers you want for a

particular group of users in an Image Template. You then use this template to publish a Layered Image to your chosen

platform.

When you need to update the Layered Image, you simply edit the Image Template to add or remove layer assignments, and

publish a new version of the image.
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Connectors for publishing

Jun 29, 2017

When publishing Layered Images, you need a Connector Configuration that defines the location where you will publish the

images, preferably near the servers you intend to provision with the images. You can create as many Connection

Configurations as you need.

It is strongly recommended that Layered Images are published to the environment where the App Layering appliance is

installed, in this case, Nutanix. To do this, you need a Nutanix Connector Configuration to define the publishing location. If

you don't yet have an Nutanix Connector Configuration, you can create one while in the process of publishing Layered

Images.

Note
If you decide to publish Layered Images on a hypervisor other than the one where the appliance is installed, you can publish to the

appliance's file share using the NFS Connector. Once the image is published, you can manually copy the file to the desired location.

See Connector essentials for more information.

http://docs.citrix.com/en-us/citrix-app-layering/4/vmware-vsphere/configure/connector-essentials.html
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Create image templates

Jun 29, 2017

You can create Image Templates to publish Layered Images to your target platform where you can then use the Layered

Image to provision servers on your chosen publishing platform. An Image Template stores your Layer assignments, along

with a Layer icon and description. You can easily edit an Image Template and use it to publish new versions of your Layered

Images.

Prerequisites

OS Layer (Required)

Platform Layer (Required for cross-platform deployments)

The Platform Layer contains the software required for publishing to your environment, in this case:

Nutanix Acropolis VM Mobility

Citrix MCS Device imaging tools

The Platform Layer must have the same hardware settings as the OS Layer. You choose these settings when deploying

the VM for the OS and Platform Layers.

App Layers (Optional)

You can create an Image Template without App Layers. This is useful for testing your OS Layer before using it to create

App Layers.

Create an Image Template

To create an Image Template:

1. In the App Layering Management Console, select the Images module, then click Create Template. This opens the

Create Template wizard.

2. In the Name and Description tab, enter a Name for the template and notes in the Description f ield, so you can identify

the template when choosing one for publishing a Layered Image.

3. In the OS Layer tab, select one of the Available OS Layers. If  there is more than one Layer Version, the most recent

version is selected by default. You can choose an older version by expanding the Layer and choosing a different one.

4. In the App Assignment tab, select the App Layers to include in the Layered Images that you publish using this template.

5. On the Connector page, select a Citrix MCS for Nutanix AHV Connector Configuration for the location where you want

to publish the Layered Image.

If  you do not yet have a Connector Configuration for Citrix MCS for Nutanix AHV, add one. Click New, choose the

Connector Type, and follow the instructions to Create a Connector Configuration.

6. In the Platform Layer tab, select a Platform Layer with the tools and hardware settings that you need to publish

Layered Images to your environment. For details, click here.

https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_admin_ah4/itoc_3_admin_manage_layering_ah4/layer_delete_co_ah4/layered_images_manage_template_ah4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_layer_ah4/itoc_3_layer_os_ah4/layer_os_create_ah4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_publish_create_template_co_ah4/layer_platform_create_ah4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_layer_ah4/itoc_3_layer_apps_ah4/layer_apps_create_ah4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_connectors_publishing_ah4/connector_config_fields_ah_mc4
https://www.unidesk.com/support/learn/4.2.0/nutanix_ahv/itoc_2_publish_ah4/itoc_3_publish_create_template_co_ah4/layered_images_create_template_ah4#platform_layer_prereqs
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7. On the Layered Image Disk page, edit the following fields, as needed:

(Optional) Layered Image Disk File name. Enter a name for the Layered Image Disk.

Layered Image Disk Size. The default disk size of 100 GB is recommended.

Layered Image Disk Format. The default disk format is VHD, but you can also select VMDK or QCOW2.

Sysprep. An appropriate default value is selected for your environment. This setting determines whether the Layered

Image will be generalized, and if  so, which script will be used to generalize the image and join a domain. Since MCS

uses its own built in technology to perform the operations generally performed by sysprep, MCS requires the VMs

used with their catalogs not be generalized so they do not go through the sysprep steps when f irst powered on in

the catalog.

Elastic Layering - Controls whether Elastic Layering on this Layered Image is allowed, and whether the user's app data

and configuration settings are saved in a User Layer . , select one of the following values:

Application Layers only. Allows Elastic Layers for users who log into this Layered Image. Available for both Session

Hosts and Desktops.

Application and User Layers (Unidesk Labs). Enables Elastic Layer assignments and User Layers on the Layered

Image. User Layers preserve users' application data and configuration settings. Currently, User Layers can be used

on Windows 7 Layered Images only, not on Windows 10, nor on Session Hosts.

None. Elastic Layers and User Layers are disabled.

8. On the Confirm and Complete tab, enter any comments you would like for this layer, and click Create Template.

The new Template icon appears in the Unidesk Images module.
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Publish to MCS for XenServer

Jun 29, 2017

A Layered Image is a virtual machine that the App Layering software has composited from the Layers and settings specified

in an Image Template. You can publish one or more Layered Images to Citrix MCS in your vSphere environment and add it to

a catalog for provisioning systems. In the Connector Configuration wizard, be sure to configure a Virtual Machine Template,

so that the Layered Image you publish will be in a ready-to-use VM, the image shut down and a snapshot taken. You can

use the VM in your Horizon environment without further modifications.

Prerequisites

To publish a Layered Image to MCS, you need:

One or more Image Templates.

Publish a Layered Image

1. In the Images module, select one or more Image Templates that you want to publish.

2. From the Action menu, select Publish Layered Image.

3. On the Confirm and Complete page, select Publish Layered Images. For each Image Template this starts a task

called, Publishing Layered Image. When each task completes, the task description provides the information you need to

navigate to the image in your environment.

At the end of the image creation process:

The App Layering software powers on the VM - This will enable the guest OS to run and execute any layer scripts

via our kmssetup.cmd functionality. This can be used to perform important layer specific steps like activating

Microsoft Office which may need to be done before the VM is used to create a view desktop pool/RDS farm or

recompose them. The mechanism used to execute these scripts can vary, including our own kmssetup.cmd

functionality, run-once support, or even manual execution. It is expected that once all scripts are run or other manual

steps are taken and the VM is in the desired state, a guest OS shutdown will be initiated either by the scripts, or by

the user (if  using the kmssetup.cmd functionality there will a documented process for initiating a shutdown after all

layer scripts and other kmssetup functionality is complete).

The VM shuts down - When the VM is in the desired state, the VM shuts down and the status changes to Done.

When the task completes, the task description provides the information you need to navigate to the image in your

environment.

4. Use the information in the expanded Packaging Disk Task to navigate to the location in your environment where the

Layered Image has been published.

Next you can move the image to a collection or other location for provisioning servers.
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Publish to PVS

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to PVS, and stream them to the systems you want to provision.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

Publish a Layered Image

To use an Image Template to publish a Layered Image:

1. Log into the UMC.

2. Select the Images modules.

3. Select one or more Image Templates, then click Publish Layered Image.

4. On the Confirm and Complete tab, click the Publish Layered Image button. This starts a task called, Publishing Layered
Image. When the task completes, the task description provides the information you need to navigate to the image in

your environment.

5. Use the information in the expanded Packaging Disk Task to navigate to the location in PVS where the Layered Image

has been published.

Next you can assign the new disk to the targeted devices.

Assign the new vDisk to the targeted devices

1. Log into the PVS Console.

2. Access the target PVS server. The new vDisk should appear under the targeted PVS store (refresh may be required).

3. Assign the new vDisk to the targeted devices.

4. Using Citrix PVS best practices, test the new vDisk to ensure that the image streams to the server as expected.
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Publish to XenServer

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to XenServer and add each one to a collection, provisioning service,

or other method for provisioning your systems.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

Publish a Layered Image

1. In the Images module, select one or more Image Templates to publish.

2. From the Action menu, select Publish Layered Image.

3. On the Confirm and Complete page, select Publish Layered Images. For each template, this starts a task

called, Publishing Layered Image. When each task completes, the task description provides the information you need to

navigate to the image in your environment.

4. Use the information in the expanded Packaging Disk Task shown above to navigate to the location in XenServer where

the Layered Image has been published.

Next you can move the image to a collection or other location for provisioning servers.
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Publish to Network File Share

Jun 29, 2017

A Layered Image is a virtual machine that Unidesk has composited from the Layers and settings specified in an Image

Template. You can publish one or more Layered Images to the ELM's Network File Share, copy the Image(s) to your target

environment, and use them to provision Session Hosts in your environment. This is especially useful if  Unidesk does not yet

include Connectors for the platform where you're provisioning systems.

Prerequisites

To publish a Layered Image, you need:

One or more Image Templates.

The Image Template you select should have the correct OS Layer and any App Layers you want in the Layered Image.

Publish a Layered Image

To use an Image Template to publish a Layered Image:

1. In the Images module, select one or more Image Template that you want to publish.

2. From the Action menu, select Publish Layered Image.

3. On the Confirm and Complete page, select Publish Layered Images. For each Image Template this starts a task

called, Publishing Layered Image. When each task completes, the task description provides the information you need to

navigate to the image in your environment.

4. Use the information in the expanded Packaging Disk Task shown above to navigate to the location where the Layered

Image has been published.

Important
When publishing a Layered Image to a file share, there will be one VMDK file option, and it will generate two

files: layer.vmdk and layer-flat.vmdk. You need to upload both of them.

Next Step

Once the Layered Image is published to the file share, you can use the image to provision servers in your environment.
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Assign layers

Jun 29, 2017

To deliver App Layers to users, you can:

Add App Layers to one or more Image Templates, then use the templates to publish Layered Images for use in

provisioning servers.

Elastically assign the App Layers to users, either through a direct user assignment, or via a machine assignment that

makes the layers available to users who log into the machine.

You can make these assignments, as long as each user is assigned a single instance of the Layer, either as part of an

image or as an elastic layer.

Do you want to assign this App Layer to one or more Image Templates for inclusion in your Layered Images? Or, do you

want to assign App Layers to users as Elastic Layers?
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Add App Layers to Image Templates

Jun 29, 2017

An Image Template is a stored selection of Layers and settings that you use to publish Layered Images. At minimum, an

Image Template contains an OS Layer, Platform Layer, and settings. Ideally, each template also contains your choice of App

Layers for a particular image, for example, an image suited for the users served by a particular silo. Once you publish a

Layered Image, you can provision systems using the image.

When you create a new App Layer, you can assign the App Layer to one or more Unidesk Image Templates, and then use

the templates to publish Layered Images that include the layer. This article explains how to assign an App Layer to one or

more Image Templates, and update the assignments when you update the Layer.

When you first update an App Layer, the new Layer Version is not assigned to any Image Templates, so you'll need to

update the Layer Assignments. Updating the assignments allows you to assign different Versions of the Layer to different

Image Templates. 

Important
 When assigning App Layers, be sure to avoid assigning the app elastically to a user, if the app is already in the Layered Image that

the user gets.

Prerequisites

One or more App Layers.

One or more Image Templates.

Add an App Layer Assignment to one or more Image Templates

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer to include in one or more of your Image Templates, and click Add Assignments.

3. In the wizard that opens, select the App Layer that you want to assign to templates.

4. On the Image Template Assignment tab, select the templates in which you want to include this App Layer Version.

5. Skip the Elastic Assignment tab.



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.520https://docs.citrix.com

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When you open each of the Image Templates you will see the App Layer Version you just assigned to the template.

Update App Layers and Image Template Assignments

When you update an application by adding a new Version to the App Layer, the new Layer Version will not inherit the

original Layer Assignments. You need to assign the new App Layer Version.

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer that has been updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new App Layer Version.

5. Click the Image Template Assignment  tab, and select the Image Templates to which you want to assign the new Layer

Version .

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out

names may appear. These Image Templates have already been assigned the Version.

6. Skip the Elastic Assignment tab.

7. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Remove Template Assignments

When you remove an App Layer's Template Assignments, the assignments for all versions of the Layer are removed. If  you

want to remove the assignments for a specific Version of the Layer, select Update Assignments instead.

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.
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Assign App Layers to users elastically (Elastic Layers)

Jun 29, 2017

Assign apps elastically

Wouldn't it be nice to drastically reduce the number of images you have to manage? What if  you could leave apps that only

a few users need out of your base image? And, assign the layers to specific users elastically on top of the base image. With

the Elastic App Layers feature, you can do just that.

An Elastic App Layer is an App Layer that you configure to be delivered to specific users and groups, based on user

entitlements, when the users log onto their session hosts or standalone desktops. With Elastic App Layers, you can give

each user his/her own unique set of applications in addition to the base Layered Image that is used across sessions in the

case of session hosts), and across floating pools/shared groups in the case of desktops.

As this diagram shows, once you add Elastic Assignments to an App Layer, a copy of the Layer is stored in the appliance's

Network File Share, and delivered to individual AD users and groups on-demand, in addition to the Layers that they receive

via the base image.

To use this feature, you'll add Elastic Assignments specifying which users and groups should receive each of the App Layers

that you would like to leave out of your base images. You'll then publish your base image(s) with the Elastic Layering For
Session Hosts selected.

How users access Elastic Layers assigned to them

When users log into their Session or Desktop, icons for their Elastic Layers will appear as shortcuts on the desktop.

A user receives an Elastic Layer in the following cases:

The user (an AD user in the Management Console) is assigned the Layer.

An AD group that the user belongs to is assigned the Layer.

A machine that the user logs into is a member of an AD Group that receives the Elastic Layer.

A machine that the user logs into is associated with an AD Group that is assigned the Layer via the Management

Console.
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If  more than one version of  the same Layer is assigned to a user

If  a Layer is assigned directly to the user and indirectly to one or more of the user's groups, the user receives the most

recent version of the Layer assigned directly to her/him. For example, if  a user is assigned Version 2, and a group that the

user belongs to is assigned Version 3, the user will get Version 2.

If  the user is assigned a Layer via one or more group assignments, the user receives the most recent version of the Layer.

If  a user has an App Layer in their Layered Image, and the Layer is also assigned to them elastically

If  a user has an App Layer in the Layered Image and the user is also assigned the Layer elastically, they will receive the

Elastic Layer, even if  the version in the base image is more recent.

Prerequisites and limitations

Prerequisites

The appliance's Network File Share must be configured correctly:

The Share must be configured using SMB technology. When using Elastic Layer assignments, NFS technology is not
supported.

The Share must be set up by the admin to be readonly for all users except for the one configured in the appliance.

This secures the Layers and other f iles stored on the Share.

The User named in this configuration must have Read/Write permissions on the root of the network f ile share.

Select System > Settings and Conf iguration and scroll to Network File Share.

Make sure that any users who will be assigned Elastic Layers have Read only access for the root directory of the

Network File Share.

.NET Framework 4.5 is required on any Layered Image where Elastic Layers are enabled.

The App Layers you want to elastically assign.

Note
App Layers must be created using the same OS Layer used to create the Layered Image that you enable to deliver the Elastic App

Layer to users.

Elastic Layering Limitations

You cannot elastically layer the following:

Microsoft Office Add-ons and extensions in individual Layers. A user must have all of their add-ons in one Layer. Note:

Please use the recipe for elastically layering MS Office.

Applications with drivers that use the driver store. For example, a printer driver.

Applications that modify the network stack or hardware. For example, a VPN client.

Applications that have boot level drivers. For example, a virus scanner.

Enable Elastic Layering in the base image
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When you publish the Layered Image that the users will log into to get the Elastic App Layer(s):

1. In the Management Console, select the Image Template used to generate the Layered Image.

2. Select the Images tab.

3. Select the Image Template on which you want to enable Elastic Layering, and select Edit Template from the Action bar.

The Edit Template wizard opens.

4. On the Layered Image Disk tab, select a value for the Elastic Layering option.

Application Layers Only - To enable Elastic Layering for your App Layers.

Application and User Layers - To enable both Elastic Layering for your App Layers, and User (personalization) Layers.

5. Finish publishing the Layered Image.

6. Provision your Session Hosts with the new base image.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Run the Elastic Fit Analyzer on App Layers (App
Layering Labs)

Before assigning an App Layer elastically, use the Elastic Fit Analyzer to determine the likelihood that the Layer assignment

will be successful.

Elastic Fit Analysis

In the Layer Details, the Elastic Fit rating indicates how likely it is that the Layer will work when elastically assigned.

Good Elastic Fit . This layer should work when deployed elastically.

Poor Elastic Fit . This layer will probably not work when deployed elastically, or may behave differently than when it

is deployed in a Layered Image.

Elastic Fit Details

You can learn more about the Elastic Fit of a Layer by expanding the Elastic Fit Analysis. If  the Elastic Fit is less than ideal,

the list of violated rules will be displayed.

Low Severity Warning. This is unlikely to cause any change in behavior or functionality for most applications.

Medium Severity Warning. This may cause minor changes in behavior or functionality for some applications.

High Severity Warning. This is likely to cause signif icant changes in behavior or functionality for many applications.
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Enable Elastic Fit in App Layering Labs

To use this App Layering Labs feature, you must enable it. To enable Elastic Fit:

1. In the Management Appliance, select System > Settings and Conf iguration.

2. Click Edit  App Layering Labs.

3. Select the Elastic Fit  check box.

4. Click Save.

Analyze an App Layer for Elastic Fit

All new Layer Versions will be analyzed for elastic layering compatibility when they are finalized. To analyze existing App

Layers for Elastic Fit:

1. Log into the Management Console.

2. Select Layers > App Layers.

3. Select the Layer to analyze, and click Analyze Layer.
4. On the Select Versions tab, choose the Layer Versions to analyze.

5. On the Confirm and Complete tab, click Analyze Layer Versions. The analysis takes seconds.

6. To see the Elastic Fit Analysis, select the App Layers module, move the mouse pointer over the Layer icon and click

the Info  icon.

7. Expand the Version Information for each Layer Version, and look for the Elastic Fit rating.

8. For a detailed report, expand the Elastic Fit Details. If  the Elastic Fit is less than ideal, the list of violated rules will be

displayed.

9. You can display the AD tree and hide the violated rules by clicking a button acknowledging that the layer is unlikely to

work as expected.

Upgrading from Earlier Releases

After upgrading from an earlier App Layering release, the Elastic Fit Detail shows that any existing Layer Version(s) have not

been analyzed. Until you run the analysis on existing Layer Versions, the Versions will have a single High severity Elastic Fit

Detail, and a Poor Elastic Fit.

Elastically assign an App Layer to AD Users and Groups

The first time you assign an App Layer elastically, we recommend starting with an app like Notepad++ or GIMP, because

they are simple to .

1. Log into the Management Console as an Admin user, and select Layers > App Layers.

2. Select an App Layer that is not going to be included in the base image, and select Add Assignments.

3. In the wizard that opens, select the Version of the App Layer that you want to assign users.

4. Skip the Image Template Assignment  tab. This tab is for assigning the Layer to an Image Template.

5. In the Elastic Assignment tab, select the users and groups who should get this App Layer.

6. In the Confirm and Complete tab, review your selections, and click Assign Apps.

When the users log in, they should see an icon for each Elastic App Layer they've been assigned.

Elastically assign an App Layer to users via machine
assignments and associations
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Any machine running the App Layering Service (ULayer.exe) can have Elastic Layers assigned to it. You can accomplish this by

either adding the machine to or associating it with the AD Group, and then elastically assigning the App Layers to the

AD Group.

The Layers assigned to the machine will be available to every User who successfully logs into that machine. The App

Layering Service will scan for changes to the machine's AD group memberships and associations every 10 minutes. When the

users log in, they should see an icon for each Elastic App Layer they've been assigned.

Use Active Directory to add the machine to the AD Group

Assuming you have a published Layered Image booted in your environment, you can add the machine to an AD Group, and

assign Elastic Layers to the AD Group.

1. Use Active Directory (AD) to add the machine to an AD Group.

2. Select an App Layer that is not going to be included in the base image, and elastically assign the Layer(s) to an AD Group.

3. You can wait for AD to propagate the changes and be recognized by the App Layering Service, or you can force the App

Layering Service to update its list of machine groups by doing one of the following:

Wait for the App Layering Service to detect the changes (within 10 minutes by default).

Restart the App Layering Service.

Reboot the App Layering Service Machine.

Execute the refresh.groups command:

C:\Program Files\Unidesk\Layering Services\ulayer.exe refresh.groups

Example

You start with an AD User, and AD Group, and a machine that you provisioned using a Layered Image.

AD User: Kenya
Kenya has no elastic assignments.

AD Group: Marketing
The Marketing group includes the member Kenya.

Machine: ElasticTestMachine
The ElasticTestMachine base image includes the MS Office App Layer.

In this example, you elastically assign the Chrome App Layer to ElasticTestMachine:

1. In AD, you add the machine ElasticTestMachine to the Marketing AD Group.

2. In the Management Console you elastically assign the Chrome App Layer to the Marketing Group.

3. When Kenya, who is part of the Marketing group, logs into ElasticTestMachine, she receives both the MS Office App
Layer, which is in the base image, and the Chrome App Layer.

4. When any user who is not in the Marketing group logs into ElasticTestMachine, they also receive both

Layers: MS Office because it is in the base image, and Chrome because the ElasticTestMachine is a member of

the Marketing AD Group.

Use the Management Console to associate the machine with an AD Group

Associating a set of machines with an AD Group allows any machine running the App Layering Service to have Layers

https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co_az4#Assign
https://www.unidesk.com/support/learn/4.2.0/ms_azure/itoc_2_assign_az4/layer_assign_apps_elastic_co_az4#Assign
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elastically assigned to it via AD group membership.

Elastic Layers granted via Machine association can be thought of as extending the layers assigned to a user. For example, if

a machine matches multiple Machine Associations, only the unique layers will be added to the ones the user already has.

In the Management Console, you use asterisk (*) wildcards in a machine name pattern to specify a set of machine names.

For example:

Machine name pattern Matches these names Does not match these names

machine*
machine01

machineindetroit

amachine

localtestmachine

*machine
amachine

localtestmachine

machine01

machineindetroit

ky*eng
ky02359eng

kytesteng

01ky_eng

testky01eng

*eng*

eng01

1eng

1eng01

en01

1en

1en01

You can create Machine Associations before or after elastically assigning App Layers to the AD Group. Also, the machines

do not need to exist when you add the associations, as the associations exist within App Layering only, and AD is not

aware of them.

Associate a set of machines with an AD Group

1. Log into the Management Console as an Admin user, and select Users > Tree.

2. Expand the Tree, select the appropriate Group and click Edit Properties in the Action bar. This opens the Edit Group

Wizard.

3. Select the checkbox, Associate machines with this AD Group. This reveals the Machine Name Pattern field:

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_notchecked.png
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4. Specify a set of machines to associate with the AD group by entering a machine name pattern. For examples, see the

above table of Machine name patterns.

5. On the Confirm and Complete tab, select Update Group. Notice the shape of a computer monitor superimposed over

the group icon. This indicates that machines are associated with the group.

When you click the group's  icon, the Detail view now includes a field called, Associate With Machines where the

pattern.

Example

You start with the machine, Mach1, the AD Group, MachineGroup, and the App Layers for Firefox and MS Office.

Machine: Mach1
AD Group: MachineGroup
App Layers: Firefox, MS Office

Further, you have elastically assigned the Firefox and MS Office Layers to the AD Group.

If  you add a Machine Association to MachineGroup with a name pattern of "Mach*", when any domain user logs

into Mach1, they will receive the Firefox and MS Office Elastic App Layers.

Manage Elastic Assignments

You can:

View a user's Elastic Layer assignments.

Update an App Layer and elastically assign the new Version of the Layer.

Remove Elastic Assignments.

Debug an Elastic Assignments.

https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_checked.png
https://www.unidesk.com/sites/default/files/support/learn/4.2.0/machine_association_details.png
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View a user's Elastic Layer assignments

1. Log into the Management Console and select Users > Tree.

2. Select an AD User or Group, and click the "i" icon to the right of the name. If  the user or group is assigned any Elastic

Layers, the Layers are listed just below the user's or group's profile information in the Details window that appears.

Update an App Layer and its Elastic Assignments

You've added Elastic Assignments to an App Layer, and users are accessing the app as expected. A new version of the

application is released, so you update it by adding a new Version to the Layer. Now you need to assign the new version to

the users who have the Layer.

1. Log into the Management Console and select Layers > App Layers.

2. Select the elastically assigned App Layer that you just updated.

3. Right-click the Layer icon and select Update Assignments.

4. In the wizard that opens, select the new Version.

5. Skip the Image Template Assignment tab.

6. In the Elastic Assignment tab, there's a list of Users and Groups who have been assigned a different version of the

selected Layer. Select the users and groups to whom you want to assign the new Version of the Layer.

Notes:

If  the list is long, use the Search f ield to f ilter the results.

If  the list is empty, click the check box called, Show AD users and groups already at this version. A list of grayed

out names may appear. These users have already been assigned the Version.

7. On the Confirm and Complete tab, verify the Users and Groups selected to receive the new Version, and click Update
Assignments.

Remove a Layer's Elastic Assignments

1. Log into the Management Console and select Layers > App Layers.

2. Select the App Layer for which you want to remove assignments, and select Remove Assignments..

3. In the wizard that opens, select the assigned templates from which you want to remove the Layer. All of the

assignments for that layer are listed.

If  the list is long, use the Search field to filter the results.

4. On the Confirm and Complete tab, verify the Image Templates selected to receive the new Version, and click Update
Assignments.

Debug an Elastic Layer

If  you have an Elastic Layering issue, you can diagnose the problem by finding out whether the layer is being delivered, and if

so, whether it is working correctly. If  needed, collect data for Support, as described here.

Is this a Delivery issue?

Are the things you'd expect to see if  this app were installed actually there as expected?

Do you see the f iles and registry entries for the layer?

If  the app is supposed to be in the Start menu, is it there?
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If  there should be a shortcut for the app on the user's desktop, is there one?

If  you discover that app delivery is an issue, you can collect the following data, open a case, and send the data to Support.

1. Collect the data from these logs:

Windows App Event log –  In the Windows Event Viewer under Windows Logs, export the Application event log as an

EVTX f ile.

App Layering Service log (ulayersvc.log) –  C:\ProgramData\Unidesk\Logs\ulayersvc.log

2. Collect the values of these Registry keys:

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:AssignmentFile

HKEY_LOCAL_MACHINE\SOFTWARE\Unidesk\ULayer:RepositoryPath

3. Collect the contents of the Assignment (ElasticLayerAssignments.json) and Layers (Layers.json) files from the Repository

Path.

4. Contact Support.

Is this an operational issue?

One of these issues could indicate that this is an Elastic Layering issue:

The app is being delivered but doesn't launch correctly.

An operation within the app doesn't work correctly.

A licensing problem or a security issue.

The app launches, but then misbehaves, for example, it crashes on startup, or starts up but doesn't work right.

If  the problem with the Layer is operational, test the App Layer in the base image to rule out general layering issues:

1. Add the App Layer to an Image Template, and publish a Layered Image that includes the App Layer.

2. Log in as a user who is not assigned the Layer elastically, and make sure that the application is operational in the base

image.

3. Contact Support with your f indings.
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System settings

Jun 29, 2017

You can specify settings for the following system configuration parameters by clicking on the Edit button of each option,

making your changes, and clicking the Save button.

Appliance
settings

Summary

HTTP

Certificate

Settings

Displays the currently set security certificate. Use the Upload and Generate buttons to upload an existing certificate or to

generate a new one. Optionally, enter a comment that describes the changes you made.

Network File

Shares

The Network File Share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

To configure the Network File Share, you specify the:

Network File Share Type

Network File Share Path

User Name & password

Then, test the connection to the file share by clicking Test Network File Share. The test returns a message stating either

"Success" or "Failed to mount network file share path". You can enter a comment describing your changes.

Security

Settings

Specify the number of minutes of inactivity before the Management Console logs you out. Optionally, enter a comment

that describes the changes you made.

Task

Retention

Settings

Specify the number of days that the appliance should retain completed Tasks before deleting them. Optionally, enter a

comment that describes the changes you made.

Audit Log

Retention

Settings

Specify the number of days that the appliance should retain audit log files. After that time elapses, the software begins to

overwrite the audit log. Optionally, enter a comment that describes the changes you made.

Notification

Settings

Configure automatic email notification settings for yourself or other users. When you export logs, the appliance sends

the specified recipients an email notification that includes a link to the log files.

To set up email notifications:

1. In the Mail Server box, enter the name of your email server or the name of the SMTP relay server.

2. In the Mail Server port, enter the number of the port that the email server uses for communication.

3. In the User Name box, enter the user name for the email account you want to use for sending notifications. For

example, username@domain.com.

4. In the Password box, enter the password for the email account.

5. In the From box, enter an email address to identify the source of the email message. For example, if you enter

myaddress@mycompany.com, the email message displays the following in the From box of the received

notification:

App Layering Manager [myaddress@mycompany.com]

6. In the Recipient List box, enter the email addresses that should receive notifications. Use a comma or semicolon to
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6. In the Recipient List box, enter the email addresses that should receive notifications. Use a comma or semicolon to

separate the email addresses.

7. Click Test Email Configuration to verify that the settings for the email server and account work correctly. If the test

succeeds, the software displays a success message and sends the recipients a confirmation email.

8. Enter a comment, if necessary, and click Save to save the email settings. Any comments you enter will appear in the

Information view Audit History.

For more information, see Export log files.

Log File

Retention

Settings

Specify the maximum disk space to use for all logs (in megabytes) and the number of days that the log files should be

retained. Optionally, enter a comment that describes the changes you made.

Appliance
settings

Summary
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System storage

Jun 29, 2017

Check the amount of free space in the appliance's local storage

The appliance's local storage is a Layer Repository where the appliance creates, composites, and stores Layers and Layered

Images. You can see how much disk space is used in the System module of the Management Appliance.

Log into the Management Console and select System > Manage Appliance.

In the Services table, the Local Storage for the Layering Service shows how much space is used and how much is free.

Notes:

Disk space is shown in 1024-based Gigabytes, not metric.

Free space is updated every time a Layering Service job completes. If  you want to make sure the page has been refreshed,

click the Refresh icon just above the Manage Appliance subtab.

When creating a Layer or adding a Version to it, extra space is temporarily required to build the Packaging Disk. You can

calculate the amount of space needed during Layer creation by adding the following Layer sizes:

The size of the OS Layer Version you're using.

The size of the writable disk you want for the App Layer.

The size of any Prerequisite Layers (if  you have any).

Add space to an existing disk in locally attached storage

You can add storage space to an existing local storage disk as follows.

Log into your hypervisor's management console, and follow the normal procedure to increase the size of the local storage

disk. (You may have more than one of these disks, and can expand each one of them.)

Log into the Management Console and select System > Manage Appliance.

Select Expand Storage. A list of expanded disks is displayed. (You might also see attached disks that are not yet part of the

layer repository, but you can ignore those.)

Notice that the New Size of the disk you expanded is larger than the Current Size.

Select the check box for the disk that you want to expand to the New Size.

On the Confirm and Complete tab, click Expand Storage.

Add a disk to locally attached storage

When you install the appliance, it comes equipped with an additional 200 GB data disk that is used as a Layer Repository.

You can expand the appliance's local storage by adding another disk to it.

Log into your management console.

Select System > Manage Appliance.

Select Expand Storage.

The Disk Selection tab is displayed of disks that are attached to the system and are not part of the layer repository.

Select the check box for each disk that you want to use to expand the layer repository.

If  a check box is grayed out and a yellow icon with an ! (exclamation point) is displayed, it means that the attached disk is

not eligible for use (for example, if  the disk is not blank). Once the attached disk is blank and unpartitioned, you will be able

to use it to expand the appliance's local storage.
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On the Confirm and Complete tab, click Expand Storage.

Add storage locations for User Layers

When you enable User Layers on a Layered Image, the data and settings for each user are persisted between sessions.

When deploying with User Layers enabled, you must add storage locations for those Layers, rather than allowing user data

to be saved on the appliance's main file share.

The main file share is used to:

Package Layers using the NFS connector, rather than a connector for your hypervisor.

Publish Layered Images to the NFS file share, rather than a connector for your publishing platform.

Serve Elastic Layers.

Upgrade the App Layering software.

When configuring storage locations:

You can assign Groups of users to each location.

The first storage location added to the appliance becomes the default location for User Layers not associated with any

other storage location.

Storage locations are listed in priority order.

If  a user belongs to more than one group and those groups are assigned to different storage locations, the person's User

Layer will be stored in the highest priority storage location. Once the person's User Layer is saved to the highest priority

location, if  you change the priority order of the storage locations that the user is assigned to, data saved up until that

point will remain in the previously highest priority location. To preserve the person's User Layer, you must copy the their User

Layer to the new highest priority location.

Create Storage Locations

To add a storage location:

Log into the management console.

Select System > Storage Locations.

Select Add Storage Location. A list is displayed of file shares, except for the appliance's main file share.

Select Add Storage Location, and enter a Name and Network Path for the new location.

On the User Layer Assignments tab, expand the directory tree and select the check box(es) for one or more groups to add

to the new storage location.

On the Confirm and Complete tab, click Add Storage Location.

Once the Storage Locations are added, you must set security on the User Layer Folders.

Configure security on user layer folders

Storage locations allow you to have more than one location specified for your User Layers. For each Storage Location

(including the default location) you need to create a /Users subfolder and secure that location.

The security on each User Layer folder must be set to the following values by a domain administrator:

Creator Owner



© 1999-2017 Citrix Systems, Inc. All rights reserved. p.534https://docs.citrix.com

Setting name Value Apply to

Creator Owner Modify Subfolders and Files only

Owner Rights Modify Subfolders and Files only

Users or group:

Create Folder/Append Data

Traverse Folder/Execute File

List Folder/Read Data

Read Attributes

Selected Folder Only

System Full Control Selected Folder, Subfolders and Files

Domain Admins, and selected Admin group Full Control Selected Folder, Subfolders and Files

Set security on the User Layer folders

1. Log into the management console.

2. Select System > Storage Locations. The f ile shares displayed are the storage locations defined for User Layers. For

example, say you've defined three Storage Locations so that you can more easily manage storage for Group1 and

Group2 separate from everyone else in the organization:

 

Default location - \\MyDefaultShare\UserLayerFolder\

Group1 - \\MyGroup1\Share\UserLayerFolder\

Group2 - \\MyGroup2\Share\UserLayerFolder\

Note: The appliance's main file share, which is used for storing OS, App, and Platform Layers, is not listed as a User Layer

Storage Location.

Create a \Users subdirectory under each file share:

 

\\MyDefaultShare\UserLayerFolder\Users\

\\MyGroup1Share\UserLayerFolder\Users\

\\MyGroup2Share\UserLayerFolder\Users\ 

Apply the security settings listed above to each /Users subdirectory.
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Firewall ports
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The App Layering appliance (aka the Enterprise Layer Manager (ELM)) must be connected to a network file share.

The App Layering installer opens ports that the appliance needs to interact with services on the virtual server where it is

hosted. The default ports that App Layering uses are listed in the tables below.

If  there is a firewall between the App Layering appliance and the machine on which you are running the App Layering Agent

or one of the App Layering Connectors, you must manually open the port in the firewall used for that purpose. If  during

installation you changed any of the ports from the default setting, be sure to open the correct port.

Admin User

By default, App Layering uses the following ports in your firewall for the Admin User to interact with the Management

Console on the App Layering appliance VM.

App Layering appliance 

(Enterprise Layer Manager (ELM))

Destination Activity Protocol Ports

App Layering appliance 

(Enterprise Layer Manager (ELM))
Management Console TCP 80, 443

App Layering appliance Administrator log download TCP 8888

Connector for Azure Communication TCP
3000 (HTTP) 

3500 (HTTPS)

Connector for PVS Communication TCP
3009 (HTTP) 

3509 (HTTPS)

Connector for vSphere Communication TCP
3004 (HTTP)

3504 (HTTPS)

Connector for XenServer Communication TCP
3002 (HTTP)

3502 (HTTPS)

Connector for Azure Communication TCP
3000 (HTTP) 

3500 (HTTPS)

Connector for Nutanix Communication TCP
3006 (HTTP)

3506 (HTTPS)

App Layering appliance ActiveMQ Console TCP 8161
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App Layering Appliance (Enterprise Layer Manager (ELM))

Internal Connections

By default, the App Layering service uses the following ports in your firewall for internal connections between the appliance

and each of the destinations listed below.

In this table:

Appliance - The App Layering Appliance, also called the Enterprise Layer Manager, or ELM. This is the virtual appliance

Agent - refers to the App Layering Agent, which is required if  you are:

Using PVS - The Agent must be installed on you PVS server(s).

Running Connector scripts - The Agent must be installed on any server on which you want to run a Connector script, for

example, a server for your connection broker, provisioning service, hypervisor, or any other server running in your environment.

Admin User - A Management Console user who is assigned the App Layering Admin Role.
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Source Destination Activity Protocol Ports

Agents Appliance Initial registration TCP 443

Appliance Agents Communication TCP 8016

Agents Appliance Log deliveries from the Agent TCP 8787

Appliance
VMware vCenter and ESX

Hosts

Communication with datastore via ESXI

Host
TCP 443

Agent Appliance Agent communication with datastore TCP 8888

Appliance Active Directory Communication with Active Directory TCP 443

Agent Appliance Log gathering TCP 14243

Appliance Active Directory LDAP TCP 389, 636

Admin User Appliance Connector for Azure Communication TCP

3000

(HTTP) 

3500

(HTTPS)

Agent on PVS server /Admin

user
Appliance

Connector for PVS Communication

/Publishing
TCP

3009

(HTTP) 

3509

(HTTPS)

Admin User Appliance Connector for vSphere Communication TCP

3004

(HTTP)

3504

(HTTPS)

Admin User Appliance Connector for XenServer Communication TCP

3002

(HTTP)

3502

(HTTPS)

Admin User Appliance Connector for Nutanix Communication TCP

3006

(HTTP)

3506

(HTTPS)
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External connection

By default, uses the following port in your firewall for external connections between the App Layering appliance and the

destination listed below.

Destination Activity Protocol Ports

cdn.unidesk.com API access TCP 443

www.unidesk.com/upgrades/latest Download upgrade media from Citrix Cloud TCP 80

OS Image (XenServer requirement only)

Citrix XenServer uses Port 5900 for communications between your OS Image and XenCenter or other Xen client.

Destination Activity Protocol Ports

XenCenter Communications 5900
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Manage layers and templates
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The App Layering Appliance (aka Enterprise Layer Manager (ELM)) is a virtual appliance that coordinates communication in

the App Layering environment and manages copies of your Layers and Image Templates. Based on CentOS, the appliance

hosts the Management Console, a friendly interface where you create Layers and use those Layers to publish Layered

Images.

You can log into the appliance and modify the administrator password, network address, NTP servers, and Time Zone

settings using the Appliance Configuration utility, as described here.

Before you start

Make sure that the App Layering Appliance is running in your hypervisor.

Make sure you have the password for an account with administrator privileges

Log into the appliance using an account with administrator privileges

Using either your hypervisor console or SSH, log into the appliance as administrator (default password Unidesk1).

Note: If  the appliance is in Azure, type /opt/sbin/cfg_launcher, and press Enter.

This opens the Appliance Configuration utility.

Change the administrator password

The App Layering Appliance (aka Enterprise Layer Manager) is managed using three administrative accounts.

Administrator account for the Management Console - The account for the management console, which is hosted

on the App Layering Appliance.

root user account for the appliance - The default Linux super user account, which has access to all commands and

files on the appliance's Linux OS. WARNING: This password is required if  you ever need to reset your other administrative

accounts.

administrator account for the appliance - The account for the command line utility where you can change the

appliance's network setting, date, time, ntp server, or time zone.

Use these steps to change the password for any of the appliance's administrative accounts.

1. If  this is the f irst time you are logging into the management console on a freshly installed appliance, take a moment to

familiarize yourself  with the administrative accounts for the appliance.

2. For each account, enter the new password and then re-enter it in the Confirm Password f ield.

3. On the Confirm and Complete tab, click Change Credentials.

Configure networking (includes Static IP Address option)

You can change the appliance's IP address and/or its DNS servers. When the appliance is first deployed, the DNS settings

are retrieved through DHCP. If  DHCP is not available and you will be using static IP addresses, once you select Static, you

will be prompted to enter the IP addresses for your DNS servers.

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter C (for Configure Networking), and press Return.
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3. At the next prompt, type D for Dynamic (DHCP) or S for Static.

If  you choose Static, you will be prompted for the IP address and Subnet mask, along with default addresses for the

Gateway and DNS addresses.

4. When prompted, enter Y to save settings.

5. At the Action prompt, enter Q to quit.

6. Restart the appliance.

Synchronize the system clock with NTP servers

You can synchronize the system clock on the ELM by configuring NTP servers. You can specify how many NTP servers you

need, with 6 being the maximum. And, you can add and remove NTP servers, as needed. Where possible your existing servers

will be used as defaults.

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter N for NTP servers change, and press Return. A list of your current NTP servers is displayed.

3. At the prompt, specify how many NTP servers you need by typing a number from 0 to 6.

0 - All servers will be removed (you will be warned).

1-6 - You will be prompted to accept or replace each of the current servers. 

4. For each server, press Enter to accept the current value. Or, enter a new server address (Example: 3.pool.ntp.org). Once

the last address is entered, an NTP Server Summary is displayed.

5. Enter S to save the settings.

6. At the Action prompt, enter Q to quit.

7. Restart the appliance.

Change the Time Zone

1. Log in to the Appliance Configuration utility, as described above.

2. At the Action prompt, enter T  for T imezone change, and press Return. The current time zone is displayed.

3. Press Enter to display available timezones. The f irst bunch of time zones are displayed in alphabetical order, starting with

the

4. Advance through the timezone codes until you see yours:

Enter - Advances one line at a time.

Page Up Page Down - Displays the next or previous screen full of choices.

Or search the timezones:

Type Slash (/) and part of the name you are looking for.

5. When your timezone is displayed, press Q to get to the prompt.

6. Type the number for your timezone. The timezone you entered is displayed.

7. Press Enter to complete the change.

8. At the Action prompt, enter Q to quit.

9. Restart the appliance.
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Update OS layer
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The Unidesk OS Layer contains the Windows Operating System that is assigned to any Unidesk Layered Images you create

using that OS Layer. Once created, you can use the OS Layer to build as many Layered Images as you want.

The OS Layer includes a virtual machine in your infrastructure running the Unidesk-supported Windows Operating System

that you want to use for your Layered Images.

Add a version of  an OS layer

1. In the Citrix App Layering Management Console, select Layers > OS Layers

2. Select or right-click an OS Layer icon and click Add Version. This opens the Create OS Version Wizard.

3. (Required) In the Version Details tab, enter a Version identif ier. This can be the application version, or anything you

choose.

4. In the Connector tab, select a Connector configuration for the platform where you'll be publishing your Layered Images.

You can also modify an existing configuration by selecting it and clicking Edit. If  you have not yet created a Connector

Configuration or if  the configuration you need is not present, click New to create a new Connector Configuration and

select it from this list.

5. In the Platform Layer tab, select a Platform Layer that contains the tools and hardware settings that you need to install

and package the OS when adding a Layer Version. Once created, the new Layer Version can be used in Layered Images

published to any platform.

6. In the Packaging Disk tab, enter a f ile name for the Packaging Disk, and select the disk format. This disk will be used for

the Packaging Machine (the VM) where you will install the application, as described in the next two sections.

7. Confirm and Complete tab - Verify your settings and click Create Version. Unidesk runs the task of creating a new OS

version. When the task completes, it shows a status of Action Required. When you double-click the task to expand it,

the task contains the following text (refer to the image in the next section): 

"The Packaging Disk has been published. The virtual machine '<...>' can be found in folder '<...>' in datacenter '<...>'. Power on

this virtual machine to install your application. When the installation is complete, power off  the virtual machine before

clicking Finalize on the Action bar."

Next, you can deploy a Packaging Machine for this OS Layer version.

Deploy a Packaging Machine to XenServer

The Packaging Machine is a virtual machine where you install any updates or applications you want to include in the OS

Layer. It is strongly recommended that you use a unique Packaging Machine for each Layer. The Packaging Machine is a

temporary VM that will be deleted once the OS Layer has been finalized.

The Task Description (example shown in the last step above) contains directions to navigate to the location in XenServer

where the Packaging Machine for this Layer has been created.

1. To create your Packaging Machine in XenServer, begin with the expanded Packaging Disk task shown in step 2 below.

2. Log into your XenServer web client.

3. Back in the Unidesk Management Console, use the instructions in the expanded Packaging Disk Task (example shown

below) to navigate to the Packaging Machine.

Install the OS update
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1. Remote log into the Packaging Machine in XenServer. Be sure to log in with the User account you used to create the OS

in XenServer.

2. Install any updates or applications you want to include in the new OS Layer version, such as Windows Updates or anti-

virus applications.

3. If  an application installation requires a system restart, restart it manually. The Packaging Machine does not restart

automatically.

4. Make sure the Packaging Machine is in the state you want it to be for the user:

If  the applications you install require any post-installation setup or application registration, complete those steps now.

Remove any settings, configurations, f iles, mapped drives, or applications that you do not want to include on the

Packaging Machine.

Next, you will shut down the Packaging Machine and verify that the Layer is ready to finalize.

Verify the Layer and shut down the Packaging Machine

Once the application is installed on the Packaging Machine, the next step is to verify that the Layer is ready to be finalized.

To be ready for finalization, any required post-installation processing needs to be completed. For example, a reboot may be

required, or a Microsoft NGen process may need to complete.

To verify that any outstanding processes are complete, you can run the Shutdown For Finalize tool (icon below), which

appears on the Packaging Machine's desktop.

To use the Shutdown For Finalize tool:

1. If  you are not logged into the Packaging Machine, remote log in as the user who created the machine.

2. Double-click the Shutdown For Finalize icon. A command line window displays messages detailing the layer verif ication

process.

3. If  there is an outstanding operation that must be completed before the Layer can be f inalized, you are prompted to

complete the process. For example, if  a Microsoft NGen operation needs to complete, you may be able to expedite the

NGen operation, as detailed below.

4. Once any pending operations are complete, double-click the Shutdown For Finalize icon again. This shuts down the

Packaging Machine.

The Layer is now ready to finalize.

Layer integrity messages

Layer integrity messages let you know what queued tasks must be completed before a Layer is finalized.

The new Layer or Version can only be finalized when the following conditions have been addressed:

A reboot is pending to update drivers on the boot disk - please check and reboot the Packaging Machine.

A post-installation reboot is pending - please check and reboot the Packaging Machine.

An MSI install operation is in progress - please check the Packaging Machine.

A Microsoft NGen operation is in progress in the background.

Note: If  a Microsoft NGen operation is in progress, you may be able to expedite it, as described in the next section.

Expediting a Microsoft NGen operation

NGen is the Microsoft Native Image Generator. It is part of the .NET system, and basically re-compiles .NET byte code into
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native images and constructs the registry entries to manage them. Windows will decide when to run NGen, based on what

is being installed and what Windows detects in the configuration. When NGen is running, you must let it complete. An

interrupted NGen operation can leave you with non-functioning .NET assemblies or other problems in the .NET system.

You have the choice of waiting for the NGen to complete in the background, or you can force the NGen to the

foreground. You can also check the status of the NGen operation, as described below. However, every time you check the

queue status, you are creating foreground activity, which might cause the background processing to temporarily pause.

Forcing the NGen to the foreground will allow you to view the progress and once the output has completed, you should be

able to finalize the layer.

1. Force an NGen operation to the foreground. 

Normally, NGen is a background operation and will pause if  there is foreground activity. Bringing the task into the

foreground can help the task to complete as quickly as possible. To do this

1. Open a command prompt as Administrator.

2. Go to the Microsoft .NET Framework directory for the version currently in use:

cd C:\Windows\Microsoft.NET\FrameworkNN\vX.X.XXXXX

3. Enter the NGen command to execute the queued items:

ngen update /force

This brings the NGen task to the foreground in the command prompt, and lists the assemblies being compiled.

Note: It’s okay if  you see several compilation failed messages!

4. Look in the Task Manager to see if  an instance of MSCORSVW.EXE is running. If  it is, you must allow it to complete,

or re-run ngen update /force. Do not reboot to stop the task. You must allow it to complete.

2. Check the status of an NGen operation

1. Open a command prompt as Administrator.

2. Check status by running this command:

ngen queue status

3. When you receive the following status, the NGen is complete, and you can f inalize the Layer.

The .NET Runtime Optimization Service is stopped

Finalize the OS layer

Once the Packaging Machine is created and any apps or updates installed, you'll need to finalize the layer.

Note: When you finalize a new version of an OS Layer, Unidesk deletes the Packaging Machine so as not to incur more

costs.

When a layer is ready to finalize:

1. Return to the Unidesk Management Console.

2. In the Layers module, select the Layer.

3. Select Finalize in the Action bar.

4. Monitor the Task bar to verify that the action completes successfully and that the layer is deployable.

Reference: Create OS Version Wizard values

Version - (Required) This can be the version of the OS Layer or a version you assign to the Layer. This value is displayed in the

Details view of the Layer.

Version Description - (Optional) Enter a description of the version.
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Max Layer Size - (Optional) Maximum layer size in gigabytes. Layers are thin provisioned, and will grow as needed, up to the

maximum size. The default Max Layer Size is 100 gigabytes. If  the version you are creating could requires more space,

change this to a realistic value.

Select a Platform Connector configuration - (Required) Specify a Unidesk Platform Connector for the platform where you'll

be publishing your Layered Images. For example, if  you're publishing to Azure RD Session Host, select the Azure RDSH

connector with the credentials required to access the account. If  the configuration you need is not listed, add a New one

and select it from this list. If  you want to change the settings of a Platform Connector configuration, select it and click

Edit.

Packaging Disk Filename - (Required) The name of the Packaging Machine you created in Azure.
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Delete OS layer

Jun 29, 2017

You can delete an OS Layer or Layer version, as long as it is not being used by another Layer, or Image Template. Deleting

the Layer itself  removes all versions, volumes, and resources from the App Layering appliance.

You can delete an entire layer or a layer version if  it is:

Not deployed to an Image Template.

Not the required OS Layer (or Layer Version) for any compatible App Layers.

Not a prerequisite for another Layer that is deployed to an Image Template.

Delete a layer or layer version

1. In the Management Console, select Layers.

2. Select an OS Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.
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Delete platform layer

Jun 29, 2017

You can delete a Platform Layer or Layer version, as long as it is not being used by an Image Template. Deleting the Layer

itself  removes all versions and resources associated with the Layer.

1. In the Management Console, select Layers > Platform Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Delete app layer

Jun 29, 2017

You can delete an app layer or layer version, as long as it is not being used by another layer as a prerequisite, or deployed to

an image template. Deleting the layer itself  removes all versions and resources associated with the layer.

1. In the Management Console, select Layers > Application Layers.

2. Select a Layer to delete.

3. Select Delete Versions in the Action bar. This opens the Delete Version Layer wizard.

4. In the Version Selection tab, select the Version you want to delete, or select the Delete Layer check box to delete the

entire Layer and all Versions.

5. In the Confirm and Complete tab, verify that the correct Version (or Layer) is selected for deletion, enter a comment if

needed, and click Delete Versions.(missing or bad snippet).
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Manage image templates

Jun 29, 2017

When you create new layers and new versions to them, you can edit the layer selection in your image templates, and use

the templates to publish new versions of your layered images. Once created, a layered image is no longer associated with

the template used to create it. This means that you can change or delete a template without affecting any previously

published layered images.

Update image templates with a new layer version

When you add a new version to an app layer or an OS layer, you can quickly identify the image templates that include the

layer, and select which templates to update with the new version.

1. In the App Layering Management Console, select Layers > App Layers or Layers > OS Layers.

2. Select the Layer you updated, and click Update Assignments.

3. In the wizard that opens, select the new version of the layer that you want to assign. The image template assignment

tab lists the image templates that include the layer but are not yet assigned the new version.

4. On the image template assignment tab, select the image templates to which you want to assign the layer or layer

version.

Notes:

If  the list is empty, click the check box called, Show Image Templates already at this version. A list of grayed out names

may appear. These templates have already been assigned the Version.

You can use the Search f ield to f ilter this list by Layer or Version. If  you search on part of a Layer name or Version, any

entry that contains the search string is displayed.

5. Skip the Elastic Assignment tab

6. On the Confirm and Complete tab, verify your choices and click Update Assignments.

Edit any image template setting

When you want to change the settings that you use to publish any of your layered images, you can edit the image

template you originally used to publish the layered image(s) and publish a new version of the image(s).

1. In the App Layering Management Console (UMC), select the Images module.

2. Select the template you want to edit, and click Edit Template. This opens the Edit Template wizard.

3. On the Name and Description tab, you can change the Name, Description, and Icon for the Image.

4. On the OS Layer tab, you can select a different version of your chosen OS layer by expanding the layer and choosing a

different one.

5. On the App Assignment tab, you can add or remove app layers to include in the layered images that you publish using this

template. If  there is more than one version of a layer, you can choose a different version by expanding the layer and

choosing a different one.

6. On the Connector tab, you can change the location to which the Layered Image is published by selecting a different

Connector Configuration.

7. On the Platform Layer tab, you can change the selected Platform Layer, if  for example, you are publishing to a different

environment.

8. On the Layered Image Disk tab, you can edit the Layered Image Disk details, for example, to enable Elastic Layering on

the image.

9. In the Confirm and Complete tab, enter any comments you would like for this layer, and click Edit Template.
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Delete an image template

When you no longer need an Image Template, you can remove it from the Management Console.

1. In the Management Console, select the Images module.

2. Select the template you want to delete, and click Delete Template. This opens the Delete Template wizard.

3. In the Confirm and Complete tab, enter any comments you would like, and click Delete Template.
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Terminology

Jun 29, 2017

This section contains terminology across all platforms and operating systems that App Layering supports. Some of these

terms may not pertain to your environment.

A

App Layer

A virtual disk containing one or more applications that you can use in any number of Layered Images. When publishing a

Layered Image, you can combine an App Layer with the OS Layer used to create it, other App Layers, and a Platform Layer.

C

Connector

Connectors are the interfaces to environments where layers are created and images are published. The type of platform

connector determines the information required to create a specific Connector Configuration.

Connector Configuration

A stored set of values for connecting to a specific environment. A configuration typically includes credentials for

authentication, a storage location, and any other information required to interface with the environment where you will be

creating layers or publishing images.

D

Directory Junction

A connection to a base Distinguished Name in a directory service (such as Microsoft Active Directory). Adding a Directory

Junction to the local tree allows you to assign Administrator privileges to users that are defined in the directory service

instead of in the Unidesk Management Console.

Directory service

A hierarchical repository of information about users, devices and services on a network server. Microsoft Active Directory

and LDAP are examples of directory services.

Directory service user

A user whose attributes reside in a remote directory service but is also visible in the Unidesk environment through the use of

a directory junction. You can assign Unidesk Administrator privileges to users.

Directory tree

A view of data in a hierarchical, tree-like structure. The Unidesk directory tree contains entries for users, groups, containers,

and Virtual Machines. You can extend this view by adding connections to a remote directory service, such as Active

Directory.

E

Elastic Layer

A Unidesk App Layer that the Unidesk administrator can deliver based on user entitlements when users log onto sessions or

standalone desktops. Elastic Layers allow administrators to give each user his/her own unique set of applications, on top of

the base Layered Image used across sessions (in the case of session hosts), and across floating pools/shared groups (in the

case of desktops). This can drastically reduce the number of base Layered Images that administrators need to maintain.

Enterprise Layer Manager (ELM)

A virtual appliance that coordinates communication in the Unidesk environment, and hosts the Unidesk Management

Console (UMC), the administrator interface for the Unidesk environment. The ELM also manages copies of all Layers.

I

Image Template

An Image Template saves the OS Layer, App Layer, and Platform Layer assignments you have chosen for a Layered Image,

allowing you to use any combination of layers to provision any number of servers.
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L

Layer

A Unidesk layer captures a Windows Operating System, a Windows Application, or the configuration settings and tools

required for Images to run on a particular platform in a virtual disk that can be combined with other layers to create a

Layered Image. Layers are created from a simple install of the application or operating system. You can select any

combination of Layers for each Layered Image. You can reuse the same layers in any combination to provision a variety of

servers.

Layered Image

A bootable image composited from an OS Layer, a Platform Layer, and any number of App Layers. Layered Image(s) are

published using Image Templates where you save your layer selections for a particular use, usually provisioning servers in a

specific silo.

Layering Management Console (LMC)

The Web-based management console that runs on the Enterprise Layer Manager (ELM). This console allows you to manage

the App Layering components in your environment. You can use is to create Layers, publish Layered Images, and manage

system settings.

Local Storage

A Layer repository where the ELM creates, composites, and stores Layers and Layered Images. Local storage is used for

temporary files during the creation of Layers and Layered Images, and for persistent files, for example, Layers and Image

Templates. Administrators can define the Network File Share location that will be used for Elastic Layers in the UMC’s

System and Settings.

O

OS Disk

The virtual disk containing the Operating System that is imported to create an OS layer. To prepare the OS disk you will

install and configure an Operating System on a virtual machine and install the Unidesk tools. The OS Disk is the virtual disk

where the Operating System was installed.

OS Layer

A virtual disk containing the operating system. You can use an OS Layer with any compatible App Layers in any number of

Layered Images. You can create a new Version of the OS Layer for every patch you need to roll out, and continue deploying

every and all versions of the layer as you add patches.

OS Machine

The Operating System (OS) Machine is a virtual machine that you create from which you can generate an OS Disk and an

OS Layer.

P

Packaging Disk

A bootable virtual disk used to create a Packaging Machine needed for creating or updating a Layer. The Packaging Disk

always includes your OS Layer and may also include selected Application and Platform Layers.

Packaging Machine

A virtual machine that acts as a staging area for the creation of App Layers, App Layer Versions, and OS Layer Versions. The

Packaging Machine is booted from a Packaging Disk using the credentials and location specified in the selected Connector

Configuration.

Platform Layer

A layer that includes configuration settings, tools, and other software required for Images to run on a particular platform.

For example, a platform layer for vSphere would include vmTools. Platform Layers also remove leftover software from other

platforms from your image.

Prerequisite Layer

An application that is required when installing another application for a new Application Layer or Layer Version. For example,
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you would select your Microsoft Office App Layer as a Prerequisite Layer when installing a Microsoft Office plugin in a

separate App Layer. Or, you would select your Java App Layer as a Prerequisite Layer when creating a Layer for an

application that requires Java.

S

Session Container

A Citrix technology that allows different users logged into the same Session Host to be assigned different versions of the

same Elastic Layer, and ensures that those Layer versions do not conflict.
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